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CAPÍTULO 1

Preambulo

Este documento é o guia do usuário original do software descrito QGIS. O software e hardware descrito neste
documento são, na maioria dos casos, marcas registradas e são, portanto, sujeitas a requisitos legais. QGIS está
sujeito à Licença Pública Geral GNU. Encontre mais informações sobre o QGIS na página, http://www.qgis.org.

Os detalhes, dados e resultados neste documento podem ter sido escritos e verificados para melhorar o conheci-
mento e a responsabilidade dos autores e editores. No entanto, erros relativos ao conteúdo são possíveis.

Portanto, os dados não estão sujeitos a quaisquer direitos ou garantias. Os autores, editores e editoras não têm
qualquer responsabilidade por falhas e suas consequências. Você é sempre bem-vindo para relatar possíveis erros.

Este documento foi elaborado com reStruturedText. Ele está disponível como código-fonte reST via github e
on-line como HTML e PDF via http://www.qgis.org/en/docs/. As versões traduzidas deste documento também
podem ser baixadas em vários formatos através da área de documentação do projeto QGIS. Para mais informações
sobre a contribuir para este documento e sobre a tradução, por favor visite http://www.qgis.org/wiki/.

Links neste Documento

Este documento contém links internos e externos. Clicando sobre um link interno move-se dentro do documento,
ao clicar em um link externo abre um endereço de internet. Em formato PDF, links internos e externos são
mostradas em azul e são tratados pelo navegador do sistema. Em formato HTML, o navegador exibe e trata ambos
de forma idêntica.

Usuário, Instalação e Código Guia dos Autores e Editores:

Copyright (c) 2004 - 2014 QGIS Equipe de Desenvolvimento

Internet: http://www.qgis.org

Licença deste documento

Permissão é garantida para cópia, distribuição e/ou modificação deste documento sobre os tremos da Licença
de Documentação Livre GNU, Versão 1.3 ou versão mais recente publicada pela Fundação Software Livre; sem
Seções Invariantes, sem textos de Capa e sem textos de Contra-Capa. A cópia da licença é incluida no Apêndice
GNU Licença de Documentação Gratuíta.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 2

Convenções

Esta seção descreve os estilos uniformes que serão utilizados ao longo deste manual.

2.1 Convenções da Interface Gráfica

Os estilos convenção da GUI, são destinados a similar a aparência gráfica. Em geral, um estilo vai refletir a
aparência, para que um usuário possa verificar visualmente a GUI e encontrar algo semelhante com as instruções
no manual.

• Menu Opções: Camada → Adicionar uma camada Raster ou Configurações → Barra de Ferramentas →
Digitalizar

• Ferramenta: Adiciona uma camada Raster

• Botão : [Salvar como padrão]

• Caixa de diálogo Título: Propriedades da camada

• Aba: Geral

• Caixa de seleção: Renderizar

• Botão de opção: Postgis SRID EPSG ID

• Selecione um número:

• Selecione uma frase:

• Procure pelo arquivo:

• Selecione uma cor:

• Barra deslizante:

• Entrada de texto:

Uma sombra indica um componente GUI clicável.

2.2 Convenções do Texto ou Teclado

Este manual também inclui estilos relacionados ao texto, comandos de teclado e de codificação para indicar
diferentes entidades, tais como classes ou métodos. Estes estilos não correspondem à aparência real de qualquer
texto ou codificação dentro do QGIS.

• Hyperlinks: http://qgis.org

5
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• A Combinação das teclas: Press Ctrl+B, ou seja, pressione e segure a tecla Ctrl e, em seguida, pressione
a tecla B.

• Nome de um arquivo: lakes.shp

• Nome de uma classe: NewLayer

• Método: classFactory

• Servidor: myhost.de

• Texto de Usuário: qgis --help

Linhas de código serão indicadas por uma fonte de tamanho fixo:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Instruções especificas da Plataforma

Sequências de GUI e pequenas quantidades de texto podem ser formatadas em linha: Clique Arquivo

QGIS → Sair para fechar o QGIS. Isso indica que em plataformas Linux, Unix e Windows, você deve clicar
primeiro no menu Arquivo, em seguida, Sair, enquanto nas plataformas Macintosh OS X, você deve clicar primeiro
no menu QGIS e, em seguida Sair.

Grandes quantidades de texto podem ser formatados com uma lista:

• Faz isso

• Faz aquilo

• Faz outro

ou um parágrafo:

Faz isso, isso e isso. Então faz isso, isso e isso e isso, isso e isso, e isso, isso e isso.

Faz aquilo. E faz aquilo e aquilo e aquilo, e aquilo e aquilo e aquilo, e aquilo e aquilo e aquilo, e aquilo e aquilo
e aquilo, e aquilo e aquilo e aquilo.

Imagens que aparecem ao longo do guia do usuário foram criadas em diferentes plataformas, a plataforma é
indicada pelo ícone específico da plataforma no final da legenda da figura.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 3

Preâmbulo

Bem vindo ao mundo maravilhoso dos Sistemas de Informação Geográficas (SIG)!

QGIS é um Sistema de Informação Geográfica de Código Aberto. O projeto nasceu em maio de 2002 e foi criado
como um projeto no SourceForge, em junho do mesmo ano. Nós trabalhamos duro para tornar o software SIG
(que é um software proprietário tradicionalmente caro) uma perspectiva viável para qualquer pessoa com acesso
básico a um computador pessoal. QGIS atualmente funciona na maioria das plataformas Unix, Windows e OS
X. QGIS é desenvolvido usando o Qt toolkit (http://qt.digia.com) e C ++. Isso significa que QGIS é considerado
amigável e tem uma interface gráfica (GUI) agradável e fácil de usar.

QGIS pretende ser um SIG de fácil utilização, fornecendo funções e feições comuns. O objetivo inicial do projeto
era fornecer um visualizador de dados SIG. QGIS chegou ao ponto em sua evolução, onde ele está sendo usado
por muitos para as suas necessidades de visualização de dados SIG diárias. QGIS suporta um grande número de
formatos de dados raster e vetoriais, com o novo formato, suporta facilmente a sua adição de outros, usando a
arquitetura de complementos.

QGIS é distribuído sob a GNU General Public License (GPL)/Licença Publica Geral. Desenvolvendo QGIS sob
esta licença significa que você pode inspecionar e modificar o código-fonte, e garante que você, nosso feliz usuário,
sempre terá acesso a um programa de SIG que é livre de custos e podem ser livremente modificado. Você deve ter
recebido uma cópia completa da licença com a sua cópia do QGIS, e você também pode encontrá-la no Apêndice:
ref: gpl_appendix.

Dica: Atualização da Documentação
A versão mais recente deste documento pode ser encontrada na área de documentação do QGIS website em
http://www.qgis.org/en/docs/.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 4

Características

QGIS offers many common GIS functionalities provided by core features and plugins. A short summary of six
general categories of features and plugins is presented below, followed by first insights into the integrated Python
console.

4.1 Visualização de dados

Pode ver ou sobrepor dados vectoriais e matriciais em diferentes formatos e projecções sem conversão para um
formato interno ou comum. Os formatos suportados incluídos são:

• Spatially-enabled tables and views using PostGIS, SpatiaLite and MS SQL Spatial, Oracle Spatial, vector
formats supported by the installed OGR library, including ESRI shapefiles, MapInfo, SDTS, GML and
many more. See section Trabalhando com Dados Vetoriais.

• Raster and imagery formats supported by the installed GDAL (Geospatial Data Abstraction Library) li-
brary, such as GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG and many more. See section
Trabalhando com Dados Raster.

• GRASS raster and vector data from GRASS databases (location/mapset). See section Integração com SIG
GRASS.

• Online spatial data served as OGC Web Services, including WMS, WMTS, WCS, WFS, and WFS-T. See
section Trabalhando com dados OGC.

• OpenStreetMap data. See section plugins_osm.

4.2 Exploração de dados e compositores de mapas

You can compose maps and interactively explore spatial data with a friendly GUI. The many helpful tools available
in the GUI include:

• Pesquisador QGIS

• Reprojecção On-the-fly

• Gestor BD

• Compositor de Mapas

• Painel de Vista Global

• Marcadores espaciais

• Ferramentas de anotação

• Identificar/seleccionar elementos

• Editar/ver/procurar atributos

9
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• Data-defined feature labeling

• Data-defined vector and raster symbology tools

• Atlas map composition with graticule layers

• North arrow scale bar and copyright label for maps

• Support for saving and restoring projects

4.3 Criar, editar, gerir e exportar dados

You can create, edit, manage and export vector and raster layers in several formats. QGIS offers the following:

• Digitizing tools for OGR-supported formats and GRASS vector layers

• Ability to create and edit shapefiles and GRASS vector layers

• Georeferencer plugin to geocode images

• GPS tools to import and export GPX format, and convert other GPS formats to GPX or down/upload directly
to a GPS unit (On Linux, usb: has been added to list of GPS devices.)

• Support for visualizing and editing OpenStreetMap data

• Ability to create spatial database tables from shapefiles with DB Manager plugin

• Tratamento melhorado de tabelas de bases de dados espaciais

• Tools for managing vector attribute tables

• Option to save screenshots as georeferenced images

4.4 Análise de dados

You can perform spatial data analysis on spatial databases and other OGR- supported formats. QGIS currently
offers vector analysis, sampling, geoprocessing, geometry and database management tools. You can also use
the integrated GRASS tools, which include the complete GRASS functionality of more than 400 modules. (See
section Integração com SIG GRASS.) Or, you can work with the Processing Plugin, which provides a power-
ful geospatial analysis framework to call native and third-party algorithms from QGIS, such as GDAL, SAGA,
GRASS, fTools and more. (See section Introdução.)

4.5 Publicação de mapas na internet

QGIS can be used as a WMS, WMTS, WMS-C or WFS and WFS-T client, and as a WMS, WCS or WFS server.
(See section Trabalhando com dados OGC.) Additionally, you can publish your data on the Internet using a
webserver with UMN MapServer or GeoServer installed.

4.6 Funcionalidades do QGIS expandida através de módulos

QGIS can be adapted to your special needs with the extensible plugin architecture and libraries that can be used
to create plugins. You can even create new applications with C++ or Python!
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4.6.1 Módulos Core

Core plugins include:

1. Coordinate Capture (Capture mouse coordinates in different CRSs)

2. Gestor BD (Troca, edição, e visualizalização de camadas e tabelas; execução de consultas SQL)

3. Diagram Overlay (Place diagrams on vector layers)

4. Dxf2Shp Converter (Convert DXF files to shapefiles)

5. eVIS (Visualize events)

6. fTools (Analyze and manage vector data)

7. GDALTools (Integração das Ferramentas GDAL no QGIS)

8. Georeferencer GDAL (Add projection information to rasters using GDAL)

9. GPS Tools (Load and import GPS data)

10. GRASS (Integrate GRASS GIS)

11. Heatmap (Generate raster heatmaps from point data)

12. Interpolation Plugin (Interpolate based on vertices of a vector layer)

13. Offline Editing (Allow offline editing and synchronizing with databases)

14. Oracle GeoRaster Espacial

15. Processamento (anteriomente designado de SEXTANTE)

16. Raster Terrain Analysis (Analyze raster-based terrain)

17. Road Graph Plugin (Analyze a shortest-path network)

18. Módulo de Consulta Espacial

19. SPIT (Import shapefiles to PostgreSQL/PostGIS)

20. Módulo SQL Anywhere (Armazena camadas vectoriais dentro de base de dados SQL Anywhere)

21. Topology Checker (Find topological errors in vector layers)

22. Zonal Statistics Plugin (Calculate count, sum, and mean of a raster for each polygon of a vector layer)

4.6.2 Módulos Externos Python

QGIS offers a growing number of external Python plugins that are provided by the community. These plugins
reside in the official Plugins Repository and can be easily installed using the Python Plugin Installer. See Section
O menu de complementos.

4.7 Consola Python

For scripting, it is possible to take advantage of an integrated Python console, which can be opened from menu:
Plugins → Python Console. The console opens as a non-modal utility window. For interaction with the QGIS en-
vironment, there is the qgis.utils.iface variable, which is an instance of QgsInterface. This interface
allows access to the map canvas, menus, toolbars and other parts of the QGIS application.

For further information about working with the Python console and programming QGIS plugins and applications,
please refer to http://www.qgis.org/html/en/docs/pyqgis_developer_cookbook/index.html.
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4.8 Known Issues

4.8.1 Number of open files limitation

If you are opening a large QGIS project and you are sure that all layers are valid, but some layers are flagged as
bad, you are probably faced with this issue. Linux (and other OSs, likewise) has a limit of opened files by process.
Resource limits are per-process and inherited. The ulimit command, which is a shell built-in, changes the limits
only for the current shell process; the new limit will be inherited by any child processes.

You can see all current ulimit info by typing

user@host:~$ ulimit -aS

You can see the current allowed number of opened files per proccess with the following command on a console

user@host:~$ ulimit -Sn

To change the limits for an existing session, you may be able to use something like

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

To fix it forever

On most Linux systems, resource limits are set on login by the pam_limits module according to the settings
contained in /etc/security/limits.conf or /etc/security/limits.d/*.conf. You should be
able to edit those files if you have root privilege (also via sudo), but you will need to log in again before any
changes take effect.

More info:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 5

O que há de novo no QGIS 2.2

Por favor, note que está é uma versão de uma nova fase do QGIS. Assim, ele contém novos recursos e estende a
interface programática do QGIS 2.0. Nós recomendamos que se utilize esta versão do que as anteriores.

Esta versão inclui a correção de centenas de bugs, além de novos recursos e aprimoramentos que serão descritos
neste manual. Você também pode rever a lista de mudanças em http://changelog.linfiniti.com/qgis/version/21/.

5.1 Aplicação e opções de projeto

• Suporte para medidas em milhas naúticas: Você agora pode medir distâncias utilizando milhas naúticas
como unidade de medida. Para habilitá-lo, use o Configurações → Opções → Ferramentas de mapa no
painel de opções

5.2 Provedor de arquivos

• Suporte para relacionamentos Um-para-muitos: Esta versão suporta a capacidade de definir relações
1:n. As relações são definidas na caixa de diálogo propriedades do projeto. Uma vez que existem relações
para uma camada, um novo elemento de interface em uma janela (ex., ao identificar uma feição e abrir um
formulário) listarão as entidades relacionadas. Isto oferece uma poderosa forma de expressar, por instâncias,
o histórico de impressões em um duto ou trecho de rodovia.

• Ferramenta para exportar DXF: Uma nova ferramenta para exportação de DXF’s foi acrescentado ao
menu Projeto.

• Colar como uma nova camada vetorial: É uma atividade comum em SIG criar uma sub-seleção e depois
criar uma nova camada a partir da seleção. No QGIS você já pode realizar isto; agora, a funcionalidade é
oferecida e permite você criar um novo arquivo ou uma camada temporária do que está na lista de trasferên-
cia. SImplesmente selecione algumas feições, copie-as para a sua lista de transferência e depois vá a Editar
→ Colar feições como e escolha ‘Nova camada vetorial’ ou ‘Nova camada temporária’ no submenu. O mel-
hor dessa nova ferramenta é que se você tem feições Well Known Text (WKT) na sua lista de transferência
de um outro aplicativo, você pode simplesmente colá-lo no QGIS como uma nova camada.

• Legenda de WMS na lista de camadas e no compositor: Versões prévias ao QGIS 2.2 não eram capazes
de mostrar a legenda de um WMS na lista de camadas. Similarmente, a legenda não podia ser mostrada no
compositor de mapa. O QGIS 2.2 incluiu ambas questões.

5.3 Digitalização

• Ferramenta de preenchimento de anel: Esta nova ferramenta é utilizada para cortar vazios em polígonos
e prrenchê-los automaticamente com novas feições. Se você pressionar Ctrl enquanto finaliza a feição, os
atributos serão herdados da feição mais completa.
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5.4 Geral

• Expressões recentes salvas: O criador de expressões permitirá salvar as últimas 20 expressões utilizadas.

• Colar WKT da área de transferência: Agora o QGIS pode colar e criar uma nova feição baseada no WKT
que se encontra na área de transferência. Apenas copie o WKT e cole em uma camada editável. Você pode
também criar uma nova camada por seleção Editar → Colar Como → Nova Camada Temporária.

5.5 Compositor de impressão

• Melhorias na borda do mapa estilo zebra Você pode ajustar as cores da borda do mapa estilo zebra no
compositor de impressão.

• Suporte para rotação de elementos Todo tipo de elementos no compositor pode ser rotacionado, incluindo
barras de escala, tabelas e legendas. Por exemplo, você pode rotacionar um rótulo na composição para
ajustá-lo melhor ao modelo do mapa (como ilustrado). O redimensionamento de elementos rotacionados
também foi melhorado.

• Melhorias na escala e régua no compositor: A aparência das réguas têm sido aperfeiçoado ajustando pela
lógica da escala e adicionando divisões menores na régua, além de utilizar textos rotacionados no sentido
vertical da régua. Também existe uma nova ação do compositor para esconder/mostar réguas. Você pode
rapidamente dar um zoom em 100% da escala da página usando a nova opção na barra de ferramentas.
A janela do compositor agora permite rapidamente trocar a escala da página através de uma nova caixa
de combinação na barra de status. Além disso, um novo indicador foi adicionado para mostrar a posição
precisa do pixel do cursor do mouse. Os botões de [Fechar] and [Ajuda] foram removidos da janela do
compositor para dar o máximo de espaço na tela para se trabalhar.

• Geração de arquivos World: No compositor, agora você pode criar mapas georreferenciados. Simples-
mente se assegure que escolheu o elemento do mapa correto na aba de composição e exporte seu mapa
como um arquivo PNG. Um acompanhamento do arquivo world será criado, permitindo carregar seu mapa
no QGIS como uma camada matricial.

• **Trabalhando com múlitplos itens: Agora é possível mover e redimensionar múltiplos itens simultane-
amente. Para isso, basta pressionar Shift enquanto redimensiona para manter a relação entre os itens,
ou Ctrl para redimensionar a partir de um item central. Estes atalhos são também aplicáveis para mover
itens, então pressione Shift enquanto move um item no sentido horizontal ou vertical e segure temporari-
amente Ctrl para desabilitar o ajuste automático dos itens. Você também pode sergurar Shift enquanto
pressiona uma tecla para deslocar todos os itens selecionados.

• Melhorias no Atlas: Você pode pré-visualizar páginas individuais no Atlas que é gerado no compositor. No
modo de pré-visualização do Atlas, você pode exportar apenas a página atual sem fazer o mesmo para todo o
Atlas. Você também pode ajustar a extensão do mapa ou escala para cada feição enquanto pré-visualiza uma
determinada página. As opções do Atlas foram movidas do painel do atlas para o painel das propriedades do
mapa, então, agora, mais de um mapa pode ser controlado pela ferramenta de Atlas. Existe uma nova opção
para centralizar automaticamente a visão geral do mapa, enquanto se está criando mapas em atlas. Maiores
informações estão também disponíveis para você ajustar sua simbologia baseado na funcionalidade do atlas
ou não.

• Aperfeiçoado a seleção de item: Você pode selecionar mais de um item apenas clicando e arrastando
uma caixa para selecionar múltiplos itens, existindo atalhos para permitir adicionar itens a uma seleção já
criada (segurando Shift enquanto seleciona), retirando de uma seleção (segurando Ctrl enquanto clica)
e alternando para “dentro” do modo de seleção (pressionando Alt enquanto clica). Clique com shift em um
item já selecionado o removerá da seleção. Também existem atalhos e menus para selecionar todos os itens,
limpar uma seleção e invertê-la. Também é possível selecionar itens que estão escondidos abaixo de outros
com um clique com Ctrl no item ou utilizando ‘Selecione o próximo item acima/abaixo’ no novo menu de
edição do compositor

• Melhor navegação de composições: QGIS 2.2 inclui muitas melhorias para ajudar a navegar em suas
composições. Você pode dar zoom maior ou menor usando a roda de rolagem do mouse. Uma ferramenta
de mover foi acrescentado, o que permite arrastar a composição em volta e trocar imediatamente para o
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modo de mover pressionando a barra de espaço ou pressionando a roda de rolagem do mouse. Também
existe uma nova ferramenta de zoom, que permite dar um zoom em uma área específica na sua composição.
Você também pode alternar para o modo de zoom em qualquer momento apenas pressionando Ctrl-Barra
de Espaço e desenhando um zoom em qualquer região da composição

• Melhoramento no estilo de páginas e formas: Você agora pode controlar o estilo do fundo da com-
posição utilizando todas as opções da simbologia do QGIS. É possível exportar composições com um fundo
transparente (ou semitransparente). Itens de forma (retângulos, triângulos e elipses) podem ser estilizados
utilizando as mesmas opções de uma camada de polígono. Você pode, inclusive, estilizar o fundo da página
ou as formas usando opções definidas baseadas na ferramenta de atlas! Existe uma nova opção para cantos
arredondados dos retângulos.

5.6 QGIS Server

• Adicionado suporte WCS ao QGIS Server: O QGIS Server suporta vários padrões, incluindo Web Map
Service (WMS versão 1.3.0 e 1.1.1), Web Feature Service (WFS versão 1.0.0) and Web Feature Service
Transacional (WFS-T). Nesta nova versão, você poderá fornecer serviços de camadas matriciais utilizando
o padrão Web Coverage Service (WCS versão 1.0.0).

5.7 Simbologia

• Suporte para preenchimento em gradiente: A nova funcionalidade de preenchimento em gradiente per-
mite criar melhores mapas do que antes. Esta funcionalidade tem numerosas opções provendo com grande
flexibilidade a forma de aplicar os gradientes às suas feições. Estas incluem:

– Preenchimento em duas cores ou em rampa de cores

– Tela- ou origem baseado em objetos e seus gradientes

– Gradientes originados a partir do centróide de uma feição

– Tipos de gradientes cônico, linear e radial

– Opções de dados definidos (ex. usar uma expressão ou uma coluna da

tabela) para todas as propriedades de gradientes

• Suporte de rótulo para rampa em camadas matriciais: Rasters que utilizam uma paleta de cores fixas
(para instâncias, um mapa de cobertura) podem ter categorias de rótulos nomeadas com o que será mostrado
na legenda do mapa e na legenda do compositor.

• Rampa de cores pode ser invertida Uma nova opção que foi acrescentada às opções de simbologias rela-
cionada às rampas de cores é que permite inverter a rampa após criada

• Copiar e colar no renderizador baseado em regra: No renderizador baseado em regra, você pode em um
clique com o botão direito do mouse numa regra, copiá-la e colá-la como uma nova regra.

• Recurso de generalização on-the-fly: O QGIS 2.2 introduz o recurso de generalização para o on-the-fly.
Isto pode melhorar o tempo de renderização enquanto se desenha inúmeras feições complexas em escala
pequena. Este recurso pode ser habilitado ou desabilitado nas propriedades da camada. Existe também uma
nova opção geral que habilita a generalização por padrão para novas camadas adicionadas. Nota: O recurso
de generalização pode apresentar artefatos no resultado da renderização em alguns casos. Isto pode incluir
linhas entre polígonos e uma renderização inexata quando utilizado simbologia com offset.

• Pontos âncoras podem ser ajustados para marcadores: Quando definida a simbologia com marcadores
(ex. uma camada de ponto simbolizada com marcadores SVG), você pode especificar qual parte da imagem
deve corresponder ao ‘ponto âncora’. Por exemplo, você pode indicar que o canto inferior esquerdo de uma
imagem deve coincidir com a posição da feição. Você também pode utilizar as propriedades de dados
definidos para ter este conjunto de propriedades em tempo baseado no atrbuto da tabela de uma camada (ou
uma expressão arbitrária).
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• Mapas temáticos baseados em expressões: Mapas temáticos categorizados ou graduados podem ser cri-
ados utilizando como resultado uma expressão. No diálogo de propriedades de uma camada vetorial, o
atributo adotado tem sido aumentado com um criador de expressões. Agora, não é necessário escrever a
classificação do atributo em uma nova coluna na tabela de atributos se você quer que a classificação do
atributo seja composta de múltiplos campos ou um qualquer tipo de fórmula.

• Suporte para expressões nos diagramas de símbolos para tamanho e atributos: Você pode usar uma
expressão para definir o tamanho e atributos quando utilizar as capacidades de construção de diagramas do
QGIS.

• Outra regra no renderizados baseado em regra: O renderizador baseado em regra suporta uma outra
regra que rodará se nenhuma outra neste nível corresponder. Outras regras podem ser encaixadas assim
como quaiquer outras. Um exemplo pode ser:

type = ’water’ (style grey) ELSE (style red)

• Apoio de traçado interno para polígonos: Foi adicionado suporte para o traçado de polígonos a serem
limitados no interior do polígono (para não transbordar para um polígono vizinho).

5.8 Interface de usuário

• Melhorias no diálogo de propriedades: Todas as propriedades diálogos tiveram seus menus atualizados
para que eles se pareçam mais lisos, com uma barra lateral de cor inversa. Isto é puramente comético, mas
deve facilitar as atividades neste diálogo.

• Melhorias no diálogo de expressões: Fizemos alguns ajustes para o diálogo de expressão - usuários avança-
dos podem esconder os botões de operação. Existem também novos divisores entre as áreas da lista de
funções, de ajudas e de expressões.

• Novas combinações de teclas: Nós atualizamos os atalhos no QGIS para fazê-lo mais eficiente em tarefas
repetitivas.

– Ctrl-d: Remove camadas selecionadas na tabela de atributos

– >: Seleciona o próximo vértice utilizando a ferramenta de nós

– <: Seleciona o vértice anterior utilizando a ferramenta de nós

– Delete or Backspace: Deletar as feições selecionadas (você pode desfazer estas ações) ou nós
utilizando a ferramenta de nós

– F5: Atualiza a tela (ao invés do Ctrl-r)

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 6

Iniciando

Este capítulo da uma visão geral rápida sobre a instalação do QGIS, alguns dados de exemplo na web sobre o
QGIS e rodar uma primeira seção simples visualizando camadas raster e vetoriais.

6.1 Instalação

A instalação do QGIS é muito simples. Estão disponíveis pacotes de instalação padrão para MS Windows e Mac
OS X. Se proporcionam pacotes binarios (rpm e deb) ou repositórios de software para adquirir o seu gerenciador
de instalação de pacotes para diversos savidores de GNU/Linux. Consiga as últimas informações sobre pacotes
binarios na página do QGIS na internet em http://download.qgis.org.

6.1.1 Instalação à partir da fonte

Se necessitar compilar o QGIS a partir da fonte, por favor consulte as instruções de instalação. São distribuídas
com o código fonte do QGIS em um arquivo chamado INSTALL. Tambem pode encontrar em linha de comando
em http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Instalação no dispositivo de armazenamento externo

QGIS te permite definir uma opção --configpath que sobrepõe uma rota pré-determinada pel configuração
do usuário (ex.: ~/.qgis2 bajo Linux) e também força uma QSettings ao usar esse diretório. Ele te permite, por
exemplo, levar uma instalação do QGIS em uma memória flash junto com todos os complementos e a configuração.
Veja a seção Menu Sistema para informações adicionais.

6.2 Amostra de Dados

O guia de utilizador contém exemplos baseados no conjunto de amostra de dados do QGIS.

O instalador do Windows tem uma opção para baixar o conjunto de dados de amostra do QGIS. Ao marcar a
opção, os dados serão baixados em sua pasta Meus Documentos e ficarão locados em uma pasta chamada GIS
Database. Pode-se usar o Windows Explorador para mover esta pasta para um local adequado. Se não marcar a
caixa de seleção para instalação do conjunto de dados de amostra durante a instalação inicial do QGIS, pode optar
por uma das seguintes:

• Usar dados SIG que já possuo

• Baixar dados de amostra de http://download.osgeo.org/qgis/data/qgis_sample_data.zip

• Desinstalar QGIS e reinstalar com a opção baixar dados marcada (só recomendado de as soluções anteriores
não funcionarem)

17

http://download.qgis.org
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html
http://download.osgeo.org/qgis/data/qgis_sample_data.zip


QGIS User Guide, Versão 2.2

Para GNU/Linux e Mac OS X, ainda não existe disponível pacotes de instalação de dados no formato rpm,
deb ou dmg. Para usar o conjunto de dados de amostra, baixe o arquivo qgis_sample_data como um arquivo
ZIP de http://download.osgeo.org/qgis/data/qgis_sample_data.zip e descompacte os arquivos no seu sistema.

O banco de dados Alaska inclue todos dados SIG que voce usará nos exemplos e verá nas imagens do manual do
usuário; também inclui uma pequena base de dados do GRASS. A projeção usada nos dados de exemplo do QGIS
é Alaska Albers Equal Area em unidade pés. O código EPSG é 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Se você pretende usar o QGIS como um visualizador gráfico para o GRASS, você pode encontrar uma
seleção de localizações de amostra (ex.:, Spearfish or South Dakota) no site oficial do SIG GRASS,
http://grass.osgeo.org/download/sample-data/.

6.3 Sessão Amostra

Agora que voce tem o QGIS instalado e um conjunto de dados de amostra disponível,
nós gostaríamos de demostrar uma corta e simples seção no QGIS. Usaremos a ca-
mada raster qgis_sample_data/raster/landcover.img, e o camada vetor lakes,
qgis_sample_data/gml/lakes.gml.

6.3.1 Iniciar o QGIS

• Iniciar QGIS teclando “QGIS” um uma linha de comando prompt, ou usando-se um binário pré-
combinado, usando o menu de Aplicativos.

• Inicie o QGIS usando o menu Iniciar ou o atalho do ambiente de trabalho, ou de duplo clique no arquivo
de projeto QGIS.

• de duplo clique no ícone na sua pasta de Aplicações.

6.3.2 Carregue camadas vetoriais ou raster a partir do conjunto de amostras de
dados

1. Clique no ícone Carregar Raster

2. Navegue até a pasta qgis_sample_data/raster/, selecione o arquivo ERDAS IMG
landcover.img e clique [Abrir].
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3. Se o arquivo não for localizado, confira se quadro combinado Tipos de Arquivos da parte de baixo do
diálogo está estabelecido o tipo correto, neste caso “Erdas Imagine Images (*.img, *.IMG)”.

4. Agora clique no ícone Carregar Vetor

5. Arquivo deveria estar selecionado como Tipo de origem na nova janela Adicionar camada vetorial.
Agora clique [Navegar] para selecionar a camada vetorial.

6. Navegue para a pasta qgis_sample_data/gml/, selecione ‘Geography Markup Language [GML]

[OGR] (.gml,.GML)’ para a caixa combinada Tipo de arquivo , em seguida selecione o arquivo GML
lakes.gml e clique [Abrir]. Na janela Adicionar camada vetorial, clique [OK].

7. Amplie um pouco até à sua área favorita com alguns lagos.

8. De duplo clique na camada lakes da legenda do mapa para abrir o diálogo Propriedades

9. Clique na janela Estilo e selecione um preenchimento de cor azul.

10. Clique na janela Etiquetas e marque a caixa de seleção Etiquetar esta camada com para habilitar o
etiqueta. Selecione o campo “NOMES” com o campo que contêm as etiquetas.

11. Para melhoras a leitura das etiquetas, pode adicionar um buffer branco ao redor dando um clique no “Buffer”

na lista da esquerda, marcando Desenhar buffer notexto e escolhendo 3 como tamanho do buffer

12. Clique [Aplicar]. Confira se o resultado ficou bom e clique finalizar [OK].

Pode ver como é fácil visualizar camadas raster e vetoriais no QGIS. Vamos até a seção seguinte para aprender
mais sobre as funções, características e configurações disponíveis e como usar-las.

6.4 Iniciar e Parar QGIS

Na seção Sessão Amostra você aprenderá como iniciar o QGIS. Repetiremos isto e verá que o QGIS também
proporciona outras opções de linha de comandos.

• Assumindo que o QGIS está instalado no PATH, inicie QGIS teclando qgis no console ao dando duplo
clique no link do aplicativo QGIS (ou atalho) no desktop ou no menu do aplicativo.

• Inicie o QGIS usando o menu Iniciar ou o atalho do ambiente de trabalho, ou de duplo clique no arquivo
de projeto QGIS.

• Duplo clique no ícone na sua pasta Aplicações. Se necessita iniciar QGIS na shell, execute
/path-to-installation-executable/Contents/MacOS/Qgis.

Para finalizar o QGIS, clique na opção do menu Arquivo QGIS → Sair, ou use o atalho Ctrl+Q.

6.5 Opções da Linha de Comandos

QGIS suportam um número de opções quando iniciam pelas linhas de comando. Para obter uma lista das
opções, introduza qgis --help na linha de comando. A sentença de uso para o QGIS é:

qgis --help
QGIS - 2.2.0-Valmiera ’Valmiera’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
Usage: qgis [OPTION] [FILE]
options:
[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
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[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--code path] run the given python file on load
[--help] this text

FILES:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - Supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - Supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Dica: Exemplo do Uso dos argumentos da linha de comandos
Inicie o QGIS para especificar um ou mais arquivos de dados na linha de comando. Por exemplo, assumindo ser
o diretório qgis_sample_data, voce inicia QGIS com uma camada de arquivo vetorial e uma raster estabele-
cidos para que se carregue no inicio, usando-se os seguintes comandos: qgis ./raster/landcover.img
./gml/lakes.gml

Opção da linha de comandos --snapshot

Esta opção permite que possa criar uma captura de ecrã no formato PNG da vista atual. Isto vem a calhar quando
tem vários projetos e quer gerar capturas de ecrã dos seus dados.

Currently, it generates a PNG file with 800x600 pixels. This can be adjusted using the --width and --height
command line arguments. A filename can be added after --snapshot.

Opção da linha de comandos --lang

Based on your locale, QGIS selects the correct localization. If you would like to change your language,
you can specify a language code. For example, --lang=it starts QGIS in italian localization. A list of
currently supported languages with language code and status is provided at http://hub.qgis.org/wiki/quantum-
gis/GUI_Translation_Progress.

Opção da linha de comandos --projeto

Iniciar o QGIS com um arquivo de projeto existente também é possível. Só adicione na linha de comando a
opção --project seguido do nome de seu projeto e QGIS irá abrir com todas as camadas carregadas no arquivo
indicado.

Opção da linha de comandos --extent

Use esta opção para iniciar com uma extensão de mapa específica. Necessita adicionar uma quadro delimitador
da sua extensão na seguinte ordem, seguido por uma vírgula:

--extent xmin,ymin,xmax,ymax

Opção da linha de comandos --nologo

Este argumento de linha de comando oculta a tela inicial quando você iniciar o QGIS.

Opção da linha de comandos --noplugins

Se você tiver problemas ao iniciar os complementos, poderá evitar iniciar-los com essa opção. Estarão sendo
disponíveis depois no gerenciador de complementos.

Opção de linha de comando --customizationfile
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Usando este argumento de linha de comando, você pode definir um arquivo GUI personalizado, que será aplicado
ao iniciar.

Opção da linha de comandos --nocustomization

Usando este argumento de linha de comando, um arquivo GUI personalizado existente, não será aplicado ao
iniciar.

Opção da linha de comandos --optionspath

Você pode ter múltiplas configurações e decidir qual usar quando iniciar o QGIS com esta opção. Veja Opções
para confirmar onde salvar os arquivos de configuração no sistema operacional. Atualmente não existe forma de
especificar um arquivo de configuração; portanto, pode-se criar uma cópia do arquivo de configuração original e
renomeá-lo

Opção da linha de comandos --configpath

Esta opção é similar a anterior, mas no entanto, anula o caminho predeterminado pela configuração do usuário
(~/.qgis2) e força QSettings para também usar esse diretório. Isto permite aos usuários, por exemplo, carregar
uma instalação QGIS na unidade flash, junto com todos os complementos e configurações.

6.6 Projetos

O estado de sua seção QGIS é considerado um projeto. QGIS trabalha em um projeto por vez. Configurações são
consideradas por projeto, ou como padrão pré-determinado para novos projetos (ver seção Opções). QGIS pode

salvar o estado de sua área de trabalho dentro do arquivo do projeto, usando a opção do menu Projeto →

Salvar ou Projeto → Salvar como....

Carregue o projeto salvo em uma seção QGIS usando Projeto → Abrir..., Projeto → Novo a partir de um
modelo ou Projeto → Abrir projeto recente →.

Se você deseja cancelar sua seção e iniciar outra escolha Projeto → Novo. Ou das opções do menu será
solicitado que você salve o projeto existente se houve mudanças desde a última vez que ele foi aberto ou salvo.

O tipo de informação guardado num arquivo de projeto inclui:

• Camadas adicionadas

• Propriedades da Camada, incluindo a simbolização

• Projeção para a vista do mapa

• Última extensão visualizada

O arquivo do projeto é salvo em formato XML, assim é possível editar o arquivo em outras versões do QGIS se
conhecer o que está fazendo. O formato do arquivo tem sido atualizado constantemente comparado com as versões
anteriores do QGIS. Os arquivos de projeto de versões antigas do QGIS não podem funcionar corretamente. Para
fazer isto, na janela Geral aba Configurações → Opções você pode selecionar:

• Avisar para salvar o projeto e alterações de fontes de dados quando necessário

• Avisar quando abrir um projeto salvo com uma versão antiga do |qg|

Sempre que salvar um projeto no QGIS 2.2 irá criar uma cópia de segurança do projeto.

6.7 Arquivo de Saída

Existem muitas maneiras de gerar uma saída para seção QGIS. Já discutimos isso na seção Projetos, salvando
como um arquivo de projeto. Aqui apresentamos outras formas de produzir arquivos de saída.
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• A opção do menu Projecto → Salvar como Imagem abre um diálogo de arquivo onde pode selecionar nome,
caminho e tipo de imagem (formato PNG ou JPG). Um arquivo world file com a extensão PNGW ou JPGW
é salvo na mesma pasta georeferenciando a imagem.

• Opção do menu Projeto → Exportar DXF ... abrirá a janela onde deve definir o ‘Modo da simbologia’, a
‘Escala da simbologia’ e a camada vetorial que irá exportar para DXF.

• Na opção de menu Projeto → Novo compositor de impressão abrirá a janela onde pode criar ou imprimir
o mapa atual (ver seção Compositor de Impressão).

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 7

QGIS GUI

Quando QGIS começa, você será apresentado a interface gráfica, como mostrado nas figuras (os números de 1 a 5
em círculos amarelos são discutidas abaixo).

Figura 7.1: GUI do QGIS com dados amostra do Alaska

Nota: Suas decorações de janela (barra de título, etc) podem parecer diferentes dependendo do seu sistema
operacional e gerenciador de janelas.

O GUI do QGIS é dividido em cinco áreas:

1. Barra de Menu

2. Barra de Ferraementas

3. Legenda do Mapa

4. Visualização do mapa

5. Barra de Status

Estes cinco componentes da interface do QGIS são descritos em mais detalhe nas seguintes secções. Mais duas
secções apresentam atalhos de teclado e ajuda do contexto.
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7.1 Barra de Menu

A barra de menu fornece acesso a diversas feições QGIS usando um menu hierárquico padrão. Os menus de nível
superior e um resumo de algumas das opções do menu estão listados abaixo, juntamente com os ícones associados
como eles aparecem na barra de ferramentas e atalhos de teclado. Os atalhos apresentados nesta seção são os
padrões; no entanto, os atalhos de teclado também podem ser configurados manualmente usando o :guilabel:
janela Configurar atalhos, aberto a partir de :menuselection:‘Configurações –> Configurar Atalhos... ‘.

Embora a maioria das opções de menu tem uma ferramenta correspondente e vice-versa, os menus não são orga-
nizados exatamente como as barras de ferramentas. A barra de ferramentas que contém as ferramentas que estão
listadas depois de cada opção habilitada no menu de entrada. Algumas opções de menu aparecem somente se o
complemento correspondente for carregado. Para mais informações sobre as ferramentas e barras de ferramentas,
consulte a seção :ref: label_toolbars.

7.1.1 Projecto

Opção de menu Atalho Referência Barra de Ferramentas

Novo Ctrl+N ver Projetos Projecto

Abrir Ctrl+O ver Projetos Projecto
Novo a partir do modelo → ver Projetos Projecto
Abrir Recente → ver Projetos

Guardar Ctrl+S ver Projetos Projecto

Salvar Como... Ctrl+Shift+S ver Projetos Projecto

Salvar como Imagem... ver Arquivo de Saída
Exportar DXF ... ver Arquivo de Saída

Novo compositor de impressão Ctrl+P ver Compositor de Impressão Projecto

Gestor de compositores ... ver Compositor de Impressão Projecto
Imprimir Compositores → ver Compositor de Impressão

Sair do QGIS Ctrl+Q
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7.1.2 Editar

Opção de menu Atalho Referência Barra de
Ferramentas

Desfazer Ctrl+Z ver Digitalização Avançada Digitalização
Avançada

Refazer Ctrl+Shift+Zver Digitalização Avançada Digitalização
Avançada

Recortar Feições Ctrl+X ver Digitalizar uma camada
existente

Digitalização

Copiar feições Ctrl+C ver Digitalizar uma camada
existente

Digitalização

Colar feições Ctrl+V ver Digitalizar uma camada
existente

Digitalização

Colar feição como → Veja Trabalhando com a Tabela
de Atributos

Adicionar feição Ctrl+. ver Digitalizar uma camada
existente

Digitalização

Mover Elemento(s) ver Digitalizar uma camada
existente

Digitalização

Excluir Selecionado(s) ver Digitalizar uma camada
existente

Digitalização

Rodar Elemento(s) ver Digitalização Avançada Digitalização
Avançada

Simplificar feições ver Digitalização Avançada Digitalização
Avançada

Adicionar Anel ver Digitalização Avançada Digitalização
Avançada

Adicionar Parte ver Digitalização Avançada Digitalização
Avançada

Preenchimento Anel ver Digitalização Avançada Digitalização
Avançada

Excluir Anel ver Digitalização Avançada Digitalização
Avançada

Excluir Parte ver Digitalização Avançada Digitalização
Avançada

Remodelar feições ver Digitalização Avançada Digitalização
Avançada

Curva de deslocamento ver Digitalização Avançada Digitalização
Avançada

Quebras Feições ver Digitalização Avançada Digitalização
Avançada

Partes Split ver Digitalização Avançada Digitalização
Avançada

Juntar Elementos Seleccionados ver Digitalização Avançada Digitalização
Avançada

Juntar Atributos dos Elementos
Seleccionados

ver Digitalização Avançada Digitalização
Avançada

Ferramenta de nós ver Digitalizar uma camada
existente

Digitalização

Rotacionar pontos com simbolos ver Digitalização Avançada Digitalização
Avançada
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Após activar o Modo de edição para uma camada, irá encontrar o ícone Adicionar Elemento no menu Editar
dependendo do tipo de camada (ponto, linha ou polígono).

7.1.3 Editar (extra)

Opção de menu Atalho Referência Barra de Ferramentas

Adicionar feição ver Digitalizar uma camada existente Digitalização

Adicionar feição ver Digitalizar uma camada existente Digitalização

Adicionar feição ver Digitalizar uma camada existente Digitalização

7.1.4 Ver

Opção de menu Atalho Referência Barra de
Ferramentas

Panorâmica no Mapa Navegação no Mapa

Mover mapa para seleção Navegação no Mapa

Aproximar Ctrl++ Navegação no Mapa

Afastar Ctrl+- Navegação no Mapa
Selecionar → ver Selecionar e desselecionar

feições
Atributos

Identificar feições Ctrl+Shift+I Atributos
Medir → ver Medição Atributos

Ver tudo Ctrl+Shift+F Navegação no Mapa

Aproximar à camada Navegação no Mapa

Aproximar à seleção Ctrl+J Navegação no Mapa

Última visualização Navegação no Mapa

Próxima visualização Navegação no Mapa

Aproximar à Resolução
Natural

Navegação no Mapa

Decorações → ver Decorações

Dicas do Mapa Atributos

Novo Favorito... Ctrl+B ver Favoritos Espaciais Atributos

Mostrar Favoritos Ctrl+Shift+B ver Favoritos Espaciais Atributos

Atualizar Ctrl+R Navegação no Mapa

7.1.5 Camada

Opção de menu Atalho Referência Barra de Ferramentas
Novo → veja Criando novas camadas Vectoriais Gerenciar camadas
Incorporar camadas e grupos... ver Projetos animados

Adicionar Camada Vectorial Ctrl+Shift+V ver Trabalhando com Dados Vetoriais Gerenciar camadas

Adicionar camada raster Ctrl+Shift+R ver Loading raster data in QGIS Gerenciar camadas
Continuação na próxima página
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Tabela 7.1 – continuação da página anterior
Opção de menu Atalho Referência Barra de Ferramentas

Adicionar Camada PostGIS Ctrl+Shift+D ver Camadas PostGIS Gerenciar camadas

Adicionar camada SpatiaLite Ctrl+Shift+L ver Camadas SpatiaLite Gerenciar camadas

Adicionar Camada Espacial MSSQL Ctrl+Shift+M veja label_mssql Gerenciar camadas

Adicionar camada Oracle GeoRaster ver Oracle Spatial GeoRaster Plugin Gerenciar camadas

Adicionar camada SQL Anywhere ver Complemento SQL Anywhere Gerenciar camadas

Adicionar Camada WMS/WMTS Ctrl+Shift+W ver Cliente WMS/WMTS Gerenciar camadas

Adicionar Camada WCS veja WCS Cliente Gerenciar camadas

Adicionar camada WFS veja WFS e WFS-T Cliente Gerenciar camadas

Adicionar Camada de Texto Delimitado ver label_dltext Gerenciar camadas

Copiar estilo veja Style Menu

Colar estilo veja Style Menu

Abrir tabela de Atributos Veja Trabalhando com a Tabela de Atributos Atributos

Opções de Ressalto ver Digitalizar uma camada existente Digitalização

Guardar edições da camada ver Digitalizar uma camada existente Digitalização

Edições Actuais → ver Digitalizar uma camada existente Digitalização
Savar como...
Savar arquivo vetor como... ver Trabalhando com a Tabela de Atributos

Remover Camada(s) Ctrl+D

Camada (s) Duplicada
Definir SRC da(s) Camada(s) Ctrl+Shift+C
Definir o SRC do projeto a partir da camada
Propriedades...
Pesquisa...

Rotular

Adicionar para a Visão Geral Ctrl+Shift+O Gerenciar camadas

Adicionar tudo para a Visão Geral

Remover tudo da Visão Geral

Mostrar todas as camadas Ctrl+Shift+U Gerenciar camadas

Ocultar todas as camadas Ctrl+Shift+H Gerenciar camadas
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7.1.6 Configurações

Opção de menu Atalho Referência Barra de
Ferramentas

Painéis → veja Painéis e Barras de Ferramentas
Barra de Ferramentas → veja Painéis e Barras de Ferramentas
Mudar para o modo de
tela inteira

F 11

Propriedades do
Projeto ...

Ctrl+Shift+Pver Projetos

SRC Personalizado... ver Sistema de Referência de Coordenadas
personalizado

Gerenciador de estilos... ver vector_style_manager
Configurar atalhos...
Personalização ... ver Personalização
Opções ... ver Opções

Opções de ajuste ...

7.1.7 Módulos

Opção de menu Atalho Referência Barra de Ferramentas

Gerir e Instalar Módulos ver O menu de complementos
Terminal Python

O começo do QGIS pela primeira vez não carrega todos os módulos core.

7.1.8 Vector

Opção de menu Atalho Referência Barra de
Ferramentas

Open Street Map → veja Loading OpenStreetMap
Vectors

Ferramenta de Analise → ver Complemento fTools

Ferramenta de pesquisa → ver Complemento fTools

Ferramenta de Geoprocessamento
→

ver Complemento fTools

|geometry| Ferramenta de Geometria →
ver Complemento fTools

Ferramenta de Gerenciamento de
Dados →

ver Complemento fTools

O começo do QGIS pela primeira vez não carrega todos os módulos core.

7.1.9 Matricial

Opção de menu Atalho Referência Barra de Ferramentas
Calculadora raster ... ver Calculadora Matricial

O começo do QGIS pela primeira vez não carrega todos os módulos core.
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7.1.10 Processamento

Opção de menu Atalho Referência Barra de
Ferramentas

Caixa de
Ferramentas

veja A caixa de ferramentas

Modelador Gráfico veja O modelador gráfico

Historia e log veja Gestão do histórico

Opções e
configurações

veja Configurando a infraestrutura do
processamento

Visualizador de
resultados

veja Configurando as aplicações externas

Comandos Ctrl+Alt+Mveja Linha de Comandos SEXTANTE

O começo do QGIS pela primeira vez não carrega todos os módulos core.

7.1.11 Ajuda

Opção de menu Atalho Referência Barra de Ferramentas

Conteúdo da Ajuda F1 Ajuda

O que é isto? Shift+F1 Ajuda
Documentação API
Precisa de suporte comercial?

Página do QGIS Ctrl+H

Verificar a versão do QGIS

Sobre

Patrocinadores

Por favor, note que para Linux , os itens do menu de barras listados acima são os padrões da janela gerenciadora
do KDE. No GNOME, o menu Configurações tem um conteúdo diferente e seus itens têm de ser encontradas aqui:

Propriedades do Projeto Projecto
Opções Editar
Configurar Atalhos Editar

Gerenciar estilo Editar

SRC personalizado Editar
Painéis → Exibir
Barra de Ferramentas → Exibir
Mudar para o Modo de Tela Inteira Exibir
Escala deslizante Exibir
Live GPS tracking Exibir

7.2 Barra de Ferramentas

A barra de ferramentas permite o acesso à maioria das mesmas funções dos menus, além de ferramentas adicionais
para interagir com o mapa. Cada item da barra de ferramentas pop-up tem ajuda disponível. Mantenha o mouse
sobre o item e uma breve descrição a respeito da ferramenta será exibida.
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Cada menu pode ser movido de acordo com suas necessidades. Além disso cada menu pode ser desligado com o
botão direito do mouse sobre o menu de contexto, segurando o botão do mouse sobre a barra de ferramentas. (leia
também Painéis e Barras de Ferramentas).

Dica: Restaurar barra de ferramentas
Se você tiver acidentalmente escondido todas as barras de ferramentas, você pode recuperá-las, escol-
hendo a opção do menu Exibir → Barras de ferramentas →. Se uma barra de ferramentas desaparece
no Windows, o que parece ser um problema no QGIS de vez em quando, você deve remover a chave
\HKEY_CURRENT_USER\Software\QGIS\qgis\UI\state no registro. Quando você reiniciar o QGIS,
a chave estará escrita novamente com o estado padrão, e todas as barras serão visíveis novamente.

7.3 Legenda do Mapa

A área da legenda do mapa lista todas as camadas do projecto. A caixa de verificação em cada entrada de legenda
pode ser usada para mostrar ou esconder a camada.

Uma camada pode ser selecionada e arrastada para cima ou para baixo na legenda para mudar a Z-ordenação. Z-
ordenação significa que as camadas listadas mais perto do topo da legenda são desenhadas sobre camadas listadas
mais abaixo na legenda.

Nota: Este comportamento pode ser substituído pelo painel ‘Ordem das Camadas’.

Camadas na janela legenda podem ser organizadas em grupos. Há duas maneiras de fazer isso:

1. Botão direito do mouse na janela de legenda e escolha Adicionar novo grupo. Digite um nome para o grupo
e pressione Enter. Agora clique em uma camada existente e arraste-a para o grupo.

2. Selecione algumas camadas, clique direito na janela de legenda e escolha Grupo selecionado. As camadas
selecionadas serão automaticamente colocadas em um novo grupo.

Para trazer uma camada de um grupo, você pode arrastá-la de fora, ou clique direito sobre ela e escolha Faça o
item toplevel. Os grupos também podem ser aninhados dentro de outros grupos.

A caixa de seleção de um grupo vai mostrar ou ocultar todas as camadas do grupo com apenas um clique.

O conteúdo do menu de contexto do botão direito do mouse depende se o item de legenda selecionado é uma

camada raster ou vetorial. Para camadas GRASS vetor, :sup: Alternar edição não está disponível. Consulte
a seção Digitalizando e editando uma camada vetorial GRASS para obter informações sobre a edição de camadas
vetoriais GRASS.

Menu botão direito do mouse para camadas raster

• Aproximar à extensão da camada

• Ampliar à Melhor Escala (100%)

• Esticar Usando o Enquadramento Actual

• Adicionar ao enquadramento

• Remover

• Duplicar

• Definir SRC da Camada

• Definir SRC do projecto a partir da Camada

• Guardar como ...

• Propriedades...

• Renomear
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• Copiar Estilo

• Adicionar Novo Grupo

• Expandir Tudo

• Ocultar Tudo

• Actualizar Ordem de Desenho

Adicionalmente, de acordo com a posição da camada e selecção

• Faça Item de Topo

• Agrupar Seleccionados

Menu botão direito do mouse para camadas vetor

• Aproximar à Extensão da Camada

• Adicionar ao Enquadramento

• Remover

• Duplicar

• Definir SRC da Camada

• Definir SRC do projecto a partir da Camada

• Abrir Tabela de Atributos

• Alternar Edição (não está disponível para camadas GRASS)

• Guardar Como ...

• Guardar Selecção Como...

• Filtrar

• Exibir Contagem de Elementos

• Propriedades...

• Renomear

• Copiar Estilo

• Adicionar Novo Grupo

• Expandir Tudo

• Ocultar Tudo

• Actualizar Ordem de Desenho

Adicionalmente, de acordo com a posição da camada e selecção

• Faça Item de Topo

• Agrupar Seleccionados

Menu botão direito do mouse para grupo de camadas

• Ampliação ao Grupo

• Remover

• Definir SRC do Grupo

• Renomear

• Adicionar Novo Grupo

• Expandir Tudo

• Ocultar Tudo
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• Actualizar Ordem de Desenho

É possível seleccionar mais de uma camada ou grupo ao mesmo tempo segurando a tecla Ctrl enquanto selec-
ciona as camadas com o botão esquerdo do rato. Pode mover todas as camadas seleccionadas para um novo grupo
ao mesmo tempo.

Você também é capaz de excluir mais de uma camada ou um grupo de uma só vez, selecionando várias camadas
com Ctrl e pressianando Ctrl+D depois. Desta forma, todas as camadas ou grupos selecionados serão removi-
dos da lista de camadas.

7.3.1 Trabalhando com a Ordem da legenda de camada indepenente

Há um painel que permite que você defina uma ordem de desenho independente para a legenda do mapa. Você
pode ativar ele no menu Exibir → Painéis → Ordem da camada. Esta funcionalidade permite-lhe, por exemplo,
ordenar suas camadas em ordem de importância, mas ainda exibi-las na ordem correta (ver figura_layer_order).

Checando a caixa Controle da ordem de renderização por baixo da lista de camadas irá causar um voltar ao
comportamento padrão.

Figura 7.2: Definir a ordem da legenda de camada indepenente

7.4 Visualização do mapa

Este é o ‘’fim do negócio” do QGIS — mapas são exibidos nesta área! O mapa exibido nesta janela dependerá
das camadas vetoriais e raster que você escolheu para carregar (ver seções a seguir para obter mais informações
sobre como carregar camadas). A vista do mapa pode ser deslocada, mudando o foco da exibição do mapa para
outra região e zoom in e out. Várias outras operações podem ser realizadas sobre o mapa, tal como descrito na
descrição acima da barra de ferramentas. A vista do mapa e a legenda estão fortemente ligados uns aos outros —
os mapas em vista refletem as alterações feitas na área de legenda.

Dica: Ampliando o mapa com a roda do mouse
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Você pode usar a roda do mouse para zoom in e out no mapa. Coloque o cursor do mouse dentro da área do mapa
e gire a roda para a frente (longe de você) para ampliar e para trás (para você) para diminuir o zoom. A posição
do cursor do mouse é o centro onde o zoom ocorre. Você pode personalizar o comportamento do zoom roda do
mouse usando o :guilabel: aba Ferramentas do mapa sob o menu Configurações → Opções.

Dica: Percorrendo o mapa com as setas e a barra de espaço
Você pode usar as setas do teclado para se deslocar no mapa. Coloque o cursor do mouse dentro da área do mapa
e clique na seta para a direita para pan Leste, seta para a esquerda para pan Oeste, seta para cima para pan Norte
e para baixo seta para deslocar Sul. Você também pode deslocar o mapa utilizando a barra de espaço ou clique na
roda do mouse.

7.5 Barra de Status

A barra de status mostra sua posição atual nas coordenadas do mapa (por exemplo, metros ou graus decimais)
como o ponteiro do mouse é movido através da visualização do mapa. Para a esquerda da tela de coordenadas
na barra de status tem um pequeno botão que irá alternar entre mostrar posição coordenada ou como você está
visualizando as extensões do mapa como pan e zoom in e out.

Próximo à coordenada mostrar que você encontra a exibição de escala. Ele mostra a escala de visualização do
mapa. Se você ampliar ou QGIS mostra a escala atual. Este é um seletor de escala que permite que você escolha
entre as escalas pré-definidas a partir de 1:500 até 1:1000000.

Uma barra de progresso na barra de status mostra o progresso de renderização como cada camada é atraída para
a visualização do mapa. Em alguns casos, como a coleta de estatísticas em camadas raster, a barra de progresso
será usada para mostrar o status de operações longas.

Se um novo complemento ou uma atualização de complemento está disponível, você verá uma mensagem na
barra de status. No lado direito da barra de status existe uma pequena caixa que pode ser usada para impedir
temporariamente que camadas sendo renderizadas sejam vistas no mapa (ver Seção Renderização abaixo). O

ícone imediatamente interrompe o processo de renderização atual mapa.

À direita da edição das funções, você encontra o código EPSG do SRC do projeto atual e um ícone projetor.
Clicando sobre ele abre as propriedades de projeção do projeto atual.

Dica: Calculando a escala correta do seu Mapa da tela/visualização
Quando você inicia o QGIS, graus é a unidade padrão, e quer diz que qualquer QGIS coordenadas em sua camada
está em graus. Para obter valores de escala correta, você pode mudar isso para metros manualmente no :guilabel:
guia Geral em :menuselection: Configurações –> ‘Propriedades do projeto ou você pode selecionar um projeto

de coordenadas referência do Sistema SRC clicando no ícone :sup: status SRC no canto inferior direito da
barra de status. No último caso, as unidades estão definidas para que a projeção projeto especifico, por exemplo,
‘+unidades=m’.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 8

Ferramentas Gerais

8.1 Atalhos de teclado

QGIS provides default keyboard shortcuts for many features. You can find them in section Barra de Menu. Ad-
ditionally, the menu option Settings → Configure Shortcuts.. allows you to change the default keyboard shortcuts
and to add new keyboard shortcuts to QGIS features.

Figura 8.1: Define shortcut options (Gnome)

Configuration is very simple. Just select a feature from the list and click on [Change], [Set none] or [Set default].
Once you have finished your configuration, you can save it as an XML file and load it to another QGIS installation.

8.2 Conteúdo da ajuda

When you need help on a specific topic, you can access context help via the [Help] button available in most
dialogs — please note that third-party plugins can point to dedicated web pages.

8.3 Renderização

By default, QGIS renders all visible layers whenever the map canvas is refreshed. The events that trigger a refresh
of the map canvas include:

• Adicionar uma camada

• Pan ou zoom
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• Resizing the QGIS window

• Mudanças na visibilidade de uma camada ou camadas

QGIS allows you to control the rendering process in a number of ways.

8.3.1 Escala dependente da renderização

Scale-dependent rendering allows you to specify the minimum and maximum scales at which a layer will be
visible. To set scale-dependent rendering, open the Properties dialog by double-clicking on the layer in the

legend. On the General tab, click on the Scale dependent visibility checkbox to activate the feature, then set
the minimum and maximum scale values.

You can determine the scale values by first zooming to the level you want to use and noting the scale value in the
QGIS status bar.

8.3.2 Controlando a renderização do mapa

Map rendering can be controlled in the various ways, as described below.

Suspensão de edição

To suspend rendering, click the Render checkbox in the lower right corner of the status bar. When the
Render checkbox is not checked, QGIS does not redraw the canvas in response to any of the events described in
section Renderização. Examples of when you might want to suspend rendering include:

• Adding many layers and symbolizing them prior to drawing

• Adding one or more large layers and setting scale dependency before drawing

• Adding one or more large layers and zooming to a specific view before drawing

• Qualquer combinação dos anteriores

Caixa de seleção :guilabel: caixa de seleção Renderizar permite renderização e causa uma atualização imediata
na tela do mapa.

Opções de adicionar configurações da camada

You can set an option to always load new layers without drawing them. This means the layer will be added to
the map, but its visibility checkbox in the legend will be unchecked by default. To set this option, choose menu

option Settings → Options and click on the Rendering tab. Uncheck the By default new layers added to the
map should be displayed checkbox. Any layer subsequently added to the map will be off (invisible) by default.

Parar rendirização

Para parar o desenho no mapa, pressione a tecla ESC. Isto irá parar a atualização da tela do mapa e deixar o mapa
parcialmente desenhado. Pode levar um pouco de tempo entre pressionar ESC e o tempo que o desenho do mapa
será interrompido.

Nota: It is currently not possible to stop rendering — this was disabled in the Qt4 port because of User Interface
(UI) problems and crashes.
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Atualização da tela durante a edição do mapa

You can set an option to update the map display as features are drawn. By default, QGIS does not display any
features for a layer until the entire layer has been rendered. To update the display as features are read from the
datastore, choose menu option Settings → Options and click on the Rendering tab. Set the feature count to an
appropriate value to update the display during rendering. Setting a value of 0 disables update during drawing (this
is the default). Setting a value too low will result in poor performance, as the map canvas is continually updated
during the reading of the features. A suggested value to start with is 500.

Influência da qualidade da edição

To influence the rendering quality of the map, you have two options. Choose menu option Settings → Options,
click on the Rendering tab and select or deselect following checkboxes:

• Fazer linhas aparecem com menos definição para não peder performance ao renderizar

• Ajustar problemas com polígonos preenchidos incorretamente

Speed-up rendering

There are two settings that allow you to improve rendering speed. Open the QGIS options dialog using Settings
→ Options, go to the Rendering tab and select or deselect the following checkboxes:

• Enable back buffer. This provides better graphics performance at the cost of losing the possibility to
cancel rendering and incrementally draw features. If it is unchecked, you can set the Number of features to
draw before updating the display, otherwise this option is inactive.

• Use render caching where possible to speed up redraws

8.4 Medição

Measuring works within projected coordinate systems (e.g., UTM) and unprojected data. If the loaded map is
defined with a geographic coordinate system (latitude/longitude), the results from line or area measurements will
be incorrect. To fix this, you need to set an appropriate map coordinate system (see section Trabalhando com
Projeções). All measuring modules also use the snapping settings from the digitizing module. This is useful, if
you want to measure along lines or areas in vector layers.

To select a measuring tool, click on and select the tool you want to use.

8.4.1 Medição de linha, áreas ou ângulos

Measure Line: QGIS is able to measure real distances between given points according to a defined ellipsoid. To
configure this, choose menu option Settings → Options, click on the Map tools tab and select the appropriate
ellipsoid. There, you can also define a rubberband color and your preferred measurement units (meters or feet)
and angle units (degrees, radians and gon). The tool then allows you to click points on the map. Each segment
length, as well as the total, shows up in the measure window. To stop measuring, click your right mouse button.

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. In
addition, the measuring tool will snap to the currently selected layer, provided that layer has its snapping tolerance
set (see section Configurando a Tolerância de Atracção e Raio de Pesquisa). So, if you want to measure exactly
along a line feature, or around a polygon feature, first set its snapping tolerance, then select the layer. Now, when
using the measuring tools, each mouse click (within the tolerance setting) will snap to that layer.
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Figura 8.2: Measure Distance (Gnome)

Figura 8.3: Measure Area (Gnome)

Measure Angle: You can also measure angles. The cursor becomes cross-shaped. Click to draw the first segment
of the angle you wish to measure, then move the cursor to draw the desired angle. The measure is displayed in a
pop-up dialog.

Figura 8.4: Measure Angle (Gnome)

8.4.2 Selecionar e desselecionar feições

The QGIS toolbar provides several tools to select features in the map canvas. To select one or several features,

just click on and select your tool:

• Select Single Feature

• Select Features by Rectangle

• Select Features by Polygon

• Select Features by Freehand

• Select Features by Radius

Para desselecionar todos as feições selecionadas clique em Desselecionar todas feições da camada.

8.5 Identificar feições

The Identify tool allows you to interact with the map canvas and get information on features in a pop-up window.

To identify features, use View → Identify features or press Ctrl + Shift + I, or click on the Identify features
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icon in the toolbar.

If you click on several features, the Identify results dialog will list information about all the selected features. The
first item is the number of the feature in the list of results, followed by the layer name. Then, its first child will be
the name of a field with its value. Finally, all information about the feature is displayed.

This window can be customized to display custom fields, but by default it will display three kinds of information:

• Actions: Actions can be added to the identify feature windows. When clicking on the action label, action
will be run. By default, only one action is added, to view feature form for editing.

• Derived: This information is calculated or derived from other information. You can find clicked coordinate,
X and Y coordinates, area in map units and perimeter in map units for polygons, length in map units for
lines and feature ids.

• Data attributes: This is the list of attribute fields from the data.

Figura 8.5: Janela identificar feição (Gnome)

At the bottom of the window, you have five icons:

• Expand tree

• Collapse tree

• Default behaviour

• Copy attributes

• Print selected HTML response

Other functions can be found in the context menu of the identified item. For example, from the context menu you
can:

• View the feature form

• Zoom para feição

• Copy feature: Copy all feature geometry and attributes

• Copy attribute value: Copy only the value of the attribute that you click on

• Copy feature attributes: Copy only attributes

• Clear result: Remove results in the window

• Clear highlights: Remove features highlighted on the map

• Destaque todos
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• Destaque a camada

• Activate layer: Choose a layer to be activated

• Layer properties: Open layer properties window

• Estender tudo

• Encolher tudo

8.6 Decorações

The Decorations of QGIS include the Grid, the Copyright Label, the North Arrow and the Scale Bar. They are
used to ‘decorate’ the map by adding cartographic elements.

8.6.1 Grid

Grid allows you to add a coordinate grid and coordinate annotations to the map canvas.

Figura 8.6: The Grid Dialog

1. Select from menu View → Decorations → Grid. The dialog starts (see figure_decorations_1).

2. Activate the Enable grid checkbox and set grid definitions according to the layers loaded in the map
canvas.

3. Activate the Draw annotations checkbox and set annotation definitions according to the layers loaded
in the map canvas.

4. Click [Apply] to verify that it looks as expected.

5. Click [OK] to close the dialog.

8.6.2 Rótulo Copyright

Copyright label adds a copyright label using the text you prefer to the map.

1. Select from menu View → Decorations → Copyright Label. The dialog starts (see figure_decorations_2).

2. Enter the text you want to place on the map. You can use HTML as shown in the example.
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Figura 8.7: The Copyright Dialog

3. Choose the placement of the label from the Placement combo box.

4. Make sure the Enable Copyright Label checkbox is checked.

5. Click [OK].

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas.

8.6.3 Seta Norte

North Arrow places a simple north arrow on the map canvas. At present, there is only one style available. You
can adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine
the direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas.

Figura 8.8: Janela de indicação do Norte

8.6.4 Barra de Escala

Scale Bar adds a simple scale bar to the map canvas. You can control the style and placement, as well as the
labeling of the bar.

QGIS only supports displaying the scale in the same units as your map frame. So if the units of your layers are in
meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create a scale
bar to display distance in meters.

Para adicionar uma barra de escala:
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Figura 8.9: A janela da barra de escala

1. Select from menu View → Decorations → Scale Bar. The dialog starts (see figure_decorations_4).

2. Choose the placement from the Placement combo box.

3. Choose the style from the Scale bar style combo box.

4. Select the color for the bar Color of bar or use the
default black color.

5. Set the size of the bar and its label Size of bar .

6. Make sure the Enable scale bar checkbox is checked.

7. Optionally, check Automatically snap to round number on resize.

8. Click [OK].

Dica: Configurações de Decorações
When you save a .qgs project, any changes you have made to Grid, North Arrow, Scale Bar and Copyright will
be saved in the project and restored the next time you load the project.

8.7 Ferramentas de anotação

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Double clicking on the item opens a dialog with various options. There is the text editor to enter the formatted text
and other item settings. For instance, there is the choice of having the item placed on a map position (displayed
by a marker symbol) or to have the item on a screen position (not related to the map). The item can be moved by
map position (by dragging the map marker) or by moving only the balloon. The icons are part of the GIS theme,
and they are used by default in the other themes, too.

The Move Annotation tool allows you to move the annotation on the map canvas.

8.7.1 Html annotations

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.
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Figura 8.10: Janela texto de anotação

8.7.2 SVG annotations

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.

8.7.3 Anotação de formulário

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://www.youtube.com/watch?v=0pDBuSbQ02o from Tim Sutton for more information.

Nota: Se você pressionar Ctrl+T enquanto uma ferramenta Anotação está ativa (mover anotação, texto de
anotação, formulário de anotação), os estados de visibilidade dos itens serão invertidos.

8.8 Favoritos Espaciais

Favoritos espaciais permite que você “marque” uma localização geográfica e volte a ela mais tarde.

8.8.1 Novo Favorito

Para criar um novo favorito:

1. Zoom ou pan na área de interesse.

2. Selecione a opção de menu Exibir → Novo Favorito ou pressione Ctrl-B.

3. Adicione um nome descritivo para o favorito (no máximo 255 caracteres).

4. Pressione Enter para adicionar um favorito ou [Delete] para remover o favorito.

Note que você pode ter vários favoritos com o mesmo nome.
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Figura 8.11: Desenho personalizado qt do formulário de anotação

8.8.2 Trabalhando com favoritos

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Geospatial Bookmarks
dialog allows you to zoom to or delete a bookmark. You cannot edit the bookmark name or coordinates.

8.8.3 Aproximar para um favorito

A partir do :guilabel: diálogo Favoritos Geoespaciais, selecione o marcador desejado, clicando sobre ele, em
seguida, clique [Aproximar para]. Você também pode ampliar até um marcador, clicando duas vezes sobre ele.

8.8.4 Deletando um favorito

To delete a bookmark from the Geospatial Bookmarks dialog, click on it, then click [Delete]. Confirm your choice
by clicking [Yes], or cancel the delete by clicking [No].

8.9 Projetos animados

If you want to embed content from other project files into your project, you can choose Layer → Embed Layers
and Groups.

8.9.1 Incorporando camadas

The following dialog allows you to embed layers from other projects. Here is a small example:

1. Pressione para olhar para outro projeto do conjunto de dados Alasca.

2. Select the project file grassland. You can see the content of the project (see figure_embed_dialog).

3. Press Ctrl and click on the layers grassland and regions. Press [OK]. The selected layers are
embedded in the map legend and the map view now.
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Figura 8.12: Selecionar camadas e grupos para incorporar

While the embedded layers are editable, you can’t change their properties like style and labeling.

8.9.2 Removing embedded layers

Right-click on the embedded layer and choose Remove.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 9

Configuração QGIS

O QGIS é altamente personalizável através do menu Configurações . Escolha entre Painéis, Caixa de Ferramentas,
Propriedades do Projecto, Opções e Personalização.

9.1 Painéis e Barras de Ferramentas

No menu Painéis→ pode desligar os widgets do QGIS. O menu Caixa de Ferramentas→ fornece a possibilidade
de trocar activar ou desactivar grupos de ícones na barra de ferramentas do QGIS (veja figure_panels_toolbars).

Figura 9.1: Os Painéis e o Menu de Barra de Ferramentas

Dica: Activando o Enquadramento QGIS
No QGIS pode usar o painel do enquadramento que fornece a extensão total das camadas adicionadas. Pode ser
seleccionada no menu Configurações → Painéis ou Ver → Paineis. Dentro da vista existe um rectângulo a
mostrar a extensão actual do mapa. Isto permite rapidamente determinar que área do mapa está a ver actualmente.
É de notar que os rótulos não serão renderizados no enquadramento do mapa mesmo que seja activado a rotulagem.
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Se clicar e arrastar o rectângulo vermelho no enquadramento que mostra a actual extensão, este irá actualizar de
acordo como o mapa principal.

Dica: Mostrar Mensagens de Registo

É possível seguir as mensagens do QGIS. Pode activar o Registo de Mensagens no menu Configurações →
Painéis ou Vier → Painéis e seguir as mensagens que aparecem nos diferentes separadores durante o carrega-
mento e operação.

9.2 Propriedades do Projecto

Na janela de propriedades no para o projecto Configurações → Propriedades do Projecto ou Configu-
rações → Propriedades do Projecto pode definir as opções específicas do projecto. Aqui estão incluídos:

• No menu Geral podem ser definidos o título do projecto, a cor de selecção e fundo, unidades da camadas,
precisão, e os caminhos relativos onde serão guardadas as camadas. Se a transformação SRC estiver ligada
pode escolher o cálculo de distâncias recorrendo ao elipsóide. Pode definir as unidades do enquadramento
(apenas usado quando a transformação SRC está desactivada) e a precisão das casas decimais a usar. Pode
definir também uma escala de projecto, que rescreverá sobre as escalas globais pré-definidas.

• O menu SRC permite que escolha o Sistema de Coordenadas Referência para o projecto, e para activar a
reprojecção on-the-fly das camadas matricias e vectoriais na exibição de camadas de diferentes SRC.

• Com o terceiro menu Identificar camadas pode definir (ou desactivar) que camadas irão responder à ferra-
menta identificar. (Veja o parágrafo das “Ferramentas de Mapa” da secção Opções Secção para activar a
identificação de múltiplas camadas).

• O menu Estilos Padrão deixa controlar a forma como serão desenhadas as novas camadas quando não
tiverem estilos .qml definidos. Pode também definir o nível de transparência padrão para novas camadas e
se os símbolos devem ter cores aleatórias associadas a eles.

• O separador Servidor OWS permite definir a informação sobre as Capacidades do WMS e WFS, a extensão
e as restrições SRC do Servidor QGIS.

• O menu Macros é para editar macros Python para os projectos. Actualmente, apenas estão disponíveis três
macros: openProject(), saveProject() e closeProject().

Figura 9.2: Configurações de Macro no QGIS
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• The Relations menu is used to define 1:n relations. The relations are defined in the project properties dialog.
Once relations exist for a layer, a new user interface element in the form view (e.g. when identifying a
feature and opening its form) will list the related entities. This provides a powerful way to express e.g. the
inspection history on a length of pipeline or road segment. You can find out more about 1:n relations support
in Section Creating one to many relations.

9.3 Opções

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. The tabs where you can customize your options are described below.

9.3.1 Menu Geral

Aplicação

• Seleccione a Estilo (Necessário reiniciar o QGIS) e escolha entre ‘Oxy-
gen’,’Windows’,’Motif’,’CDE’, ‘Plastique’ e ‘Cleanlux’ ( ).

• Definir o Tema de Ícone . Actualmente a opção ‘default’ é possível.

• Definir o Tamanho do Ícone .

• Definir a Fonte. Escolha entre QT padrão e uma fonte definida pelo utilizador.

• Altera o Tempo limite para mensagens ou diágolos .

• Não exibir a janela inicial

• Mostrar dicas ao iniciar

• Títulos da caixa de grupos a negrito

• QGIS-estilo das caixas de grupo

• Use diálogos selectores de cor para actualizações ao vivo

Ficheiros de projecto

• Abrir o projecto no arranque (escolha entre ‘Novo’. ‘Mais recente’ e ‘Específico’). Quando escolher

‘Específico’ use para definir um projecto.

• Create new project from default project. You have the possibility to press on Set current project as
default or on Reset default. You can browse through your files and define a directory where you find your
user-defined project templates. This will be added to Project → New From Template. If you first activate

Create new project from default project and then save a project in the project templates folder.

• Avisar para salvar projecto e alterações de fontes de dados quando necessário

• Avisar quando abrir um projecto guardado com uma versão antiga do |qg|

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.
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9.3.2 Menu Sistema

Ambiente

System environment variables can now be viewed, and many configured, in the Environment group (see fig-
ure_environment_variables). This is useful for platforms, such as Mac, where a GUI application does not nec-
essarily inherit the user’s shell environment. It’s also useful for setting and viewing environment variables for
the external tool sets controlled by the Processing toolbox (e.g., SAGA, GRASS), and for turning on debugging
output for specific sections of the source code.

• Use custom variables (restart required - include separators). You can [Add] and [Remove] variables.
Already-defined environment variables are displayed in Current environment variables, and it’s possible to

filter them by activating Show only QGIS-specific variables.

Figura 9.3: Variáveis de ambiente do Sistema no QGIS

Directórios dos módulos

[Adicionar] ou [Remover] Caminho(s) para pesquisar bibliotecas de módulos C++ adicionais

9.3.3 Menu Fonte de Dados

Atributos dos elementos e tabela

• Abre a tabela de atributos na janela principal (Necessário reiniciar o QGIS)
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• Copy geometry in WKT representation from attribute table. When using Copy selected rows to clipboard

from the Attribute table dialog, this has the result that the coordinates of points or vertices are also copied
to the clipboard.

• Comportamento da tabela de atributos . Existem três possibilidades: ‘Mostrar todos os elementos’,
‘Mostrar elementos seleccionados’ e ‘Mostrar elementos visiveis no mapa’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Representação para valores NULL. Aqui, pode definir um valor para os campos de dados que contêm
valores NULL.

Manipulação das fontes de dados

• Pesquisar por atributos válidos na janela do navegador . Pode escolher entre ‘Verificar extensão’ e
‘Verificar conteúdo do ficheiro’.

• Pesquisar por conteúdo de ficheiros compactados (.zip) na janela do navegador . ‘Não’, ‘Verificação
básica’ e ‘Verificação completa’ são possiveis.

• Prompt for raster sublayers when opening. Some rasters support sublayers — they are called subdatasets
in GDAL. An example is netCDF files — if there are many netCDF variables, GDAL sees every variable
as a subdataset. The option allows you to control how to deal with sublayers when a file with sublayers is
opened. You have the following choices:

– ‘Sempre’: Perguntar sempre (se existem subcamadas)

– ‘Se necessário’: Perguntar se a camada não tem bandas, mas tem subcamadas

– ‘Nunca’: Nunca pede, não irá carregar nada

– ‘Carregar tudo’: Nunca pede, mas carrega todas as subcamadas

• Ignora a declaração de codificação da shapefile. Se a shapefile tiver informação de codificação, este
será ignorado pelo QGIS.

• Adicionar uma camada PostGIS com duplo clique e seleccione em modo extendido

• Adicione camadas Oracle com duplo clique e seleccione em modo extendido

9.3.4 Menu de Renderização

Comportamento da renderização

• By default new layers added to the map should be displayed

• Enable back buffer

• Use render caching where possible to speed up redraws

• Enable feature simplication by default for newly added layers

• Simplify on provider side if possible

Qualidade de renderização

• Faz com que as linhas apareçam menos irregulares, em detrimento de algum desempenho do desenho

• Resolver problemas com polígonos incorrectamente preenchidos

Matriciais

• Com a Selecção de banda RGB pode definir o número para a banda Vermelha, Verde e Azul.
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Melhorar contraste

• Banda cinzenta única . Uma banda cinzenta única pode ter ‘Sem esticar’, ‘Esticar para MinMax’,
‘Esticar e Cortar para MinMax’ e também ‘Cortar para MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Limites de contagem cumulativa de pixeis de corte

• Multiplicador do desvio-padrão

Corrigindo Erros

• Map canvas refresh

9.3.5 Menu de Janela e Legenda

Aparência padrão do mapa (reescrita pelas propriedades do projecto)

• Define a Cor da selecção e a Cor de fundo.

Legenda da camada

• Duplo clique na legenda . Pode ‘Abrir propriedades da camada’ ou ‘Abrir tabela de atributos’ com
duplo clique.

• The following Legend item styles are possible:

– Tornar maiusculo os nomes da camada

– Tornar negrito os nomes da camada

– Tornar negrito os nomes dos grupos

– Mostrar nomes de atributos de classificação

– Criar ícones matriciais (pode ser lento)

– Adicionar novas camadas ao grupo actual ou seleccionado

9.3.6 Menu Ferramentas de Mapa

Identificar

• Abre resultados identificados numa pequena janela (será necessário reiniciar o QGIS)

• The Mode setting determines which layers will be shown by the Identify tool. By switching to ‘Top down’
or ‘Top down, stop at first’ instead of ‘Current layer’, attributes for all identifiable layers will be shown with
the Identify tool. In QGIS 2.2. you can now use a ‘Layer selection’ option so that you can choose with the
left-mouse menu which layer you want to identify (see the “Project properties” section under Projetos to set
which layers are identifiable).

• Abre o formulário do elemento, se só um elemento for identificado

• Define Raio de pesquisa para identificar e exibir dicas de mapa como uma percentagem de largura de mapa

Ferramenta de medida
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• Define Cor do elástico para as ferramentas de medida

• Define Casas decimais

• Manter unidade base

• Preferred measurements units (‘Meters’, ‘Feet’, ‘Nautical Miles’ or ‘Degrees’)‘

• Preferred angle units (‘Degrees’, ‘Radians’ or ‘Gon’)

Movendo e ampliando

• Define a Acção da roda do rato (‘Visualizar’, ‘Visualizar e Centrar’, ‘Aproximar ao cursor do rato’,
‘Nada’)

• Define o factor de aproximação/ afastamento para a roda do rato

Escalas pré-definidas

Here, you find a list of predefined scales. With the [+] and [-] buttons you can add or remove your individual
scales.

9.3.7 Composer Menu

Composition defaults

You can define the Default font here.

Aparência da Grelha

• Define the Grid style (‘Solid’, ‘Dots’, ‘Crosses’)

• Define the Color...

Grid defaults

• Define the Spacing

• Define the Grid offset for x and y

• Define the Snap tolerance

Guide defaults

• Define the Snap tolerance

9.3.8 Menu Digitalizar

Criação de elementos

• Suprimir atributos de janelas pop-up depois de cada elemento criado

• Reutilizar últimos valores de atributos inseridos

• Validate geometries. Editing complex lines and polygons with many nodes can result in very slow rendering.
This is because the default validation procedures in QGIS can take a lot of time. To speed up rendering, it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

Elástico

• Define a Borracha Espessura da linha e Cor da linha

Ajuste

• Abrir opções de atracção na janela principal (necessário reiniciar o QGIS)
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• Define o Modo de atracção padrão (‘Ao vértice’, ‘Ao segmento’, ‘Ao vértice e segmento’, ‘Desli-
gado’)

• Define Tolerância de atracção pré-definida em unidades de mapa ou pixeis

• Define o Raio de pesquisa para editar vértices em unidades de mapa ou pixeis

Marcadores de Vértices

• Mostrar marcadores apenas para elementos seleccionados

• Define o vértice do Estilo do Marcador (‘Cruz’ (padrão), ‘Circulo semi-transparente’ ou ‘Nenhum’)

• Definir o vértice Tamanho do Marcador

Ferramenta de curva de afastamento

The next 3 options refer to the Offset Curve tool in Digitalização Avançada. Through the various settings, it is
possible to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Join style

• Quadrant segments

• Miter limit

9.3.9 Menu GDAL

GDAL is a data exchange library for raster files. In this tab, you can Edit create options and Edit Pyramids Options
of the raster formats. Define which GDAL driver is to be used for a raster format, as in some cases more than one
GDAL driver is available.

9.3.10 Menu SRC

SRC padrão para novos projectos

• Don’t enable ‘on the fly’ reprojection

• Automatically enable ‘on the fly’ reprojection if layers have different CRS

• Enable ‘on the fly’ reprojection by default

• Seleccione um SRC em Iniciar sempre um novo projecto com este SRC

SRC para novas camadas

This area allows you to define the action to take when a new layer is created, or when a layer without a CRS is
loaded.

• Pergunta por SRC

• Usar SRC do projecto

• Utilizar SRC padrão mostrado em baixo

Default datum transformations

• Ask for datum transformation when no default is defined

• If you have worked with the ‘on-the-fly’ CRS transformation you can see the result of the transformation in
the window below. You can find information about ‘Source CRS’ and ‘Destination CRS’ as well as ‘Source
datum transform’ and ‘Destination datum transform’.
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9.3.11 Locale Menu

• Sobrepor idioma do sistema e Idioma a utilizar em alternativa

• Informação sobre a região do sistema activo local

9.3.12 Network Menu

Geral

• Define Pesquisa de endereço WMS, padrão como http://geopole.org/wms/search?search=\%1\&type=rss

• Define Tempo esgotado para pedidos de rede (ms) - o padrão é 60000

• Define Período padrão de validade para a quadrícula WMSC/WMTS (horas) - o padrão é 24

• Define Max retry in case of tile request errors

• Define User-Agent

Figura 9.4: Configurações-proxy no QGIS

Configurações de cache

Define a Pasta e Tamanho para o cache.

• Usar proxy para aceder à web e define ‘Máquina’, ‘Porta’, ‘Utilizador’, e ‘Palavra-chave’.
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• Configura o Tipo de proxy de acordo com as necessidades.

– Default Proxy: Proxy é determinado baseando-se na definição do proxy da aplicação em uso

– Socks5Proxy: Proxy genérico para qualquer tipo de ligação. Suporta TCP, UDP, unindo a uma porta
(ligações de entrada) e autenticação.

– HttpProxy: Implementado usando o comando “LIGAR” , apenas suporta ligações TCP de saída; su-
porta autenticação.

– HttpCachingProxy: Implementado usando comandos HTTP normais, é útil apenas em pedidos no
contexto do HTTP.

– FtpCachingProxy: Implementado usando um proxy FTP, é útil no contexto de pedidos FTP.

Alguns URLs excluídos podem ser adicionados na caixa de texto debaixo das configurações de proxy (veja Fig-
ure_Network_Tab).

If you need more detailed information about the different proxy settings, please refer to the manual of the under-
lying QT library documentation at http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Dica: Usando Proxies
Using proxies can sometimes be tricky. It is useful to proceed by ‘trial and error’ with the above proxy types, to
check to see if they succeed in your case.

Pode modificar as opções de acordo com as suas necessidades. Algumas das alterações pode requerer o reinicio
do QGIS antes de ser efectiva.

• As configurações são guardadas no ficheiro de texto: $HOME/.config/QGIS/qgis.conf

• pode encontrar as configurações em: $HOME/Library/Preferences/org.qgis.qgis.plist

• As configurações são armazenadas no registo em: HKEY\CURRENT_USER\Software\QGIS\qgis

9.4 Personalização

A ferramenta de personalização permite que (des)active a maioria dos elementos na interface de utilizador QGIS.
Isto pode ser muito útil se tiver um número elevado de módulos instalados que nunca usa e que estão a encher o
ecrã.

Figura 9.5: A janela de Personalização

QGIS A Personalização está dividida em cinco grupos. No Menus pode esconder as entradas na Barra Menu.

No Painel pode encontrar o painel de janelas. As janelas do Painel são aplicações que pode ser iniciadas
e usadas como flutuantes, janelas de topo de nível ou embebidas na janela principal do QGIS como um widget
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ancorado (veja also Painéis e Barras de Ferramentas). Na Barra de Estado características como a informação

das coordenadas podem ser desactivadas. Na Caixa de Ferramentas pode (des)activar os ícones da barraa de

ferramentas do QGIS e em Widgets pode (des)activatar janelas assim como os seus botões.

With Switch to catching widgets in main application, you can click on elements in QGIS that you want to be hidden and
find the corresponding entry in Customization (see figure_customization). You can also save your various setups
for different use cases as well. Before your changes are applied, you need to restart QGIS.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 10

Trabalhando com Projeções

O QGIS permite que os utilizadores definam de forma global e para todo o projecto um SC (Sistema de Co-
ordenadas) para temas que não têm um SC pré-definido. Também permite que o utilizador defina sistemas de
coordenadas personalizados e suporta a projecção dinâmica no ecrã de temas com diferentes SCs conseguindo
sobrepondo-os correctamente.

10.1 Visão geral do Suporte a Projeções

O QGIS suporta aproximadamente 2.700 SCs conhecidos. Definições para cada SC são guardados numa base
de dados SQLite que é instalada com o QGIS. Normalmente, não terá necessidade de manipular a base de dados
directamente. De facto, ao fazê-lo poderá causar problemas. SCs definidos manualmente são guardados numa
base de dados do utilizador. Veja a secção Sistema de Referência de Coordenadas personalizado para informação
sobre a gestão dos seus sistemas de coordenadas.

Os SCs disponíveis no QGIS são baseados nos definidos pelo Grupo Europeu de Pequisa Petrolífera (EPSG) e pelo
Instituto Geográfico Nacional Francês (IGNF) e são em grande parte derivados das tabelas de referência espacial
usadas pelo GDAL. Os identificadores EPSG presentes na base de dados podem ser usados para especificar um
SC no QGIS.

Para poder usar a projecção dinâmica, os seus dados devem conter informação sobre o seu sistema de coordenadas
ou vocês deverá definir um sistema global, para temas ou para o projecto. Para temas PostGIS, o QGIS usa
o identificador de referência espacial que foi especificado aquando da criação do tema. Para dados suportados
pelo OGR, o QGIS recorre à presença de um meio reconhecível para especificar o SC. No caso de shapefiles, isto
significa um ficheiro contendo um texto bem-conhecido (WKT) especificando o SC. Este ficheiro de projecção tem
o mesmo nome base que o shapefile e uma extensão .prj. Por exemplo, um shapefile chamado alaska.shp
teria um ficheiro de projecção correspondente chamado alaska.prj.

Sempre que selecionar um novo SC, as unidades do temas serão mudadas automaticamente no separador Geral
das |mActionsOptions| na janela de Propriedades do Projecto, no menu Projecto (Gnome, OSX) ou Definições
(KDE, Windows).

10.2 Especificação de Projeção Global

O QGIS inicia cada novo projecto usando a projecção global pré-definida. O SC global por omissão é
o EPSG:4326 - WGS 84 (proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), e vem pré-
definido no QGIS. Este valor pode ser alterado via o botão [Seleccionar...] na primeira secção, que é usada
para definir o sistema de coordenadas por omissão para novos projectos, como mostrado na figure_projection_1.
Este opção pode ser gravada para uso em sessões subsequentes do QGIS.

Quando usa temas que não têm um SC, tem de definir como o QGIS reage a estes temas. Isto pode ser feito
globalmente ou por projecto no separador SC no Definições → Opções.

As opções mostradas na figure_projections_1 são:
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Figura 10.1: Separador SRC na Janela de Opções QGIS
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• Entrada de SC

• Usar SRC do projeto

• Usar o SC pré-definido mostrado abaixo

Se quer definir o sistema de coordenadas para um dado tema sem informação de SC, pode também fazê-lo no
separador Geral da janela de propriedade raster e vector (ver Menu Geral para rasters e General Menu para
vectores). Se o seu tema já tem um SC definido, este será mostrado como na Vector Layer Properties Dialog .

Dica: SRC na Legenda do Mapa
Clicando com o botão direito num tema na Legenda do Mapa (secção Legenda do Mapa) mostra dois atalhos SC.
Definir SC do tema abre a janela de Selecção de Sistema de Coordenadas (ver figure_projection_2). Definir SC
do projecto a partir do Tema redefine o SC do projecto usando o SC do tema.

10.3 Definir Reprojeção Dinâmica Voo Livre (OTF)

O QGIS suporta reprojecção dinâmica para dados raster e vector. Contudo, RD não está activa por omissão. Para

usar projecção dinâmica, deve activar a caixa de opção Activar transformação dinâmica de SC no separador

SC na janela Propriedades do Projecto.

Há três formas de fazer isto:

1. Selecione :menuselecion:‘Propriedades do Projeto‘ no menu Projecto (Gnome, OSX) ou Definições
(KDE, Windows).

2. Clique no ícone estado SC no canto inferior direito da barra de estado.

3. Active a projecção dinâmica por omissão no separador SC da janela Opções selecionando a Activar
reprojecção dinâmica por omissão ou Automaticamente activar a reprojecção dinâmica se temas têm difer-
entes SC.

Se tem já carregado um tema e quer activar a projecção dinâmica, a melhor prática é abrir o separador SC na janela

Propriedades do Projecto, selecionar um SC, e activar a caixa de selecção Activar transformação dinâmica de

SC. O ícone Estado SC deixará de estar desactivado (cinzento), e todos os temas serão dinamicamente reprojec-
tados para o SC mostrado junto ao ícone.

O separador SC na janela Propriedades do Projecto contem cinco componentes importantes, como mostrado na
Figure_projections_2 e descritos abaixo:

1. Acivar transformção ‘dinâmica´ de SC — Esta caixa de selecção é usada para activar ou desactivar a
projecção dinâmica. Quando desligada, cada tema é desenhado usando as coordenadas lidas dos seus da-
dos, e os componentes descritos abaixo estão inactivos. Quando ligada, as coordenadas de cada tema são
projectadas para o sistema de coordenadas definido para o mapa.

2. Filtro — Se conhece o código EPSG, o identificador, ou o nome para um sistema de coordenadas, pode
usar a função de pesquisa para o encontrar. Introduza o código EPSG, o identificador ou o nome.

3. Sistemas de coordenadas usados recentemente — Se tem certos SCs que usa frequentemente no seu
trabalho SIG diário, estes serão mostrados nesta lista. Clique num destes itens para selecionar o SC corre-
spondente.

4. Sistemas de coordenadas do mundo — Esta é a lista de todos os SCs suportados pelo QGIS, incluindo
sistemas de coordenadas Geográficas, Projectadas, e Personalizados. Para definir um SC, seleccione-o na
lista expandindo o nó apropriado e seleccionado o SC. O SC activo está pré-seleccionado.

5. Texto PROJ.4 — Este é um texto de SC usado pelo motor de projecções PROJ.4. Este texto é de apenas
leitura e fornecido para fins de informação.
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Figura 10.2: Janela de Propriedades do Projeto

Dica: Janela de Propriedades do Projeto
Se abrir a janela Propriedades do Projecto a partir do menu :menuselecion:‘Projecto‘, deve clicar no separador
SC para ver as definições de SC.

Abrindo a janela a partir do ícone Estado SC abrirá automaticamente o separador SC.

10.4 Sistema de Referência de Coordenadas personalizado

Se o QGIS não fornece o sistema de coordenadas que necessita, pode definir um SC personalizado. Para definir

um SC, seleccione SC personalizado... a partir do menu Definições. SCs personalizados são guardados na
sua base de dados de utilizador QGIS. Além dos seus SCs, esta base de dados também contem os seus marcadores
espaciais e outros dados personalizados.

Definindo um SRC personalizado no QGIS requer uma boa compreensão da biblioteca de projeções PROJ.4.
Para começar, consulte “Procedimentos cartográficos projeção para o Ambiente UNIX - Manual do Usuário”
por Gerald I. Evenden, Serviço Geológico dos EUA Abra o Arquivo Relatório 90-284, 1990 (disponível em
ftp://ftp.remotesensing.org/proj/OF90-284.pdf).

Este manual descreve o uso do proj.4 e utilidades de linha de comando relacionados. Os parâmetros cartográ-
ficos usados com o proj.4 são descritos no manual do utilizador e são os mesmo que os usados pelo QGIS.

A janela Definição de Sistema de Referência de Coordenadas personalizado exige apenas dois parâmetros para
definir um SRC ao usuário:

1. Um nome descritivo

2. Os parametros cartográficos do formato PROJ.4

Para criar um novo SRC, clique no botão Adicionar novo SRC e digite um nome descritivo e os parâmetros do SRC.
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Figura 10.3: Janela de SRC personalizado

Note-se que o: guilabel: Parâmetros deve começar com um bloco + proj=, para representar o novo sistema de
referência de coordenadas.

Você pode testar os parâmetros SRC para ver se eles dão bons resultados. Para fazer isso, digite valores conhecidos
de latitude e longitude em WGS 84 Norte e :guilabel: Campos Leste, respectivamente. Clique em [Calcular], e
comparar os resultados com os valores conhecidos em seu sistema de referência de coordenadas.

10.5 transformações de datum padrão

depende OTF para ser capaz de transformar dados em um ‘SRC padrão’, e QGIS usa WGS84. Para alguns SRC
há uma série de transformações disponíveis. QGIS permite que você defina a transformação utilizada para outros
fins QGIS usa uma transformação padrão.

Na aba SRC Configurações → Opções você pode:

• QGIS está configurado para perguntar-lhe quando ele precisa definir uma transformação usando :guil-
abel: ‘Pergunte qual a transformação do datum quando nenhum padrão for definido‘

• editar uma lista dos padrões do usuário para transformações.

QGIS pede qual a transformação irá usar ao abrir uma caixa de diálogo exibindo texto PROJ.4 descrevendo as
transformações de origem e destino. Mais informações podem ser encontradas a respeito de uma transformação.
Os padrões do usuário podem ser salvos, selecionando Lembrar seleção.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 11

QGIS Browser

The QGIS Browser is a panel in QGIS that lets you easily navigate in your filesystem and manage geodata. You
can have access to common vector files (e.g., ESRI shapefiles or MapInfo files), databases (e.g., PostGIS, Oracle,
SpatiaLite or MS SQL Spatial) and WMS/WFS connections. You can also view your GRASS data (to get the data
into QGIS, see Integração com SIG GRASS).

Figura 11.1: QGIS browser as a stand alone application

Use the QGIS Browser to preview your data. The drag-and-drop function makes it easy to get your data into the
map view and the map legend.

1. Activate the QGIS Browser: Right-click on the toolbar and check Browser or select it from Settings →
Panels.

2. Drag the panel into the legend window and release it.

3. Clique no separador Pesquisar .

4. Browse in your filesystem and choose the shapefile folder from qgis_sample_data directory.

5. Press the Shift key and select the airports.shp and alaska.shp files.

6. Press the left mouse button, then drag and drop the files into the map canvas.
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7. Clique com o direito do raro na camada e escolha Definir o SRC do projecto a partir da camada . Para mais
informações veja Trabalhando com Projeções.

8. Clique em Ampliação Total para tornar as camadas visíveis.

There is a second browser available under Settings → Panels. This is handy when you need to move files or layers
between locations.

1. Activate a second QGIS Browser: Right-click on the toolbar and check Browser (2), or select it from
Settings → Panels.

2. Arraste o painel para a janela de legenda.

3. Navegue para o separador Pesquisador (2) e pesquise pela shapefile no seu sistema de ficheiros.

4. Select a file with the left mouse button. Now you can use the Add Selected Layers icon to add it into the
current project.

QGIS automatically looks for the coordinate reference system (CRS) and zooms to the layer extent if you work
in a blank QGIS project. If there are already files in your project, the file will just be added, and in the case that
it has the same extent and CRS, it will be visualized. If the file has another CRS and layer extent, you must first
right-click on the layer and choose Set Project CRS from Layer. Then choose Zoom to Layer Extent.

The Filter files function works on a directory level. Browse to the folder where you want to filter files and enter
a search word or wildcard. The Browser will show only matching filenames – other data won’t be displayed.

It’s also possible to run the QGIS Browser as a stand-alone application.

Start the QGIS browser

• Escreva na linha de comandos “qbrowser” .

• Start the QGIS Browser using the Start menu or desktop shortcut.

• The QGIS Browser is available from your Applications folder.

In figure_browser_standalone_metadata, you can see the enhanced functionality of the stand-alone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see Metadata Menu). With the Preview tab, you can
have a look at your files without importing them into your QGIS project. It’s also possible to preview the attributes
of your files in the Attributes tab.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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Trabalhando com Dados Vetoriais

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

12.1 Formatos de dados suportados

QGIS uses the OGR library to read and write vector data formats, including ESRI shapefiles, MapInfo and Mi-
croStation file formats, AutoCAD DXF, PostGIS, SpatiaLite, Oracle Spatial and MSSQL Spatial databases, and
many more. GRASS vector and PostgreSQL support is supplied by native QGIS data provider plugins. Vector
data can also be loaded in read mode from zip and gzip archives into QGIS. As of the date of this document, 69
vector formats are supported by the OGR library (see OGR-SOFTWARE-SUITE in Referências Bibliográficas e
Web). The complete list is available at http://www.gdal.org/ogr/ogr_formats.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL/OGR installation of your OS may not have been built to support the format
you want to use. Only those formats that have been well tested will appear in the list of file types when loading a
vector into QGIS. Other untested formats can be loaded by selecting *.*.

Procedimentos com dados vetoriais GRASS são descritos na Seção Integração com SIG GRASS.

This section describes how to work with several common formats: ESRI shapefiles, PostGIS layers, SpatiaLite
layers, OpenStreetMap vectors, and Comma Separated data (CSV). Many of the features available in QGIS work
the same, regardless of the vector data source. This is by design, and it includes the identify, select, labeling and
attributes functions.

12.1.1 Shapefiles ESRI

The standard vector file format used in QGIS is the ESRI shapefile. Support is provided by the OGR Simple
Feature Library (http://www.gdal.org/ogr/).

Um shapefile consiste na verdade de um conjunto de vários arquivos. Os três seguintes são necessários:

1. .shp file containing the feature geometries

2. .dbf file containing the attributes in dBase format

3. .shx index file

Shapefiles also can include a file with a .prj suffix, which contains the projection information. While it is very
useful to have a projection file, it is not mandatory. A shapefile dataset can contain additional files. For further
details, see the ESRI technical specification at http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.
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Carregando um Shapefile

To load a shapefile, start QGIS and click on the Add Vector Layer toolbar button, or simply press Ctrl+Shift+V.
This will bring up a new window (see figure_vector_1).

Figura 12.1: Add Vector Layer Dialog

From the available options check File. Click on [Browse]. That will bring up a standard open file dialog (see
figure_vector_2), which allows you to navigate the file system and load a shapefile or other supported data source.

The selection box Filter allows you to preselect some OGR-supported file formats.

You can also select the encoding for the shapefile if desired.

Figura 12.2: Open an OGR Supported Vector Layer Dialog

Ao selecinar um shapefile a partir da lista e clicando em [Abrir] o QGIS o carregará. A Figure_vector_3 exibe o
QGIS depois de carregar o arquivo alaska.shp.

Dica: Cores das camadas
Quando você adiciona uma camada ao mapa, é atribuída uma cor aleatória. Na adição de mais de uma camada de
uma vez, são atribuídas cores diferentes para cada camada.

Once a shapefile is loaded, you can zoom around it using the map navigation tools. To change the style of a layer,
open the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the

68 Capítulo 12. Trabalhando com Dados Vetoriais



QGIS User Guide, Versão 2.2

Figura 12.3: QGIS with Shapefile of Alaska loaded
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legend and choosing Properties from the context menu. See section Style Menu for more information on setting
symbology of vector layers.

Dica: Carregando camadas e armazenando projetos em unidades externas no OS X
On OS X, portable drives that are mounted beside the primary hard drive do not show up as expected under File
→ Open Project. We are working on a more OSX-native open/save dialog to fix this. As a workaround, you can
type /Volumes in the File name box and press Enter. Then you can navigate to external drives and network
mounts.

Improving Performance for Shapefiles

Para melhorar o desempenho do desenho de um shapefile, você pode criar um índice espacial. Um índice espacial
irá melhorar a velocidade do zoom e visão panorâmica. Os índices espaciais utilizados pelo QGIS estão na
extensão .qix.

Siga estes passos para criar o índice:

• Load a shapefile by clicking on the Add Vector Layer toolbar button or pressing Ctrl+Shift+V.

• Open the Layer Properties dialog by double-clicking on the shapefile name in the legend or by right-clicking
and choosing Properties from the context menu.

• In the General tab, click the [Create Spatial Index] button.

Problema ao carregar um arquivo shape .prj

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

12.1.2 Carregando uma camada MapInfo

To load a MapInfo layer, click on the Add Vector Layer toolbar button; or type Ctrl+Shift+V, change the

file type filter Files of type : to ‘Mapinfo File [OGR] (*.mif *.tab *.MIF *.TAB)’ and select the MapInfo
layer you want to load.

12.1.3 Carregando uma camada ArcInfo Binary

To load an ArcInfo Binary Coverage, click on the Add Vector Layer toolbar button or press Ctrl+Shift+V
to open the Add Vector Layer dialog. Select Directory as Source type. Change the file type filter Files of type

to ‘Arc/Info Binary Coverage’. Navigate to the directory that contains the coverage file, and select it.

Similarly, you can load directory-based vector files in the UK National Transfer Format, as well as the raw TIGER
Format of the US Census Bureau.
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12.1.4 Delimited Text Files

Tabular data is a very common and widely used format because of its simplicity and readability – data can be
viewed and edited even in a plain text editor. A delimited text file is an attribute table with each column separated
by a defined character and each row separated by a line break. The first row usually contains the column names. A
common type of delimited text file is a CSV (Comma Separated Values), with each column separated by a comma.

Such data files can also contain positional information in two main forms:

• As point coordinates in separate columns

• As well-known text (WKT) representation of geometry

QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:

1. The file must have a delimited header row of field names. This must be the first line in the text file.

2. The header row must contain field(s) with geometry definition. These field(s) can have any name.

3. The X and Y coordinates (if geometry is defined by coordinates) must be specified as numbers. The coor-
dinate system is not important.

As an example of a valid text file, we import the elevation point data file elevp.csv that comes with the QGIS
sample dataset (see section Amostra de Dados):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Some items to note about the text file:

1. The example text file uses ; (semicolon) as delimiter. Any character can be used to delimit the fields.

2. The first row is the header row. It contains the fields X, Y and ELEV.

3. No quotes (") are used to delimit text fields.

4. The X coordinates are contained in the X field.

5. The Y coordinates are contained in the Y field.

Loading a delimited text file

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text_1.

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To
enable QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter
by activating Custom delimiters, or by activating Regular expression delimiter and entering text into the
Expression field. For example, to change the delimiter to tab, use \t (this is a regular expression for the tab
character).

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.

Finally, enter a layer name (e.g., elevp), as shown in figure_delimited_text_1. To add the layer to the map, click
[OK]. The delimited text file now behaves as any other map layer in QGIS.
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Figura 12.4: Delimited Text Dialog

There is also a helper option that allows you to trim leading and trailing spaces from fields — Trim fields.

Also, it is possible to Discard empty fields. If necessary, you can force a comma to be the decimal separator

by activating Decimal separator is comma.

If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Additionaly, you can enable:

• Use spatial index to improve the performance of displaying and spatially selecting features.

• Use subset index.

• Watch file to watch for changes to the file by other applications while QGIS is running.

12.1.5 OpenStreetMap data

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital road maps are available. The objective of the OSM project is to create a free editable map of the world
from GPS data, aerial photography or local knowledge. To support this objective, QGIS provides suppport for
OSM data.

Loading OpenStreetMap Vectors

QGIS integrates OpenStreetMap import as a core functionality.

• To connect to the OSM server and download data, open the menu Vector → Openstreetmap → Load data.
You can skip this step if you already obtained an .osm XML file using JOSM, Overpass API or any other
source.

• The menu Vector → Openstreetmap → Import topology from an XML file will convert your .osm file into
a SpatiaLite database and create a corresponding database connection.
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• The menu Vector → Openstreetmap → Export topology to SpatiaLite then allows you to open the database
connection, select the type of data you want (points, lines, or polygons) and choose tags to import. This

creates a SpatiaLite geometry layer that you can add to your project by clicking on the Add SpatiaLite Layer

toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu (see section
Camadas SpatiaLite).

12.1.6 Camadas PostGIS

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are the spatial indexing, filter-
ing and query capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than they do with OGR layers in QGIS.

Criando uma conexão armazenada

The first time you use a PostGIS data source, you must create a connection to the PostgreSQL database that

contains the data. Begin by clicking on the Add PostGIS Layer toolbar button, selecting the Add PostGIS
Layer... option from the Layer menu, or typing Ctrl+Shift+D. You can also open the Add Vector Layer dialog
and select Database. The Add PostGIS Table(s) dialog will be displayed. To access the connection manager,
click on the [New] button to display the Create a New PostGIS Connection dialog. The parameters required for a
connection are:

• Name: A name for this connection. It can be the same as Database.

• Service: Service parameter to be used alternatively to hostname/port (and potentially database). This can
be defined in pg_service.conf.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: Port number the PostgreSQL database server listens on. The default port is 5432.

• Database: Name of the database.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speedups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. The following options
are available:

– Disable: Only try an unencrypted SSL connection.

– Allow: Try a non-SSL connection. If that fails, try an SSL connection.

– Prefer (the default): Try an SSL connection. If that fails, try a non-SSL connection.

– Require: Only try an SSL connection.

• Username: User name used to log in to the database.

• Password: Password used with Username to connect to the database.

Optionally, you can activate the following checkboxes:

• Salvar nome do usuário

• Salvar Senha

• Apenas olhar na tabela geometry_columns

• Don’t resolve type of unrestricted columns (GEOMETRY)

• :guilabel:‘Apenas olhar no esquema ‘público’
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• Também listar tabelas sem geometrias

• Usar metadados atribuidos da tabela

Uma vez que todos os parâmetros e as opções estão configuradas, você pode testar a conexão clicando no botão
[Testar Conexão].

Dica: QGIS Configurações do Usuário e Segurança
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk. Your
customized settings for QGIS are stored based on the operating system:

• The settings are stored in your home directory in ~/.qgis2.

• The settings are stored in the registry.

Carregando uma camada PostGIS

Once you have one or more connections defined, you can load layers from the PostgreSQL database. Of
course, this requires having data in PostgreSQL. See section Importação de dados no PostgreSQL for a discussion
on importing data into the database.

Para colocar uma camada no PostGIS, execute os seguintes passos:

• If the Add PostGIS layers dialog is not already open, selecting the Add PostGIS Layer... option from the
Layer menu or typing Ctrl+Shift+D opens the dialog.

• Escolha a conexão a partir da lista drop-down e clique em [Conectar].

• Select or unselect Also list tables with no geometry.

• Optionally, use some Search Options to define which features to load from the layer, or use the [Build
query] button to start the Query builder dialog.

• Encontre a camada(s) que deseja adicionar na lista de camadas disponíveis.

• Select it by clicking on it. You can select multiple layers by holding down the Shift key while clicking.
See section Ferramenta de Consulta for information on using the PostgreSQL Query Builder to further
define the layer.

• Clique no botão [Add] para adicionar a camada ao mapa.

Dica: Camadas PostGIS
Normally, a PostGIS layer is defined by an entry in the geometry_columns table. From version 0.9.0 on, QGIS
can load layers that do not have an entry in the geometry_columns table. This includes both tables and views.
Defining a spatial view provides a powerful means to visualize your data. Refer to your PostgreSQL manual for
information on creating views.

Alguns detalhes sobre as camadas PostgreSQL

This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time, QGIS should
simply provide you with a list of database tables that can be loaded, and it will load them on request. However,
if you have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any
QGIS messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to
load it.

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables,
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively, the ctid column can be used as primary
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key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).

If the PostgreSQL layer is a view, the same requirement exists, but views do not have primary keys or columns
with unique constraints on them. You have to define a primary key field (has to be integer) in the QGIS dialog
before you can load the view. If a suitable column does not exist in the view, QGIS will not load the layer. If this
occurs, the solution is to alter the view so that it does include a suitable column (a type of integer and either a
primary key or with a unique constraint, preferably indexed).

QGIS offers a checkbox Select at id that is activated by default. This option gets the ids without the attributes
which is faster in most cases. It can make sense to disable this option when you use expensive views.

12.1.7 Importação de dados no PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, including the SPIT plugin and the command
line tools shp2pgsql and ogr2ogr.

DB Manager

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section Módulo Gestor BD for more information.

shp2pgsql

PostGIS includes an utility called shp2pgsql that can be used to import shapefiles into a PostGIS-enabled database.
For example, to import a shapefile named lakes.shp into a PostgreSQL database named gis_data, use the
following command:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

This creates a new layer named lakes_new in the gis_data database. The new layer will have a spatial
reference identifier (SRID) of 2964. See section Trabalhando com Projeções for more information on spatial
reference systems and projections.

Dica: Exportando conjuntos de dados do PostGIS
Like the import tool shp2pgsql, there is also a tool to export PostGIS datasets as shapefiles: pgsql2shp. This is
shipped within your PostGIS distribution.

ogr2ogr

Besides shp2pgsql and DB Manager, there is another tool for feeding geodata in PostGIS: ogr2ogr. This is part
of your GDAL installation.

Para importar um shapefile no PostGIS, faça o seguinte :

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

This will import the shapefile alaska.shp into the PostGIS database postgis using the user postgres with the
password topsecret on host server myhost.de.

Note that OGR must be built with PostgreSQL to support PostGIS. You can verify this by typing (in )

ogrinfo --formats | grep -i post
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If you prefer to use PostgreSQL’s COPY command instead of the default INSERT INTO method, you can export

the following environment variable (at least available on and ):

export PG_USE_COPY=YES

ogr2ogr does not create spatial indexes like shp2pgsl does. You need to create them manually, using the normal
SQL command CREATE INDEX afterwards as an extra step (as described in the next section melhorando o
Desempenho).

melhorando o Desempenho

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can
improve the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on
each layer in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed
up spatial searches of the data (GiST index information is taken from the PostGIS documentation available at
http://postgis.refractions.net).

The syntax for creating a GiST index is:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Observe que para grandes tabelas, a criação do índice pode levar um longo tempo. Uma vez que o índice é
criado, você deve realizar um VACUUM ANALYZE. Consulte a documentação do PostGIS (PostGIS-PROJECT
Referências Bibliográficas e Web) para mais informações.

A seguir um exemplo de criação de um índice GiST:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

12.1.8 Camadas vetoriais que ultrapassam 180° de longitude

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_4, the tiny point on the far left of the map canvas (Chatham Islands) should be within the grid, to
the right of the New Zealand main islands.

A work-around is to transform the longitude values using PostGIS and the ST_Shift_Longitude function. This
function reads every point/vertex in every component of every feature in a geometry, and if the longitude coordi-
nate is < 0°, it adds 360° to it. The result is a 0° - 360° version of the data to be plotted in a 180°-centric map.
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Figura 12.5: Map in lat/lon crossing the 180° longitude line

Figura 12.6: Crossing 180° longitude applying the ST_Shift_Longitude function

Uso

• Import data into PostGIS (Importação de dados no PostgreSQL) using, for example, the DB Manager plugin.

• Use the PostGIS command line interface to issue the following command (in this example,
“TABLE” is the actual name of your PostGIS table): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• If everything went well, you should receive a confirmation about the number of features that were updated.
Then you’ll be able to load the map and see the difference (Figure_vector_5).

12.1.9 Camadas SpatiaLite

The first time you load data from a SpatiaLite database, begin by clicking on the Add SpatiaLite Layer

toolbar button, or by selecting the Add SpatiaLite Layer... option from the Layer menu, or by typing
Ctrl+Shift+L. This will bring up a window that will allow you either to connect to a SpatiaLite database
already known to QGIS, which you can choose from the drop-down menu, or to define a new connection to a new
database. To define a new connection, click on [New] and use the file browser to point to your SpatiaLite database,
which is a file with a .sqlite extension.

If you want to save a vector layer to SpatiaLite format, you can do this by right clicking the layer in the legend.
Then, click on Save as.., define the name of the output file, and select ‘SpatiaLite’ as format and the CRS. Also,
you can select ‘SQLite’ as format and then add SPATIALITE=YES in the OGR data source creation option field.
This tells OGR to create a SpatiaLite database. See also http://www.gdal.org/ogr/drv_sqlite.html.

QGIS also supports editable views in SpatiaLite.

Criando uma nova camada SpatiaLite

Se você quiser criar uma nova camada SpatiaLite, consulte a seção Criando uma nova camada SpatialLite.
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Dica: Gestão complementos de dados SpatiaLite
For SpatiaLite data management, you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or
DB Manager (core plugin, recommended). If necessary, they can be downloaded and installed with the Plugin
Installer.

12.1.10 MSSQL Spatial Layers

QGIS also provides native MS SQL 2008 support. The first time you load MSSQL Spatial data, begin by

clicking on the Add MSSQL Spatial Layer toolbar button or by selecting the Add MSSQL Spatial Layer... option
from the Layer menu, or by typing Ctrl+Shift+M.

12.1.11 Oracle Spatial Layers

The spatial features in Oracle Spatial aid users in managing geographic and location data in a native type within
an Oracle database. QGIS now has support for such layers.

Criando uma conexão armazenada

The first time you use an Oracle Spatial data source, you must create a connection to the database that

contains the data. Begin by clicking on the Add Orcale Spatial Layer toolbar button, selecting the Add Orcale
Spatial Layer... option from the Layer menu, or typing Ctrl+Shift+O. To access the connection manager, click
on the [New] button to display the Create a New Oracle Spatial Connection dialog. The parameters required for
a connection are:

• Name: A name for this connection. It can be the same as Database

• Database: SID or SERVICE_NAME of the Oracle instance.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
telnet connection or ping the host. If the database is on the same computer as QGIS, simply enter ‘localhost’
here.

• Port: Port number the PostgreSQL database server listens on. The default port is 1521.

• Username: Username used to login to the database.

• Password: Password used with Username to connect to the database.

Optionally, you can activate following checkboxes:

• Save Username Indicates whether to save the database username in the connection configuration.

• Save Password Indicates whether to save the database password in the connection settings.

• Only look in meta data table Restricts the displayed tables to those that are in the
all_sdo_geom_metadata view. This can speed up the initial display of spatial tables.

• Only look for user’s tables When searching for spatial tables, restrict the search to tables that are owned
by the user.

• Also list tables with no geometry Indicates that tables without geometry should also be listed by default.

• Use estimated table statistics for the layer metadata When the layer is set up, various metadata are
required for the Oracle table. This includes information such as the table row count, geometry type and
spatial extents of the data in the geometry column. If the table contains a large number of rows, determining
this metadata can be time-consuming. By activating this option, the following fast table metadata operations

78 Capítulo 12. Trabalhando com Dados Vetoriais



QGIS User Guide, Versão 2.2

are done: Row count is determined from all_tables.num_rows. Table extents are always determined
with the SDO_TUNE.EXTENTS_OF function, even if a layer filter is applied. Table geometry is determined
from the first 100 non-null geometry rows in the table.

• Only existing geometry types Only list the existing geometry types and don’t offer to add others.

Uma vez que todos os parâmetros e as opções estão configuradas, você pode testar a conexão clicando no botão
[Testar Conexão].

Dica: QGIS Configurações do Usuário e Segurança
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk.
Passwords are saved in clear text in the system configuration and in the project files! Your customized settings for
QGIS are stored based on the operating system:

• The settings are stored in your home directory in .config/QGIS/QGIS2.conf.

• The settings are stored in the registry.

Loading an Oracle Spatial Layer

Once you have one or more connections defined, you can load layers from the Oracle database. Of course,
this requires having data in Oracle.

To load a layer from Oracle Spatial, perform the following steps:

• If the Add Oracle Spatial layers dialog is not already open, click on the Add Oracle Spatial Layer toolbar
button.

• Escolha a conexão a partir da lista drop-down e clique em [Conectar].

• Select or unselect Also list tables with no geometry.

• Optionally, use some Search Options to define which features to load from the layer or use the [Build
query] button to start the Query builder dialog.

• Encontre a camada(s) que deseja adicionar na lista de camadas disponíveis.

• Select it by clicking on it. You can select multiple layers by holding down the Shift key while clicking.
See section Ferramenta de Consulta for information on using the Oracle Query Builder to further define the
layer.

• Clique no botão [Add] para adicionar a camada ao mapa.

Dica: Oracle Spatial Layers
Normally, an Oracle Spatial layer is defined by an entry in the USER_SDO_METADATA table.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

12.2 Janela de Propriedades de Vetor

The Layer Properties dialog for a vector layer provides information about the layer, symbology settings and
labeling options. If your vector layer has been loaded from a PostgreSQL/PostGIS datastore, you can also alter
the underlying SQL for the layer by invoking the Query Builder dialog on the General tab. To access the Layer
Properties dialog, double-click on a layer in the legend or right-click on the layer and select Properties from the
pop-up menu.
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Figura 12.7: Vector Layer Properties Dialog
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12.2.1 Style Menu

The Style menu provides you with a comprehensive tool for rendering and symbolizing your vector data. You can
use Layer rendering → tools that are common to all vector data, as well as special symbolizing tools that were
designed for the different kinds of vector data.

Layer rendering

• Layer transparency : You can make the underlying layer in the map canvas visible with
this tool. Use the slider to adapt the visibility of your vector layer to your needs. You can also make a
precise definition of the percentage of visibility in the the menu beside the slider.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described below.

– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it. The colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with the other. In case of values
above one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the corresponding
pixels for the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.

– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This is supposed to emulate shining a soft light onto an image.

– Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a
very intense light onto an image.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer from the other. In case of negative
values, black is displayed.

Renderers

The renderer is responsible for drawing a feature together with the correct symbol. There are four types of
renderers: single symbol, categorized, graduated and rule-based. There is no continuous color renderer, because it
is in fact only a special case of the graduated renderer. The categorized and graduated renderers can be created by
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specifying a symbol and a color ramp - they will set the colors for symbols appropriately. For point layers, there
is a point displacement renderer available. For each data type (points, lines and polygons), vector symbol layer
types are available. Depending on the chosen renderer, the Style menu provides different additional sections. On
the bottom right of the symbology dialog, there is a [Symbol] button, which gives access to the Style Manager
(see section vector_style_manager). The Style Manager allows you to edit and remove existing symbols and add
new ones.

Dica: Seleção e mudança de simbolos multiplos
The Symbology allows you to select multiple symbols and right click to change color, transparency, size, or width
of selected entries.

Renderizando Simbolo Individual

The Single Symbol Renderer is used to render all features of the layer using a single user-defined symbol. The
properties, which can be adjusted in the Style menu, depend partially on the type of layer, but all types share the
following dialog structure. In the top-left part of the menu, there is a preview of the current symbol to be rendered.
On the right part of the menu, there is a list of symbols already defined for the current style, prepared to be used
by selecting them from the list. The current symbol can be modified using the menu on the right side. If you
click on the first level in the Symbol layers dialog on the left side, it’s possible to define basic parameters like Size,
Transparency, Color and Rotation. Here, the layers are joined together.

Figura 12.8: Single symbol line properties

More detailed settings can be made when clicking on the second level in the Symbol layers dialog. You can
define Symbol layers that are combined afterwards. A symbol can consist of several Symbol layers. The following
settings are possible:

• Point layers:
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• Symbol layer type: You have the option to use Ellipse markers, Font markers, Simple markers, SVG markers
and Vector Field markers.

• Colors

• Size

• Outline style

• Outline width

• Angle

• Offset X,Y: You can shift the symbol in the x- or y-direction.

• Anchor point

• Data defined properties ...

• Line layers:

• Symbol layer type: Here you can use Simple Lines and Marker Lines.

• Color

• Pen width

• Offset

• Pen style

• Join style

• Cap style

• Use custom dash pattern

• Dash pattern unit

• Data defined properties ...

• Polygon Layers:

• Symbol layer type: It’s possible to use Centroid Fill, Gradient Fill, Line Pattern Fill, Point Pattern Fill, SVG
Fill, Simple Fill and two Outlines (Marker line and Simple line).

• Colors

• Fill style

• Border style

• Border width

• Offset X,Y

• Data defined properties ...

‘Gradient Fill’ Symbol layer type allows you to select between a Two color and Color ramp setting. You

can use the Feature centroid as Referencepoint. All fills ‘Gradient Fill‘ Symbol layer type is also available
through the Symbol menu of the Categorized and Graduated Renderer and through the Rule properties menu of
the Rule-based renderer.

It is possible to only draw polygon borders inside the polygon. Using ‘Outline: Simple line’ select Draw line
only inside polygon.

Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the whole symbol
can be changed with the Size menu in the first level again. The size of the lower levels changes accordingly,
while the size ratio is maintained. After having made any needed changes, the symbol can be added to the list

of current style symbols (using [Symbol] Save in symbol library), and then it can easily be used in the

future. Furthermore, you can use the [Save Style] button to save the symbol as a QGIS layer style file
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(.qml) or SLD file (.sld). SLDs can be exported from any type of renderer – single symbol, categorized, graduated
or rule-based – but when importing an SLD, either a single symbol or rule-based renderer is created. That means
that categorized or graduated styles are converted to rule-based. If you want to preserve those renderers, you have
to stick to the QML format. On the other hand, it can be very handy sometimes to have this easy way of converting

styles to rule-based. With the Style manager from the [Symbol] menu you can administer your symbols.

You can add item, edit item, remove item and share item. ‘Marker’ symbols, ‘Line’ symbols, ‘Fill’ patterns
and ‘Color ramps’ can be used to create the symbols (see defining_symbols). The symbols are then assigned to
‘All Symbols’, ‘Groups’ or ‘Smart groups’.

Renderizador Categorizado

The Categorized Renderer is used to render all features from a layer, using a single user-defined symbol whose
color reflects the value of a selected feature’s attribute. The Style menu allows you to select:

• The attribute (using the Column listbox or the Set column expression function)

• Simbolo (usando a aba Simbolo)

• As cores (usando rampa de cores lista box)

The [Advanced] button in the lower-right corner of the dialog allows you to set the fields containing rotation and
size scale information. For convenience, the center of the menu lists the values of all currently selected attributes
together, including the symbols that will be rendered.

The example in figure_symbology_2 shows the category rendering dialog used for the rivers layer of the QGIS
sample dataset.

Figura 12.9: Categorized Symbolizing options

You can create a custom color ramp choosing New color ramp... from the Color ramp drop-down menu. A dialog
will prompt for the ramp type: Gradient, Random, ColorBrewer, or cpt-city. The first three have options for

number of steps and/or multiple stops in the color ramp. You can use the Invert option while classifying the
data with a color ramp. See figure_symbology_3 for an example of custom color ramp and figure_symbology_3a
for the cpt-city dialog.

The cpt-city option opens a new dialog with hundreds of themes included ‘out of the box’.

Renderização Graduada
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Figura 12.10: Example of custom gradient color ramp with multiple stops

Figura 12.11: cpt-city dialog with hundreds of color ramps

12.2. Janela de Propriedades de Vetor 85



QGIS User Guide, Versão 2.2

The Graduated Renderer is used to render all the features from a layer, using a single user-defined symbol whose
color reflects the assignment of a selected feature’s attribute to a class.

Figura 12.12: Graduated Symbolizing options

Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Also, analogous to the Categorized Renderer, the Style tab allows you to select:

• The attribute (using the Column listbox or the Set column expression function)

• O simbolo (usando o botão Propriedades do Simbolo)

• As cores (usando a lista de rampas de cores)

Additionally, you can specify the number of classes and also the mode for classifying features within the classes
(using the Mode list). The available modes are:

• Intervalo igual

• Quartil

• Quebras Naturais (Jenks)

• Desvio padrão

• Quebras suaves

The listbox in the center part of the Style menu lists the classes together with their ranges, labels and symbols that
will be rendered.

The example in figure_symbology_4 shows the graduated rendering dialog for the rivers layer of the QGIS sample
dataset.

Dica: Thematic maps using an expression
Categorized and graduated thematic maps can now be created using the result of an expression. In the properties
dialog for vector layers, the attribute chooser has been augmented with a Set column expression function. So
now you no longer need to write the classification attribute to a new column in your attribute table if you want the
classification attribute to be a composite of multiple fields, or a formula of some sort.
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Renderizador baseado em regras

The Rule-based Renderer is used to render all the features from a layer, using rule based symbols whose color
reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements. The
dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use only
the first-matched rule.

The example in figure_symbology_5 shows the rule-based rendering dialog for the rivers layer of the QGIS sample
dataset.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Calculadora de Campos). Since QGIS 2.2, you can create a new rule by copying and
pasting an existing rule with the right mouse button. Also since QGIS 2.2, you can use the ‘ELSE’ rule that will
be run if none of the other rules on that level match.

Figura 12.13: Rule-based Symbolizing options

Deslocamento de ponto

The Point Displacement Renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around a center symbol.

Dica: Export vector symbology
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files. Just
open the right mouse menu of the layer and click on Save selection as → to specify the name of the output file and
its format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology →
or as Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

12.2.2 Labels Menu

The Labels core application provides smart labeling for vector point, line and polygon layers, and it only
requires a few parameters. This new application also supports on-the-fly transformed layers. The core functions
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Figura 12.14: Point displacement dialog
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of the application have been redesigned. In QGIS, there are a number of other features that improve the labeling.
The following menus have been created for labeling the vector layers:

• Text

• Formatting

• Buffer

• Background

• Shadow

• Placement

• Rendering

Let us see how the new menus can be used for various vector layers. Rotulando camadas de pontos

Start QGIS and load a vector point layer. Activate the layer in the legend and click on the Layer Labeling Options

icon in the QGIS toolbar menu.

The first step is to activate the Label this layer with checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.

The following steps describe a simple labeling without using the Data defined override functions, which are
situated next to the drop-down menus.

You can define the text style in the Text menu (see Figure_labels_1 ). Use the Type case option to influence the text
rendering. You have the possibility to render the text ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
Use the blend modes to create effects known from graphics programs (see blend_modes).

In the Formatting menu, you can define a character for a line break in the labels with the ‘Wrap on character’

function. Use the Formatted numbers option to format the numbers in an attribute table. Here, decimal places
may be inserted. If you enable this option, three decimal places are initially set by default.

To create a buffer, just activate the Draw text buffer checkbox in the Buffer menu. The buffer color is variable.
Here, you can also use blend modes (see blend_modes).

If the Color buffer’s fill checkbox is activated, it will interact with partially transparent text and give mixed
color transparency results. Turning off the buffer fill fixes that issue (except where the interior aspect of the buffer’s
stroke intersects with the text’s fill) and also allows you to make outlined text.

In the Background menu, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see blend_modes).

Use the Shadow menu for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode (see blend_modes).

Choose the Placement menu for the label placement and the labeling priority. Using the Offset from point
setting, you now have the option to use Quadrants to place your label. Additionally, you can alter the angle of
the label placement with the Rotation setting. Thus, a placement in a certain quadrant with a certain rotation is
possible.

In the Rendering menu, you can define label and feature options. Under Label options, you find the scale-based

visibility setting now. You can prevent QGIS from rendering only selected labels with the Show all labels for
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this layer (including colliding labels) checkbox. Under Feature options, you can define whether every part of a
multipart feature is to be labeled. It’s possible to define whether the number of features to be labeled is limited

and to Discourage labels from covering features.

Figura 12.15: Smart labeling of vector point layers

Rotulando camadas de linhas

The first step is to activate the Label this layer checkbox in the Label settings tab and select an attribute column
to use for labeling. Click if you want to define labels based on expressions - See labeling_with_expressions.

After that, you can define the text style in the Text menu. Here, you can use the same settings as for point layers.

Also, in the Formatting menu, the same settings as for point layers are possible.

The Buffer menu has the same functions as described in section labeling_point_layers.

The Background menu has the same entries as described in section labeling_point_layers.

Also, the Shadow menu has the same entries as described in section labeling_point_layers.

In the Placement menu, you find special settings for line layers. The label can be placed Parallel, Curved

or Horizontal. With the Parallel and Curved option, you can define the position Above line,

On line and Below line. It’s possible to select several options at once. In that case, QGIS will look for the
optimal position of the label. Remember that here you can also use the line orientation for the position of the label.
Additionally, you can define a Maximum angle between curved characters when selecting the Curved option
(see Figure_labels_2 ).

The Rendering menu has nearly the same entries as for point layers. In the Feature options, you can now Suppress
labeling of features smaller than.

Rotulando camadas de polígonos

The first step is to activate the Label this layer checkbox and select an attribute column to use for labeling.
Click if you want to define labels based on expressions - See labeling_with_expressions.
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Figura 12.16: Smart labeling of vector line layers

In the Text menu, define the text style. The entries are the same as for point and line layers.

The Formatting menu allows you to format multiple lines, also similar to the cases of point and line layers.

As with point and line layers, you can create a text buffer in the Buffer menu.

Use the Background menu to create a complex user-defined background for the polygon layer. You can use the
menu also as with the point and line layers.

The entries in the Shadow menu are the same as for point and line layers.

In the Placement menu, you find special settings for polygon layers (see Figure_labels_3). Offset from centroid,
Horizontal (slow), Around centroid, Free and Using perimeter are possible.

In the Offset from centroid settings, you can specify if the centroid is of the visible polygon or whole
polygon. That means that either the centroid is used for the polygon you can see on the map or the centroid is
determined for the whole polygon, no matter if you can see the whole feature on the map. You can place your
label with the quadrants here, and define offset and rotation. The Around centroid setting makes it possible to
place the label around the centroid with a certain distance. Again, you can define visible polygon or whole
polygon for the centroid. With the Using perimeter settings, you can define a position and a distance for the

label. For the position, Above line, On line, Below line and Line orientation dependent position
are possible.

The entries in the Rendering menu are the same as for line layers. You can also use Suppress labeling of features
smaller than in the Feature options. Define labels based on expressions

QGIS allows to use expressions to label features. Just click the icon in the Labels menu of the properties
dialog. In figure_labels_4 you see a sample expression to label the alaska regions with name and area size, based
on the field ‘NAME_2’, some descriptive text and the function ‘$area()’ in combination with ‘format_number()’
to make it look nicer.
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Figura 12.17: Smart labeling of vector polygon layers

Figura 12.18: Using expressions for labeling
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Expression based labeling is easy to work with. All you have to take care of is, that you need to combine all
elements (strings, fields and functions) with a string concatenation sign ‘||’ and that fields a written in “double
quotes” and strings in ‘single quotes’. Let’s have a look at some examples:

# label based on two fields ’name’ and ’place’ with a
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ with a descriptive text
’My name is ’ || "name" || ’and I live in ’ || "place"

-> My name is John Smith and I live in Paris

# label based on two fields ’name’ and ’place’ with a descriptive text
# and a line break (\n)
’My name is ’ || "name" || ’\nI live in ’ || "place"

-> My name is John Smith
I live in Paris

# create a multi-line label based on a field and the $area function
# to show the place name and its area size based on unit meter.
’The area of ’ || "place" || ’has a size of ’ || $area || ’m²’

-> The area of Paris has a size of 105000000 m²

# create a CASE ELSE condition. If the population value in field
# population is <= 50000 it is a town, otherwise a city.
’This place is a ’ || CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END

-> This place is a town

As you can see in the expression builder, you have hundreds if functions available to create simple and very
complex expressions to label your data in QGIS.

Using data-defined override for labeling

With the data-defined override functions, the settings for the labeling are overridden by entries in the attribute
table. You can activate and deactivate the function with the right-mouse button. Hover over the symbol and you
see the information about the data-defined override, including the current definition field. We now describe an

example using the data-defined override function for the Move label function (see figure_labels_5 ).

1. Import lakes.shp from the QGIS sample dataset.

2. Double-click the layer to open the Layer Properties. Click on Labels and Placement. Select Offset from
centroid.

3. Look for the Data defined entries. Click the icon to define the field type for the Coordinate. Choose
‘xlabel’ for X and ‘ylabel’ for Y. The icons are now highlighted in yellow.

4. Zoom into a lake.

5. Go to the Label toolbar and click the icon. Now you can shift the label manually to another position
(see figure_labels_6 ). The new position of the label is saved in the ‘xlabel’ and ‘ylabel’ columns of the
attribute table.

12.2.3 Fields Menu

Within the Fields menu, the field attributes of the selected dataset can be manipulated. The buttons
New Column and Delete Column can be used when the dataset is in Editing mode.
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Figura 12.19: Labeling of vector polygon layers with data-defined override

Figura 12.20: Move labels
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Edição de Widget

Figura 12.21: Dialog to select an edit widget for an attribute column

Within the Fields menu, you also find an edit widget column. This column can be used to define values or a range
of values that are allowed to be added to the specific attribute table column. If you click on the [edit widget]
button, a dialog opens, where you can define different widgets. These widgets are:

• Line edit: An edit field that allows you to enter simple text (or restrict to numbers for numeric attributes).

• Classification: Displays a combo box with the values used for classification, if you have chosen ‘unique
value’ as legend type in the Style menu of the properties dialog.

• Range: Allows you to set numeric values from a specific range. The edit widget can be either a slider or a
spin box.

• Unique values: You can select one of the values already used in the attribute table. If ‘Editable’ is activated,
a line edit is shown with autocompletion support, otherwise a combo box is used.

• ** Nome do Arquivo **: Simplifica a seleção, adicionando uma janela de seleção de arquivos.

• Value map: A combo box with predefined items. The value is stored in the attribute, the description is
shown in the combo box. You can define values manually or load them from a layer or a CSV file.

• Enumeration: Opens a combo box with values that can be used within the columns type. This is currently
only supported by the PostgreSQL provider.

• ** Imutável **: A coluna de atributo imutável é somente leitura. O usuário não é habilitado para modificar
o conteúdo.

• Hidden: A hidden attribute column is invisible. The user is not able to see its contents.

• Checkbox: Displays a checkbox, and you can define what attribute is added to the column when the check-
box is activated or not.
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• ** Edição de texto **: Isto abre um campo de edição de texto que permite que várias linhas sejam utilizadas.

• ** Calendário **: Abre um widget de calendário para introduzir uma data. Tipo de coluna deve ser de texto.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column.

• UUID Generator: Generates a read-only UUID (Universally Unique Identifiers) field, if empty.

• Photo: Field contains a filename for a picture. The width and height of the field can be defined.

• Webview: Field contains a URL. The width and height of the field is variable.

• Color: A field that allows you to enter color codes. During data entry, the color is visible through a color
bar included in the field.

• Relation Reference: This widged lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Creating one to many relations.

With the Attribute editor layout, you can now define built-in forms for data entry jobs (see figure_fields_2).

Choose ‘Drag and drop designer’ and an attribute column. Use the icon to create a category that will then be
shown during the digitizing session (see figure_fields_3). The next step will be to assign the relevant fields to the

category with the icon. You can create more categories and use the same fields again. When creating a new
category, QGIS will insert a new tab for the category in the built-in form.

Other options in the dialog are ‘Autogenerate’ and ‘Provide ui-file’. ‘Autogenerate’ just creates editors for all
fields and tabulates them. The ‘Provide ui-file’ option allows you to use complex dialogs made with the Qt-
Designer. Using a UI-file allows a great deal of freedom in creating a dialog. For detailed information, see
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/.

QGIS dialogs can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. An example is (in module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: MyForms.open

MyForms.py must live on PYTHONPATH, in .qgis2/python, or inside the project folder.

12.2.4 General Menu

Use this menu to make general settings for the vector layer. There are several options available:

Layer Info

• Change the display name of the layer in displayed as

• Define the Layer source of the vector layer

• Define the Data source encoding to define provider-specific options and to be able to read the file

Coordinate Reference System

• Specify the coordinate reference system. Here, you can view or change the projection of the specific vector
layer.

• Create a Spatial Index (only for OGR-supported formats)

• Update Extents information for a layer

• View or change the projection of the specific vector layer, clicking on Specify ...

Scale dependent visibility
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Figura 12.22: Dialog to create categories with the Attribute editor layout

Figura 12.23: Resulting built-in form in a data entry session
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• You can set the Maximum (inclusive) and Minimum (exclusive) scale. The scale can also be set by the
[Current] buttons.

Feature subset

• With the [Query Builder] button, you can create a subset of the features in the layer that will be visualized
(also refer to section Salvar elementos selecionados como uma nova camada).

Figura 12.24: General menu in vector layers properties dialog

12.2.5 Rendering Menu

QGIS 2.2 introduces support for on-the-fly feature generalisation. This can improve rendering times when drawing

many complex features at small scales. This feature can be enabled or disabled in the layer settings using the
Simplify geometry option. There is also a new global setting that enables generalisation by default for newly
added layers (see section Opções). Note: Feature generalisation may introduce artefacts into your rendered output
in some cases. These may include slivers between polygons and inaccurate rendering when using offset-based
symbol layers.

12.2.6 Display Menu

This menu is specifically created for Map Tips. It includes a new feature: Map Tip display text in HTML.
While you can still choose a Field to be displayed when hovering over a feature on the map, it is now possible
to insert HTML code that creates a complex display when hovering over a feature. To activate Map Tips, select
the menu option View → MapTips. Figure Display 1 shows an example of HTML code.
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Figura 12.25: HTML code for map tip

Figura 12.26: Map tip made with HTML code
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12.2.7 Actions Menu

QGIS fornece a capacidade de executar uma ação com base nos atributos de um recurso. Isso pode ser usado
para executar qualquer número de ações, por exemplo, a execução de um programa com argumentos construídos
a partir dos atributos de um recurso ou passar parâmetros ao uma ferramenta de comunicação web.

Figura 12.27: Overview action dialog with some sample actions

Actions are useful when you frequently want to run an external application or view a web page based on one or
more values in your vector layer. They are divided into six types and can be used like this:

• Generic, Mac, Windows and Unix actions start an external process.

• Python actions execute a Python expression.

• Generic and Python actions are visible everywhere.

• Mac, Windows and Unix actions are visible only on the respective platform (i.e., you can define three ‘Edit’
actions to open an editor and the users can only see and execute the one ‘Edit’ action for their platform to
run the editor).

There are several examples included in the dialog. You can load them by clicking on [Add default actions]. One
example is performing a search based on an attribute value. This concept is used in the following discussion.

** Definição de Ações **

Attribute actions are defined from the vector Layer Properties dialog. To define an action, open the vector Layer
Properties dialog and click on the Actions menu. Go to the Action properties. Select ‘Generic’ as type and provide
a descriptive name for the action. The action itself must contain the name of the application that will be executed
when the action is invoked. You can add one or more attribute field values as arguments to the application. When
the action is invoked, any set of characters that start with a % followed by the name of a field will be replaced by
the value of that field. The special characters %% will be replaced by the value of the field that was selected from
the identify results or attribute table (see using_actions below). Double quote marks can be used to group text into
a single argument to the program, script or command. Double quotes will be ignored if preceded by a backslash.

100 Capítulo 12. Trabalhando com Dados Vetoriais



QGIS User Guide, Versão 2.2

If you have field names that are substrings of other field names (e.g., col1 and col10), you should indicate that
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent
the %col10 field name from being mistaken for the %col1 field name with a 0 on the end. The brackets will be
removed by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded
by square brackets, use a second set like this: [[%col10]].

Using the Identify Features tool, you can open the Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by preceeding the derived field name with (Derived).. For example, a point layer has an X and Y field, and
the values of these fields can be used in the action with %(Derived).X and %(Derived).Y. The derived
attributes are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Two example actions are shown below:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In the first example, the web browser konqueror is invoked and passed a URL to open. The URL performs a
Google search on the value of the nam field from our vector layer. Note that the application or script called
by the action must be in the path, or you must provide the full path. To be certain, we could rewrite the first
example as: /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam. This will
ensure that the konqueror application will be executed when the action is invoked.

The second example uses the %% notation, which does not rely on a particular field for its value. When the action
is invoked, the %% will be replaced by the value of the selected field in the identify results or attribute table. **
Utilizando Ações **

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the record and choose the action from the pop-up menu. Ac-
tions are listed in the popup menu by the name you assigned when defining the action. Click on the action you
wish to invoke.

If you are invoking an action that uses the %% notation, right-click on the field value in the Identify Results dialog
or the Attribute Table dialog that you wish to pass to the application or script.

Here is another example that pulls data out of a vector layer and inserts it into a file using bash and the echo com-

mand (so it will only work on or perhaps ). The layer in question has fields for a species name taxon_name,
latitude lat and longitude long. We would like to be able to make a spatial selection of localities and export
these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is the action
to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Depois de selecionar algumas localidades e executar a ação em cada um, a abertura do arquivo de saída irái mostrar
algo como isto:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

As an exercise, we can create an action that does a Google search on the lakes layer. First, we need to determine
the URL required to perform a search on a keyword. This is easily done by just going to Google and doing a
simple search, then grabbing the URL from the address bar in your browser. From this little effort, we see that the
format is http://google.com/search?q=qgis, where QGIS is the search term. Armed with this information, we can
proceed:

1. Verifique se a camada lagos está carregada.

2. Open the Layer Properties dialog by double-clicking on the layer in the legend, or right-click and choose
Properties from the pop-up menu.

3. Click on the Actions menu.
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4. Digite um nome para a ação, por exemplo ‘‘ Google Search ‘‘.

5. Para a ação, precisamos fornecer o nome do programa externo a ser executado. Neste caso, podemos usar o
Firefox. Se o programa não estiver em seu caminho, você precisará fornecer o caminho completo.

6. Following the name of the external application, add the URL used for doing a Google search, up to but not
including the search term: http://google.com/search?q=

7. O texto no campo de ação será mostrado como este: ‘‘ firefox http://google.com/search?q =‘‘

8. Click on the drop-down box containing the field names for the lakes layer. It’s located just to the left of
the [Insert Field] button.

9. From the drop-down box, select ‘NAMES’ and click [Insert Field].

10. Seu texto ação agora se parecerá como este:

firefox http://google.com/search?q=%NAMES

11. To finalize the action, click the [Add to action list] button.

This completes the action, and it is ready to use. The final text of the action should look like this:

firefox http://google.com/search?q=%NAMES

Agora podemos utilizar a ação. Feche a: aba de diálogo: ‘Propriedades da camada ‘ e aplique um zoom em uma
área de interesse. Certifique-se que a camada lagos está ativa e identifique um lago. Na caixa o resultado que
você poderá visualizar que a nossa ação está visível:

Figura 12.28: Select feature and choose action

When we click on the action, it brings up Firefox and navigates to the URL
http://www.google.com/search?q=Tustumena. It is also possible to add further attribute fields to the ac-
tion. Therefore, you can add a + to the end of the action text, select another field and click on [Insert Field]. In
this example, there is just no other field available that would make sense to search for.

You can define multiple actions for a layer, and each will show up in the Identify Results dialog.

There are all kinds of uses for actions. For example, if you have a point layer containing locations of images or
photos along with a file name, you could create an action to launch a viewer to display the image. You could also
use actions to launch web-based reports for an attribute field or combination of fields, specifying them in the same
way we did in our Google search example.

We can also make more complex examples, for instance, using Python actions.

Usually, when we create an action to open a file with an external application, we can use absolute paths, or
eventually relative paths. In the second case, the path is relative to the location of the external program executable
file. But what about if we need to use relative paths, relative to the selected layer (a file-based one, like a shapefile
or SpatiaLite)? The following code will do the trick:
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command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None);

path = os.path.dirname(str(layerpath));
image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

We just have to remember that the action is one of type Python and the command and imagerelpath variables must
be changed to fit our needs.

But what about if the relative path needs to be relative to the (saved) project file? The code of the Python action
would be:

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Another Python action example is the one that allows us to add new layers to the project. For instance, the
following examples will add to the project respectively a vector and a raster. The names of the files to be added to
the project and the names to be given to the layers are data driven (filename and layername are column names of
the table of attributes of the vector where the action was created):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’,
’ogr’)

To add a raster (a TIF image in this example), it becomes:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]
’)

12.2.8 Joins Menu

The Joins menu allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target
layer. As a result of the join, all information from the join layer and the target layer are displayed in the attribute
table of the target layer as joined information.

QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins_1).

Additionally, the add vector join dialog allows you to:

• Cache join layer in virtual memory

• Create attribute index on the join field

12.2.9 Diagrams Menu

The Diagrams menu allows you to add a graphic overlay to a vector layer (see figure_diagrams_1).
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Figura 12.29: Join an attribute table to an existing vector layer

The current core implementation of diagrams provides support for pie charts, text diagrams and histograms.

The menu is divided into four tabs: Appearance, Size, Postion and Options.

In the cases of the text diagram and pie chart, text values of different data columns are displayed one below the
other with a circle or a box and dividers. In the Size tab, diagram size is based on a fixed size or on linear scaling
according to a classification attribute. The placement of the diagrams, which is done in the Position tab, interacts
with the new labeling, so position conflicts between diagrams and labels are detected and solved. In addition,
chart positions can be fixed manually.

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Amostra de
Dados).

1. First, click on the Load Vector icon, browse to the QGIS sample dataset folder, and load the two vector
shape layers alaska.shp and climate.shp.

2. Dê um clique duplo na camada clima na legenda do mapa para abrir a aba de diálogo ‘Propriedades da
camada ‘.

3. Click on the Diagrams menu, activate Display diagrams, and from the Diagram type combo box,
select ‘Text diagram’.

4. In the Appearance tab, we choose a light blue as background color, and in the Size tab, we set a fixed size
to 18 mm.

5. In the Position tab, placement could be set to ‘Around Point’.

6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

First select T_F_JAN as Attributes and click the button, then T_F_JUL, and finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can adapt the chart size in the Size tab. Deactivate the Fixed size and set the size of the diagrams on
the basis of an attribute with the [Find maximum value] button and the Size menu. If the diagrams appear
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Figura 12.30: Vector properties dialog with diagram menu

too small on the screen, you can activate the Increase size of small diagrams checkbox and define the
minimum size of the diagrams.

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_2 gives an idea of the result.

10. Finally, click [Ok].

Remember that in the Position tab, a Data defined position of the diagrams is possible. Here, you can use
attributes to define the position of the diagram. You can also set a scale-dependent visibility in the Appearance
tab.

The size and the attributes can also be an expression. Use the button to add an expression.

12.2.10 Metadata Menu

The Metadata menu consists of Description, Attribution, MetadataURL and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and
location, number of features, feature type, and editing capabilities. The Extents table provides you with layer
extent information and the Layer Spatial Reference System, which is information about the CRS of the layer. This
is a quick way to get information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalogue. If you want to use a title from
an XML metadata file, you have to fill in a link in the DataUrl field. Use Attribution to get attribute data from an
XML metadata catalogue. In MetadataUrl, you can define the general path to the XML metadata catalogue. This
information will be saved in the QGIS project file for subsequent sessions and will be used for QGIS server.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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Figura 12.31: Diagram from temperature data overlayed on a map

Figura 12.32: Metadata menu in vector layers properties dialog
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12.3 Editando

QGIS supports various capabilities for editing OGR, SpatiaLite, PostGIS, MSSQL Spatial and Oracle Spatial
vector layers and tables.

Nota: The procedure for editing GRASS layers is different - see section Digitalizando e editando uma camada
vetorial GRASS for details.

Dica: Edições Simultâneas
This version of QGIS does not track if somebody else is editing a feature at the same time as you are. The last
person to save their edits wins.

12.3.1 Configurando a Tolerância de Atracção e Raio de Pesquisa

Antes de podermos editar os vértices, necessitamos de configurar a tolerância e o raio de pesquisa para um valor
que nos permita uma edição ideal das geometrias da camada vectorial.

Tolerância de Atracção

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying to
connect to when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools that work with tolerance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options. On Mac, go
to QIS → Preferences.... On Linux: Edit → Options. In the Digitizing tab, you can select between
‘to vertex’, ‘to segment’ or ‘to vertex and segment’ as default snap mode. You can also define a default
snapping tolerance and a search radius for vertex edits. The tolerance can be set either in map units or in
pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t have to be changed after
zoom operations. In our small digitizing project (working with the Alaska dataset), we define the snapping
units in feet. Your results may vary, but something on the order of 300 ft at a scale of 1:10000 should be a
reasonable setting.

2. A layer-based snapping tolerance can be defined by choosing Settings → (or File →) Snapping options... to
enable and adjust snapping mode and tolerance on a layer basis (see figure_edit_1 ).

Note that this layer-based snapping overrides the global snapping option set in the Digitizing tab. So, if you need
to edit one layer and snap its vertices to another layer, then enable snapping only on the snap to layer, then
decrease the global snapping tolerance to a smaller value. Furthermore, snapping will never occur to a layer that
is not checked in the snapping options dialog, regardless of the global snapping tolerance. So be sure to mark the
checkbox for those layers that you need to snap to.

Raio de pesquisa

Search radius is the distance QGIS uses to search for the closest vertex you are trying to move when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing, and it will
pop up an annoying warning to that effect. Snap tolerance and search radius are set in map units or pixels, so you
may find you need to experiment to get them set right. If you specify too big of a tolerance, QGIS may snap to the
wrong vertex, especially if you are dealing with a large number of vertices in close proximity. Set search radius
too small, and it won’t find anything to move.

The search radius for vertex edits in layer units can be defined in the Digitizing tab under Settings → Options.
This is the same place where you define the general, project- wide snapping tolerance.
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Figura 12.33: Edição das opções de atracção numa camada base

12.3.2 Ampliando e Movendo

Antes de editar uma camada, deve fazer uma ampliação à zona da área de interesse. Isto evita que espere enquanto
os marcadores dos vértices são renderizados em toda a camada.

Além de usar os ícones mover mapa e aproximar / afastar na barra de ferramentas com o rato, a navegação
pode também ser feita com a roda do rato, espaço e as teclas de direcção.

Ampliando e movendo com a roda do rato

While digitizing, you can press the mouse wheel to pan inside of the main window, and you can roll the mouse
wheel to zoom in and out on the map. For zooming, place the mouse cursor inside the map area and roll it forward
(away from you) to zoom in and backwards (towards you) to zoom out. The mouse cursor position will be the
center of the zoomed area of interest. You can customize the behavior of the mouse wheel zoom using the Map
tools tab under the Settings → Options menu.

Movendo a direcção com as setas do teclado

Panning the map during digitizing is possible with the arrow keys. Place the mouse cursor inside the map area,
and click on the right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow
key to pan south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out without interrupting your digitizing session.

12.3.3 Edição Topológica

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, you can activate the column Avoid Int., which avoids intersection of new polygons.

Activar edição topológica

The option Enable topological editing is for editing and maintaining common boundaries in polygon mosaics.
QGIS ‘detects’ a shared boundary in a polygon mosaic, so you only have to move the vertex once, and QGIS will
take care of updating the other boundary.
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Evitar intersecções de novos polígonos

The second topological option in the Avoid Int. column, called Avoid intersections of new polygons, avoids
overlaps in polygon mosaics. It is for quicker digitizing of adjacent polygons. If you already have one polygon,
it is possible with this option to digitize the second one such that both intersect, and QGIS then cuts the second
polygon to the common boundary. The advantage is that you don’t have to digitize all vertices of the common
boundary.

Activar atracção nas intersecções

Another option is to use Enable snapping on intersection. It allows you to snap on an intersection of back-
ground layers, even if there’s no vertex on the intersection.

12.3.4 Digitalizar uma camada existente

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a
slip of the mouse. However, you can choose to edit any layer as long as the data provider supports it, and the
underlying data source is writable (i.e., its files are not read-only).

In general, tools for editing vector layers are divided into a digitizing and an advanced digitizing
toolbar, described in section Digitalização Avançada. You can select and unselect both under Set-
tings → Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Ícone Finalidade Ícone Finalidade

Edições actuais Alternar edição

Adicionando Elementos: Capturar Ponto Adicionando Elementos: Capturar Linha

Adicionando Elementos: Capturar Polígono Mover Elemento

Ferramenta de Nós Apagar Seleccionados

Cortar Elementos Copiar Elementos

Colar Elementos Guardar edições da camada

Edição da Tabela: Edição básica da camada vectorial pela barra de ferramentas

All editing sessions start by choosing the Toggle editing option. This can be found in the context menu after right
clicking on the legend entry for a given layer.

Alternatively, you can use the Toggle Editing Toggle editing button from the digitizing toolbar to start or stop the
editing mode. Once the layer is in edit mode, markers will appear at the vertices, and additional tool buttons on
the editing toolbar will become available.

Dica: Guardar Regularmente

Lembre-se de Guardar Edições da Camada regularmente. Isto irá também verificar que a sua fonte de dados aceita
todas as alterações.

Adicionando Elementos

Pode usar os ícones Adicionar Elemento, Adicionar Elemento ou Adicionar Elemento da barra de ferramentas para por
o cursor QGIS no modo de digitalização.

Para cada elemento, primeiro digitaliza a geometria, e de seguida introduz os atributos. Para digitalizar a geome-
tria, clique com o botão direito do rato na área do mapa para criar o primeiro ponto do seu novo elemento.
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Para linhas e polígonos, mantenha o clique com o botão direito do rato para cada ponto adicional que pretende
capturar. Quando acabar de adicionar os pontos, clique com o direito do rato em qualquer sítio da área do mapa
para confirmar a finalização da introdução da geometria desse elemento.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_2 shows
setting attributes for a fictitious new river in Alaska. In the Digitizing menu under the Settings → Options menu,

you can also activate Suppress attributes pop-up windows after each created feature and Reuse last entered
attribute values.

Figura 12.34: Introduza os Valores dos atributos na Janela após a digitalização do novo elemento vectorial

With the Move Feature(s) icon on the toolbar, you can move existing features.

Dica: Tipos de Valores de Atributo
For editing, the attribute types are validated during entry. Because of this, it is not possible to enter a number into
a text column in the dialog Enter Attribute Values or vice versa. If you need to do so, you should edit the attributes
in a second step within the Attribute table dialog.

Edições Actuais

This new feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all

changes you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that

the digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers,
Cancel for Selected Layer(s) is an easy way.

The same functions are available for editing all layers of the project.

Ferramenta de Nós

For shapefile-based layers as well as SpatialLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle Spatial tables,

the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It is possible to
simply select multiple vertices at once and to move, add or delete them altogether. The node tool also works with
‘on the fly’ projection turned on, and it supports the topological editing feature. This tool is, unlike other tools in
QGIS, persistent, so when some operation is done, selection stays active for this feature and tool. If the node tool
is unable to find any features, a warning will be displayed.

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero (i.e., 10). Otherwise, QGIS will not be able to tell which vertex is being edited.

Dica: Marcadores de Vértice
The current version of QGIS supports three kinds of vertex markers: ‘Semi-transparent circle’, ‘Cross’ and ‘None’.
To change the marker style, choose Options from the Settings menu, click on the Digitizing tab and select the
appropriate entry.
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Operações Básicas

Comece por activar a Ferramenta de Nós e seleccione um elemento clicando em cima de um, As caixas vermelhos
irão aparecer em cada vértice deste elemento.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl or Shiftwhen clicking to toggle the selection state of vertices
(vertices that are currently unselected will be selected as usual, but also vertices that are already selected
will become unselected).

• Adding vertices: To add a vertex, simply double click near an edge and a new vertex will appear on the
edge near to the cursor. Note that the vertex will appear on the edge, not at the cursor position; therefore, it
should be moved if necessary.

• Eliminar vértices: Depois de selecionar os vértices para eliminar, clique na tecla Delete. Note-se que não

pode usar a Node Tool para eliminar um elemento completo; QGIS vais assegurar que mantém o número
mínimo de vértices necessários para o tipo de elemento que está a trabalhar. Para eliminar um elemente

completo, utilize a ferramenta Delete Selected.

• Mover vértices: Selecione todos os vértices que pretende mover. Clique num vértice selecionado ou na
extreminade e arraste na direção que pretende mover. Todos os vértices selecionados serão movidos em
conjunto. Se a ferramenta snapping está ativa, toda a seleção pode saltar para o vértice ou linha mais
próximos.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Cortando, Copiando e Colando Elementos

Feições selecionadas podem ser recortadas, copiadas e coladas entre camadas do mesmo projeto do QGIS contanto

que a camada de destino estejam selecionadas como :sup: Alternar edição previamente.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format.

However, in this version of QGIS, text features from outside QGIS cannot be pasted to a layer within QGIS. When
would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer at a
time and copy/paste features between layers. Why would we want to do this? Say we need to do some work on a
new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer and
use copy/paste to plop the needed lakes into it.

As an example, we will copy some lakes to a new layer:

1. Carregue a camada que quer copiar a partir (camada de origem)

2. Carregue ou crie a camada que quer copiar para (camada de destino)

3. Começar a editar a camada de destino

4. Active a camada de origem clicando nela na legenda

5. Use a ferramenta Seleccione Elemento Único para seleccionar os elemento(s) na camada fonte

6. Clique na ferramenta Copiar Elementos

7. Active a camada de destino clicando na legenda
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8. Clique na ferramenta Colar Elementos

9. Parar a edição e guardar as alterações

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - the feature
and its attributes - gets copied, make sure the schemas match.

Dica: Congruência dos Elementos Colados
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However, if the destination layer is a different projection, then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.

Apagando os Elementos Seleccionados

Se quisermos apagar o polígono todo, podemos faze-lo seleccionando o polígono usando a ferramenta
Seleccionar Elemento Único. Pode seleccionar múltiplos elementos para apagar. Uma vez feita a selecção do conjunto,

use a ferramenta Apagar Seleccionados para apagar os elementos.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So, we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

Guardando as Camadas Editadas

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g., disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

Dica: Integridade dos dados
É sempre boa ideia fazer cópias de segurança da sua fonte de dados antes de começar a editar. Enquanto os autores
do QGIS fizeram todo o esforço para preservar a integridade dos seus dados, nós não oferecemos garantia neste
sentido.
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12.3.5 Digitalização Avançada

Ícone Finalidade Ícone Finalidade

Retroceder Retomar

Rodar Elemento(s) Simplificar elemento

Adicionar Anél Adicionar Parte

Fill Ring Apagar Anél

Apagar Parte Refazer elementos

Curva de Afastamento Dividir Elementos

Split Parts Juntar Elementos Seleccionados

Juntar Atributos dos Elementos Seleccionados Rodar Símbolos de Pontos

Tabela de edição avançada: Barra de ferramentas de edição avançada de camadas vectoriais

Retroceder e Retomar

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_3). This widget is not displayed by
default; it can be displayed by right clicking on the toolbar and activating the Undo/Redo checkbox. Undo/Redo
is however active, even if the widget is not displayed.

Figura 12.35: Refazer e desfazer passos de digitalização

When Undo is hit, the state of all features and attributes are reverted to the state before the reverted operation
happened. Changes other than normal vector editing operations (for example, changes done by a plugin), may or
may not be reverted, depending on how the changes were performed.

To use the undo/redo history widget, simply click to select an operation in the history list. All features will be
reverted to the state they were in after the selected operation.

Rodar Elemento(s)

Use Rotate Feature(s) to rotate one or multiple selected features in the map canvas. You first need to select the

features and then press the Rotate Feature(s) icon. The centroid of the feature(s) appears and will be the rotation
anchor point. If you selected multiple features, the rotation anchor point will be the common center of the features.
Press and drag the left mouse button in the desired direction to rotate the selected features.

It’s also possible to create a user-defined rotation anchor point around which the selected feature will rotate. Select

the features to rotate and activate the Rotate Feature(s) tool. Press and hold the Ctrl button and move the mouse
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pointer (without pressing the mouse button) to the place where you want the rotation anchor to be moved. Release
the Ctrl button when the desired rotation anchor point is reached. Now, press and drag the left mouse button in
the desired direction to rotate the selected feature(s).

Simplificar elemento

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
doesn’t change. First, select a feature. It will be highlighted by a red rubber band and a slider will appear. Moving
the slider, the red rubber band will change its shape to show how the feature is being simplified. Click [OK] to
store the new, simplified geometry. If a feature cannot be simplified (e.g. multi-polygons), a message will appear.

Adicionar Anél

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.

Adicionar Parte

You can add part polygons to a selected multipolygon. The new part polygon must be digitized outside the
selected multi-polygon.

Fill Ring

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Thus you need not first use the Add Ring icon and then the Add feature function anymore.

Apagar Anél

The Delete Ring tool allows you to delete ring polygons inside an existing area. This tool only works with
polygon layers. It doesn’t change anything when it is used on the outer ring of the polygon. This tool can be used
on polygon and multi-polygon features. Before you select the vertices of a ring, adjust the vertex edit tolerance.

Apagar Parte

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). It won’t delete the last part of the feature; this last part will stay untouched. This tool works with all
multi-part geometries: point, line and polygon. Before you select the vertices of a part, adjust the vertex edit
tolerance.

Refazer elementos

You can reshape line and polygon features using the Reshape Features icon on the toolbar. It replaces the line or
polygon part from the first to the last intersection with the original line. With polygons, this can sometimes lead
to unintended results. It is mainly useful to replace smaller parts of a polygon, not for major overhauls, and the
reshape line is not allowed to cross several polygon rings, as this would generate an invalid polygon.
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Por exemplo, pode editar o limite de um polígono com esta ferramenta. Primeiro, clique na área interna do polígos
junto do ponto onde pretende adicionar o novo vértice. Depois, atravesse o limite e adicione os vértices no exterior
do polígono. Para finalizar, clique com o botão direito na área interna do polígono. A ferramente vai adicionar
um nó automaticamente no ponto onde a linha atravessa o limite. Também é possível remover parte da área do
polígono, começa-se a nova linha no exterior do polígono, adicionam-se vértices no interior e termina-se a linha
no exterior do polígono com um clique no botão direito.

Nota: The reshape tool may alter the starting position of a polygon ring or a closed line. So, the point that is
represented ‘twice’ will not be the same any more. This may not be a problem for most applications, but it is
something to consider.

Curvas de Afastamento

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the the edited layer). It is thus ideally suited for the creation of distance line layers. The displacement is
shown at the bottom left of the taskbar. To create a shift of a line layer, you must first go into editing mode and

then select the feature. You can make the Offset Curve tool active and drag the cross to the desired distance. Your

changes may then be saved with the Save Layer Edits tool.

Dividir Elementos

Pode dividir elementos usando o ícone Dividir Elementos da barra de ferramentas. Apenas desenhe uma linha ao
longo do elemento que quer dividir.

Split parts

In QGIS 2.0 it is now possible to split the parts of a multi part feature so that the number of parts is increased. Just

draw a line across the part you want to split using the Split Parts icon.

Juntar elementos seleccionados

The Merge Selected Features tool allows you to merge features that have common boundaries and the same attributes.

Juntar os atributos dos elementos seleccionados

The Merge Attributes of Selected Features tool allows you to merge attributes of features with common boundaries

and attributes without merging their boundaries. First, select several features at once. Then press the
Merge Attributes of Selected Features button. Now QGIS asks you which attributes are to be applied to all selected objects.
As a result, all selected objects have the same attribute entries.

Rodar Símbolos de Pontos

Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. You must first define
a rotation column from the attribute table of the point layer in the Advanced menu of the Style menu of the Layer

Properties. Also, you will need to go into the ‘SVG marker’ and choose Data defined properties .... Activate
Angle and choose ‘rotation’ as field. Without these settings, the tool is inactive.
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Figura 12.36: Rodar Símbolos de Pontos

To change the rotation, select a point feature in the map canvas and rotate it, holding the left mouse button pressed.
A red arrow with the rotation value will be visualized (see Figure_edit_4). When you release the left mouse button
again, the value will be updated in the attribute table.

Nota: Se segurar a tecla Ctrl premido, a rotação irá ser feita em passos de 15 graus.

12.3.6 Criando novas camadas Vectoriais

QGIS allows you to create new shapefile layers, new SpatiaLite layers, and new GPX layers. Creation of a new
GRASS layer is supported within the GRASS plugin. Please refer to section Criando uma nova camada vetorial
GRASS for more information on creating GRASS vector layers.

Criando uma nova camada Shapefile

To create a new shape layer for editing, choose New → New Shapefile Layer... from the Layer menu. The
New Vector Layer dialog will be displayed as shown in Figure_edit_5. Choose the type of layer (point, line or
polygon) and the CRS (coordinate reference system).

Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

To complete the creation of the new shapefile layer, add the desired attributes by clicking on the [Add to attributes
list] button and specifying a name and type for the attribute. A first ‘id’ column is added as default but can be

removed, if not wanted. Only Type: real , Type: integer , Type: string and Type:date
attributes are supported. Additionally and according to the attribute type, you can also define the width and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the shapefile. QGIS will automatically add a .shp extension to the name you specify. Once the layer has been
created, it will be added to the map, and you can edit it in the same way as described in section Digitalizar uma
camada existente above.

Criando uma nova camada SpatialLite

Para criar uma nova camada SpatialLite para edição, escolha Novo → Nova Camada SpatiaLite... do menu
Camada. O diálogo Nova Camada SpatiaLite irá aparecer como é mostrado na Figure_edit_6.

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.
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Figura 12.37: Janela de criação de uma nova camada Shapefile

Figura 12.38: Janela de criação de uma nova camada SpatialLite
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To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Digitalizar uma camada existente above.

Further management of SpatiaLite layers can be done with the DB Manager. See Módulo Gestor BD.

Criando uma nova camada GPX

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, you can choose where to save the new GPX layer.

12.3.7 Trabalhando com a Tabela de Atributos

The attribute table displays features of a selected layer. Each row in the table represents one map feature, and
each column contains a particular piece of information about the feature. Features in the table can be searched,
selected, moved or even edited.

To open the attribute table for a vector layer, make the layer active by clicking on it in the map legend area. Then,

from the main Layer menu, choose Open Attribute Table. It is also possible to right click on the layer and

choose Open Attribute Table from the drop-down menu, and to click on the Open Attribute Table button
in the Attributes toolbar.

This will open a new window that displays the feature attributes for the layer (figure_attributes_1). The number
of features and the number of selected features are shown in the attribute table title.

Figura 12.39: Tabela de Atributos para a camada regiões

Seleccionando elementos na tabela de atributos

Cada linha selecionada na tabela de atributos representa os atributos de um determinado elemento da camada.
Se o conjunto de elementos selecionados na janela principal é alterado, a seleção também é atualizada na tabela de
atributos. Da mesma forma, se um conjunto de linhas selecionadas na tabela de atributos é modificada, o conjunto
de elementos selecionado na janela principal será atualizado.
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As linhas podem ser selecionadas ao clicar no número da linha, do lado esquerdo desta. Podem ser marcadas
Linhas múltiplas manter a tecla Ctrl primida. Pode ser feita uma seleção contínua se manter primida a tecla
Shift e clicar na entrada de várias linha, do lado esquerdo. Todas as linhas entre a posição atual do cursor e
a linha clicada serão selecionados. Ao mover a posição do cursor na tabela de atributos, ao clicar um célula na
tabela, não tem influência na seleção de linhas. Modificar a seleção na tela principal não altera a posição do cursor
na tabela de atributos.

A tabela pode ser ordenada por qualquer coluna, clicando no cabeçalho da coluna. Uma pequena seta indica
a forma de ordenação (apontar para baixo significa valores descendentes do topo da linha, apontar para cima
significa valores descendentes do topo da linha).

For a simple search by attributes on only one column, choose the Column filter → from the menu in the bottom
left corner. Select the field (column) on which the search should be performed from the drop-down menu, and hit
the [Apply] button. Then, only the matching features are shown in the attribute table.

To make a selection, you have to use the Select features using an Expression icon on top of the attribute table.
Select features using an Expression allows you to define a subset of a table using a Function List like in the Field Calculator

(see Calculadora de Campos). The query result can then be saved as a new vector layer. For example, if you want
to find regions that are boroughs from regions.shp of the QGIS sample data, you have to open the Fields and
Values menu and choose the field that you want to query. Double-click the field ‘TYPE_2’ and also [Load all
unique values] . From the list, choose and double-click ‘Borough’. In the Expression field, the following query
appears:

"TYPE_2" = ’Borough’

Here you can also use the Function list → Recent (Selection) to make a selection that you used before. The
expression builder remembers the last 20 used expressions.

The matching rows will be selected, and the total number of matching rows will appear in the title bar of the
attribute table, as well as in the status bar of the main window. For searches that display only selected features on
the map, use the Query Builder described in section Ferramenta de Consulta.

To show selected records only, use Show Selected Features from the menu at the bottom left.

The other buttons at the top of the attribute table window provide the following functionality:

• Toggle editing mode to edit single values and to enable functionalities described below (also with Ctrl+E)

• Save Edits (also with Ctrl+S)

• Unselect all (also with Ctrl+U)

• Move selected to top (also with Ctrl+T)

• Invert selection (also with Ctrl+R)

• Copy selected rows to clipboard (also with Ctrl+C)

• Zoom map to the selected rows (also with Ctrl+J)

• Pan map to the selected rows (also with Ctrl+P)

• Delete selected features (also with Ctrl+D)

• New Column for PostGIS layers and for OGR layers with GDAL version >= 1.6 (also with Ctrl+W)

• Delete Column for PostGIS layers and for OGR layers with GDAL version >= 1.9 (also with Ctrl+L)

• Open field calculator (also with Ctrl+I)
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Dica: Ignorar geometria WKT

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard button.
You can copy the information without vector geometries if you deactivate Settings → Options → Data sources

menu Copy geometry in WKT representation from attribute table.

Guardar elementos seleccionados como nova camada

The selected features can be saved as any OGR-supported vector format and also transformed into another coor-
dinate reference system (CRS). Just open the right mouse menu of the layer and click on Save selection as → to
define the name of the output file, its format and CRS (see section Legenda do Mapa). It is also possible to specify
OGR creation options within the dialog.

Paste into new layer

Features that are on the clipboard may be pasted into a new layer. To do this, first make a layer editable. Select
some features, copy them to the clipboard, and then paste them into a new layer using Edit → Paste Features as
and choosing New vector layer or New memory layer.

This applies to features selected and copied within QGIS and also to features from another source defined using
well-known text (WKT).

Trabalhando com tabelas de atributos não espaciais

QGIS allows you also to load non-spatial tables. This currently includes tables supported by OGR and delimited
text, as well as the PostgreSQL, MSSQL and Oracle provider. The tables can be used for field lookups or just
generally browsed and edited using the table view. When you load the table, you will see it in the legend field. It

can be opened with the Open Attribute Table tool and is then editable like any other layer attribute table.

As an example, you can use columns of the non-spatial table to define attribute values, or a range of values that are
allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit widget in section
Fields Menu to find out more.

12.3.8 Creating one to many relations

Relations are a technique often used in databases. The concept is, that features (rows) of different layers (tables)
can belong to each other.

As an example you have a layer with all regions of alaska (polygon) which provides some attributes about its name
and region type and a unique id (which acts as primary key).

Foreign keys

Then you get another point layer or table with information about airports that are located in the regions and you
also want to keep track of these. If you want to add them to the region layer, you need to create a one to many
relation using foreign keys, because there are several airports in most regions.

In addition to the already existing attributes in the airports attribute table another field fk_region which acts as a
foreign key (if you have a database, you will probably want to define a constraint on it).

This field fk_region will always contain an id of a region. It can be seen like a pointer to the region it belongs
to. And you can design a custom edit form for the editing and QGIS takes care about the setup. It works with
different providers (so you can also use it with shape and csv files) and all you have to do is to tell QGIS the
relations between your tables.
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Figura 12.40: Alaska region with airports

Layers

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So can add your table as a vector layer. To demostrate you can load the ‘region’ shapefile (with geometries) and
the ‘airport’ csv table (without geometries) and a foreign key (fk_region) to the layer region. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Definition (Relation Manager)

The first thing we are going to do is to let QGIS know about the relations between the layer. This is done in
Settings → Project Properties. Open the Relations menu and click on Add.

• name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say “Airports” in this case.

• referencing layer is the one with the foreign key field on it. In our case this is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer is the one with the primary key, pointed to, so here it is the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms once this
is supported. If you leave it empty, one will be generated for you but you can assign one yourself to get one
that is easier to handle.

Forms

Now that QGIS knows about the relation, it will be used to improve the forms it generates. As we did not change
the default form method (autogenerated) it will just add a new widget in our form. So let’s select the layer region
in the legend and use the identify tool. Depending on your settings, the form might open directly or you will have
to choose to open it in the identification dialog under actions.

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly
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Figura 12.41: Relation Manager

Figura 12.42: Identification dialog regions with relation to airports
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• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.

• The button will delete the selected airport permanently.

• The symbol will open a new dialog where you can select any existing airport which will then be assigned
to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• The two buttons to the right switch between table view and form view where the later let’s you view all the
airports in their respective form.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.

Figura 12.43: Identification dialog airport with relation to regions

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

12.4 Ferramenta de Consulta

The Query Builder allows you to define a subset of a table using a SQL-like WHERE clause and to display the
result in the main window. The query result can then be saved as a new vector layer.

12.4.1 Consulta

Open the Query Builder by opening the Layer Properties and going to the General menu. Under Feature subset,
click on the [Query Builder] button to open the Query builder. For example, if you have a regions layer with a
TYPE_2 field, you could select only regions that are borough in the Provider specific filter expression box of the
Query Builder. Figure_attributes_2 shows an example of the Query Builder populated with the regions.shp
layer from the QGIS sample data. The Fields, Values and Operators sections help you to construct the SQL-like
query.
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Figura 12.44: Ferramenta de Consulta

The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to
the SQL WHERE clause field, double click its name in the Fields list. Generally, you can use the various fields,
values and operators to construct the query, or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
column in the Fields list and click the [Sample] button. To add a value to the SQL WHERE clause field, double
click its name in the Values list.

The Operators section contains all usable operators. To add an operator to the SQL WHERE clause field, click
the appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), and logical operators
(AND, OR, ...) are available.

The [Test] button shows a message box with the number of features satisfying the current query, which is useful
in the process of query construction. The [Clear] button clears the text in the SQL WHERE clause text field.
The [OK] button closes the window and selects the features satisfying the query. The [Cancel] button closes the
window without changing the current selection.

12.4.2 Salvar elementos selecionados como uma nova camada

The selected features can be saved as any OGR-supported vector format and also transformed into another coor-
dinate reference system (CRS). Just open the right mouse menu of the layer and click on Save selection as → to
define the name of the output file, its format and CRS (see section Legenda do Mapa). It is also possible to specify
OGR creation options within the dialog.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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12.5 Calculadora de Campos

O botão Calculadora de Campos na tabela de atributos permite realizar cálculos com base em valores de atributos
existentes ou funções, definidas, por exemplo, para calcular o comprimento ou a área da geometria dos elementos.
Os resultados podem ser escritos numa nova coluna de atributo ou pode ser usado para actualizar os valores de
uma coluna já existente.

Você tem que trazer a camada vetorial em modo de edição, antes de você pode clicar no ícone da calculadora
de campos para abrir a caixa de diálogo (ver figure_attributes_3). Na caixa de diálogo você tem primeiro que
escolher se quer apenas atualizar os elementos seleccionados, criar um novo campo de atributo onde os resultados
do cálculo serão adicionados ou actualizar um campo existente.

Figura 12.45: Calculadora de Campos

Se optar por adicionar um novo campo, você precisa digitar um nome de campo, o tipo de campo (inteiro, real ou
texto), a largura total do campo, e a precisão do campo (veja figure_attributes_3). Por exemplo, se você escolher
uma largura de campo de 10 e uma precisão de 3, significa que você tem 6 números antes do ponto, então o ponto
e mais 3 indicações para a precisão.

A Lista de Funções contém funções bem como campos e valores. Veja a ajuda para a função no Função de
Ajuda Seleccionada. Em Expressão irá ver as expressões de cálculo que você cria com a Lista de Funções. Os
operadores comumente mais utilizados. veja em Operadores.

Na Lista de Funções, clique no Campos e Valores para ver todos os atributos da tabela de atributos para ser
pesquisado. Para adicionar um atributo no campo Expressão da Calculadora de campos, faça duplo-clique no
nome na lista do Campos e Valores. Geralmente podemos usar vários campos, valores e funções para construir a
expressão do cálculo ou pode apenas introduzir dentro da caixa. Para exibir os valores do campo, clique no direito
do rato no campo apropriado. Pode escolher entre Carregar 10 valores de amostra e Carregar todos os valores
únicos . No lado direito abre a lista dos Valores do Campo com os valores únicos. Para adicionar um valor à
caixa de Expressão da Calculadora de Campos, faço duplo clique no nome na lista de Valores de Campo.

Os grupos Operadores, Matemática, Conversões, Cadeia de Texto, Geometria e Registo fornecem várias funções.
No Operadores pode encontrar operadores matemáticos. Encontre em Matemática funções matemáticas. O grupo
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Conversões contém funções que convertem um tipo de dados para outro. O grupo Cadeia de Texto fornece funções
para dados de cadeia de texto. No grupo Geometria encontra funções para objectos de geometria. Com o grupo
de funções Registo pode adicionar numeração ao seu conjunto de dados. Para adicionar uma função na caixa de
Expressão da Calculadora de campos, clique em > e de seguida faça duplo clique na função.

Um pequeno exemplo ilustra como a calculadora de campos funciona. Nós queremos calcular o comprimento em
km na camada railroads do conjunto de dados amostra do QGIS:

1. Carregue a Shapefile railroads.shp no QGIS e pressione Abrir Tabela de Atributos.

2. Clique no Alternar o modo de edição e abra a janela da Calculadora de Campos .

3. Selecciona a caixa de verificação Criar novo campo para guardar os cálculos no novo campo.

4. Adicione comprimento como campo de saída do nome, ‘‘real como o tipo de campo de saída e defina o
campo de comprimento de saída de 10 com Precisão 3.

5. agora faça duplo clique na função $length no grupo :guilabel:‘Geometria‘para adicionar à caixa de ex-
pressões da Calculadora de campos.

6. Complete a expressão introduzindo “/ 1000” na caixa de expressões da Calculadora de campos e clique
[OK].

7. Pode agora encontrar a nova coluna comprimento na tabela de atributos.

As funções disponíveis estão listadas em baixo.

A calculadora de campos Lista de Funções com os menus Ajuda da Função Seleccionada, Operadores e Ex-
pressões são também disponíveis através de uma renderização baseada em regras no menu Estilo das propriedades

da Camada e a expressão baseada na etiquetagem na aplicação core Etiquetagem.

Operadores

Este grupo contém operadores (ex.: +, -, *).

a + b a plus b
a - b a minus b
a * b a multiplied by b
a / b a divided by b
a % b a modulo b (for example, 7 % 2 = 1, or 2 fits into 7 three times with remainder 1)
a ^ b a power b (for example, 2^2=4 or 2^3=8)
a = b a and b are equal
a > b a is larger than b
a < b a is smaller than b
a <> b a and b are not equal
a != b a and b are not equal
a <= b a is less than or equal to b
a >= b a is larger than or equal to b
a ~ b a matches the regular expression b
+ a positive sign
- a negative value of a
|| joins two values together into a string ’Hello’ || ’ world’
LIKE returns 1 if the string matches the supplied pattern
ILIKE returns 1 if the string matches case-insensitive the supplied

pattern (ILIKE can be used instead of LIKE to make the match case-insensitive)
IS returns 1 if a is the same as b
OR returns 1 when condition a or b is true
AND returns 1 when condition a and b are true
NOT returns 1 if a is not the same as b
column name "column name" value of the field column name
’string’ a string value
NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
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a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed

Condicionantes

Este grupo contém funções para controlar verificações condicionais em expressões.

CASE evaluates multiple expressions and returns a result
CASE ELSE evaluates multiple expressions and returns a result
coalesce returns the first non-NULL value from the expression list
regexp_match returns true if any part of a string matches

the supplied regular expression

Funções Matemáticas

Este grupo contém funções matemáticas (ex.: raíz quadrada, sen e cos).

sqrt(a) square root of a
abs returns the absolute value of a number
sin(a) sine of a
cos(a) cosine of a
tan(a) tangent of a
asin(a) arcsin of a
acos(a) arccos of a
atan(a) arctan of a
atan2(y,x) arctan of y/x using the signs of the two arguments

to determine the quadrant of the result
exp exponential of a value
ln value of the natural logarithm of the passed expression
log10 value of the base 10 logarithm of the passed expression
log value of the logarithm of the passed value and base
round round to number of decimal places
rand random integer within the range specified by the minimum

and maximum argument (inclusive)
randf random float within the range specified by the minimum

and maximum argument (inclusive)
max largest value in a set of values
min smallest value in a set of values
clamp restricts an input value to a specified range
scale_linear transforms a given value from an input domain to an output

range using linear interpolation
scale_exp transforms a given value from an input domain to an output

range using an exponential curve
floor rounds a number downwards
ceil rounds a number upwards
$pi pi as value for calculations

Conversões

Este grupo contém funções para converter tipos de data para outros (ex.: cadeia de texto para inteiro, inteiro para
cadeia de texto).

toint converts a string to integer number
toreal converts a string to real number
tostring converts number to string
todatetime converts a string into Qt data time type
todate converts a string into Qt data type
totime converts a string into Qt time type
tointerval converts a string to an interval type (can be used to take days,

hours, months, etc. off a date)

Funções de Data e Tempo

Este grupo contém funções para manusear dados do tipo data e tempo.
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$now current date and time
age difference between two dates
year extract the year part from a date, or the number of years from an interval
month extract the month part from a date, or the number of months from an interval
week extract the week number from a date, or the number of weeks from an interval
day extract the day from a date, or the number of days from an interval
hour extract the hour from a datetime or time, or the number

of hours from an interval
minute extract the minute from a datetime or time, or the number

of minutes from an interval
second extract the second from a datetime or time, or the number

of minutes from an interval

Funções de Cadeia de Texto

Este grupo contém funções que operam com cadeias de texto (ex.: substituir, converter, ou tornar maiúsculas).

lower convert string a to lower case
upper convert string a to upper case
title converts all words of a string to title case (all words lower case

with leading capital letter)
trim removes all leading and trailing white space (spaces, tabs, etc.) from a string
length length of string a
replace returns a string with the supplied string replaced
regexp_replace(a,this,that) returns a string with the supplied regular expression replaced
regexp_substr returns the portion of a string which matches a supplied regular expression
substr(*a*,from,len) returns a part of a string
concat concatenates several strings to one
strpos returns the index of a regular expression in a string
left returns a substring that contains the n leftmost characters of the string
right returns a substring that contains the n rightmost characters of the string
rpad returns a string with supplied width padded using the fill character
lpad returns a string with supplied width padded using the fill character
format formats a string using supplied arguments
format_number returns a number formatted with the locale separator for thousands

(also truncates the number to the number of supplied places)
format_date formats a date type or string into a custom string format

Funções de Cor

Este grupo contém funções para manipular cores.

color_rgb returns a string representation of a color based on its red, green,
and blue components

color_rgba returns a string representation of a color based on its red, green,
blue, and alpha (transparency) components

ramp_color returns a string representing a color from a color ramp
color_hsl returns a string representation of a color based on its hue,

saturation, and lightness attributes
color_hsla returns a string representation of a color based on its hue, saturation,

lightness and alpha (transparency) attributes
color_hsv returns a string representation of a color based on its hue,

saturation, and value attributes
color_hsva returns a string representation of a color based on its hue, saturation,

value and alpha (transparency) attributes
color_cmyk returns a string representation of a color based on its cyan, magenta,

yellow and black components
color_cmyka returns a string representation of a color based on its cyan, magenta,

yellow, black and alpha (transparency) components

Funções de Geometria

Este grupo contém funções que operam na geometria de objectos (ex.:, comprimento e área).
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xat retrieves an x coordinate of the current feature
yat retrieves a y coordinate of the current feature
$area returns the area size of the current feature
$length returns the length size of the current feature
$perimeter returns the perimeter length of the current feature
$x returns the x coordinate of the current feature
$y returns the y coordinate of the current feature
$geometry returns the geometry of the current feature (can be used

for processing with other functions)
geomFromWKT returns a geometry created from a well-known text (WKT) representation
geomFromGML returns a geometry from a GML representation of geometry
bbox
disjoint returns 1 if the geometries do not share any space together
intersects returns 1 if the geometries spatially intersect

(share any portion of space) and 0 if they don’t
touches returns 1 if the geometries have at least one point in common,

but their interiors do not intersect
crosses returns 1 if the supplied geometries have some, but not all,

interior points in common
contains returns true if and only if no points of b lie in the exterior of a,

and at least one point of the interior of b lies in the interior of a
overlaps returns 1 if the geometries share space, are of the same dimension,

but are not completely contained by each other
within returns 1 if geometry a is completely inside geometry b
buffer returns a geometry that represents all points whose distance

from this geometry is less than or equal to distance
centroid returns the geometric center of a geometry
convexHull returns the convex hull of a geometry (this represents the

minimum convex geometry that encloses all geometries within the set)
difference returns a geometry that represents that part of geometry a that

does not intersect with geometry b
distance returns the minimum distance (based on spatial ref) between

two geometries in projected units
intersection returns a geometry that represents the shared portion

of geometry a and geometry b
symDifference returns a geometry that represents the portions of a and b

that do not intersect
combine returns the combination of geometry a and geometry b
union returns a geometry that represents the point set union of the geometries
geomToWKT returns the well-known text (WKT) representation of the

geometry without SRID metadata

Funções de Registo

Este grupo contém funções que operam em indentificadores de registo.

$rownum returns the number of the current row
$id returns the feature id of the current row
$scale returns the current scale of the map canvas

Campos e Valores

Contém a lista de campos da camada. Valores de amostra podem também ser acedida através do clique direito.

Seleccione o nome do campo da lista e clique com o botão direito para aceder ao menu de contexto com as opções
para carregar os valores amostra do campo seleccionado.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 13

Trabalhando com Dados Raster

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

13.1 Trabalhando com dados raster

This section describes how to visualize and set raster layer properties. QGIS uses the GDAL library to read and
write raster data formats, including ArcInfo Binary Grid, ArcInfo ASCII Grid, GeoTIFF, ERDAS IMAGINE, and
many more. GRASS raster support is supplied by a native QGIS data provider plugin. The raster data can also be
loaded in read mode from zip and gzip archives into QGIS.

As of the date of this document, more than 100 raster formats are supported by the GDAL library
(see GDAL-SOFTWARE-SUITE in Referências Bibliográficas e Web). A complete list is available at
http://www.gdal.org/formats_list.html.

Nota: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
commercial libraries, or the GDAL installation of your OS may not have been built to support the format you want
to use. Only those formats that have been well tested will appear in the list of file types when loading a raster into
QGIS. Other untested formats can be loaded by selecting the [GDAL] All files (*) filter.

Working with GRASS raster data is described in section Integração com SIG GRASS.

13.1.1 O que são dados raster?

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid is the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

13.1.2 Loading raster data in QGIS

Raster layers are loaded either by clicking on the Add Raster Layer icon or by selecting the Layer → Add
Raster Layer menu option. More than one layer can be loaded at the same time by holding down the Ctrl or
Shift key and clicking on multiple items in the Open a GDAL Supported Raster Data Source dialog.
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Once a raster layer is loaded in the map legend, you can click on the layer name with the right mouse button to
select and activate layer-specific features or to open a dialog to set raster properties for the layer.

Menus do Botão direito do mouse para camadas raster

• Zoom to Layer Extent

• Zoom to Best Scale (100%)

• Stretch Using Current Extend

• Show in Overview

• Remover

• Duplicate

• Set Layer CRS

• Set Project CRS from Layer

• Save as ...

• Properties

• Rename

• Copy Style

• Add New Group

• Expandir tudo

• Fechar tudo

• Update Drawing Order

|atualizardireitos|

13.2 Diálogo de propriedades do Raster

Para visualizar e definir as propriedades da camada de um layer, dê um duplo clique no nome da camada na
legenda do mapa, ou clique com botão direito no nome da camada e escolha:Propriedades a partir do menu de
contexto. Isto vai abrir o diálogo :guilabel:‘Propriedades da camada Raster ‘ (ver figura_raster_1).

Existem vários menus na janela de dialogo:

• Geral

• Estilo

• Transparência

• Pirâmides

• Histograma

• Metadados

13.2.1 Menu Geral

Informação da camada

O menu Geral apresenta informação básica do raster selecionado, incluindo o caminho da camada origem, o nome
que aparece na legenda (que pode ser modificado), e o número de colunas, linhas e valores nulos do raster.
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Figura 13.1: Diálogo de Propriedades das Camadas do Raster

Sistema de Referencia de Coordenadas

Aqui encontra-se a informação do Sistema de Referencia de Coordenadas (SRC), impressa como string PROJ.4.
Se esta definição no é a correta, pode-se modificar, clicando no botão [Especifique]

Visibilidade dependente da escala

Também nesta aba pode acertar a visibilidade dependente da escala. Será necessária clicar a caixa de checagem e
colocar uma escala apropriada, na qual seus dados serão visualizados na tela do mapa.

Na parte inferior, pode-se ver uma miniatura da camada, a simbologia da legenda e o mapa de cores.

13.2.2 Menu de Estilos

Representar a banda

QGIS permite quatro diferentes Tipos de Representação. A representação escolhida depende do tipo de dados.

1. Color multibanda - se o arquivo vem como multibanda, com várias bandas (por exemplo, usado para ima-
gens de satélite com várias bandas)

2. Mapa de Cores - se um arquivo de banda única vem com um mapa de cores indexado (por exemplo, usado
para mapas topográficos digitais)

3. Banda única cinza - (uma banda apenas) a imagem será representada como cinza; QGIS escolherá o método
de representação, se o arquivo não é multibandas, não tem um mapa de cores indexado ou não tem um mapa
de cores contínuos (por exemplo, usado para mapa de relevo sombreado)
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4. Banda única Falsa Cor - este método de representação é usado em arquivos com mapa de cores contínuos
ou com mapa de cores (por exemplo, para mapa de elevações)

Multibanda Colorida

Para representar em color multibanda, selecione três bandas da imagem que vai representar, cada banda representa
respectivamente, a componente vermelha, verde e azul, que serão usadas para criar a cor da imagem. Podem-se
escolher vários métodos para Melhora do contraste : ‘Sem melhora’, ‘Estique para MinMax’, ‘Estique e corte no
MinMax’ e ‘Corte no min max’.

Figura 13.2: Representação do Raster - Multibanda Colorida

Esta seleção lhe oferece uma ampla variedade de opções para modificar a aparência da sua camada raster. Primeira-
mente, deve-se ter a amplitude dos dados da sua imagem. Isto pode ser visto escolhendo Extensão e clicando
[Carregar]. QGIS pode Estimar (mais rápido) os valores Mín e Máx das bandas ou use o Real (mais
lento) Precisão.

Agora pode-se criar uma escala de cores com ajuda da seção Carregar valores mín/máx ‘ . Muitas imagens tem
valores muito baixos ou muito altos. Estes valores discrepantes, ou outliers, podem ser eliminados usando o
|radiobuttonon| :guilabel:‘Corte na Contagem acumulativa para definir a eliminação. A amplitude padrão está
fixada entre 2% a 98% dos valores dos dados e pode ser modificada manualmente. Com esta definição, o tipo cinza
da imagem pode desaparecer. Com a opção de escala Mín/máx, QGIS cria uma tabela de cores com todos os
dados incluídos na imagem original (por exemplo, QGIS cria uma tabela de cor com 256 valores, se temos uma
imagem com banda de 8 bits). Pode-se calcular também uma tabela de cores usando :guilabel:‘Média +/- x
desvio padrão ‘ . Assim, apenas valores dentro do desvio padrão o dentro de múltiplos desvios padrão serão
considerados na tabela de cores. Isto é útil quando se tem uma ou duas células com valores sumamente altos em
uma gride raster que tem um impacto negativo na representação da imagem raster

Todos os cálculos pode ser feitos também através da extensão Atual

Dica: Visualizando uma única banda do Raster Multibanda
Se deseja ver uma única banda de uma imagem multibanda (por exemplo apenas a Vermelha), pode-se colocar
as bandas Verde e Azul como “Não definidas”, mas isto não é a forma correta. Para mostrar apenas a banda
Vermelha, coloque o tipo da imagem como ‘Banda única Cinza’, depois selecione o Vermelho como a banda para
usar no Cinza.

Mapa de Cores

Esta é a opção padrão de representação para arquivos de uma banda que incluem uma tabela de cores, onde a
cada valor de pixel é atribuída uma determinada cor. Nesse caso, o mapa de cores é gerado automaticamente. SE
deseja cambiar as cores atribuídas a determinados valores, apenas de clique duplo no color e a janela de diálogo
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Selecione cor vai aparecer.Também em QGIS 2.2. agora é possível atribuir um rótulo aos valores das cores. Assim
o rótulo aparece na legenda da camada raster.

Figura 13.3: Representação do Raster - Mapa de cores

Melhora do contraste

Nota: Quando adicionamos camadas GRASS, a opção Melhorar o Contraste será automaticamente definida
como esticar ao mín máx, independentemente de estar definido outro valor na QGIS opções gerais.

Banda única cinza

Esse método permite representar uma camada de uma banda através de Gradiente de Cores: Preto para Branco’
ou ‘Branco para Preto’. Pode definir os valores Mín e Máx escolhendo primeiro a Extensão e depois clicando em
[Carregar]. QGIS pode Estimar (mais rápido) os valores Mín e Máx das bandas ou usar Real (mais lento)
Precisão.

Figura 13.4: Representação do Raster - Banda única cinza
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Pode-se criar uma escala de cores com ajuda da seção Carregar valores mín/máx. Os valores discrepantes podem
ser eliminados usando o Corte na Contagem acumulativa para definir a eliminação. A amplitude padrão está
fixada entre 2% a 98% dos valores dos dados e pode ser modificada manualmente. Com esta definição, os valores
cinza da imagem podem desaparecer. Outras definições podem ser determinadas com o Mín/máx e Média
+/- x desvio padrão . Enquanto a primeira opção cria uma tabela de cores com todos os dados incluídos na
imagem original, a segunda cria uma tabela de cores que considera apenas dentro do desvio padrão ou dentro de
vários desvios padrão. Isto é util quando se tem uma ou duas células com valores anormalmente altos numa gride
raster que provocam um impacto negativo na representação da imagem raster.

Bamda única Falsa cor

Este é um opção de representação para arquivos de uma banda, que incluem um mapa de cores contínuo. Pode-se
também aqui criar mapas de cores individuais para uma banda. Existem três tipos de interpolação de cores

Figura 13.5: Representação do Raster - Banda única Falsa Cor

1. Método Discreto

2. Método Linear

3. Método Exato

No bloco da esquerda, o botão Adicionar valores manualmente , adiciona um valor individual na tabela de cores. O

botão Apagar a linha selecionada , apaga um valor individual da tabela e o botão , Ordene os valores do mapa de cores,
ordena a tabela de acordo ao valor de pixel da coluna valor. Também é possível adicionar rótulos para cada cor,
mas esse valor não será mostrado quando se use o identificador feição ferramenta. Também pode clicar no botão

Carregar mapa de cor da banda, o qual tenta carregar uma tabela de cores a partir da banda (se tem alguma). Pode-se

usar também os botões Carregar mapa de cor de arquivo o Exportar mapa de color map para arquivo, para carregar uma tabela
de cor já existente o salvar uma tabela de cor para uso futuro.
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No bloco da direita, Generar novo mapa de cor, permite criar novos mapas de cor categorizados. Em Modo

Classificação ‘Intervalos iguais’, apenas necessita selecionar o Número de classes e clicar o botão

Classificar. Pode-se inverter as cores do mapa de cores clicando na caixa de seleção Invertir. Em caso de

Modo ‘Contínuo’, QGIS cria as classes automáticamente, dependo dos valores Mín and Máx. A definição
dos valores Mín/Máx, pode ser feita com ajuda da seção Carregar valores mín/máx. Muitas imagens tem uns
poucos valores com dados muito altos e baixos. Esses valores discrepantes ou outliers, podem ser eliminados
usando o botão :guilabel:‘‘Corte na Contagem acumulativa‘ para definir a eliminação. A amplitude padrão
está fixada entre 2% a 98% dos valores dos dados e pode ser modificada manualmente. Com esta definição, os
valores cinzas na imagem podem desaparecer. Com a opção de escala Mín/máx, QGIS cria uma tabela de cores
com todos os dados incluídos na imagem original (por exemplo, QGIS cria uma tabela de cores com 256 valores,
dado o fato de tersetemos uma imagem com banda de 8 bit). Pode-se calcular também uma tabela de cores usado
o botão Média +/- x desvio padrão . Assim, são considerados para a tabela de cores, apenas os valores
dentro do desvio padrão ou dentro de vários desvios padrão

Representação das cores

Em cada Representação da banda, é possível encontrar uma Representação da cor

Podem-se fazer efeitos especias de representação para seus arquivo(s) raster, usando um dos modos de combinação
(veja Janela de Propriedades de Vetor).

Definições adicionais podem ser estabelecidas modificanco em Brilho, Saturação e Contraste. Pode usar também
a opção Escala de cinzas, onde pode escolher entre ‘Por claridade’, ‘Por luminosidade’ e ‘Por média’. Por um
determinado matiz na tabela de cores, você pode modificar a ‘Força’.

Reamostragem

A opção Reamostragem, faz a representação da imagem quando se dá mais ou menos zoom nela. Os modos
de reamostragem podem melhorar a apariência do mapa. Eles calculam um novo valor de cinza através de uma
transformação geométrica.

Figura 13.6: Representação Raster - Reamostragem

Quando aplicamos o método ‘Vizinho mais próximo’, o mapa pode ter uma estrutura tipo pixelada, quando damos
mais zoom. Essa apariència pode ser melhorada usando os métodos ‘Bilinear’ ou ‘Cúbico’., o qual causa que as
feições mais afiadas, se suavizem.

13.2.3 Menu de transparência

QGIS mostra cada camada raster com um nível diferente de transparência. Use a barra deslizante de transparência

para indicar a que nível as camadas de baixo (se houver alguma) devem ser vísiveis através
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da camada em uso. Isto é muito útil se deseja sobrepor mais de uma camada (por exemplo um mapa de relevo
sombreado sobreposto a um mapa raster com classificação). Assim o mapa terá um aspecto mais tridimensional.

Além disso pode-se colocar um valor de pixel que será considerado como SEMDADOS no menu Valor adicional
sem dados

Uma maneira ainda mais flexível de modificar a banda de transparência poder ser feita no :guilabel: Modificações
das opções de transparência. Aqui podemos definir a transparência de cada pixel.

Como exemplo, desejamos colocar a água de nosso arquivo raster de exemplo :Arquivo:‘landcover.tif‘, com
transparência de 20%. Os seguintes passos são necessários:

1. Carregar o arquivo raster: Arquivo:landcover.tif.

2. Abra o diálogo Propriedades fazendo clique duplo no nome do raster na legenda, o clicando com botão e
selecionando:Propriedades do menu pop-up.

3. Selecione o menu Transparência

4. No menu Transparência da banda, escolher ‘Nenhum’.

5. Clique no botão Adicionar valores manualmente uma nova linha vai aparecer na lista de pixels.

6. Entre o valor raster na coluna ‘De’ e ‘Até’ (usamos 0 aqui), e ajuste a transparência a 20%.

7. Pressione o botão [Aplicar] e visualize no mapa as modificações feitas.

Podemos repetir os passos 5 e 6 para ajustar mais valores com a transparência desejada.

Como podemos ver, é fácil definir uma transparência desejada, mas requer um grande esforço. Aliás, pode-se usar

o botão Exportar para arquivo para salvar sua lista de transparências para um arquivo. O botão Importar do arquivo

carrega sua definição de transparências e a aplica a camada do raster em uso.

13.2.4 Menu de Piramides

Grandes camadas raster com grande resolução, podem tornar a navegação lenta em QGIS. Criando cópias em baixa
resolução dos dados (pirâmides), o desempenho pode ser melhorado consideravelmente, já que QGIS, seleciona a
resolução mais apropriada dependendo do nível do zoom.

Você deve pode ter direito de gravação no diretório onde os dados originais são armazenados para construir
pirâmides.

Vários métodos de reamostragem podem ser usados para calcular as piramides.

• Vizinho mais próximo

• Média

• Gauss

• Cúbico

• Modo

• Nenhum

Se seleciona ‘Interno (se possível)’ do menu Formato Overview , QGIS tenta calcular as pirâmides internamente.
Pode-se selecionar também ‘Externo’ e ‘Erdas Externo (Formato Erdas Imagine).

Note que o cálculo de pirâmides pode modificar o arquivo original de dados, e uma vez criado, não pode ser
apagado. Se deseja preservar uma versão ‘sem pirâmides’ de seu raster, faça uma copia de segurança antes do
cálculo das pirâmides.
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Figura 13.7: The Pyramids Menu

13.2.5 Menu Histograma

O menu The Histograma permite ver a distribuição das bandas ou cores no rastser. O histograma é gerado auto-
maticamente quando se abre o menu Histograma. Todas as bandas presentes som apresentadas juntas. Pode-se
salvar o histograma como imagem com o botão |mAçãoSalvarArquivo|. Com a opção With the Visibilidade do

menu Prefs/Ações, podem se mostrar histogramas individuais de bandas. Para isto, selecione a opção
Mostrar banda selecionada. O Opções Mín/máx permite ‘Sempre mostrar marcadores mín/máx ‘, a ‘Zoom para
mín/máx’ e ‘Atualizar estilo para mín/máx’. Depois de escolher Opções Mín/máx usando a opção Ações pode-se
‘Redefinir’ e ‘Recalcular o histograma’ .

Figura 13.8: Histograma do raster
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13.2.6 Menu Metadados

O menu Metadados, mostra o estado da informação da camada do raster, incluindo estatísticas de cada banda
na camada do raster em uso. A partir deste menu, podem ser definidas entradas na guia Descrição, Atribuição,
MetadadosUrl e Propriedades. Na guia:guilabel:Propriedades, são geradas estatísticas na base de ‘é preciso
saber’ ou seja é possível que uma determinada e específica estatística da camada, no tenha sido ainda coletada.

Figura 13.9: Metadados do raster

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

13.3 Calculadora Matricial

The Raster Calculator in the Raster menu allows you to perform calculations on the basis of existing raster pixel
values (see figure_raster_2_). The results are written to a new raster layer with a GDAL-supported format.

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

In the Result layer section, you will need to define an output layer. You can then define the extent of the calculation
area based on an input raster layer, or based on X,Y coordinates and on columns and rows, to set the resolution of
the output layer. If the input layer has a different resolution, the values will be resampled with the nearest neighbor
algorithm.

The Operators section contains all available operators. To add an operator to the raster calculator expression box,
click the appropriate button. Mathematical calculations (+, -, *, ... ) and trigonometric functions (sin, cos,
tan, ... ) are available. Stay tuned for more operators to come!

With the Add result to project checkbox, the result layer will automatically be added to the legend area and
can be visualized.

13.3.1 Exemplos

Convert elevation values from meters to feet

Creating an elevation raster in feet from a raster in meters, you need to use the conversion factor for meters to feet:
3.28. The expression is:
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Figura 13.10: Calculador Matricial

"elevation@1" * 3.28

Usando uma máscara

If you want to mask out parts of a raster – say, for instance, because you are only interested in elevations above 0
meters – you can use the following expression to create a mask and apply the result to a raster in one step.

("elevation@1" >= 0) * "elevation@1"

In other words, for every cell greater than or equal to 0, set its value to 1. Otherwise set it to 0. This creates the
mask on the fly.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 14

Trabalhando com dados OGC

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

14.1 QGIS como Cliente de Dados OGC

O Consórcio Geoespacial Aberto (OGC), é uma organização internacional como mais de 300 organizações em
todo mundo do tipo comerciais, sem fins lucrativos e de investigação. Os membros desenvolvem e implementam
padroões para os conteúdos e serviços geoespaciais, processamento e troca de dados SIG.

Descrevendo um modelo básico de dados para elementos geográficos e um número crescente de específicações
estão desenvolvidos para servir necessidades específicas para localização interoperável e tecnologia geoespacial,
incluindo o SIG. Mais informação é encontrada em http://www.opengeospatial.org/.

As espcificações OGC importantes suportadas pelo QGIS são:

• WMS — Serviço de Mapas Web (Cliente WMS/WMTS)

• WMTS — Serviço de Mosaicos de Mapa Web (Cliente WMS/WMTS)

• WFS — Serviços de Elementos Web (WFS e WFS-T Cliente)

• WFS-T — Serviços de Elementos Web - Transacionais (WFS e WFS-T Cliente)

• WCS — Serviços de Cobertura Web (WCS Cliente)

• SFS — Elementos Simples para SQL (Camadas PostGIS)

• GML — Linguagem de Marcadores Geográfico

Os serviços OGC estão a ser crescentemente usados para troca de dados geoespaciais de diferentes implemen-
tações SIG e armazenamento de dados. O QGIS consegue lidar com as especificações em baixo como cliente,
sendo SFS (através do suporte do fornecedor PostgreSQL/ PostGIS, veja Secção Camadas PostGIS).

14.1.1 Cliente WMS/WMTS

Visão Global do Suporte WMS

O QGIS actualmente pode funcionar como cliente WMS que entende servidores WMS 1.1, 1.1.1 e 1.3. Foi
particularmente testado contra serviços públicos de acesso como os DEMIS.

Os servidores WMS funcionam através de pedidos pelo cliente (ex.: QGIS) para mapas matriciais com uma dada
extensão, conjunto de camadas, estilos de simbolização, e transparência. O servidor WMS de seguida consulta
as suas fontes de dados locais, matricializa num mapa e manda de volta ao cliente em formato matricial. Para o
QGIS isto tipicamente vem em JPEG ou PNG.

WMS é um serviço REST genérico (Estado de Transferência Representativo) mais que um Serviço Web comple-
tamente fundido.Como tal, pode realmente obter os URLs gerados pelo QGIS e usá-los num navegador da web
para recuperar as mesmas imagens que o QGIS usa internamente. Isto pode ser útil para resolver problemas, uma
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vez que existem várias marcas de servidores WMS no mercado e todos eles têm a sua própria interpretação da
norma WMS.

As camadas WMS podem ser adicionadas facilmente, desde que conheça o acesso URL para o servidor WMS,
tenha uma ligação de serviço a esse servidor, e o servidor compreenda HTTP como um mecanismos de transporte
de dados.

Visão Global do Suporte WMTS

O QGIS pode também agir como um cliente WMTS. O WMTS é um padrão OGC para a distribuição de conjuntos
de mosaicos de dados geoespaciais. Isto é uma forma mais rápida e mais eficiente para distribuir dados que o WMS
porque com o WMTS os conuntos de mosaicos são pré-gerados e o cliente apenas faz pedidos de transmissão dos
mosaicos e não os produz. Um pedido típico do WMS envolve a geração e transmissão de dados. Um exemplo
conhecido de um padrão não-OGC para a visualização de mosaicos de dados geoespaciais é o Google Maps.

De maneira a exibir os dados a várias escalas perto do que o utilizador queira ver, os conjuntos de mosaicos WMTS
são produzidos em vários diferentes níveis de escala e são disponibilizados para o cliente SIG a seu pedido.

Este diagrama ilustra o conceito dos conjuntos de mosaicos

Figura 14.1: Conceito dos conjuntos de mosaicos do WMTS

Os dois tipos de interfaces WMTS que o QGIS suporta são via Key-Value-Pairs (KVP) e RESTful. Estas duas
interfaces são diferentes e necessita especificá-los ao QGIS de forma diferente.

1) In order to access a WMTS KVP service, a QGIS user must open the WMS/WMTS interface and add the
following string to the URL of the WMTS tile service:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Um exemplo deste tipo de endereço é

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

A camada topo2 funciona lindamente para testar neste WMTS. Adicionando esta linha e texto indica que é um
serviço web WMTS que deverá ser usado em vez de o serviço WMS.

2. O serviço WMTS RESTful torna-se uma forma diferente, é um URL simples, a forma recomendada pela
OGC é:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

Este formato ajuda-o a reconhecer que isto é um endereço RESTful. O WMTS RESTful é acedido no QGIS
adicionando simplesmente o endereço na configuração do WMS no campo do URL da forma. Como exemplo para
um mapa base Austríaco deste tipo de endereço é http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.
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Nota: Pode encontrar alguns serviços antigos chamados de WMS-C. Esses serviços são muito
semelhantes ao WMTS com a mesma finalidade mas trabalham ligeiramente diferente). Pode geri-
los da mesma forma que faz nos serviços WMTS. Apenas adicione ?tiled=true no final do url. Veja
http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification para mais informações sobre esta especificação.

Quando lê o WMTS pode muitas vezes pensar em WMS-C.

Seleccionando os Servidores WMS/WMTS

Na primeira vez que usa o elemento WMS no QGIS, não existem servidores definidos.

Comece clicando no botão Adicionar camada WMS na barra de ferramentas, ou através do menu Camada → Adi-
cionar Camada WMS ....

A janela Adicionar Camada(s) do Servidor para adicionar camadas dos servidores WMS aparecem. Pode
adicionar alguns servidores para brincar clicando no botã0 [Adicionar servidores padrões] . Isto irá adicionar
dois servidores WMS demonstração para que possa usar, os servidores WMS do DM Solutions Group e
Lizardtech. Para definir uma novo servidor WMS no separador Camadas, seleccione o botão [Novo] . De
seguida introduza os parâmetros de ligação que deseja para o Servidor WMS, como está listado na table_OGC_1:

Nome Um nome para esta ligação. Este nome será usado para a lista de Ligações do Servidor para
que possa distingui-la de outros Servidores WMS.

URL URL do servidor que fornece os dados. Isto deverá ser um nome de alojamento válido – o
mesmo formato que irá usar para abrir a ligação telnet ou o ping a um alojamento.

Utilizador Nome de Utilizador para aceder a um Servidor WMS protegido. Este parâmetro é opcional.
Palavra-chave Palavra-chave para autenticação básica no Servidor WMS. Este parâmetro é opcional.

Ignorar
GetMap URI

Ignorar GetMap URI reportado nas capacidades. Use um URI dado em cima para o
campo URL.

Ignorar
GetFeatureInfo
URI

Ignorar GetMap URI reportado nas capacidades, use um URI dado em cima para o
campo URL.

Tabela 1 OGC : Parâmetros de Ligação do WMS

Se precisar de configurar um servidor proxy para receber serviços WMS da internet, pode adicionar o seu servidor
proxy nas opções. Escolha o menu Configurações → Opções e clique no separador Rede & Proxy. De seguida

pode adicionar as suas configurações de proxy e activá-las configurando o Use o proxy para acesso web.

Certifique-se que seleccionou o tipo proxy correcto da lista de menu Tipo de Proxy .

Uma vez a nova ligação do Servidor WMS for criada, será preservada para sessões futuras do QGIS.

Dica: Ligar URLs dos Servidores WMS
Certifique-se, que quando introduzir o URL do servidor WMS, seja o URL base. Por exemplo, não deve ter
fragmentos como request=GetCapabilities ou version=1.0.0 no seu URL.

Carregando as camadas WMS/WMTS

Uma vez preenchido os parâmetros com sucesso pode usar o botão [Ligar] para responder às capacidades do
servidor seleccionado. Isto inclui a codificação da imagem, Camadas, Estilos de Camadas, e Projecções. Uma vez
que isto é uma operação de rede, a velocidade de resposta depende da qualidade da ligação da sua rede ao servidor
WMS. Enquanto faz a transferência de dados do servidor WMS, o progresso da transferência é visualizada no
canto inferior esquerdo da janela do WMS.

O seu ecrã irá ficar parecido um pouco como figure_OGR_1, que mostra a resposta fornecida pelo servidor WMS
do DM Solutions Group.

Codificação da Imagem
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Figura 14.2: Janela para adicionar servidores WMS, mostra as camadas disponíveis
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A secção Codificação de Imagem agora apresenta uma lista de formatos suportados pelo cliente e servidor. Escolha
de acordo com as exigências de precisão da sua imagem.

Dica: Codificação da Imagem
Tipicamente irá encontrar servidores WMS que oferecem a escolha da codificação de imagem JPEG ou PNG.
O JPEG é um formato de perda de compressão, enquanto que o PNG reprodução fielmente os dados brutos do
matricial.

Use JPEG se espera dados WMS para fotografia na natureza e/ou não se importa da perda de alguma qualidade na
imagem. Este típico trade.off reduz em 5 vezes o requerimento de transferência comparado ao PNG.

Use o PNG se necessitar representações precisas dos dados originais, e não se importa dos requerimentos de
transferência de dados.

Opções

O campo Opções fornece um campo de texto onde pode adicionar Nome da Camada para a camada WMS. Este
nome irá ser apresentado na legenda após carregamento da camada.

Em baixo do nome da camada pode definir Tamanho do mosaico, se quiser configurar os tamanhos do mosaico
(ex.: 256x256) para dividir o pedido do WMS em pedidos múltiplos.

O Limite de elementos para GetFeatureInfo define quais os elementos do servidor para consulta.

Se seleccionou um WMS da lista, um capo com a projecção padrão, fornecida pelo mapserver, aparece. Se o
botão [Change...] está activo, pode clicar e mudar para a projecção padrão do WMS para outro SRC fornecido
pelo Servidor WMS.

Ordem das Camadas

O separador Ordem de Camada tem uma lista das camadas seleccionadas disponíveis do WMS actual ligado.
Poderá reparar que algumas camadas expansíveis, isto significa que a camada pode ser exibida na escolha dos
estilos de imagem.

Pode seleccionar várias camadas de uma só vez, mas apenas um estilo de imagem por camada. Quando várias
camadas são seleccionadas, elas serão combinadas no Servidor WMS e transmitido ao QGIS de uma só vez.

Dica: Ordenação das Camadas WMS
As camadas WMS renderizadas por um servidor são sobrepostas na ordem da lista da secção de Camadas, de cima
para baixo da lista. Se quiser alterar a ordem de sobreposição, pode usar o separador Ordem de camadas.

Transparência

Nesta versão do QGIS, a configuração Transparência Global da Propriedades da Camada está codificado para
estar sempre ligado, quando disponível.

Dica: Transparência da Camada WMS
Disponibilidade da transparência da imagem do WMS depende da codificação da imagem usada: PNG e GIF
suportam transparência enquanto que o JPEG deixa como não suportado.

Sistema de Coordenadas Referência

O Sistema de Coordenadas Referência (SRC) é a terminologia OGC para uma projecção QGIS.

Cada Camada WMS pode ser apresentada em múltiplos SRC, depedendo da capacidade do servidor WMS.

Para escolher o SRC seleccione [Alterar...] e a janela semelhante à da Figura Projecção 3 na Trabalhando com
Projeções aparecerá. A diferença principal com a versão do WMS do ecrã é que neste apenas os SRC suportados
apareceram no Servidor WMS.
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Pesquisa de servidor

Dentro do QGIS pode pesquisar por servidores WMS. Figure_OGC_2 mostra o separador Pesquisar Servidor com
a janela Adicionar Camada(s) do Servidor.

Figura 14.3: Janela de pesquisa de servidores WMS depois de algumas palavras-chave

Como pode ver é possível introduzir uma cadeia de texto de pesquisa no campo de texto e pressionar o botão
[Pesquisar]. Após pouco tempo o resultado da pesquisa será preenchido na lista debaixo do campo de texto.
Procure a lista de resultados dentro da tabela. Para visualizar os resultados, seleccione uma entrada da tabela,
prima o botão [Adicionar a linha seleccionada à lista WMS] e mude para o separador Camadas. O QGIS
automaticamente actualiza a sua lista de servidores e o resultado seleccionado da pesquisa está disponível na lista
de servidores WMS guardados no separador Camadas. Apenas precisará de pedir a lista de camadas clicando no
botão [Ligar]. Esta opção é especialmente útil quando quer pesquisar mapas por palavras-chave específicas.

Basicamente esta opção é um frontend para a API do http://geopole.org.

Mosaicos

Ao usar Serviços WMTS (WMS em cache) como

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

pode procurar através do separador Conjuntos de Mosaicos dados pelo servidor. Informação adicional como o
tamanho do mosaico, formatos e SRC suportados estão na lista desta tabela. Em combinação com esta caracterís-
tica pode usar a escala da quadrícula do Configurações → Painéis (KDE e Windows) ou Ver → Painéis (Gnome
e MacOSX) e de seguida escolha Escala da quadrícula, que dá escalas disponíveis do servidor de mosaicos com
uma barra de deslizamento acoplada.
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Usando a Ferramenta Identificar

Uma vez adicionado o servidor WMS, e se qualquer camada do servidor WMS é consultável, pode usar a ferra-

menta Identificar para seleccionar o píxel do enquadramento do mapa. A consulta é feita ao servidor WMS para
cada selecção feita. Os resultados da consulta vêm na forma de um texto plano. A formatação desse texto depende
do servidor WMS particular usado. Selecção do formato

Se múltiplos formatos são suportados pelo servidor, uma caixa de combinação com os formatos suportados é
automaticamente adicionado aos resultados da janela de identificação e o formato seleccionado irá armazenar no
projecto para a camada. Suporte do formato GML

A ferramenta Identificar suporta respostas do Servidor WMS (GetFeatureInfo) no formato GML (é chamado de
Elemento no GUI do|qg| neste contexto). Se o formato “Elemento” for suportado pelo servidor e seleccionado,
os resultados da ferramenta Identificar são elementos vectoriais como normais camadas vectoriais. Quando um
elemento é seleccionado na árvore, é destacada no mapa e pode ser copiada para a área de transferência e colada
noutra camada vectorial. Veja o exemplo da instalação em baixo do UMN Mapserver para suportar o formato
GML GetFeatureInfo.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Propriedades de Visualização

Uma vez ter adicionado o servidor WMS, pode ver as suas propriedades clicando com o direito do rato na legenda,
e seleccionando Propriedades. Separador de Metadados

O separador Metadados exibem a riqueza de informação sobre o servidor WMS, geralmente recolhidos a partir
da declaração de de Capacidades devolvidos a partir desse servidor. Muitas das definições podem ser removidas
através da leitura dos padrões WMS (veja OPEN-GEOSPATIAL-CONSORTIUM Referências Bibliográficas e
Web), mas aqui estão algumas definições uteis:

• Propriedades do Servidor

– Versão do WMS — Versão do WMS suportada pelo servidor.

– Formatos de Imagem — A lista de MIME-types que o servidor pode responder com o desenho do
mapa. O QGIS formata qualquer que seja as bibliotecas Qt subjacentes que foram construídas, que é
pelo menos tipicamente a image/png e image/jpeg.

– Formatos de Identidade — A lista dos MIME-types do servidor pode responder quando usa a ferra-
menta identificar. Actualmente o QGIS suporta o tipo text-plain.

• Propriedades da Camada
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– Seleccionado — Querendo ou não esta camada seleccionado quando o seu servidor foi adicionado a
este projecto.

– Visível — Seja ou não essa camada esta é seleccionada como visível na legenda. (Ainda não é usado
nesta versão do QGIS.)

– Pode Identificar — Camada que retorna ou não resultados através do uso da ferramenta Identificar.

– Pode ser Transparente — Quando uma camada pode ou não pode ser renderizada com transparência.
Esta versão do QGIS irá sempre usar a transparência se esta é Sim e a codificação da imagem suportar
transparência

– Permite Aproximar — Quando uma camada pode ou não pode ser ampliada neste servidor. Esta
versão do QGIS assume que todas as camadas WMS têm esta definida como Sim. Camadas deficientes
podem ser renderizadas de forma estranha.

– Contagem em cascata — Os servidores WMS pode funcionar como proxy para outros servidores
WMS para obter dados matriciais para uma camada. Esta entrada mostra quantas vezes o pedido para
esta camada é avançada por peer nos servidores WMS para o resultado.

– Largura Fixa, Altura Fixa — Quando uma camada pode ou não pode ter dimensões de pixeis da
fonte fixadas. Esta versão QGIS assume que todas as camadas WMS têm esta definição como nada.
Camadas deficientes podem ser renderizadas de forma estranha.

– Caixa de Enquadramento WGS 84 — A caixa de enquadramento desta camada, nas coordenadas
WGS 84. Alguns servidores WMS não configuram esta situação correctamente (ex.: usam as coor-
denadas UTM). Se for esse o caso, então a vista inicial desta camada pode ser renderizada com uma
aparência ‘afastada’ pelo QGIS. O webmaster do WMS deve informar deste erro, que pode ser con-
hecido como elementos WMS XML LatLonBoundingBox, EX_GeographicBoundingBox
ou CRS:84 BoundingBox.

– SRC disponíveis — As projecções desta camada podem ser renderizadas pelo servidor WMS. Os
mesmos estão listados num formato nativo WMS.

– Disponível em estilo — Os estilos da imagem desta camada podem ser renderizadas pelo o servidor
WMS.

Mostra a legenda gráfica do WMS no tabela de conteúdos e compositor

O provedor de dados WMS QGIS é capaz de exibir um gráfico legenda na tabela da lista de camadas conteúdos e
no compositor mapa. A legenda WMS será exibida somente se o servidor WMS suportar GetLegendGraphic e a
camada tiver getCapability url especificado, para que você também tenha como escolher um estilo para a camada.

Se uma legendGraphic está disponível, será mostrada abaixo da camada. É pequena, e você tem que clicar sobre
ela para abrir na dimensão real (devido à limitação arquitetônica QgsLegendInterface). Clicando sobre a legenda
da camada abrirá um quadro com a legenda em resolução máxima.

No compositor de impressão, a legenda será integrada a ele (baixando) dimensão originária. Resolução do gráfico
lenda pode ser definido nas propriedades do item sob Legenda -> WMS LegendGraphic para atender às suas
necessidades de impressão

A lenda irá exibir informações contextuais com base em sua escala atual. A lenda WMS será exibida somente se o
servidor WMS tiver capacidade GetLegendGraphic e a camada for getCapability url especificada, então você tem
que selecionar um estilo.

Limitações do WMS Cliente

Nem todas as funcionalidades possíveis do cliente WMS foram incluídas nesta versão do QGIS. Seguem-se algu-
mas das mais notáveis excepções .

Editando as Configurações da Camada WMS
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Uma vez completo o procedimento Adicionar camada WMS, não existe forma para alterar as configurações. Uma
forma alternativa é apagar a camada completamente e começar de novo.

Servidores WMS que Requerem Autenticação

Actualmente o acesso público e serviços WMS protegidos são suportados. Os servidores WMS protegidos podem
ser acedidos pela autenticação pública. Pode adicionar credenciais (opcionais) quando adiciona o servidor WMS.
Veja a secção Seleccionando os Servidores WMS/WMTS para detalhes.

Dica: Accedendo a camadas protegidas OGC
Se necessitar de proteger camadas com outros métodos seguros além da autenticação básica, pode usar o InteProxy
como proxy transparente, que suporta vários métodos de suporte. Mais informação pode ser encontrada no manual
InteProxy no sítio na internet http://inteproxy.wald.intevation.org.

Dica: |qg| WMS Mapserver
Desde a Versão 1.7. o QGIS tem uma implementação própria do Masserver WMS 1.3.0. Leia mais sobre este
assunto no capítulo QGIS com Servidor de Dados OGC.

14.1.2 WCS Cliente

O Serviço Web de Cobertura (WCS) fornecem acesso aos dados matriciais de forma a serem úteis à renderiza-
ção cliente, como entrada a modelos científicos, e para outros clientes. O WCS pode ser comprado ao WFS e ao
WMS. Como as instâncias WMS e WFS, o WCS permite aos clientes escolher porções de informação guardada
de servidores baseaados condicionantes espaciais e outros critérios de consulta.

O QGIS tem um fornecedor WCS nativo e suporta a versão 1.0 e 1.1 (que são significativamente diferentes), mas
actualmente dá-se preferência ao 1.0, porque o 1.1 tem vários problemas (ex.: cada servidor implementa de formas
diferentes com várias particularidades).

O fornecedor WCS nativo gere todos pedidos de rede e usa as configurações padrões de rede do QGIS (especial-
mente o proxy). É também possível seleccionar o modo de cache (‘sempre cache’, ‘preferir cache’, ‘preferir rede’,
‘sempre rede’) e fornece também suporte à selecção de posição do tempo se o domínio temporal é oferecido pelo
servidor.

14.1.3 WFS e WFS-T Cliente

No QGIS, a camada WFS comporta-se de forma semelhante a uma camada vectorial. Pode identificar e seleccionar
elementos e ver a tabela de atributos. Desde o QGIS 1.6 a edição WFS-T é também suportada.

De uma forma geral adicionar uma camada WFS é muito semlehante ao procedimento usado com o WMS. A
diferença é que não existe servidores padrões definidos, portanto nós teremos de adicionar o nosso.

Carregando uma camada WFS

Como exemplo nós usaremos o servidor WFS DM Solutions e exibiremos uma camada, O URL é:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Clique na ferramenta Adicionar Camada WFS na barra de ferramentas Camadas, a janela Adicionar Camada
WFS do Servidor aparecerá.

2. Clique em [Novo].

3. Introduza ‘DM Solutions’ como nome.

4. Introduza o URL (veja em cima).

5. Clique [OK].

6. Escolha ‘DM Solutions’ da lista Ligações do Servidor .
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7. Clique [Ligar].

8. Espera pela lista de camadas a ser preenchida.

9. Seleccione a camada Parques da lista.

10. Clique [Aplicar] para adicionar a camada ao mapa.

Repare que as configurações proxy que definiu nas suas preferências são também reconhecidas.

Figura 14.4: Adicionando uma camada WFS

Será avisado do progresso de transferência que pode ser visualizado na janela principal do QGIS no canto inferior
esquerdo. Uma vez a camada carregada, pode identificar e seleccionar uma província ou duas e ver na tabela de
atributos.

Apenas o WFS 1.0.0 é suportado. Até este momento não houve muitos testes contra versões WFS implementadas
em outros servidores WFS. Se encontrar problemas com outros servidores WFS, por favor não hesite em contactar
a equipa de desenvolvimento. Por favor dirija-se à Secção Ajuda e Suporte para mais informação sobre as listas
de discussões.

Dica: Encontrando Servidores WFS
Pode encontrar servidores WFS adicionais usando o Google ou outro motor de busca favorito. Existe um número
de listas com URLs públicos, alguns têm manutenção outros não.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

14.2 QGIS com Servidor de Dados OGC

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, im-
plements advanced cartographic features for thematic mapping. The QGIS Server is a FastCGI/CGI (Common
Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd). It
is funded by the EU projects Orchestra, Sany and the city of Uster in Switzerland.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is
used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS
Server uses cartographic rules as a configuration language, both for the server configuration and for the user-
defined cartographic rules.
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Moreover, the QGIS Server project provides the ‘Publish to Web’ plugin, a plugin for QGIS desktop that exports
the current layers and symbology as a web project for QGIS Server (containing cartographic visualization rules
expressed in SLD).

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS. The ‘Publish to Web’ plugin currently supports basic symbolization, with the
option to introduce more complex cartographic visualization rules manually. As the configuration is performed
with the SLD standard and its documented extensions, there is only one standardised language to learn, which
greatly simplifies the complexity of creating maps for the Web.

In one of the following manuals, we will provide a sample configuration to set up a QGIS Server. For now, we
recommend to read one of the following URLs to get more information:

• http://karlinapp.ethz.ch/qgis_wms/

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

14.2.1 Instalação simples no Debian Squeeze

At this point, we will give a short and simple sample installation how-to for Debian Squeeze. Many other OSs
provide packages for QGIS Server, too. If you have to build it all from source, please refer to the URLs above.

Apart from QGIS and QGIS Server, you need a web server, in our case apache2. You can install all packages with
aptitude or apt-get install together with other necessary dependency packages. After installation, you
should test to confirm that the web server and QGIS Server work as expected. Make sure the apache server is
running with /etc/init.d/apache2 start. Open a web browser and type URL: http://localhost.
If apache is up, you should see the message ‘It works!’.

Now we test the QGIS Server installation. The qgis_mapserv.fcgi is available at
/usr/lib/cgi-bin/qgis_mapserv.fcgi and provides a standard WMS that shows the state boundaries
of Alaska. Add the WMS with the URL http://localhost/cgi-bin/qgis_mapserv.fcgi as
described in Seleccionando os Servidores WMS/WMTS.

14.2.2 Creating a WMS/WFS/WCS from a QGIS project

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.

Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRS from the Coordinate Reference System Selector, or click Used to
add the CRS used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetCapabilities response, and they
can be used by the GetPrint request to create prints, using one of the print composer layouts as a template. This
is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.
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Figura 14.5: WMS padrão com os limites dos EUA incluído no Servidor QGIS (KDE)
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Figura 14.6: Definitions for a QGIS Server WMS/WFS/WCS project (KDE)
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If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries at once.

You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format choosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

WFS capabilities

In the WFS capabilities area, you can select the layers that you want to publish as WFS, and specify if they
will allow the update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS
capabilities section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Now, save the session in a project file alaska.qgs. To provide the project as a WMS/WFS, we create a new
folder /usr/lib/cgi-bin/project with admin privileges and add the project file alaska.qgs and a
copy of the qgis_mapserv.fcgi file - that’s all.

Now we test our project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in Carregando as
camadas WMS/WMTS, WFS e WFS-T Cliente and WCS Cliente to QGIS and load the data. The URL is:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

Afinando o seu OWS

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you want a specific
attribute not to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See section Annotation Tools in Ferramentas Gerais for instructions on creating annotations.
For annotations to be displayed as watermarks on the WMS output, the Fixed map position check box in the
Annotation text dialog must be unchecked. This can be accessed by double clicking the annotation while one of
the annotation tools is active. For SVG annotations, you will need either to set the project to save absolute paths
(in the General menu of the Project → Project Properties dialog) or to manually modify the path to the SVG
image in a way that it represents a valid relative path.

Os parâmetros extra suportados pelo pedido WMS GetMap

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OCG WMS 1.3.0 specification:

• Parâmetro MAPA: Semelhante ao MapServer, o parâmetro MAPA pode ser usado para especificar o caminho
para o ficheiro de projecto QGIS. Pode especificar um caminho absoluto ou relativo para a localização do
executável do servidor (qgis_mapserv.fcgi). Se não estiver especificado, o Servidor QGIS procura
por ficheiros .qgs no directório onde o executável do servidor está localizado.

Exemplo:
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http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

• Parâmetro DPI : O parâmetro DPI pode ser usado para especificar o pedido de saída da resolução.

Exemplo:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• Parâmetro OPACIDADE: A opacidade pode se definida numa camada ou ao nível do grupo. O intervalo de
valores permitido vai de 0 (totalmente trasnaprente) a 255 (totalmente opaco).

Exemplo:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 15

Trabalhando com dados GPS

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

15.1 Complemento GPS

15.1.1 O que é GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

15.1.2 Carregando dados GPS de um arquivo

Existem dezenas de diferentes formatos de arquivo para armazenar dados de GPS. O formato que QGIS usa
é chamado GPX (GPS eXchange format), que é um formato padrão de intercâmbio que pode conter qualquer
número de waypoints, rotas e trilhas no mesmo arquivo.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, two buttons with a small handheld GPS
device will show up in the toolbar:

• Create new GPX Layer

• GPS Tools

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Amostra de Dados for more infor-
mation about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS_1).

2. Navegue até a pasta qgis_sample_data/gps/, selecione o arquivo GPX
national_monuments.gpx e clique ** [Abrir]. **

Use o botão [Procurar...] para selecionar o arquivo GPX, então use as caixas de seleção para escolher os tipos
de recursos que você deseja carregar a partir desse arquivo GPX. Cada tipo de recurso será carregado em uma
camada separada quando você clicar [OK]. O arquivo national_monuments.gpx inclui apenas waypoints.

159



QGIS User Guide, Versão 2.2

Figura 15.1: Janela de diálogo Ferramentas GPS

Nota: GPS units allow you to store data in different coordinate systems. When downloading a GPX file
(from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX
file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

15.1.4 Importando dados GPS

To import GPS data from a file that is not a GPX file, you use the tool Import other file in the GPS Tools dialog.
Here, you select the file that you want to import (and the file type), which feature type you want to import from it,
where you want to store the converted GPX file and what the name of the new layer should be. Note that not all
GPS data formats will support all three feature types, so for many formats you will only be able to choose between
one or two types.

15.1.5 Descarregando dados de um receptor GPS

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use the
Download from GPS tab of the GPS Tools dialog (see Figure_GPS_2). Here, we select the type of GPS device,
the port that it is connected to (or USB if your GPS supports this), the feature type that you want to download, the
GPX file where the data should be stored, and the name of the new layer.

The device type you select in the GPS device menu determines how GPSBabel tries to communicate with your
GPS device. If none of the available types work with your GPS device, you can create a new type (see section
Definindo novos tipos de dispositivo).

The port may be a file name or some other name that your operating system uses as a reference to the physical port
in your computer that the GPS device is connected to. It may also be simply USB, for USB-enabled GPS units.

• On Linux, this is something like /dev/ttyS0 or /dev/ttyS1.

• On Windows, it is COM1 or COM2.
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Figura 15.2: Ferramenta de download

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.

15.1.6 Carregando dados no receptor GPS

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

15.1.7 Definindo novos tipos de dispositivo

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type will be replaced by -w if you are downloading waypoints, -r if you are downloading routes and -t if
you are downloading tracks. These are command-line options that tell GPSBabel which feature type to download.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

Os comandos indicados nas linhas de ‘Carregar’ são aqueles utilizados para carregar os dados no dispositivo. As
mesmas palavras-chave são utilizadas, porém %in é substituído pelo nome do arquivo GPS que é utilizado e %out
é substituído pelo nome da porta.

You can learn more about GPSBabel and its available command line options at http://www.gpsbabel.org.

Once you have created a new device type, it will appear in the device lists for the download and upload tools.
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15.1.8 Download of points/tracks from GPS units

As described in previous sections QGIS uses GPSBabel to download points/tracks directly in the project. QGIS
comes out of the box with a pre-defined profile to download from Garmin devices. Unfortunately there is a bug
that does not allow create other profiles, so downloading directly in QGIS using the GPS Tools is at the moment
limited to Garmin USB units.

Garmin GPSMAP 60cs

MS Windows

Install the Garmin USB drivers from http://www8.garmin.com/support/download_details.jsp?id=591

Connect the unit. Open GPS Tools and use type=garmin serial and port=usb: Fill the fields Layer
name and Output file. Sometimes it seems to have problems saving in a certain folder, using something like
c:\temp usually works.

Ubuntu/Mint GNU/Linux

It is first needed an issue about the permissions of the device, as described at
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. You can try to create a file
/etc/udev/rules.d/51-garmin.rules containing this rule

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

After that is necessary to be sure that the garmin_gps kernel module is not loaded

rmmod garmin_gps

and then you can use the GPS Tools. Unfortunately there seems to be a bug and usually QGIS freezes several
times before the operation work fine.

BTGP-38KM datalogger (only Bluetooth)

MS Windows

The already referred bug does not allow to download the data from within QGIS, so it is needed to use GPSBabel
from the command line or using its interface. The working command is

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Use same command (or settings if you use GPSBabel GUI) as in Windows. On Linux it maybe somehow common
to get a message like

skytraq: Too many read errors on serial port

it is just a matter to turn off and on the datalogger and try again.

BlueMax GPS-4044 datalogger (both BT and USB)

MS Windows

Nota: It needs to install its drivers before using it on Windows 7. See in the manufacturer site for the proper
download.

Downloading with GPSBabel, both with USB and BT returns always an error like

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsucessfully with code 1
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Ubuntu/Mint GNU/Linux

With USB

After having connected the cable use the dmesg command to understand what port is being used, for example
/dev/ttyACM3. Then as usual use GPSBabel from the CLI or GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

With Bluetooth

Use Blueman Device Manager to pair the device and make it available through a system port, then run GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

15.2 Rastreio GPS em tempo real

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

There are four possible screens in this GPS tracking window:

• GPS position coordinates and an interface for manually entering vertices and features

• GPS signal strength of satellite connections

• GPS polar screen showing number and polar position of satellites

• GPS options screen (see figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Aviso: If you want to record your position to the canvas, you have to create a new vector layer first and switch
it to editable status to be able to record your track.

15.2.1 Posição e atributos adicionais

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

15.2.2 Força do sinal GPS

Here, you can see the signal strength of the satellites you are receiving signals from.

15.2.3 Posiçao polar GPS

Se você quer saber onde estão todos os satélites conectados, é preciso mudar para a tela polar. Você também
pode ver os números de identificação dos satélites conectados.
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Figura 15.3: Posição GPS e atributos adicionais

Figura 15.4: Intensidade do sinal de rastreamento GPS

Figura 15.5: Posição polar de rastreamento GPS
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15.2.4 Opções GPS

In case of connection problems, you can switch between:

• Autodetectar

• Interno

• Dispositivo serial

• gpsd (selecting the Host, Port and Device your GPS is connected to)

Um clique sobre ** [Conectar] ** reinicia a ligação ao receptor GPS.

Figura 15.6: Janela de opções de rastreamento GPS

You can activate Automatically save added features when you are in editing mode. Or you can activate
Automatically add points to the map canvas with a certain width and color.

Activating Cursor, you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.
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Finally, you can activate Log file and define a path and a file where log messages about the GPS tracking are
logged.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

15.2.5 Connect to a Bluetooth GPS for live tracking

With QGIS you can connect a Bluetooth GPS for field data collection. To perform this task you need a GPS
Bluetooth device and a Bluetooth receiver on your computer.

At first you must let your GPS device be recognized and paired to the computer. Turn on the GPS, go to the
Bluetooth icon on your notification area and search for a New Device.

On the right side of the Device selection mask make sure that all devices are selected so your GPS unit will
probably appear among those available. In the next step a serial connection service should be available, select it
and click on [Configure] button.

Remember the number of the COM port assigned to the GPS connection as resulting by the Bluetooth properties.

After the GPS has been recognized, make the pairing for the connection. Usually the autorization code is 0000.

Now open :guilabel:‘GPS information‘panel and switch to GPS options screen. Select the COM port assigned
to the GPS connection and click the [Connect]. After a while a cursor indicating your position should appear.

If QGIS can’t receive GPS data, then you should restart your GPS device, wait 5-10 seconds then try to connect
again. Usually this solution work. If you receive again a connection error make sure you don’t have another
Bluetooth receiver near you, paired with the same GPS unit.

15.2.6 Using GPSMAP 60cs

MS Windows

Easiest way to make it work is to use a middleware (freeware, not open) called GPSGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

As for Windows the easiest way is to use a server in the middle, in this case GPSD, so

sudo apt-get install gpsd

Then load the garmin_gps kernel module

sudo modprobe garmin_gps

And then connect the unit. Then check with dmesg the actual device being used bu the unit, for example
/dev/ttyUSB0. Now you can launch gpsd

gpsd /dev/ttyUSB0

And finally connect with the QGIS live tracking tool.

15.2.7 Using BTGP-38KM datalogger (only Bluetooth)

Using GPSD (under Linux) or GPSGate (under Windows) is effortless.
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15.2.8 Using BlueMax GPS-4044 datalogger (both BT and USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.

Ubuntu/Mint GNU/Linux

For USB

The live tracking works both with GPSD

gpsd /dev/ttyACM3

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/ttyACM3).

For Bluetooth

The live tracking works both with GPSD

gpsd /dev/rfcomm0

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/rfcomm0).

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 16

Integração com SIG GRASS

The GRASS plugin provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Refer-
ências Bibliográficas e Web). This includes visualizing GRASS raster and vector layers, digitizing vector layers,
editing vector attributes, creating new vector layers and analysing GRASS 2-D and 3-D data with more than 400
GRASS modules.

In this section, we’ll introduce the plugin functionalities and give some examples of managing and working with
GRASS data. The following main features are provided with the toolbar menu when you start the GRASS plugin,
as described in section sec_starting_grass:

• Abrir mapset

• Novo mapset

• Fechar mapset

• Adicionar uma camada vetorial do GRASS

• Adicionar uma camada raster do GRASS

• Criar um novo vetor do GRASS

• Editar camada vetorial do GRASS

• Abrir ferramentas GRASS

• Mostrar a região atual do GRASS

• Edita região atual do GRASS

16.1 Iniciando o complemento GRASS

To use GRASS functionalities and/or visualize GRASS vector and raster layers in QGIS, you must select and load

the GRASS plugin with the Plugin Manager. Therefore, go to the menu Plugins → Manage Plugins, select

GRASS and click [OK].

You can now start loading raster and vector layers from an existing GRASS LOCATION (see section
sec_load_grassdata). Or, you can create a new GRASS LOCATION with QGIS (see section Criando uma nova
Localização GRASS) and import some raster and vector data (see section Importando dados para uma localização
GRASS) for further analysis with the GRASS Toolbox (see section The GRASS Toolbox).
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16.2 Carregando camadas raster e vetorial GRASS

With the GRASS plugin, you can load vector or raster layers using the appropriate button on the toolbar menu.
As an example, we will use the QGIS Alaska dataset (see section Amostra de Dados). It includes a small sample
GRASS LOCATION with three vector layers and one raster elevation map.

1. Create a new folder called grassdata, download the QGIS ‘Alaska’ dataset
qgis_sample_data.zip from http://download.osgeo.org/qgis/data/ and unzip the file into
grassdata.

2. Start QGIS.

3. If not already done in a previous QGIS session, load the GRASS plugin clicking on Plugins → Manage

Plugins and activate GRASS. The GRASS toolbar appears in the QGIS main window.

4. Na barra de ferramentas GRASS. clique no :sup: ícone Abrir mapset para abrir o :guilabel: assistente
MAPSET.

5. For Gisdbase, browse and select or enter the path to the newly created folder grassdata.

6. Você agora será capaz de selecionar o LOCATION alaska e o MAPSET demo.

7. Clique [OK]. Observe que algumas ferramentas anteriormente desabilitadas na barra de ferramentas
GRASS agora estão habilitadas.

8. Clique em Adicionar camada raster GRASS, escolha o nome do mapa: arquivo: gtopo30 e clique [OK]. A
camada de elevação será visualizada.

9. Click on Add GRASS vector layer, choose the map name alaska and click [OK]. The Alaska boundary
vector layer will be overlayed on top of the gtopo30 map. You can now adapt the layer properties as
described in chapter Janela de Propriedades de Vetor (e.g., change opacity, fill and outline color).

10. Also load the other two vector layers, rivers and airports, and adapt their properties.

As you see, it is very simple to load GRASS raster and vector layers in QGIS. See the following sections for
editing GRASS data and creating a new LOCATION. More sample GRASS LOCATIONs are available at the
GRASS website at http://grass.osgeo.org/download/sample-data/.

Dica: Carregando dados GRASS
If you have problems loading data or QGIS terminates abnormally, check to make sure you have loaded the
GRASS plugin properly as described in section sec_starting_grass.

16.3 Localização e MAPSET GRASS

GRASS data are stored in a directory referred to as GISDBASE. This directory, often called grassdata, must
be created before you start working with the GRASS plugin in QGIS. Within this directory, the GRASS GIS
data are organized by projects stored in subdirectories called LOCATIONs. Each LOCATION is defined by its
coordinate system, map projection and geographical boundaries. Each LOCATION can have several MAPSETs
(subdirectories of the LOCATION) that are used to subdivide the project into different topics or subregions, or as
workspaces for individual team members (see Neteler & Mitasova 2008 in Referências Bibliográficas e Web). In
order to analyze vector and raster layers with GRASS modules, you must import them into a GRASS LOCATION.
(This is not strictly true – with the GRASS modules r.external and v.external you can create read-only
links to external GDAL/OGR-supported datasets without importing them. But because this is not the usual way
for beginners to work with GRASS, this functionality will not be described here.)
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Figura 16.1: Dados GRASS em LOCATION alaska

16.3.1 Criando uma nova Localização GRASS

As an example, here is how the sample GRASS LOCATION alaska, which is projected in Albers Equal Area
projection with unit feet was created for the QGIS sample dataset. This sample GRASS LOCATION alaska
will be used for all examples and exercises in the following GRASS-related sections. It is useful to download and
install the dataset on your computer (see Amostra de Dados).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Visualize the alaska.shp shapefile (see section vector_load_shapefile) from the QGIS Alaska dataset
(see Amostra de Dados).

3. Na barra de ferramentas GRASS, clique no ícone Abrir mapset para abrir o :arquivo: Assistente‘MAPSET‘.

4. Select an existing GRASS database (GISDBASE) folder grassdata, or create one for the new
LOCATION using a file manager on your computer. Then click [Next].

5. Podemos usar este assistente para criar um novo :arquivo: MAPSET dentro de um já existente :ar-
quivo:‘LOCATION‘ (ver seção :ref:‘ sec_add_mapset ) ou para criar um novo: arquivo:‘LOCATION.
Selecione Criar nova location (ver figure_grass_location_2).

6. Enter a name for the LOCATION – we used ‘alaska’ – and click [Next].

7. Defina a projeção, clicando no botão de rádio :guilabel: Projeção para habilitar a lista de projeções.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Trabalhando com Projeções)).

9. In Filter, insert 2964 to select the projection.

10. Clique [Próximo].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current |qg| extent], to apply the extent of the loaded
layer alaska.shp as the GRASS default region extent.

12. Clique [Próximo].

13. We also need to define a MAPSET within our new LOCATION (this is necessary when creating a new
LOCATION). You can name it whatever you like - we used ‘demo’. GRASS automatically creates a special
MAPSET called PERMANENT, designed to store the core data for the project, its default spatial extent and
coordinate system definitions (see Neteler & Mitasova 2008 in Referências Bibliográficas e Web).
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14. Confira o resumo para ter certeza que está correto e clique [Fim].

15. The new LOCATION, ‘alaska’, and two MAPSETs, ‘demo’ and ‘PERMANENT’, are created. The currently
opened working set is ‘demo’, as you defined.

16. Note que algumas das ferramentas na barra de ferramentas GRASS que foram desativadas estão agora
habilitadas.

Figura 16.2: Criando um novo LOCATION GRASS ou um novo MAPSET no QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Importando dados para uma localização GRASS).
You can also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’, included
in the QGIS ‘Alaska’ dataset Amostra de Dados, and move on to section O modelo de dados vetorial do GRASS.

16.3.2 Adicionando um novo MAPSET

A user has write access only to a GRASS MAPSET he or she created. This means that besides access to your own
MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify or remove
only the maps in your own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (see Neteler & Mitasova 2008 in Referências Bibliográficas e Web, and section A ferramenta
região GRASS).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Na barra de ferramentas GRASS, clique no ícone Abrir mapset para abrir o :arquivo: Assistente‘MAPSET‘.

3. Select the GRASS database (GISDBASE) folder grassdata with the LOCATION ‘alaska’, where we
want to add a further MAPSET called ‘test’.

4. Clique [Próximo].

5. Podemos usar este assistente para criar um novo :arquivo:‘MAPSET‘ dentro de um já existente :ar-
quivo:‘LOCATION‘ ou para criar um completamente novo :arquivo:‘LOCATION‘. Clique no botão
de rádio Selecionar a localização (ver figure_grass_location_2) e clique [Próximo].

6. Enter the name text for the new MAPSET. Below in the wizard, you see a list of existing MAPSETs and
corresponding owners.

7. Clique [Próximo], confira o resumo para se certificar de que está tudo correto e clique [Fim].
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16.4 Importando dados para uma localização GRASS

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset. Therefore, we use the landcover raster map landcover.img and the
vector GML file lakes.gml from the QGIS ‘Alaska’ dataset (see Amostra de Dados).

1. Start QGIS and make sure the GRASS plugin is loaded.

2. Na barra de ferramentas GRASS, clique no ícone Abrir MAPSET para abrir o :gulabel: assistente MAPSET.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION ‘alaska’, as
MAPSET ‘demo’ and click [OK].

4. Agora, clique no ícone | grass_tools |: sup: ‘Abrir ferramentas GRASS . A caixa de ferramentas GRASS
(ver secção: ref: ‘subsec_grass_toolbox) aparece o diálogo.

5. To import the raster map landcover.img, click the module r.in.gdal in the Modules Tree tab. This
GRASS module allows you to import GDAL-supported raster files into a GRASS LOCATION. The module
dialog for r.in.gdal appears.

6. Browse to the folder raster in the QGIS ‘Alaska’ dataset and select the file landcover.img.

7. As raster output name, define landcover_grass and click [Run]. In the Output tab, you
see the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. When it says Succesfully finished, click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. To import the vector GML file lakes.gml, click the module v.in.ogr in the Modules Tree tab. This
GRASS module allows you to import OGR-supported vector files into a GRASS LOCATION. The module
dialog for v.in.ogr appears.

10. Browse to the folder gml in the QGIS ‘Alaska’ dataset and select the file lakes.gml as OGR file.

11. As vector output name, define lakes_grass and click [Run]. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

16.5 O modelo de dados vetorial do GRASS

É importante compreender o modelo de dados vetor GRASS antes da digitalização.

Em geral, GRASS utiliza um modelo de vetor topológico.

Isto significa que as áreas não são representadas como polígonos fechados, mas por um ou mais limites. A fronteira
entre duas áreas adjacentes é digitalizada apenas uma vez, e é compartilhada por ambas as áreas. Limites precisam
estar conectados e fechados sem lacunas. Uma área é identificada (e rotulada) pelo ** centróide** da área.

Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so-called ‘layers’ inside one GRASS vector map.
So in GRASS, a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully. (Although it is possible to mix geometry elements, it is unusual and, even in GRASS, only used in
special cases such as vector network analysis. Normally, you should prefer to store different geometry elements
in different layers.)

It is possible to store several ‘layers’ in one vector dataset. For example, fields, forests and lakes can be stored in
one vector. An adjacent forest and lake can share the same boundary, but they have separate attribute tables. It is
also possible to attach attributes to boundaries. An example might be the case where the boundary between a lake
and a forest is a road, so it can have a different attribute table.
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The ‘layer’ of the feature is defined by the ‘layer’ inside GRASS. ‘Layer’ is the number which defines if there is
more than one layer inside the dataset (e.g., if the geometry is forest or lake). For now, it can be only a number. In
the future, GRASS will also support names as fields in the user interface.

Attributes can be stored inside the GRASS LOCATION as dBase or SQLite3 or in external database tables, for
example, PostgreSQL, MySQL, Oracle, etc.

Atributos em tabelas de base de dados estão ligados a elementos geométricos usando um valor ‘categoria’.

‘Categoria’ (chave, ID) é um número inteiro ligado a geometrias primitivas, e que é usada como ligação a uma
coluna chave na tabela de base de dados.

Dica: Aprendendo um Modelo Vetor GRASS
A melhor maneira de aprender os modelos de vetores GRASS, e as suas capacidades é baixando
um dos muitos tutoriais GRASS onde o modelo de vetor é descrito mais profundamente. Veja
http://grass.osgeo.org/documentation/manuals/ Para mais informações, livros e tutoriais em várias línguas.

16.6 Criando uma nova camada vetorial GRASS

To create a new GRASS vector layer with the GRASS plugin, click the Create new GRASS vector toolbar icon. Enter
a name in the text box, and you can start digitizing point, line or polygon geometries following the procedure
described in section Digitalizando e editando uma camada vetorial GRASS.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Criando novas camadas Vectoriais).

Dica: Criando uma tabela de atributos para uma nova camada vetorial GRASS
Se você deseja atribuir atributos a seus recursos de geometria digitalizados, certifique-se de criar uma tabela de
atributos com colunas antes de começar a digitalização (ver figure_grass_digitizing_5).

16.7 Digitalizando e editando uma camada vetorial GRASS

As ferramentas de digitalização para as camadas vetor GRASS são acessadas usando o | grass_edit |: sup:ícone Ed-
itar camada vetorial GRASS na barra de ferramentas. Certifique-se de que você tenha carregado um vetor GRASS
e é a camada selecionada na legenda antes de clicar na ferramenta de edição. Figura figure_grass_digitizing_2
mostra o diálogo de edição GRASS que é exibido quando você clica na ferramenta de edição. As ferramentas e as
configurações serão discutidas nas seções seguintes.

Dica: Digitalizando polígonos no GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon, setting the mode to ‘No
category’. Then you add a centroid (label point) into the closed boundary, setting the mode to ‘Next not used’.
The reason for this is that a topological vector model links the attribute information of a polygon always to the
centroid and not to the boundary.

Barra de Ferramentas

In figure_grass_digitizing_1, you see the GRASS digitizing toolbar icons provided by the
GRASS plugin. Table table_grass_digitizing_1 explains the available functionalities.
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Figura 16.3: Barra de ferramentas de Digitalização GRASS

Ícone Ferramenta Propósito

Novo Ponto Digitaliza novo ponto

Nova Linha Digitaliza nova linha

Nova
Fronteira

Digitaliza novo limite (acaba ao selecionar nova ferramenta)

Novo
Centróide

Digitaliza novo centróide (etiqueta da área existente)

Mova vértice Mova um vértice da linha ou limite existente e identifique nova posição

Adiciona
vértice

Adiciona novo vértice à uma linha existente

Exclua
vértice

Exclua vértice da linha existente (confirme vértice selecionado por outro clique)

Mova
elemento

Mova limite, linha, ponto ou centróide selecionado e clique em nova posição

Dividir linha Split an existing line into two parts

Exclua
elemento

Exclua limite existente, linha, ponto ou centróide (confirme elemento selecionado
por outro clique)

Editar
atributos

Editar atributos do elemento selecionado (note que um elemento pode representar
mais recursos, veja acima)

Fechar Fechar sessão e salvar o estado atual (reconstrói topologia depois)

GRASS Digitalização de Tabela 1: GRASS Ferramentas de Digitalização

Aba Categoria

A: guilabel: guia Categoria permite definir a forma em que os valores da categoria serão atribuídos à um novo
elemento geométrico.

Figura 16.4: Aba Categoria Digitalização GRASS

• Mode: The category value that will be applied to new geometry elements.

– Next not used - Apply next not yet used category value to geometry element.
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– Manual entry - Manually define the category value for the geometry element in the ‘Category’ entry
field.

– No category - Do not apply a category value to the geometry element. This is used, for instance, for
area boundaries, because the category values are connected via the centroid.

• Category - The number (ID) that is attached to each digitized geometry element. It is used to connect each
geometry element with its attributes.

• Field (layer) - Each geometry element can be connected with several attribute tables using different GRASS
geometry layers. The default layer number is 1.

Dica: Creating an additional GRASS ‘layer’ with |qg|
If you would like to add more layers to your dataset, just add a new number in the ‘Field (layer)’ entry box and
press return. In the Table tab, you can create your new table connected to your new layer.

Aba Configurações

A: guilabel: guia Configurações permite que você defina o encaixe em pixels da tela. O limite que define qual
distância para novos pontos de linha ou extremidades são agarrados por nós existentes. Isso ajuda a evitar lacunas
ou oscilações entre fronteiras. O padrão é definido como 10 pixels.

Figura 16.5: Aba Configurações de Digitalização GRASS

Aba Simbologia

The Symbology tab allows you to view and set symbology and color settings for various geometry types and their
topological status (e.g., closed / opened boundary).

Figura 16.6: GRASS Digitizing Symbology Tab
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Aba Tabela

The Table tab provides information about the database table for a given ‘layer’. Here, you can add new columns
to an existing attribute table, or create a new database table for a new GRASS vector layer (see section Criando
uma nova camada vetorial GRASS).

Figura 16.7: Aba Tabela de Digitalização GRASS

Dica: GRASS Edita Permissões
You must be the owner of the GRASS MAPSET you want to edit. It is impossible to edit data layers in a MAPSET
that is not yours, even if you have write permission.

16.8 A ferramenta região GRASS

The region definition (setting a spatial working window) in GRASS is important for working with raster layers.
Vector analysis is by default not limited to any defined region definitions. But all newly created rasters will have
the spatial extension and resolution of the currently defined GRASS region, regardless of their original extension
and resolution. The current GRASS region is stored in the $LOCATION/$MAPSET/WIND file, and it defines
north, south, east and west bounds, number of columns and rows, horizontal and vertical spatial resolution.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.

With the Edit current GRASS region icon, you can open a dialog to change the current region and the symbology of
the GRASS region rectangle in the QGIS canvas. Type in the new region bounds and resolution, and click [OK].
The dialog also allows you to select a new region interactively with your mouse on the QGIS canvas. Therefore,
click with the left mouse button in the QGIS canvas, open a rectangle, close it using the left mouse button again
and click [OK].

The GRASS module g.region provides a lot more parameters to define an appropriate region extent and reso-
lution for your raster analysis. You can use these parameters with the GRASS Toolbox, described in section The
GRASS Toolbox.

16.9 The GRASS Toolbox

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.
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Figura 16.8: Ferramentas do GRASS e Modulo de Árvore

16.9.1 Trabalhando com módulos GRASS

The GRASS shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user-friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs within the GRASS plugin Toolbox.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.2 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

It is also possible to customize the GRASS Toolbox content. This procedure is described in section Personalizando
a caixa de ferramentas GRASS.

As shown in figure_grass_toolbox_1, you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.

By clicking on a graphical module icon, a new tab will be added to the Toolbox dialog, providing three new
sub-tabs: Options, Output and Manual.

Opções

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

The provided module parameters are often not complete to keep the dialog clear. If you want to use further module
parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Saída

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manual

The Manual tab shows the HTML help page of the GRASS module. You can use it to check further module
parameters and flags or to get a deeper knowledge about the purpose of the module. At the end of each module
manual page, you see further links to the Main Help index, the Thematic index and the Full index.
These links provide the same information as the module g.manual.
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Figura 16.9: Ferramentas GRASS Opções de Módulo

Figura 16.10: Ferramentas GRASS Modulo de Saída
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Figura 16.11: Ferramentas GRASS Modulo Manual

Dica: Mostra Resultados Imediatamente
Se você quiser exibir os resultados de cálculo imediatamente em sua tela do mapa, você pode usar o botão “Ver
Saída” na parte inferior da aba módulo.

16.9.2 Exemplos de módulos GRASS

Os exemplos seguintes demonstrarão o poder de alguns dos módulos grama.

Criando linhas de contorno

The first example creates a vector contour map from an elevation raster (DEM). Here, it is assumed that you have
the Alaska LOCATION set up as explained in section Importando dados para uma localização GRASS.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Agora carregue o raster gtopo30 elevação clicando : sup: Adicionar camada raster GRASS’ e sele-
cionando o raster ‘‘gtopo30‘ a partir do local de demonstração.

• Agora, abra a caixa de ferramentas com o : sup: botão ‘Abrir ferramentas GRASS‘.

• In the list of tool categories, double-click Raster → Surface Management → Generate vector contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Trabalhando com
módulos GRASS). The gtopo30 raster should appear as the Name of input raster.

• Digite no Incremento entre os níveis de contorno o valor 100. (Isto criará linhas de contorno em
intervalos de 100 metros.)

• Digite no :guilabel: Nome para a saída do vetor mapa o nome ctour_100.
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• Clique [Rodar] para iniciar o processo. Aguarde alguns instantes até que a mensagem Terminado com
sucesso apareça na janela de saída. Então, clique [Ver saída] e [fechar].

Como se trata de uma grande região, vai demorar um pouco para exibir. Depois de terminar a renderização,
você pode abrir a janela de propriedades da camada para alterar a cor da linha para que os contornos apareçam
claramente sobre o raster elevação, como em: ref: vector_properties_dialog.

Next, zoom in to a small, mountainous area in the center of Alaska. Zooming in close, you will notice that the
contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps while keeping
their overall shape. The tool uses several different algorithms with different purposes. Some of the algorithms
(i.e., Douglas Peuker and Vertex Reduction) simplify the line by removing some of the vertices. The resulting
vector will load faster. This process is useful when you have a highly detailed vector, but you are creating a very
small-scale map, so the detail is unnecessary.

Dica: A ferramenta simplificar
Note that the QGIS fTools plugin has a Simplify geometries → tool that works just like the GRASS v.generalize
Douglas-Peuker algorithm.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms, there is Chaiken’s, which does just that (also
Hermite splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even
more slowly.

• Open the GRASS Toolbox and double-click the categories Vector → Develop map → Generalization, then
click on the v.generalize module to open its options window.

• Verifique se o vetor ‘ctour_100’ aparece como Nome do vetor de entrada.

• From the list of algorithms, choose Chaiken’s. Leave all other options at their default, and scroll down to
the last row to enter in the field Name for output vector map ‘ctour_100_smooth’, and click [Run].

• The process takes several moments. Once Successfully finished appears in the output windows,
click [View output] and then [Close].

• É possível mudar a cor do vetor para apresentar claramente o fundo matricial e para contrastar com as linhas
de contorno originais. Você notará que as novas linhas de contorno têm cantos mais suaves do que o original,
enquanto permanecer fiel à forma geral de origem.

Dica: Outros usos para r.contour
The procedure described above can be used in other equivalent situations. If you have a raster map of precipitation
data, for example, then the same method will be used to create a vector map of isohyetal (constant rainfall) lines.

Creating a Hillshade 3-D effect

Several methods are used to display elevation layers and give a 3-D effect to maps. The use of contour lines, as
shown above, is one popular method often chosen to produce topographic maps. Another way to display a 3-D
effect is by hillshading. The hillshade effect is created from a DEM (elevation) raster by first calculating the slope
and aspect of each cell, then simulating the sun’s position in the sky and giving a reflectance value to each cell.
Thus, you get sun-facing slopes lighted; the slopes facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS Toolbox, and under the
Raster category, double-click to open Spatial analysis → Terrain analysis.

• Então, clique r.shaded.relief para abrir o módulo.

• Altere o ângulo azimute 270 a 315.

• Digite gtopo30_shade para o novo raster sombreado e clique [rodar].

• Quando o processo termina, adicione o raster sombreado ao mapa. Você deve vê-lo exibido em escala de
cinza.
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Figura 16.12: Modulo GRASS v.generalize para visualizar um mapa vetorial

• To view both the hillshading and the colors of the gtopo30 together, move the hillshade map below the
gtopo30 map in the table of contents, then open the Properties window of gtopo30, switch to the
Transparency tab and set its transparency level to about 25%.

Agora você deve ter a elevação gtopo30 com o seu mapa de cores e configuração de transparência apresen-
tada acima o tons de cinza mapa sombreado. Para ver os efeitos visuais do sombreamento, desligue o mapa
gtopo30_shade em seguida, ligue-o novamente.

Usando a linha de comando GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

The module r.shaded.relief can take a parameter zmult, which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.

• Load the gtopo30 elevation raster as above, then start the GRASS Toolbox and click on the
GRASS shell. In the shell window, type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press [Enter].

• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• As explained above, move the shaded relief raster below the gtopo30 raster in the table of contents, then
check the transparency of the colored gtopo30 layer. You should see that the 3-D effect stands out more
strongly compared with the first shaded relief map.
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Figura 16.13: A shell GRASS, módulo r.shaded.relief

Figura 16.14: Exibindo relevo sombreado criado com o módulo GRASS r.shaded.relief
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Estatísticas Raster em um mapa vetor

O próximo exemplo mostra como um módulo GRASS pode agregar dados raster e adicionar colunas de estatísticas
para cada polígono em um mapa vetor.

• Novamente usando os dados do Alasca, consulte a: ref: sec_import_loc_data para importar o shapefile
árvores do diretório shapefiles no GRASS.

• Now an intermediate step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).

• From the Toolbox, choose Vector → Manage features, and open the module v.centroids.

• Digite como mapa vetor de saída ‘forest_areas’ e rode o módulo.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
sec_symbology of the vector section.)

• Next, reopen the GRASS Toolbox and open Vector → Vector update by other maps.

• Click on the v.rast.stats module. Enter gtopo30 and forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click [Run]. This is a computa-
tionally heavy operation, which will run for a long time (probably up to two hours).

• Finally, open the forest_areas attribute table, and verify that several new columns have been added,
including elev_min, elev_max, elev_mean, etc., for each forest polygon.

16.9.3 Trabalhando com o buscador LOCALIZAÇÃO GRASS

Another useful feature inside the GRASS Toolbox is the GRASS LOCATION browser. In figure_grass_module_7,
you can see the current working LOCATION with its MAPSETs.

In the left browser windows, you can browse through all MAPSETs inside the current LOCATION. The right
browser window shows some meta-information for selected raster or vector layers (e.g., resolution, bounding box,
data source, connected attribute table for vector data, and a command history).

The toolbar inside the Browser tab offers the following tools to manage the selected LOCATION:

• : guilabel:Adicione mapa selecionado à tela

• : guilabel:’Copiar mapa selecionado‘

• :guilabel:’Renomeia mapa selecionado‘

• : guilabel: ‘Exclua mapa selecionado‘

• : guilabel:’Defina região atual de mapa selecionado‘

• : guilabel: Atualizar janela de busca

A guilabel: : Renomeia mapa selecionado e guilabel: : ‘Exclua mapa selecionado‘só trabalha com os
mapas dentro do seu selecionado: arquivo:MAPSET. Todas as outras ferramentas também trabalham com camadas
vetoriais e raster em outro: arquivo: MAPSET.

16.9.4 Personalizando a caixa de ferramentas GRASS

Nearly all GRASS modules can be added to the GRASS Toolbox. An XML interface is provided to parse the
pretty simple XML files that configure the modules’ appearance and parameters inside the Toolbox.
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Figura 16.15: Buscador de LOCALIZAÇÃO GRASS

Um exemplo de arquivo XML para gerar o módulo v.buffer (v.buffer.qgm) se parece com isto:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 17

QGIS estrutura de processamento

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

17.1 Introdução

This chapter introduces the QGIS processing framework, a geoprocessing environment that can be used to call
native and third-party algorithms from QGIS, making your spatial analysis tasks more productive and easy to
accomplish.

In the following sections, we will review how to use the graphical elements of this framework and make the most
out of each one of them.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox, as we will see) can be accessed from the Processing menu item. (You will see more than four
entries. The remaining ones are not used to execute algorithms and will be explained later in this chapter.)

• A caixa de ferramentas. O elemento principal do GUI, é usado para executar um algoritmo único ou correr
um processo batch baseado nesse algoritmo.

Figura 17.1: Caixa de Ferramentas Processamento
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• The graphical modeler. Several algorithms can be combined graphically using the modeler to define a
workflow, creating a single process that involves several subprocesses.

Figura 17.2: Modelador do Processamento

• The history manager. All actions performed using any of the aforementioned elements are stored in a history
file and can be later easily reproduced using the history manager.

• A interface de processamento batch. Esta interface permite que possa executar processos batch e automati-
camente a execução de um único algoritmo num múltiplo conjunto de dados.

In the following sections, we will review each one of these elements in detail.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

17.2 A caixa de ferramentas

The Toolbox is the main element of the processing GUI, and the one that you are more likely to use in your daily
work. It shows the list of all available algorithms grouped in different blocks, and it is the access point to run them,
whether as a single process or as a batch process involving several executions of the same algorithm on different
sets of inputs.

A caixa de ferramentas contém todos os algoritmos disponíveis, divididos em grupos pré-definidos. Todos esses
grupos podem ser encontrados numa árvore única com uma entrada que chama Geoalgoritmos

Additionally, two more entries are found, namely Models and Scripts. These include user-created algorithms, and
they allow you to define your own workflows and processing tasks. We will devote a full section to them a bit
later.

In the upper part of the toolbox, you will find a text box. To reduce the number of algorithms shown in the toolbox
and make it easier to find the one you need, you can enter any word or phrase on the text box. Notice that, as you
type, the number of algorithms in the toolbox is reduced to just those that contain the text you have entered in their
names.

In the lower part, you will find a box that allows you to switch between the simplified algorithm list (the one
explained above) and the advanced list. If you change to the advanced mode, the toolbox will look like this:
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Figura 17.3: Histórico do Processamento

Figura 17.4: Interface de Processamento Batch
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Figura 17.5: Caixa de Ferramentas Processamento

Figura 17.6: Caixa de Ferramentas Processamento (modo avançado)
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In the advanced view, each group represents a so-called ‘algorithm provider’, which is a set of algorithms coming
from the same source, for instance, from a third-party application with geoprocessing capabilities. Some of
these groups represent algorithms from third-party applications like SAGA, GRASS or R, while others contain
algorithms directly coded as part of the processing plugin, not relying on any additional software.

This view is recommended to those users who have a certain knowledge of the applications that are backing the
algorithms, since they will be shown with their original names and groups.

Also, some additional algorithms are available only in the advanced view, such as LiDAR tools and scripts based
on the R statistical computing software, among others. Independent QGIS plugins that add new algorithms to the
toolbox will only be shown in the advanced view.

Particularmente, a vista simplificada contém algoritmo dos seguintes fornecedores:

• GRASS

• SAGA

• OTB

• Algoritmos nativos QGIS

In the case of running QGIS under Windows, these algorithms are fully-functional in a fresh installation of QGIS,
and they can be run without requiring any additional installation. Also, running them requires no prior knowledge
of the external applications they use, making them more accesible for first-time users.

If you want to use an algorithm not provided by any of the above providers, switch to the advanced mode by
selecting the corresponding option at the bottom of the toolbox.

Para executar um algoritmo, faça duplo clique no seu nome na caixa de ferramentas.

17.2.1 O diálogo do algoritmo

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the SAGA ‘Convergence index’ algorithm).

Figura 17.7: Diálogo dos Parâmetros

This dialog is used to set the input values that the algorithm needs to be executed. It shows a table where input
values and configuration parameters are to be set. It of course has a different content, depending on the require-
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ments of the algorithm to be executed, and is created automatically based on those requirements. On the left side,
the name of the parameter is shown. On the right side, the value of the parameter can be set.

Although the number and type of parameters depend on the characteristics of the algorithm, the structure is similar
for all of them. The parameters found in the table can be of one of the following types.

• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

Irá ver um botão por cada seleccionador de camada vectorial, como é exibido na figura em baixo.

Figura 17.8: Botão de interacção vectorial

If the algorithm contains several of them, you will be able to toggle just one of them. If the button corresponding to
a vector input is toggled, the algorithm will be executed iteratively on each one of its features, instead of just once
for the whole layer, producing as many outputs as times the algorithm is executed. This allows for automating the
process when all features in a layer have to be processed separately.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• Uma opção, a escolher de uma lista de selecção de uma lista de opções possíveis.

• A numerical value, to be introduced in a text box. You will find a button by its side. Clicking on it, you
will see a dialog that allows you to enter a mathematical expression, so you can use it as a handy calculator.
Some useful variables related to data loaded into QGIS can be added to your expression, so you can select
a value derived from any of these variables, such as the cell size of a layer or the northernmost coordinate
of another one.

Figura 17.9: Seleccionador de Números

• Um intervalo, com valores min e máx para serem introduzidos em duas caixas de texto.

192 Capítulo 17. QGIS estrutura de processamento



QGIS User Guide, Versão 2.2

• Uma cadeia de texto, a ser introduzida na caixa de texto.

• Um campo, para escolher a partir de uma tabela de atributos de uma camada vectorial ou uma tabela única
de outro parâmetro.

• A coordinate reference system. You can type the EPSG code directly in the text box, or select it from the
CRS selection dialog that appears when you click on the button on the right-hand side.

• An extent, to be entered by four numbers representing its xmin, xmax, ymin, ymax limits. Clicking on
the button on the right-hand side of the value selector, a pop-up menu will appear, giving you two options:
to select the value from a layer or the current canvas extent, or to define it by dragging directly onto the map
canvas.

Figura 17.10: Seleccionador de Extensão

Se seleccione a primeira opção, irá ver uma janela igual a próxima.

Figura 17.11: Lista de Extensão

Se seleccionar o segundo, os parâmetros da janela irão esconder-se, para que possa clicar e arrastar para o
enquadramento. Uma vez definido o rectângulo seleccionado, o diálogo irá reaparecer, contendo os valores
na caixa de texto da extensão.

Figura 17.12: Arrastamento para Extensão

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

• Uma pequena tabela para ser editada pelo utilizador. Estes são usados para definir os parâmetros como
tabelas lookup ou kernels de convolução, entre outros.
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Figura 17.13: Múltipla Selecção

Figura 17.14: Tabela Fixa
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Clique no botão do lado direito para ver a tabela e editar os seus valores.

Depending on the algorithm, the number of rows can be modified or not by using the buttons on the right
side of the window.

You will find a [Help] tab in the the parameters dialog. If a help file is available, it will be shown, giving you
more information about the algorithm and detailed descriptions of what each parameter does. Unfortunately, most
algorithms lack good documentation, but if you feel like contributing to the project, this would be a good place to
start.

Uma nota nas projecções

Algorithms run from the processing framework — this is also true of most of the external applications whose
algorithms are exposed through it. Do not perform any reprojection on input layers and assume that all of them
are already in a common coordinate system and ready to be analized. Whenever you use more than one layer as
input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same coordinate
system.

Note that, due to QGIS‘s on-the-fly reprojecting capabilities, although two layers might seem to overlap and
match, that might not be true if their original coordinates are used without reprojecting them onto a common
coordinate system. That reprojection should be done manually, and then the resulting files should be used as input
to the algorithm. Also, note that the reprojection process can be performed with the algorithms that are available
in the processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the processing configuration dialog, unchecking the Show CRS
option.

If you try to execute an algorithm using as input two or more layers with unmatching CRSs, a warning dialog will
be shown.

Pode continuar a executar o algoritmo, mas tenha atenção que na maioria dos casos irá produzir resultados errados,
tais como, camadas vazias devido à falta de sobreposição das camadas usadas como ficheiros de entrada.

17.2.2 Objecto de dados gerados por algoritmos

Objectos de dados gerado por um algoritmo podem ser dos seguintes tipos:

• Uma camada raster

• Uma camada vectorial

• Uma tabela

• Um ficheiro HTML (usado para ficheiro de saída de texto e gráficos)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but the architecture
allows for any other way of storing it. For instance, a vector layer can be stored in a database or even uploaded
to a remote server using a WFS-T service. Although solutions like these are not yet implemented, the processing
framework is prepared to handle them, and we expect to add new kinds of output channels in a near feature.

To select an output channel, just click on the button on the right side of the text box. That will open a save file
dialog, where you can select the desired file path. Supported file extensions are shown in the file format selector
of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension (usually .dbf‘ for tables, .tif for raster layers and .shp for vector layers) will
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be appended to the file path, and the file format corresponding to that extension will be used to save the layer or
table.

If you do not enter any filename, the result will be saved as a temporary file in the corresponding default file
format, and it will be deleted once you exit QGIS (take care with that, in case you save your project and it contains
temporary layers).

You can set a default folder for output data objects. Go to the configuration dialog (you can open it from the
Processing menu), and in the General group, you will find a parameter named Output folder. This output folder
is used as the default path in case you type just a filename with no path (i.e., myfile.shp) when executing an
algorithm.

When running an algorithm that uses a vector layer in iterative mode, the entered file path is used as the base path
for all generated files, which are named using the base name and appending a number representing the index of
the iteration. The file extension (and format) is used for all such generated files.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

For all the other types of output, you will find a checkbox that you can use to tell the algorithm whether to load
the file once it is generated by the algorithm or not. By default, all files are opened.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

17.2.3 Configurando a infraestrutura do processamento

As has been mentioned, the configuration menu gives access to a new dialog where you can configure how algo-
rithms work. Configuration parameters are structured in separate blocks that you can select on the left-hand side
of the dialog.

Juntamente com o que já foi mencionada da entrada Pasta de saída, o bloco Geral contem parâmetros para
configuração de estilos de renderização padrão para camadas de saída (ou seja, camadas geradas pela utilização
de algoritmo de qualquer componente da infraestrutura do GUI). Basta criar um estilo que quer usar no QGIS,
guarda-lo num ficheiro, e de seguida introduzir um caminho para o ficheiro nas configurações para que sejam
usado pelos algoritmos. Cada vez que a camada for carregada pelo SEXTANTE e adicionada ao enquadramento
do QGIS, esta será renderizada com esse estilo.

Os estilos de renderização podem ser configurados individualmente para cada algoritmo e cada um para os seus
ficheiros de saída. Apenas clique com o direito do rato no nome do algoritmo na caixa de ferramentas e seleccione
Editar estilos de renderização. Irá ver um diálogo como o que é exibido a seguir.

Seleccione o ficheiro de estilo (.qml) que quer para cada ficheiro de saída e pressione [OK].

Other configuration parameters in the General group are listed below:

• Use filename as layer name. The name of each resulting layer created by an algorithm is defined by the
algorithm itself. In some cases, a fixed name might be used, meaning that the same output name will be
used, no matter which input layer is used. In other cases, the name might depend on the name of the input
layer or some of the parameters used to run the algorithm. If this checkbox is checked, the name will be
taken from the output filename instead. Notice that, if the output is saved to a temporary file, the filename
of this temporary file is usually a long and meaningless one intended to avoid collision with other already
existing filenames.
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Figura 17.15: Estilos de Renderização

• Use only selected features. If this option is selected, whenever a vector layer is used as input for an al-
gorithm, only its selected features will be used. If the layer has no selected features, all features will be
used.

• Pre-execution script file and Post-execution script file. These parameters refer to scripts written using the
processing scripting functionality, and are explained in the section covering scripting and the console.

Apart from the General block in the settings dialog, you will also find a block for algorithm providers. Each
entry in this block contains an Activate item that you can use to make algorithms appear or not in the toolbox.
Also, some algorithm providers have their own configuration items, which we will explain later when covering
particular algorithm providers.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

17.3 O modelador gráfico

O modelador gráfico permite que possa criar modelos complexos usando uma simples interface fácil-de-usar.
Quando trabalha com um SIG, a maioria das operações de análises não são isoladas, mas sim parte das cadeias de
operações. Usando um modelador gráfico, a cadeia de processos podem ser agregados num único processo, sendo
mais fácil e mais conveniente a sua execução de um processo único num conjunto de diferentes dados de entrada.
Não importa o número de etapas e os diferentes algoritmos envolvidos, o modelo é executado como um algoritmo
único, desta forma vai poupar tempo e esforços, especialmente para modelos largos.

O modelador pode ser aberto a partir do menu processamento.

O modelador tem uma área de trabalho onde a estrutura do modelo e o sue fluxo de trabalho são representados
como está exibido. Na parte esquerda da janela, um painel com dois separadores podem ser usados para adicionar
novos elementos ao modelo.

A criação de um modelo involve dois passos:

1. Definição dos dados entrada necessários. Estes dados de entrada serão adicionados na janela de parâmetros,
para que o utilizador possa configurar os seus valores quando executa o modelo. O modelo por si é um al-
goritmo, portanto os parâmetros da janela é gerado automaticamente como acontece em todos os algoritmos
disponíveis na infraestrutura de processamento.

2. Definição do fluxo de trabalho. Usando os dados de entrada do modelo, o fluxo de trabalho é definido
adicionando algoritmos e seleccionando como vão usar esses ficheiros de entrada ou de saída gerados por
outros algoritmos que já existem no modelo
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Figura 17.16: Modelador

17.3.1 Definição das entradas

O primeiro passo para criar um modelo é definir as entradas que necessita. Os seguintes elementos são encontrados
no separador Entradas no lado esquerdo da janela do modelador:

• Camada matricial

• Camada vectorial

• Cadeia de texto

• Campo da tabela

• Tabela

• Extensão

• Número

• Booleano

• Ficheiro

Faça duplo clique em qualquer um, e será exibido um diálogo para definir as suas características. Dependendo do
parâmetro, o diálogo irá conter apenas um elemento básico (a descrição, que será o que o utilizador irá ver quando
executar o modelo) ou outros. Por exemplo, quando quer adicionar um valor númerico, como aparece na próxima
figura, além da descrição do parâmetro tem um conjunto de valor por defeito e um intervalo de valores válidos.

Para cada entrada adicionada, um novo elemento é adicionado ao enquadramento do modelador.

17.3.2 Definição do fluxo de trabalho

Uma vez as entradas definidas, é tempo de definir os algoritmos que vamos aplicar. Os algoritmos podem ser
encontrados no separador Algoritmos, agrupados na mesma forma que estão na caixa de ferramentas.
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Figura 17.17: Parâmetros do Modelo

Figura 17.18: Parâmetros do Modelo

Figura 17.19: Parâmetros do Modelo
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A aparência da caixa de ferramentas tem dois modos: simplificado e avançado. Contudo, não existe nenhum ele-
mento para trocar entre as vistas no modelador, e pode fazê-lo na caixa de ferramentas. O modo que é seleccionado
na caixa de ferramentas é aquele que será usado para a lista de algoritmos no modelador.

Para adicionar um algoritmo ao modelo, clique duas vezes no seu nome. Um diálogo de execução irá aparecer, com
um conteúdo similar ao que é encontrado no painel de execução que é exibido aquando da execução do algoritmo
a partir da caixa de ferramentas, O algoritmo que é exibido corresponde ao algoritmo SAGA ‘Convergence index’,
o mesmo que viu na secção dedicada na caixa de ferramentas.

Figura 17.20: Parâmetros do Modelo

Como pode ver, existem algumas diferenças. Em vez da caixa de saída do ficheiro ser usada para configurar o
caminho do ficheiro para as camadas e tabelas de saída, é usado apenas uma caixa de texto simples. Se a camada
gerada pelo algoritmo é apenas um resultado temporário, este será usado como o ficheiro de entrada de outro
algoritmo e não será mantido como resultado final, mas não edite essa caixa de texto. Introduzindo alguma coisa
nela, significa que o resultado é final, e o texto que forneceu será a descrição para o ficheiro de saída, que será
aquele que o utilizador irá ver quando executar o modelo.

A selecção do valor para cada parâmetro é também um pouco diferente, uma vez que existem diferenças impor-
tantes entre o contexto do modelador e a caixa de ferramentas. Vamos ver como é introduzido os valores para cada
tipo de parâmetro.

• Camadas (raster e vector) e tabelas. Estes são seleccionados de uma lista, mas só em caso dos valores
possíveis serem camadas ou tabelas carregadas no QGIS, a lista dos dados de entrada do modelo do tipo
correspondente, ou outras camadas ou tabelas geradas por algoritmos que já tenham sido adicionadas ao
modelo.

• Valores numéricos. Valores literais podem ser introduzidos directamente na caixa de texto. Mas esta caixa
de texto é também uma lista que pode ser usada para seleccionar qualquer valor numérico de entrada do
modelo. Nesse caso, o parãmetro irá tomar o valor introduzido pelo utilizador quando executado o modelo.

• Cadeia de texto. Como no caso dos valores numéricos, as cadeias de texto podem ser introduzidas, ou uma
cadeia de texto de entrada pode ser seleccionada.

• Campo da Tabela. Os campos de uma tabela origem ou camada não podem ser conhecidas na altura do
seu desenho, uma vez que dependem da selecção do utilizador cada vez que o modelo é executado. Para
definir o valor para este parâmetro, introduza o nome do campo directamente na caixa de texto, ou usa a
lista para seleccionar a entrada do campo de tabela que já está adicionada no modelo. A validade de um
campo seleccionado irá ser verificado no seu processo de execução.
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Em todos os casos, irá encontrar um parâmetro adicional denominado de Algoritmos Parent que não está disponível
quando é chamado o algoritmo a partir da caixa de ferramentas. Este parâmetro permite que possa definir a ordem
de como os algoritmos são executados, definindo explicitamente um algoritmo como parent do actual, que irá
força-lo a executá-lo antes.

Quando usa um ficheiro de saída de um algoritmo prévio como ficheiro de entrada do seu algoritmo, isso implica
definir o antigo como parent do actual (e posiciona a seta correspondente no enquadramento do modelador),
Contudo, em alguns casos o algoritmo pode depender de outro mesmo que não use um objecto de saída a partir
dele (por exemplo, um algoritmo que executa uma instância SQL numa base de dados PostGIS e outra que importa
uma camada para a mesma base de dados). Nesse caso, apenas seleccione no parâmetro Algoritmos Parent e eles
irão ser executados na ordem correcta.

Uma vez todos os parâmetros estiver relacionados a valores válidos, clique no botão [OK] e o algoritmo irá ser
adicionado ao enquadramento. Será ligado a todos os outros elementos do enquadramento, sejam eles algorit-
mos ou ficheiros de entrada, o que irá fornecer objectos que foram usados como ficheiros de entrado para esse
algoritmo.

Os elementos podem ser arrastados para diferentes posições dentro do enquadramento, para alterar a forma como
é exibida a estrutura do módulo e tornar mais claro e intuitivo. As ligações entre os elementos são actualizados
automaticamente.

Pode correr o seu algoritmo em qualquer altura clicando no botão [Executar]. Contudo, se quiser usá-lo a partir
da caixa de ferramentas, é necessário guarda-lo e fechar o diálogo do modelador, para permitir que a caixa de
ferramentas actualize os seus conteúdos.

17.3.3 Guardando e e carregando os modelos

Use o botão [Guardar] para guardar o modelo actual e o [Abrir] para abrir qualquer modelo anteriormente
guardado. Os modelos são guardados com a extensão: .model. Se o modelo for previamente guardado da janela
do modelador, não lhe irá ser solicitado por um nome de ficheiro, uma vez que já existe um ficheiro associado ao
modelo, e será usado.

Antes de guardar o modelo, necessita de introduzir o nome e o grupo do modelo, usando as caixas de texto para
parte superior da janela.

Os modelos guardados na pasta modelos (a pasta padrão quando é pedido o nome do ficheiro para guardar o mod-
elo) irá aparecer na caixa de ferramentas na ligação correspondente. Quando a caixa de ferramentas é chamada,
ele procura na pasta modelos por ficheiros com a extensão :file:‘.model‘e carrega os modelos guardados. Uma
vez que o modelo é um próprio algoritmo, este pode ser adicionado na caixa de ferramentas como qualquer outro
algoritmo.

A pasta de modelos pode ser configurada a partir do diálogo de configuração do processamento, no grupo Mode-
lador

Os modelos carregados a partir da pasta modelos aparecem na caixa de ferramentas, mas também na árvore de
algoritmos do separador Algoritmos da janela do modelador. Isto significa que pode incorporar o modelo como
parte de um modelo maior, tal como adiciona qualquer outro algoritmo.

Em alguns casos, um modelo pode não ser carregado porque nem todos os algoritmos incluídos estão disponíveis.
Se tiver usado um dado algoritmo como parte do seu modelo, este deverá estar disponível (isto é, deverá aparecer
na caixa de ferramentas) de forma a carregar o modelo. Desactivando um fornecedor de algoritmos nas configu-
rações do da janela do processamento poderá desactivar o modelador, o que pode trazer problemas quando carrega
os modelos. Tenha isso em atenção quando tiver problemas a carregar ou a executar modelos.

17.3.4 Editando um modelo

Pode editar o modelo que criou, redefinindo o fluxo de trabalho e as relações entre os algoritmos e os dados de
entrada que defeniu no modelo.

Se clicar com o direito do rato num algoritmo na área que representa o modelo, irá ver o menu contexto como é
mostrado a seguir:
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Figura 17.21: Clique direito do Modelador

Seleccionando a opção Remover irá fazer com que o algoritmo para ser removido. Um algoritmo só pode ser
removido apenas se existir outros algoritmos dependentes dele. Isto é, se não estiver a ser usado um ficheiro de
saída de um algoritmo usado como ficheiro de entrada diferente. Se tentar remover um algoritmo que tenha outros
que dependa dele, uma mensagem de aviso igual à que vê aqui em baixo:

Figura 17.22: Não pode apagar o Algoritmo

Seleccionando a opção Editar ou fazendo simplesmente duplo clique no ícone do algoritmo, irá ser exibido o
diálogo de parâmetros do algoritmo, para que possa mudar os ficheiros de entrada e os valores do parâmetro.
Tenha em atenção que nem todos os elementos disponíveis no modelo aparecerão neste caso como ficheiros de
entrada disponível. Camadas ou valores gerados num passo mais avançado no fluxo de trabalho definido pelo
modelo não irá estar disponível se causar dependências em ciclo.

Seleccione novos valores e de seguida clique no botão [OK] como comum. As ligações entre os elementos do
modelo irão alterar de acordo com o enquadramento do modelador.

17.3.5 Activando e desactivando os algoritmos

Os algoritmos podem ser desactivados no modelador, para que não sejam executados a quando da execução do
modelo. Isto pode ser usado para teste, basta dar apenas uma parte do modelo, ou quando não necessita da geração
de todos os dados de saída.

Para desactivar um algoritmo, clique com o direito do rato no seu ícone no enquadramento do modelo e seleccione
a opção Desactivar. Irá ver que esse algoritmo é representado agora com uma etiqueta vermelha debaixo do seu
nome indicando que não está activa.

Figura 17.23: Desactivação

Todas as dependências dos algoritmos (directas e indirectas) nesse algoritmo irão também aparecer como inactivo,
uma vez não poderem ser executados.

Para activar um algoritmo, clique com o direito do rato no seu ícone e seleccione a opção Activar.
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17.3.6 Editando os ficheiros de ajuda do modelo e a meta-informação

Pode documentar os seus modelos a partir do próprio modelador. Basta apenas clicar no botão [Editar ajuda do
modelo] e o diálogo como aquele que irá aparecer.

Figura 17.24: Edição da Ajuda

No lado direito irá ver uma página simples HTML, criada usando a descrição dos parâmetros de entrada e de saída
do algoritmo, juntamente com itens adicionais como uma descrição geral do modelo ou o seu autor. A primeira
vez que abre o editor da ajuda, todas as ajudas estão vazias, mas pode editá-los usando os elementos do lado
esquerdo do diálogo. Seleccione um elemento na parte superior e escreva a descrição na caixa de texto em baixo.

A ajuda do Modelo é guardada num ficheiro na mesma pasta ao pé do seu respectivo modelo. Não tem de ser
preocupar como guardá-lo, uma vez ser feito automaticamente.

17.3.7 Sobre os algoritmos disponíveis

Poderá notar que alguns algoritmos podem ser executados a partir da caixa de ferramentas mas não aparecem na
lista de algoritmos disponíveis quando está a desenhar o modelo. Para ser incluído no modelo, o algoritmo deve ter
uma semântica correcta, assim como ligações apropriadas a outros fluxos de trabalho. Se um algoritmo não tiver
uma boa semântica bem definida (por exemplo, se o número de camadas de saída não são conhecidas), portanto
não é possível usá-lo dentro do modelo, e não aparece na lista na janela do diálogo do modelador.

Adicionalmente, irá ver algoritmos no modelador que não se encontram na caixa de ferramentas. Esses algoritmos
são para ser usados exclusivamente como parte do modelo, e eles não têm interesse noutro contexto diferente.
O algoritmo ‘Calculadora’ é um exemplo disso. É apenas uma simples calculadora aritmética que pode usar
para modificar valores numéricos (introduzidos pelo utilizador ou gerados por outro tipo de algoritmo). Estas
ferramentas são realmente úteis dentro do modelo, mas fora do contexto, não fazem sentido.

17.3.8 Guardando os modelos como código Python

Dado um modelo, é possível automaticamente criar um código Python que executa as mesmas tarefas do próprio
modelo. Este código é usado para criar um script para a consola. (será explicado mais tarde neste modelo) e
poderá modificar o script para incorporar em acções e métodos que não estão disponíveis no modelador gráfico,
como loops ou instâncias condicionantes.

17.3. O modelador gráfico 203



QGIS User Guide, Versão 2.2

Esta característica é também uma forma prática de aprender como usar os algoritmos do processamento a partir
da consola e como criar novos algoritmos usando código Python, portanto pode usá-lo como uma ferramenta de
aprendizagem quando começar a criar os seus próprios scripts.

Guarde o seu modelo na pasta de modelos e vá para a caixa de ferramentas onde deverá aparecer, pronto para ser
executado. Clique com o direito do rato no nome do modelo e seleccione Guardar como script Python no menu
contexto que irá ser exibido. A caixa de diálogo irá pedir-lhe para introduzir o ficheiro no qual deseja guardar o
script.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

17.4 A interface do processamento em lote

17.4.1 Introdução

Todos os algoritmos (incluindo modelos) podem ser executados como um processo descontínuo. Isto é, eles podem
ser executados não utilizando apenas um único conjunto de entradas, mas alguns delas, a execução do algoritmo
tantas vezes quanto necessário. Isto é útil quando se processa grandes quantidades de dados, uma vez que não será
necessário iniciar o algoritmo várias vezes na caixa de ferramentas.

Para executar um algoritmo como um processamento em lote, clique com o direito do mouse na caixa de ferra-
mentas e selecione a opção Executar como processamento em lote no balão de opções que irá aparecer.

Figura 17.25: Clique no botão direito do mouse para processar em lote

17.4.2 Os parâmetros da tabela

A execução de um processamento em lote é semelhante à execução única de um algoritmo. Os valores do
parâmetro têm de ser definidos, mas neste caso nós necessitamos um conjunto de parâmetros, uma para cada
vez que o algoritmo é executado. Os valores são introduzidos usando uma tabela como é mostrada a seguir.

Cada linha desta tabela representa uma única execução do algoritmo, e cada célula contém o valor de um dos
parâmetros. É semelhante aos parâmetros do diálogo que vê quando executa o algoritmo a partir da caixa de
ferramentas, mas com uma diferente disposição.

Por defeito, a tabela contém apenas duas linhas. Pode adicionar ou remover linhas usando os botões na parte
inferior da janela.

Uma vez que o tamanho da tabela for configurado, terá de ser preenchido com os valores desejados.

17.4.3 Preenchendo os parâmetros da tabela

Para a maioria dos parâmetros, a configuração do valor é trivial. Basta digitar o valor ou selecioná-lo na lista de
opções disponíveis, dependendo do tipo de parâmetro.

As principais diferenças são encontradas para os parâmetros que representam camadas ou tabelas, e caminho de
arquivo de saída. Quanto camadas de entrada e tabelas, representam um algoritmo que será executado como parte
de um processo de grupo, os objetos de dados de entrada são levados diretamente a partir de arquivos, e não a partir
do conjunto deles já aberto no QGIS. Por esta razão, qualquer algoritmo pode ser executado como um processo
em lote, mesmo que os objetos de dados ao todo não sejam abertos e o algoritmo não possa ser executado a partir
da caixa de ferramentas.
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Figura 17.26: Processamento em Lote

Nomes de arquivos de objetos de dados de entrada são introduzidos digitando diretamente ou, mais conveniente-

mente, clicando no botão do lado direito da célula, o que mostra uma janela típica de seleção de arquivos.
Múltiplos arquivos podem ser selecionados de cada vez. Se o parâmetro de entrada representa um único objeto
de dados e vários arquivos são selecionados, cada um deles será colocado em uma linha separada, acrescentando
novos, se necessário. Se o parâmetro representa uma entrada múltipla, todos os arquivos selecionados serão adi-
cionados a uma única célula, separados por ponto e vírgula (;).

Objetos de dados de saída sempre são salvos em um arquivo e, ao contrário, quando a execução de um algoritmo
a partir da caixa de ferramentas, salvar em um arquivo temporário não é permitido. Você pode digitar o nome
diretamente ou usar a janela de diálogo de seleção de arquivos que aparece ao clicar no botão que o acompanha.

Um vez selecionado o arquivo, um novo diálogo será exibido para permitir que faça o auto-preenchimento das
outras células na mesma coluna (o mesmo parâmetro).

Figura 17.27: Salvar Processamento em Lote

Se o valor padrão (‘Não efetuar auto-preenchimento’) é selecionado, irá apenas por o nome do arquivo selecionado
na célula selecionada da tabela de parâmetros. Se alguma das outras opções estiver selecionada, todas as células
abaixo da selecionada irão automaticamente ser preenchidas baseando-se no critério definido. Desta forma, é mais
fácil preencher a tabela, e o processamento em lote pode ser definido com menor esforço.

O preenchimento automático pode ser feito simplesmente adicionando números relativos ao caminho do arquivo
selecionado, ou acrescentando o valor de outro campo na mesma linha. Isto é particularmente útil para nomear
objetos de dados de saída de acordo com os de entrada.
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Figura 17.28: Caminho do Arquivo do Processamento em Lote

17.4.4 Executando o processo em lote

Após a introdução de todos os valores necessários pode executar o processamento em lote, apenas clicando em
[OK]. O progresso global da tarefa de processamento será exibido na barra de progresso na parte inferior do
diálogo.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

17.5 Usando os algoritmos do processamento a partir da consola

The console allows advanced users to increase their productivity and perform complex operations that cannot be
performed using any of the other GUI elements of the processing framework. Models involving several algorithms
can be defined using the command-line interface, and additional operations such as loops and conditional sentences
can be added to create more flexible and powerful workflows.

There is not a proccesing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

O código que pode executar a partir da consola Python, mesmo quando não chama nenhum método específico do
processamento, pode ser convertido num novo algoritmo que pode mais tarde chamar da caixa de ferramentas, o
modelador gráfico ou qualquer outro componente, como faz para outro algoritmo. De facto, alguns algoritmos
que encontra na caixa de ferramentas são scripts simples.

In this section, we will see how to use processing algorithms from the QGIS Python console, and also how to write
algorithms using Python.

17.5.1 Chamando os algoritmos a partir da consola Python

A primeira coisa que tem de fazer é importar as funções do processamento com a seguinte linha:

>>> import processing

Now, there is basically just one (interesting) thing you can do with that from the console: execute an algorithm.
That is done using the runalg() method, which takes the name of the algorithm to execute as its first parameter,
and then a variable number of additional parameters depending on the requirements of the algorithm. So the first
thing you need to know is the name of the algorithm to execute. That is not the name you see in the toolbox, but
rather a unique command–line name. To find the right name for your algorithm, you can use the algslist()
method. Type the following line in your console:

>>> processing.alglist()

Irá ver algo como isto.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
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Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Esta é a lista de todos os algoritmos disponíveis, ordenados alfabeticamente, juntamente com os seus nomes da
linha de comandos correspondentes.

You can use a string as a parameter for this method. Instead of returning the full list of algorithms, it will only
display those that include that string. If, for instance, you are looking for an algorithm to calculate slope from a
DEM, type alglist("slope") to get the following result:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]

Este resultado pode mudar dependendo dos algoritmos que estão disponíveis.

Agora é mais fácil encontrar o algoritmo que procura e o seu nome da linha de comandos, neste caso
saga:slopeaspectcurvature.

Once you know the command-line name of the algorithm, the next thing to do is to determine the right syntax to
execute it. That means knowing which parameters are needed and the order in which they have to be passed when
calling the runalg() method. There is a method to describe an algorithm in detail, which can be used to get a
list of the parameters that an algorithm requires and the outputs that it will generate. To get this information, you
can use the alghelp(name_of_the_algorithm) method. Use the command-line name of the algorithm,
not the full descriptive name.

Calling the method with saga:slopeaspectcurvature as parameter, you get the following description:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Agora tem tudo o que necessita de correr qualquer algoritmo. Como já tínhamos mencionado, existe apenas um
comando para executar algoritmos: runalg(). A sua síntaxe é como está descrito a seguir:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

A lista de parâmetros e ficheiros de saída para adicionar dependem do algoritmo que quer correr, e é exactamente
a lista que o método alghelp() lhe dá, na mesma ordem que é exibido.

Depending on the type of parameter, values are introduced differently. The next list gives a quick review of how
to introduce values for each type of input parameter:

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
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layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Selecção. Se algum algoritmo tiver um parâmetro de selecção, o valor desse parâmetro deve ser introduzido
usando um valor inteiro. Para saber as opções disponíveis, pode usar o comando algoptions(), como é
exibido no seguinte exemplo:

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In this case, the algorithm has one such parameter, with seven options. Notice that ordering is zero-based.

• Multiple input. The value is a string with input descriptors separated by semicolons (;). As in the case of
single layers or tables, each input descriptor can be the data object name, or its file path.

• Campo da Tabela de XXX. Use uma cadeia de texto com o nome do campo a usar. O parâmetro é caso
sensitivo.

• Fixed Table. Type the list of all table values separated by commas (,) and enclosed between quotes (").
Values start on the upper row and go from left to right. You can also use a 2-D array of values representing
the table.

• SRC. Introduza o número do código ESPG do SRC desejado.

• Extensão. Deve usar uma cadeia de texto com xmin, xmax, ymin e ymax valores separados por vírgulas
(,).

Os parâmetros booleanos, de ficheiro, cadeia de texto e númericos não necessitam de explicações adicionais.

Input parameters such as strings, booleans, or numerical values have default values. To use them, specify None
for the corresponding parameter entry.

For output data objects, type the file path to be used to save it, just as it is done from the toolbox. If you want to
save the result to a temporary file, use None. The extension of the file determines the file format. If you enter
a file extension not supported by the algorithm, the default file format for that output type will be used, and its
corresponding extension appended to the given file path.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to the map canvas, you have to do it
yourself after running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the
handy methods provided for such tasks.

The runalg method returns a dictionary with the output names (the ones shown in the algorithm description)
as keys and the file paths of those outputs as values. You can load those layers by passing the corresponding file
paths to the load() method.

17.5.2 Funções adicionais para a manipulação dos dados

Além das funções usadas para chamar os algoritmos, importar o pacote processamento irá também importar
algumas funções adicionais que facilitará o trabalho dos dados, particularmente os dados vectoriais. Estas funções
de conveniência que envolvem alguma funcionalidade a partir da API do QGIS, usualmente com uma sintaxe
menos complexa. Estas funções devem ser usadas quando são programados novos algoritmos, para tornar mais
fácil a operação com o os dados de entrada.

Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.
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• getobject(obj): Retorna um objecto|qg| (uma camada ou tabela) a partir de um objecto que passou,
que pode ser um nome de ficheiro ou o nome do objecto na Tabela de Conteúdos do QGIS.

• values(layer, fields): Returns the values in the attributes table of a vector layer, for the passed
fields. Fields can be passed as field names or as zero-based field indices. Returns a dict of lists, with the
passed field identifiers as keys. It considers the existing selection.

• getfeatures(layer): Retorna um iterador sobre os elementos da camada vectorial, considerando a
selecção existente.

• uniquelabels(layer, field): Returns a list of unique values for a given attribute. Attributes can
be passed as a field name or a zero-based field index. It considers the existing selection.

17.5.3 Criando scripts e correndo-os a partir da caixa de ferramentas

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed to define the semantics of the algorithm. You can find a Create new script
menu under the Tools group in the Script algorithms block of the toolbox. Double-click on it to open the script
editing dialog. That’s where you should type your code. Saving the script from there in the scripts folder (the
default folder when you open the save file dialog) with .py extension will automatically create the corresponding
algorithm.

O nome do algoritmo (aquele que irá ver na caixa de ferramentas) é criado a partir do nome do ficheiro, removendo
a extensão e substituindo os hífens inferiores com espaços em branco.

Let’s have a look at the following code, which calculates the Topographic Wetness Index (TWI) directly from a
DEM.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, the calculation involves three algorithms, all of them coming from SAGA. The last one calculates
the TWI, but it needs a slope layer and a flow accumulation layer. We do not have these layers, but since we have
the DEM, we can calculate them by calling the corresponding SAGA algorithms.

A parte do código onde este processamento tem lugar não é difícil de perceber se leu-o as secções anteriores deste
capítulo. Contudo, as primeiras linhas, necessitam de uma explicação adicional. Eles fornecem a informação que
é necessária para tornar o código num algortimo que possa ser corrido a partir qualquer componente do GUI, como
por exemplo a caixa de ferramentas ou o modelador gráfico.

These lines start with a double Python comment symbol (##) and have the following structure:

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processing scripts, their syntax and some examples.

• raster. A raster layer.

• vector. A vector layer.

• table. A table.

• number. A numerical value. A default value must be provided. For instance, depth=number 2.4.

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor.

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True.
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• múltiplos raster. Um conjunto de camadas rasters de entrada.

• vectores múltiplos. Um conjunto de camadas vectoriais de entrada.

• campo. Um campo da tabela de atributos de uma camada vectorial. O nome da camada tem de ser
adicionada depois da etiqueta campo. Por exemplo, se declarou um ficheiro de entrada vectorial com
mylayer=vector, poderá usar myfield=field mylayer para adicionar o campo a partir dessa
camada como parâmetro.

• folder. A folder.

• file. A filename.

O nome do parâmetro é o nome que será exibido ao utilizador quando executa o algoritmo, e também o nome da
variável a usar no código do script. O valor introduzido pelo utilizador para esse parâmetro será atibuído à variável
com esse nome.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
low hyphens with spaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and table values are strings containing the file path of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the file paths to all selected object, separated by semicolons (;).

Os ficheiros de saída são definidos numa maneira semelhante, usando as seguintes etiquetas:

• raster de saída

• vector de saída

• tabela de saída

• html de saída

• ficheiro de saída

• número de saída

• cadeia de texto de saída

The value assigned to the output variables is always a string with a file path. It will correspond to a temporary file
path in case the user has not entered any output filename.

When you declare an output, the algorithm will try to add it to QGIS once it is finished. That is why, although the
runalg() method does not load the layers it produces, the final TWI layer will be loaded (using the case of our
previous example), since it is saved to the file entered by the user, which is the value of the corresponding output.

Do not use the load() method in your script algorithms, just when working with the console line. If a layer is
created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly use
the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, you have to assign a value to them. To do so,
just set the value of a variable with the name you used to declare that output. For instance, if you have used this
declaration,

##average=output number

a linha seguinte irá configurar o valor de saída para 5:

average = 5

Em adição às etiquetas para os parâmetros e ficheiros de saída, pode também definir o grupo onde o algoritmo
será exibido, usando a etiqueta group.

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two possible methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.
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Several examples are provided. Please check them to see real examples of how to create algorithms using the
processing framework classes. You can right-click on any script algorithm and select Edit script to edit its code or
just to see it.

17.5.4 Documentando os seus scripts

As in the case of models, you can create additional documentation for your scripts, to explain what they do and
how to use them. In the script editing dialog, you will find an [Edit script help] button. Click on it and it will
take you to the help editing dialog. Check the section about the graphical modeler to know more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving the script for the first time. If you later close the script editing dialog
without saving the script (i.e., you discard it), the help content you wrote will be lost. If your script was already
saved and is associated to a filename, saving the help content is done automatically.

17.5.5 Pré- e pós-execução de encaixe da script

Os scripts podem também ser usados para definir um encaixe de pré- e pós-execução que correm antes e depois do
algoritmo correr. Isto pode ser usado para automatizar tarefas que serão executados quando qualquer algoritmo é
executado.

A sintaxe é identica à sintaxe explicada em cima, mas uma variável global alg está disponível, representando o
algoritmo que foi (ou está prestes a ser) executado.

In the General group of the processing configuration dialog, you will find two entries named Pre-execution script
file and Post-execution script file where the filename of the scripts to be run in each case can be entered.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

17.6 Gestão do histórico

17.6.1 O histórico do processamento

Cada vez que executa um algoritmo, a informação do processo é armazenado no gestor histórico. Juntamente com
os parâmetros usados, a data e o tempo de execução são também guardados.

This way, it is easy to track and control all the work that has been developed using the processing framework, and
easily reproduce it.

The history manager is a set of registry entries grouped according to their date of execution, making it easier to
find information about an algorithm executed at any particular moment.

A informação do processo é mantida como uma expressão de linha de comandos, mesmo se o algoritmo seja
lançado a partir da barra de ferramentas. Isto permite ser útil para aqueles que querem aprender como se usa a
interface da linha de comandos, uma vez que podem chamar o algortimo usando a barra de ferramentas e verificar
o gestor histórico para ver como o mesmo algoritmo pode ser chamado a partir da linha de comandos.

Apart from browsing the entries in the registry, you can also re-execute processes by simply double-clicking on
the corresponding entry.

Along with recording algorithm executions, the processing framework communicates with the user by means of
the other groups of the registry, namely Errors, Warnings and Information. In case something is not working
properly, having a look at the Errors might help you to see what is happening. If you get in contact with a
developer to report a bug or error, the information in that group will be very useful for her or him to find out what
is going wrong.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is stored in the Information group
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Figura 17.29: Histórico

each time you run one of those algorithms. If, for instance, you are having problems executing a SAGA algorithm,
look for an entry named ‘SAGA execution console output’ to check all the messages generated by SAGA and try
to find out where the problem is.

Some algorithms, even if they can produce a result with the given input data, might add comments or additional
information to the Warning block if they detect potential problems with the data, in order to warn you. Make sure
you check those messages if you are having unexpected results.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

17.7 Configurando as aplicações externas

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external application are managed by their own algorithm provider.

This section will show you how to configure the processing framework to include these additional applications,
and it will explain some particular features of the algorithms based on them. Once you have correctly configured
the system, you will be able to execute external algorithms from any component like the toolbox or the graphical
modeler, just like you do with any other geoalgorithm.

By default, all algorithms that rely on an external appplication not shipped with QGIS are not enabled. You can
enable them in the configuration dialog. Make sure that the corresponding application is already installed in your
system. Enabling an algorithm provider without installing the application it needs will cause the algorithms to
appear in the toolbox, but an error will be thrown when you try to execute them.

This is because the algorithm descriptions (needed to create the parameters dialog and provide the information
needed about the algorithm) are not included with each application, but with QGIS instead. That is, they are part
of QGIS, so you have them in your installation even if you have not installed any other software. Running the
algorithm, however, needs the application binaries to be installed in your system.
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17.7.1 Uma nota para utilizadores Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the OSGeo4W application. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms in the simplified view of the toolbox will be ready to be run without needing any further
configuration.

If you want to know more about how these providers work, or if you want to use some algorithms not included in
the simplified toolbox (such as R scripts), keep on reading.

17.7.2 Uma nota para os formatos dos ficheiros

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

Usando as camadas raster GRASS, por exemplo, um dos casos em que pode ter problema e não seja possível
completar o seu trabalho é se chamar um algoritmo externo usando uma camada como ficheiro de entrada. Por
esta razão, essas camadas não irão aparecer como disponíveis para os algoritmos.

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common raster layer formats that can later
be transformed by QGIS automatically. As in the case of input layers, if this conversion is needed, that might
increase the processing time.

If the extension of the filename specified when calling an algorithm does not match the extension of any of the
formats supported by QGIS, then a suffix will be added to set a default format. In the case of raster layers, the
.tif extension is used, while .shp is used for vector layers.

17.7.3 Uma nota para as selecções da camada vectorial

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

Noutros casos, exportando apenas os elementos seleccionados é necessário, o que em alguns casos os tempos de
execução serão mais longos.

SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.
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If you have installed SAGA yourself (remember, you need version 2.1), the path to the SAGA executable must be
configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named SAGA
Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you are
ready to run SAGA algorithms from QGIS.

If you are running Linux, SAGA binaries are not included with SEXTANTE, so you have to download and install
the software yourself. Please check the SAGA website for more information. SAGA 2.1 is needed.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folders.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

17.7.4 Sobre as limitações do sistema de grelhas do SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

The definition of that common grid system is controlled by the user, and you will find several parameters in the
SAGA group of the settings window to do so. There are two ways of setting the target grid system:

• Setting it manually. You define the extent by setting the values of the following parameters:

– Reamostragem do X min

– Reamostragem do X máx

– Reamostragem do Y min

– Reamostragem do Y máx

– Reamostragem do tamanho da célula

Tenha em atenção que o QGIS irá reamostrar as camadas de entrada para essa extensão, mesmo que não se
sobreponham.

• Setting it automatically from input layers. To select this option, just check the Use min covering grid system
for resampling option. All the other settings will be ignored and the minimum extent that covers all the
input layers will be used. The cell size of the target layer is the maximum of all cell sizes of the input layers.

Para algoritmos que não usam camadas raster múltiplas, ou para aquelas que não necessitam de um único sistema
de grelha de entrada, não será feito uma reamostragem antes de chamar o SAGA, e esses parãmetros não serão
usados.

17.7.5 Limitações para camadas multi-banda

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).

17.7.6 Limitations in cell size

SAGA assumes that raster layers have the same cell size in the X and Y axis. If you are working with a layer with
different values for horizontal and vertical cell size, you might get unexpected results. In this case, a warning will
be added to the processing log, indicating that an input layer might not be suitable to be processed by SAGA.
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17.7.7 Registando

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.

Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

A maioria dos outros fornecedores que usam uma aplicação externa e chamam a partir da linha de comandos têm
opções semelhantes, portanto irá encontrar noutros sítios da lista de configurações do processamento.

R. Creating R scripts

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can run
(except for a few examples). Instead, you should write your scripts and call R commands, much like you would do
from R, and in a very similar manner to what we saw in the section dedicated to processing scripts. This section
shows you the syntax to use to call those R commands from QGIS and how to use QGIS objects (layers, tables)
in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell QGIS where your R binaries are located.
You can do this using the R folder entry in the processing configuration dialog. Once you have set that parameter,
you can start creating and executing your own R scripts.

Uma vez mais, isto é diferente no Linux, e só tem de ter certeza que a pasta do R está incluída na variável de
ambiente PATH. Se conseguir iniciar o R, apenas introduza R na consola, e estará pronto a começar.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

R script files have the extension .rsx, and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can set this folder in the R settings group
(available from the processing settings dialog), just like you do with the folder for regular processing scripts.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the SEXTANTE
scripts that we have already seen, so they will not be described here again. Check the processing_scripts section
for more information.

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of a
parameter is also the name of the variable that we can use in R for accesing the value of that parameter (thus, you
should avoid using reserved R words as parameter names).
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Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Tables are opened using the read.csv() command. If a table entered by the user is not in CSV format, it will
be converted prior to importing it into R.

Additionally, raster files can be read using the readGDAL() command instead of brick() by using the
##usereadgdal.

If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilename tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

Com a informação em cima, podemos agora perceber a primeira linha do nosso primeiro script exemplo (a primeira
linha que não começa com o comentário Python).

pts=spsample(polyg,numpoints,type="random")

A variável polygon já contém o objecto SpatialPolygonsDataFrame, portanto pode ser usado para
chamar o método spsample, tal como o numpoints, que indica o número de pontos a ser adicionados à
grelha de amostra criada.

Since we have declared an output of type vector named out, we have to create a variable named out and store a
Spatial*DataFrame object in it (in this case, a SpatialPointsDataFrame). You can use any name for
your intermediate variables. Just make sure that the variable storing your final result has the same name that you
used to declare it, and that it contains a suitable value.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
#dontuserasterpackage option. In you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

Se usou a opção #passfilename, os ficheiros de sáida são gerados usando o pacote raster (com
writeRaster()), mesmo que não seja usado nos ficheiros de entrada.

If your algorithm does not generate any layer, but rather a text result in the console instead, you have to indicate
that you want the console to be shown once the execution is finished. To do so, just start the command lines that
produce the results you want to print with the > (‘greater’) sign. The output of all other lines will not be shown.
For instance, here is the description file of an algorithm that performs a normality test on a given field (column) of
the attributes of a vector layer:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Se o seu algoritmo criar qualquer tipo de gráficos (usando o método ‘‘plot()), adicione a seguinte linha:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Tanto os gráficos como os resultados da consola serão exibidos no gestor de resultados do processamento.

For more information, please check the script files provided with SEXTANTE. Most of them are rather simple and
will greatly help you understand how to create your own scripts.
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Nota: rgdal and maptools libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R distribution).
However, other additional libraries that you might need have to be explicitly loaded. Just add the necessary com-
mands at the beginning of your script. You also have to make sure that the corresponding packages are installed in
the R distribution used by QGIS. The processing framework will not take care of any package installation. If you
run a script that requires a package that is not installed, the execution will fail, and SEXTANTE will try to detect
which packages are missing. You must install those missing libraries manually before you can run the algorithm.

GRASS

Configurar o GRASS não é muito diferente de configurar o SAGA. Primeiro, o caminho para a pasta GRASS tem
de ser definida, mas apenas se estiver a correr o Windows. Adicionalmente, um interpretador shell, (normalmente
o msys.exe, que pode ser encontrado na maioria das distribuições do GRASS para o Windows) tem de ser
definido e o seu caminho configurado.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

Se está a trabalhar em Linux, só necessita de ter a certeza que o GRASS está correctamente instalado, e pode ser
executado sem problema a partir da consola.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behaviour you prefer, just check the
Use min covering region option in the GRASS configuration parameters.

The last parameter that has to be configured is related to the mapset. A mapset is needed to run GRASS, and the
processing framework creates a temporary one for each execution. You have to specify if the data you are working
with uses geographical (lat/lon) coordinates or projected ones.

GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

Orfeo Toolbox

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are runing Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Then, configure the path to the folder where OTB command-line tools and libraries are installed:

• Usually OTB applications folder points to /usr/lib/otb/applications and OTB command line
tools folder is /usr/bin.

• If you use the OSGeo4W installer, then install otb-bin package and enter
C:\OSGeo4W\apps\orfeotoolbox\applications as OTB applications folder and
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C:\OSGeo4W\bin as OTB command line tools folder. These values should be configured by de-
fault, but if you have a different OTB installation, configure them to the corresponding values in your
system.

TauDEM

To use this provider, you need to install TauDEM command line tools.

17.7.8 Windows

Please visit the TauDEM homepage for installation instructions and precompiled binaries for 32-bit and 64-bit
systems. IMPORTANT: You need TauDEM 5.0.6 executables. Version 5.2 is currently not supported.

17.7.9 Linux

There are no packages for most Linux distributions, so you should compile TauDEM by yourself. As TauDEM
uses MPICH2, first install it using your favorite package manager. Alternatively, TauDEM works fine with Open
MPI, so you can use it instead of MPICH2.

Download TauDEM 5.0.6 source code and extract the files in some folder.

Open the linearpart.h file, and after line

#include "mpi.h"

add a new line with

#include <stdint.h>

e irá obter

#include "mpi.h"
#include <stdint.h>

Save the changes and close the file. Now open tiffIO.h, find line #include "stdint.h" and replace
quotes () with <>, so you’ll get

#include <stdint.h>

Save the changes and close the file. Create a build directory and cd into it

mkdir build
cd build

Configure your build with the command

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

e de seguida compile

make

Finally, to install TauDEM into /usr/local/bin, run

sudo make install

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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17.8 Linha de Comandos SEXTANTE

SEXTANTE includes a practical tool that allows you to run algorithms without having to use the toolbox, but just
by typing the name of the algorithm you want to run.

This tool is known as the SEXTANTE Commander, and it is just a simple text box with autocompletion where you
type the command you want to run.

Figura 17.30: Linha de Comandos SEXTANTE

The Commander is started from the Analysis menu or, more practically, by pressing Shift + Ctrl + M (you
can change that default keyboard shortcut in the QGIS configuration, if you prefer a different one). Apart from
executing SEXTANTE algorithms, the Commander gives you access to most of the functionality in QGIS, which
means that it gives you a practical and efficient way of running QGIS tasks and allows you to control QGIS with
reduced usage of buttons and menus.

Moreover, the Commander is configurable, so you can add your custom commands and have them just a few
keystrokes away, making it a powerful tool to help you become more productive in your daily work with QGIS.

17.8.1 Comandos disponíveis

The commands available in the Commander fall in the following categories:

• SEXTANTE algorithms. These are shown as SEXTANTE algorithm: <name of the
algorithm>.

• Menu items. These are shown as Menu item: <menu entry text>. All menus items available
from the QGIS interface are available, even if they are included in a submenu.

• Python functions. You can create short Python functions that will be then included in the list of available
commands. They are shown as Function: <function name>.

To run any of the above, just start typing and then select the corresponding element from the list of available
commands that appears after filtering the whole list of commands with the text you have entered.

No caso de chamar uma função Python, pode seleccionar uma entrada da lista, que tem o prefixo de
Função: (para a instância, Função: removeall), ou apenas escreva directamente o
nome da função (‘‘removeall no exemplo anterior). Não existe necessidade de adicionar parêntesis
após o nome da função.

17.8.2 Criando funções personalizadas

As funções personalizadas são adicionadas ao introduzir o código Python correspondente no ficheiro
commands.py que pode ser encontrado .qgis/sextante/commander directory na pasta do uti-
lizador. É apenas um ficheiro Python simples onde pode adicionar as funções que necessita.
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The file is created with a few example functions the first time you open the Commander. If you haven’t launched
the Commander yet, you can create the file yourself. To edit the commands file, use your favorite text editor. You
can also use a built-in editor by calling the edit command from the Commander. It will open the editor with the
commands file, and you can edit it directly and then save your changes.

Por exemplo, pode adicionar a seguinte função, que remove todas as camadas:

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Once you have added the function, it will be available in the Commander, and you can invoke it by typing
removeall. There is no need to do anything apart from writing the function itself.

Functions can receive parameters. Add *args to your function definition to receive arguments. When calling the
function from the Commander, parameters have to be passed separated by spaces.

Aqui está um exemplo de uma função que carrega uma camada e que tome como parâmetro o nome do ficheiro
da camada para carregar.

import sextante

def load(*args):
sextante.load(args[0])

If you want to load the layer in /home/myuser/points.shp, type load /home/myuser/points.shp
in the Commander text box.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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Compositor de Impressão

The Print Composer provides growing layout and printing capabilities. It allows you to add elements such as
the QGIS map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML
frames. You can size, group, align and position each element and adjust the properties to create your layout. The
layout can be printed or exported to image formats, PostScript, PDF or to SVG (export to SVG is not working
properly with some recent Qt4 versions; you should try and check individually on your system). You can save the
layout as a template and load it again in another session. Finally, generating several maps based on a template can
be done through the atlas generator. See a list of tools in table_composer_1:
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Ícone Finalidade Ícone Finalidade

Guardar Projecto Novo Compositor

Duplicar Compositor Gestor de Compositores

Carregar a partir do modelo Guardar como modelo

Print or export as PostScript Exportar como imagem

Exportar como SVG Exportar como PDF

Reverter à última alteração Restaurar a última alteração

Zoom Total Zoom to 100%

Aproximar Afastar

Refresh View

Pan Zoom to specific region

Seleccionar/ Mover item Mover conteúdo do item

Adicionar novo mapa do QGIS no enquadramento do mapa Adicionar imagem

Adicionar nova etiqueta Adicionar nova legenda

Add scale bar to print composition Adicionar forma básica

Adicionar seta Adicionar tabela de atributos

Add an HTML frame

Agrupar itens Desagrupar itens
Lock Selected Items Unlock All items

Elevar itens seleccionados Abaixar itens seleccionados

Trazer para a frente Enviar para trás

Alinhar à esquerda Alinhar à direita

Alinhar ao centro Centraliza na vertical

Alinhar ao topo Alinhar ao fundo

Preview Atlas First Feature

Previous Feature Next Feature

Last feature Print Atlas

Export Atlas as Image Atlas Settings

Tabela 1 do Compositor: Ferramentas do Compositor de Impressão

Todas as ferramentas do Compositor de Impressão estão disponíveis nos menus e como ícones na barra de fer-
ramentas. A barra de ferramentas pode ser desligada ou ligada usando o botão direito do rato sobre a barra de
ferramentas.

18.1 Primeiros passos

18.1.1 Abrir um novo Modelo de de Compositor de Impressão

Before you start to work with the Print Composer, you need to load some raster and vector layers in the QGIS
map canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized
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to your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will
be prompted to choose a title for the new Composer.

18.1.2 Usando o Compositor de Impressão

Opening the Print Composer provides you with a blank canvas to which you can add the current QGIS map
canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. Fig-
ure_composer_1 shows the initial view of the Print Composer before any elements are added.

Figura 18.1: Compositor de Impressão

The Print Composer provides four tabs:

• The Composition tab allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all elements will be rastered before printing or saving as PostScript or PDF. In this tab, you can
also customize settings for grid and smart guides.

• The Item Properties tab displays the properties for the selected item element. Click the Select/Move item

icon to select an element (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties tab
and customize the settings for the selected element.

• The Command history tab (hidden by default) displays a history of all changes applied to the Print Composer
layout. With a mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Atlas generation tab allows you to enable the generation of an atlas for the current Composer and gives
access to its parameters.

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number and a combo box to set the zoom level.
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You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

Ferramentas de Navegação

To navigate in the canvas layout, the Print Composer provides some general tools:

• Aproximar

• Afastar

• Zoom to full extent

• Zoom to 100%

• Actualiza a vista (se encotnrar uma vista com um estado insconscitente)

• Pan composer

• Marquee zoom mode (zoom to a specific region of the Composer)

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need to switch
to pan mode while working in the Composer area, you can hold the Spacebar or the the mouse wheel. With
Ctrl+Spacebar, you can temporarily switch to marquee zoom mode, and with Ctrl+Shift+Spacebar,
to zoom out mode.

18.1.3 Print Composer Options

From Settings → Composer Options you can set some options that will be used as default during your work.

• Compositions defaults let you specify the default font to use.

• With Grid appearance, you can set the grid style and its color.

• Grid defaults defines spacing, offset and tolerance of the grid. There are three types of grid: Dots, Solid
lines and Crosses.

• Guide defaults defines the tolerance for the guides.

18.1.4 Separador de Composição — Configuração geral da composição

No separador Composição, pode definir as configurações globais à sua composição.

• You can choose one of the Presets for your paper sheet, or enter your custom width and height.

• Composition can now be divided into several pages. For instance, a first page can show a map canvas, and
a second page can show the attribute table associated with a layer, while a third one shows an HTML frame
linking to your organization website. Set the Number of pages to the desired value. You can choose the

page Orientation and its Exported resolution. When checked, print as raster means all elements will be
rasterized before printing or saving as PostScript or PDF.

• Grid lets you customize grid settings like spacings, offsets and tolerance to your need.

• In Snap to alignments, you can change the Tolerance, which is the maximum distance below which an item
is snapped to smart guides.

Snap to grid and/or to smart guides can be enabled from the View menu. In this menu, you can also hide or show
the grid and smart guides.
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18.1.5 Opções gerais dos itens do Compositor

Composer items have a set of common properties you will find on the bottom of the Item Properties tab: Position
and size, Frame, Background, Item ID and Rendering (See figure_composer_2).

Figura 18.2: Janela comum das propriedades do item

• A janela Posição e tamanho permite que defina o tamanho e posição da moldura que contém o item. Pode
também escolher que Ponto de referência será configurado nas coordenadas X e Y previamente definidas.

• The Rotation sets the rotation of the element (in degrees).

• A Moldura mostra ou esconde a moldura à volta da etiqueta. Clique nos botões de [Cor] e [Espessura]
para ajustar essas propriedades.

• The Background enables or disables a background color. Click on the [Color...] button to display a
dialog where you can pick a color or choose from a custom setting. Transparency can also be adjusted
throught the alpha field.

• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
any potential web client. You can set an ID on an item (e.g., a map and a label), and then the web client can
send data to set a property (e.g., label text) for that specific item. The GetProjectSettings command will list
what items and which IDs are available in a layout.

• Rendering mode can be selected in the option field. See Rendering_Mode.

18.2 Modo de Renderização

QGIS now allows advanced rendering for Composer items just like vector and raster layers.

Figura 18.3: Modo de Renderização
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• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the the menu beside the slider.

• Blending mode: You can achieve special rendering effects with these tools that you previously only may
know from graphics programs. The pixels of your overlaying and underlaying items are mixed through the
settings described below.

– Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with
the pixel beneath it; the colors aren’t mixed.

– Lighten: This selects the maximum of each component from the foreground and background pixels.
Be aware that the results tend to be jagged and harsh.

– Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This
mode is most useful for mixing the texture of one layer with another layer (e.g., you can use a hillshade
to texture another layer).

– Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works
best if the top pixels aren’t too bright; otherwise the effect is too extreme.

– Addition: This blend mode simply adds pixel values of one layer with pixel values of the other. In case
of values above 1 (as in the case of RGB), white is displayed. This mode is suitable for highlighting
features.

– Darken: This creates a resultant pixel that retains the smallest components of the foreground and
background pixels. Like lighten, the results tend to be jagged and harsh.

– Multiply: Here, the numbers for each pixel of the top layer are multiplied with the numbers for the
corresponding pixel of the bottom layer. The results are darker pictures.

– Burn: Darker colors in the top layer cause the underlying layers to darken. Burn can be used to tweak
and colorise underlying layers.

– Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light
parts become lighter and dark parts become darker.

– Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This mode is supposed to emulate shining a soft light onto an image.

– Muita luz: Este modo é muito semelhante ao modo de sobreposição. É suposto simular a projecção de
uma luz muito intensa numa imagem.

– Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to
always get a positive value. Blending with black produces no change, as the difference with all colors
is zero.

– Subtract: This blend mode simply subtracts pixel values of one layer with pixel values of the other. In
case of negative values, black is displayed.

18.3 Itens do Compositor

18.3.1 Adicionando um enquadramento de mapa QGIS actual no Compositor de
Impressão

Click on the Add new map toolbar button in the Print Composer toolbar to add the QGIS map canvas. Now, drag
a rectangle onto the Composer canvas with the left mouse button to add the map. To display the current map, you
can choose between three different modes in the map Item Properties tab:

• Rectângulo é a configuração padrão. Apenas exibe uma caixa vazia com a mensagem ‘O mapa será im-
presso aqui’.
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• Cache renders the map in the current screen resolution. If you zoom the Composer window in or out, the
map is not rendered again but the image will be scaled.

• Render means that if you zoom the Composer window in or out, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache is the default preview mode for newly added Print Composer maps.

You can resize the map element by clicking on the Select/Move item button, selecting the element, and dragging
one of the blue handles in the corner of the map. With the map selected, you can now adapt more properties in the
map Item Properties tab.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map element frame with the left mouse button. After you have found the right place for an
element, you can lock the element position within the Print Composer canvas. Select the map element and click

on the right mouse button to Lock the element position and again to unlock the element. You can also lock the

map element by activating the Lock layers for map item checkbox in the Map dialog of the Item Properties
tab.

Propriedades principais

The Main properties dialog of the map Item Properies tab provides the following functionalities (see fig-
ure_composer_4):

Figura 18.4: Separador das propriedades da Mapa

• The Preview area allows you to define the preview modes ‘Rectangle’, ‘Cache’ and ‘Render’, as described
above. If you change the view on the QGIS map canvas by changing vector or raster properties, you can
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update the Print Composer view by selecting the map element in the Print Composer and clicking the
[Update preview] button.

• O campo Escala define a escala manual.

• The field Rotation allows you to rotate the map element content clockwise in degrees. Note that a
coordinate frame can only be added with the default value 0.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.

• You can choose to lock the layers shown on a map item. Check Lock layers for map item. After this is
checked, any layer that would be displayed or hidden in the main QGIS window won’t appear or be hidden
in the map item of the Composer. But style and labels of a locked layer are still refreshed according to the
main QGIS interface.

Extensões

The Extents dialog of the map item tab provides the following functionalities (see figure_composer_5):

Figura 18.5: Janela de Extensões do Mapa

• The Map extent area allows you to specify the map extent using Y and X min/max values or by clicking
the [Set to map canvas extent] button.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_2).

Grelha

The Grid dialog of the map Item Properties tab provides the following functionalities (see Figure_composer_6):

• The Show grid checkbox allows you to overlay a grid onto the map element. As grid type, you can
specify to use a solid line or cross. Symbology of the grid can be chosen. See section Rendering_Mode.
Furthermore, you can define an interval in the X and Y directions, an X and Y offset, and the width used for
the cross or line grid type.

• You can choose to paint the frame with a zebra style. If not selected, the general frame option is used (see
section Frame_dialog). Advanced rendering mode is also available for grids (see section Rendering_mode).

• The Draw coordinates checkbox allows you to add coordinates to the map frame. The annotation can
be drawn inside or outside the map frame. The annotation direction can be defined as horizontal, vertical,
horizontal and vertical, or boundary direction, for each border individually. Units can be in meters or in
degrees. Finally, you can define the grid color, the annotation font, the annotation distance from the map
frame and the precision of the drawn coordinates.
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Figura 18.6: Janela da Grelha do Mapa

Visão Global

The Overview dialog of the map Item Properties tab provides the following functionalities (see Fig-
ure_composer_7):

Figura 18.7: Janela da Visão Global do Mapa

If the Composer has more than one map, you can choose to use a first map to show the extents of a second map.
The Overview dialog of the map Item Properties tab allows you to customize the appearance of that feature.

• The Overview frame combo list references the map item whose extents will be drawn on the present map
item.

• The Overview Style allows you to change the frame color. See section vector_style_manager .

• The Overview Blend mode allows you to set different transparency blend modes, to enhance visibility of the
frame. See Rendering_Mode.

• If checked, Invert overview creates a mask around the extents: the referenced map extents are shown
clearly, whereas everything else is blended with the frame color.

18.3.2 Adicionando uma etiqueta ao Compositor de Impressão

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties tab.

The Item Properties tab of a label item provides the following functionalities:
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Figura 18.8: Separador das propriedades da Etiqueta

Propriedades principais

The Main properties dialog of the label Item Properties tab provides the following functionalities (see Fig-
ure_composer_9):

Figura 18.9: Janela Principal das propriedades da Etiqueta

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Labels can be interpreted as HTML code: check Render as HTML. You can now insert a URL, a
clickable image that links to a web page or something more complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. On the right side of the Insert an
expression dialog, the help file associated with the function selected is displayed. Two special categories
can be useful, particularly associated with the atlas functionality: geometry functions and records functions.
At the bottom, a preview of the expression is shown.

• Define font and font color by clicking on the [Font] and [Font color...] buttons.

Alinhamentos e Exibição

The Alignment and Display dialogs of the label Item Properties tab provide the following functionalities (see
Figure_composer_10):
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Figura 18.10: Janelas do Alinhamento e Exibição da Etiqueta

• You can define the horizontal and vertical alignment in the Alignment zone.

• No rótulo Exibição, pode definir a margem em mm e/ou o ângulo de rotação em graus para o texto.

18.3.3 Adicionando uma imagem ao Compositor de Impressão

To add an image, click the Add image icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the image Item Properties tab.

The image Item Properties tab provides the following functionalities (see figure_composer_11):

Figura 18.11: Separador Propriedades do Item da Imagem

Propriedades principais, Directórios de pesquisa e Rotação

The Main properties and Search directories dialogs of the image Item Properties tab provide the following func-
tionalities (see Figure_composer_12):

• A janela das Propriedades principais mostra a imagem actual que é exibida no item imagem. Clique no
botão [...] para seleccionar um ficheiro do teu computador.

• Esta janela mostra todas as imagens armazenadas nos caminhos seleccionados.

• The Search directories area allows you to add and remove directories with images in SVG format to the
picture database.

• Images can be rotated with the Rotation field.

• Activating the Sync with map checkbox synchronizes the rotation of a picture in the QGIS map canvas
(i.e., a rotated north arrow) with the appropriate Print Composer image.
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Figura 18.12: Janelas das Propriedades principais da imagem, Directórios de pesquisa e Rotação

18.3.4 Adicionando uma Legenda ao Compositor de Impressão

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties tab.

The Item properties of a legend item tab provides the following functionalities (see figure_composer_14):

Figura 18.13: Propriedades do Separador da Legenda
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Propriedades principais

The Main properties dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_14):

Figura 18.14: Janela das Propriedades principais da Legenda

• Here, you can adapt the legend title.

• You can also choose which Map item the current legend will refer to in the select list.

• Since QGIS 1.8, you can wrap the text of the legend title on a given character.

Itens Legenda

The Legend items dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_15):

Figura 18.15: Legenda da Janela dos itens da Legenda

• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, and edit layer names. After changing the symbology in the QGIS main window,
you can click on [Update] to adapt the changes in the legend element of the Print Composer. The item order
can be changed using the [Up] and [Down] buttons or with ‘drag-and-drop’ functionality.

• The feature count for each vector layer can be shown by enabling the [Sigma] button.

• The legend will be updated automatically if Auto-update is checked.

Fontes, Colunas, Símbolos e Espaçamento

The Fonts, Columns, Symbol and Spacing dialogs of the legend Item Properties tab provide the following func-
tionalities (see figure_composer_16):
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Figura 18.16: Legenda da Janela Fontes, Colunas, Símbolos e Espaçamento
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• Pode mudar a fonte do título, grupo, subgrupo, e item (camada) no item legenda. Clique no botão da
categoria para abrir a janela de Seleccionar fonte.

• All these items will get the same Color.

• Os itens Legenda pode ser arranjado em várias colunas. Seleccione o valor correcto no campo Contagem
.

• Equal column widths sets how legend columns should be adjusted.

• The Split layers option allows a categorized or a graduated layer legend to be divided between columns.

• You can change the width and height of the legend symbol in this dialog.

• Spacing aroung title, group, subgroup, symbol, icon label, box space or column space can be customized
through this dialog.

18.3.5 Adding a Scale Bar item to the Print Composer

To add a scale bar, click the Add new scalebar icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the scale bar Item Properties tab.

The Item properties of a scale bar item tab provides the following functionalities (see figure_composer_17):

Figura 18.17: Scale Bar Item properties Tab

Propriedades principais

The Main properties dialog of the scale bar Item Properties tab provides the following functionalities (see fig-
ure_composer_18):

Figura 18.18: Scale Bar Main properties Dialog

• First, choose the map the scale bar will be attached to.

• Then, choose the style of the scale bar. Six styles are available:

– Single box and Double box styles, which contain one or two lines of boxes alternating colors.
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– Middle, Up or Down line ticks.

– Numeric, where the scale ratio is printed (i.e., 1:50000).

Unidades e Segmentos

The Units and Segments dialogs of the scale bar Item Properties tab provide the following functionalities (see
figure_composer_19):

Figura 18.19: Scale Bar Units and Segments Dialogs

In these two dialogs, you can set how the scale bar will be represented.

• Select the map units used. There are three possible choices: Map Units is the automated unit selection;
Meters or Feet force unit conversions.

• The Label field defines the text used to describe the units of the scale bar.

• The Map units per bar unit allows you to fix the ratio between a map unit and its representation in the scale
bar.

• You can define how many Segments will be drawn on the left and on the right side of the scale bar, and how
long each segment will be (Size field). Height can also be defined.

Exibição, Fontes e cores

The Display and Fonts and colors dialogs of the scale bar Item Properties tab provide the following functionalities
(see figure_composer_20):

• You can define how the scale bar will be displayed in its frame. Adjust the Box margin between text
and frame borders, Labels margin between text and scale bar drawing and the Line width of the scale bar
drawing.

• The Alignment in the Display dialog only applies to Numeric styled scale bars and puts text on the left,
middle or right side of the frame.

18.3.6 Adicionando uma Forma básica ou item Seta no Compositor de Im-
pressão

It is possible to add basic shapes (ellipse, rectangle, triangle) and arrows to the Print Composer canvas: Click the
Add basic shape icon or the Add Arrow icon, place the element with the left mouse button on the Print Composer

canvas and position and customize the appearance in the Item Properties tab.
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Figura 18.20: Scale Bar Display, Fonts and colors Dialogs

The Shape item properties tab allows you to draw an ellipse, rectangle, or triangle in the Print Composer canvas.
You can define its outline and fill color, the outline width and a clockwise rotation. For the rectangle shape, you
can change the value of the corner radius.

Figura 18.21: Separador de propriedades da Forma

The Arrow item properties tab allows you to draw an arrow in the Print Composer canvas. You can define color,
outline and arrow width, and it is possible to use a default marker, no marker, or an SVG marker. For the SVG
marker, you can additionally add an SVG start and end marker from a directory on your computer.

Propriedades principais

• For basic shapes, this dialog allows you to choose an Ellipse, Rectangle or Triangle shape and its rotation.

• Contrariamente aos outros items, o estilo de linha, cor da linha e cor de fundo da forma básica são ajustados
com a Janela de Moldura e Fundo. Nenhuma moldura é desenhada.

• For arrows, you can define here the line style: Color, Line width and Arrow head width.

• Arrows markers can be adjusted. If you want to set an SVG Start marker and/or End marker, browse to
your SVG file by clicking on the [...] button after selecting the SVG radio button.
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Figura 18.22: Separador das propriedades da Seta

Nota: Unlike other items, the background color for a basic shape is the shape background and not the frame
background.

18.3.7 Adicionar valores da tabela de atributos ao Compositor de Impressão

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, place the element with the left mouse button on the Print Composer canvas, and position and customize the
appearance in the Item Properties tab.

The Item properties of an attribute table item tab provides the following functionalities (see figure_composer_23):

Figura 18.23: Scale Bar Item properties Tab

Propriedades principais, Mostrar grelha e Fontes

The Main properties, Show grid and Fonts dialogs of the attribute table Item Properties tab provide the following
functionalities (see figure_composer_24):
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Figura 18.24: Janela das Propriedades principais, Mostrar grelha e Fontes

Figura 18.25: Janela Secção de atributos da tabela de atributos
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• The Table dialog allows you to select the vector layer and columns of the attribute table. Attribute columns
can be sorted, and you can specify whether to show values in ascending or descending order (see fig-
ure_composer_25).

• You can choose to display the attributes of only features visible on a map. Check Show only visible
features and select the corresponding Composer map to filter.

• You can define the Maximum number of rows to be displayed and the margin around text.

• Additionally, you can define the grid characteristics of the table (Stroke width and Color of the grid) and the
header and content font.

18.3.8 Add an HTML frame to the Print Composer

It is possible to add a clickable frame linked to a URL: Click the Add HTML frame icon, place the element with the
left mouse button on the Print Composer canvas and position and customize the appearance in the Item Properties
tab.

Propriedades principais

The Main properties dialog of the HTML frame Item Properties tab provides the following functionalities (see
figure_composer_26):

Figura 18.26: Separadores das propriedades do frame HTML

• Point the URL field to the URL or the HTML file you want to insert in the Composer.

• You can adjust the rendering of the page with the Resize mode.

• Use existing frames constrains the page inside its first frame or in the frame created with the next settings.

• Extent to next page will create as many frames (and corresponding pages) as necessary to render the height
of the web page. Each frame can be moved around on the layout. If you resize a frame, the webpage will
be divided up between the other frames. The last frame will be trimmed to fit the web page.

• Repeat on every page will repeat the upper left of the web page on every page in frames of the same size.

• Repeat until finished will also create as many frames as the Extend to next page option, except all frames
will have the same size.
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18.4 Manage items

18.4.1 Size and position

Each item inside the Composer can be moved/resized to create a perfect layout. For both operations the first step is

to activate the Select/Move item tool and to click on the item; you can then move it using the mouse while holding
the left button. If you need to constrain the movements to the horizontal or the vertical axis, just hold the Shift
while moving the mouse. If you need a better precision, you can move a selected item using the Arrow keys
on the keyboard; if the movement is too slow, you can speed up it by holding Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item in
the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Ctrl will
resize from the item center.

The correct position for an item can be obtained using snapping to grid or smart guides. If you need to disable the
snap on the fly just hold Ctrl while moving the mouse.

You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group just like a single item.

Once you have found the correct position for an item, you can lock it by clicking with the right mouse button.
Press the same button another time to unlock it. You can also lock/unlock items using the icons on the toolbar.

To unselect an item, just click on it holding the Shift button.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.

18.4.2 Alignment

Raising or lowering functionalities for elements are inside the Raise selected items pull-down menu. Choose an
element on the Print Composer canvas and select the matching functionality to raise or lower the selected element
compared to the other elements (see table_composer_1).

There are several alignment functionalities available within the Align selected items pull-down menu (see ta-
ble_composer_1). To use an alignment functionality, you first select some elements and then click on the matching
alignment icon. All selected elements will then be aligned within to their common bounding box. When moving
items on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.

18.4.3 Copy/Cut and Paste items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position.

18.5 Ferramentas de Reverter e Restaurar

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Reverter as últimas alterações

• Restaura as últimas alterações

This can also be done by mouse click within the Command history tab (see figure_composer_28).
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Figura 18.27: Linhas Guia de alinhamento no Compositor de Impressão

Figura 18.28: Histórico de comandos no Compositor de Impressão
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18.6 Geração de Atlas

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation
parameters, refer to the Atlas generation tab. This tab contains the following widgets (see Figure_composer_29):

Figura 18.29: Separador de Geração de Atlas

• Generate an atlas, which enables or disables the atlas generation.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the geometries
on which to iterate over.

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• A caixa de texto Expressão do nome do ficheiro de saída que é usada para criar o nome do ficheiro para cada
geometria se necessária. É baseado em expressões. Este campo é significativo apenas para a renderização
de múltiplos ficheiros.

• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.
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• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• An input box Margin around feature that allows you to select the amount of space added around each
geometry within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.

18.6.1 Labels

In order to adapt labels to the feature the atlas plugin iterates over, use a label with this special notation [%expres-
sion using field_name%]. For example, for a city layer with fields CITY_NAME and ZIPCODE, you could insert
this:

“[% ‘A área de ‘ || upper(CITY_NAME) || ‘,’ || ZIPCODE || ‘ é ‘ format_number($area/1000000,2) || ‘ km2’ %]“

That would result in the generated atlas as

“A área de PARIS, 75001 é 1.94 km2”.

18.6.2 Preview

Once the atlas settings have been configured and map items selected, you can create a preview of all the pages by
clicking on Atlas → Preview Atlas and using the arrows, in the same menu, to navigate through all the features.

18.6.3 Criação

The atlas generation can be done in different ways. For example, with Atlas → Print Atlas, you can directly print
it. You can also create a PDF using Atlas → Export Atlas as PDF: The user will be asked for a directory for saving

all the generated PDF files (except if the Single file export when possible has been selected). If you need to
print just a page of the atlas, simply start the preview function, select the page you need and click on Composer
→ Print (or create a PDF).

18.7 Criando um ficheiro de Saída

Figure_composer_30 shows the Print Composer with an example print layout, including each type of map element
described in the sections above.

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• Export as PDF saves the defined Print Composer canvas directly as a PDF.

244 Capítulo 18. Compositor de Impressão



QGIS User Guide, Versão 2.2

Figura 18.30: Print Composer with map view, legend, image, scale bar, coordinates, text and HTML frame added

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

If you need to export your layout as a georeferenced image (i.e., to load back inside QGIS), you need to enable

this feature under the Composition tab. Check World file on and choose the map item to use. With this option,
the ‘Export as image’ action will create also a world file.

Nota: Currently, the SVG output is very basic. This is not a QGIS problem, but a problem with the underlying
Qt library. This will hopefully be sorted out in future versions. Exporting big rasters can sometimes fail, even if
there seems to be enough memory. This is also a problem with the underlying Qt management of rasters.

18.8 Gerir o Compositor

With the Save as template and Load from template icons, you can save the current state of a Print Composer session
as a .qpt template and load the template again in another session.

The Composer Manager button in the QGIS toolbar and in Composer → Composer Manager allows you to add a
new Composer template, create a new composition based on a previously saved template or to manage already
existing templates.

By default, the Composer manager searches for user templates in ~/.qgis2/composer_template.

The New Composer and Duplicate Composer buttons in the QGIS toolbar and in Composer → New Composer
and Composer → Duplicate Composer allow you to open a new Composer dialog, or to duplicate an existing
composition from a previously created one.
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Figura 18.31: O gestor do Compositor de Impressão

Finally, you can save your print composition with the Save Project button. This is the same feature as in the QGIS
main window. All changes will be saved in a QGIS project file.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 19

Complementos

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.1 Complementos QGIS

QGIS foi projetado com uma arquitetura de complementos. Isto permite que muitos recursos e funções possam ser
facilmente adcionados à aplicação. Muitos recursos no QGIS são atualmente implementados como complementos.

19.1.1 O menu de complementos

Os menus no diálogo de Complementos permite ao usuário instalar, desinstalar e atualizar os complementos de
diferentes formas.

Todos

Aqui, todos os complementos disponíveis são apresentados, incluindo os complementos nativos e externos. Utilize
[Atualizar tudo] para procurar por novas versões dos complementos. Além disso, você pode usar [Instalar
complemento], se um complemento estiver listado, mas não instalado, e [Desinstalar complemento] assim como
[Reinstalar complemento], se um complemento já estiver instalado. Se um complemento estiver instalado, ele
pode ser ativado e desativado utilizando a caixa de marcação.

Instalados

Neste menu, você pode encontrar somente os complementos instalados. Os complementos externos podem ser
desinstalados e reinstalados utilizando os botões [Desinstalar complemento] and [Reinstalar complemento].
Você também pode [Atualizar todos].

Não instalados

Este menu lista todos os complementos disponíveis que não estão instalados. Você pode usar o botão [Instalar
complemento] para implementar um complemento no QGIS.

Atualizável

Se você ativar Também mostrar complementos experimentais no Opções, você pode utilizar este menu
para procurar por versões mais recentes dos complementos. Isto pode ser feito com os botões [Atualizar comple-
mento] ou [Atualizar todos].

Opções

Neste menu, você pode definir as seguintes opções:
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Figura 19.1: The :guilabel: menu‘Todos‘

Figura 19.2: The :guilabel: menu Instalados
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Figura 19.3: The :guilabel: menu Não instalados

Figura 19.4: The :guilabel: menu Atualizável
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• Verificar por atualizações quando iniciar. Sempre que um novo complemento ou uma atualização de
algum estiver disponível, o QGIS informará a você ‘toda vez ao iniciar o QGIS’, ‘uma vez por dia’, ‘a cada
3 dias’, ‘a cada semana’, ‘a cada 2 semanas’ ou ‘a cada mês’.

• Mostrar tambéms os complementos experimentais. O QGIS mostrará todos os complementos nos está-
gios iniciais de desenvolvimento, que geralemente são inadequados para uso em produção

• Também mostrar complementos obsoletos. Estes complementos são obsoletos e geralmente inadequados
para uso em produção.

Para adicionar repositórios externos, clique em [Adicionar...] na seção de Repositórios de complementos. Se
você não quer um ou mais repositórios adicionados, eles podem ser desabilitados através do botão [Editar...] or
remover completamente com o botão **[Excluir].

Figura 19.5: The :guilabel: menu Opções

A função Buscar está disponível em quase todos os menus (exceto em Opções). Aqui, você pode procurar
por complementos específicos

Dica: Complementos nativos e externos
Complementos do QGIS são implementados como Complementos nativos ou Complementos externos. Com-
plementos nativos são mantidos pelo grupo de desenvolvedores do QGIS e faz parte automaticamente da dis-
tribuição de cada versão do QGIS. Eles são desenvolvidos em uma das duas linguagens: C++ ou Python. Com-
plementos externos são atualmente desenvolvidos em Python. Eles são armazenados em repositórios externos e
mantidos por seus autores

Documentação detalahada sobre o uso, versão mínima do QGIS, home page, autores e outras informações im-
portantes são fornecidas pelo Repositório ‘Oficial’ do QGIS em http://plugins.qgis.org/plugins/. Para repositórios
externos, a documentação deve estar disponível com os autores dos mesmos. No geral, não está incluída neste
guia.
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Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.2 Usando os Módulos QGIS Core

Ícone Módulo Descrição Referência do Manual

Captura de
Coordenadas

Capture coordenadas com o rato em
diferentes SRC

Complemento de Captura de
Coordenadas

Gestor BD Faça a gestão das suas bases de dados
dentro do QGIS

Módulo Gestor BD

Conversor DXF2Shape Converte do DXF para o formato de
ficheiro SHP

Complemento dxf2shp

eVis Ferramenta de Visualização Event Complemento eVis

fTools Um conjunto de ferramentas vectoriais Complemento fTools

Ferramentas GPS Ferramentas para carregamento e
importação de dados GPS

Complemento GPS

GRASS Funcionalidade GRASS Integração com SIG GRASS

Ferramentas GDAL Funcionalidade matricial GDAL Módulo de Ferramentas
GDAL

Georeferenciador
GDAL

Georeferenciar rasters com GDAL georeferenciar

Mapa de Densidade Criar rasters heatmap para entrar pontos
vetoriais

Módulo de Mapa de
Densidade

Módulo de
Interpolação

Interpolação baseada nos vértices da
camada vectorial

Complemento de
Interpolação

Edição Offline Edição Offline e sincronização com a base
de dados

Módulo Edição Offiline

Oracle Spatial
GeoRaster

Acesso ao Oracle Spatial GeoRasters Oracle Spatial GeoRaster
Plugin

Gestor de módulos Gerir módulos core e externos O menu de complementos

Análise do Terreno
Matricial

Computar características geomorfológicas
a partir de MDE

Módulo de Análise do
Terreno Matricial

Complemento caminho
mais curto

Análise do Caminho mais curto Módulo de Cálculo de Rotas

Módulo SQL
Anywhere

Acesso a BD SQL anywhere Complemento SQL
Anywhere

Interrogação Espacial Interrogação espacial nos vectores Complemento de Consulta
Espacial

SPIT Ferramenta de importação Shapefile para
PostgreSQL/PostGIS

Complemento SPIT

Estatísticas Locais Calcular estatísticas matriciais a partir de
polígonos vectoriais

Complemento Estatística
Zonal

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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19.3 Complemento de Captura de Coordenadas

O complemento de captura de coordenadas é fácil de usar e oferece a possibilidade de visualizar as coordenadas
na tela de mapa para dois sistemas de referência de coordenadas selecionados (SRC).

Figura 19.6: Complemento de Captura de Coordenadas

1. Iniciar QGIS, selecionar Propriedades do Projeto apartir do menu Configurações (KDE, Windows) ou
Arquivo (Gnome, OSX) e clique no :guilabel: Aba Projeção. Alternativamente, você pode clicar no ícone

Status do SRC no canto inferior direito da barra de status.

2. Clique na caixa de verificação Ativar projeção “on the fly” e selecione o sistema de coordenadas proje-
tado à sua escolha (veja também Trabalhando com Projeções).

3. Carregue o complemento de captura de coordenadas no Gerenciador de Complementos (veja

load_core_plugin) e assegure-se que a janela é visível indo Ver → Painéis e assegurar que a Cap-
tura de Coordenadas está ativada. A janela de captura de coordenadas aparece como mostra a Figura
figure_coordinate_capture_1. Em alternativa, pode também ir Vector → Captura de Coordenadas e ver se

Captura de Coordenadas está ativa.

4. Clique no ícone Clique para selecionar o SRC para a exibição de coordenadas e selecione um SRC diferente a partir do
que selecionou acima.

5. Para iniciar a capturar coordenadas, clique em [Iniciar captura]. Pode clicar agora em qualquer sítio do
enquadramento do mapa e o módulo irá mostrar as coordenadas em ambos os SRC selecionados.

6. Para habilitar coordenar de rastreamento do mouse, clique no :sup: ícone rastreamento do mouse.

7. Pode também copiar as coordenadas selecionadas para a área de transferência.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.4 Módulo Gestor BD

The DB Manager Plugin is officially part of the QGIS core and is intended to replace the SPIT Plugin and,

additionally, to integrate all other database formats supported by QGIS in one user interface. The DB Manager

Plugin provides several features. You can drag layers from the QGIS Browser into the DB Manager, and it will
import your layer into your spatial database. You can drag and drop tables between spatial databases and they will
get imported. You can also use the DB Manager to execute SQL queries against your spatial database and then
view the spatial output for queries by adding the results to QGIS as a query layer.

The Database menu allows you to connect to an existing database, to start the SQL window and to exit the DB
Manager Plugin. Once you are connected to an existing database, the menus Schema and Table additionally
appear.

The Schema menu includes tools to create and delete (empty) schemas and, if topology is available (e.g., PostGIS
2), to start a TopoViewer.
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Figura 19.7: Janela do Gestor DB

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

If connected to a database, the main window of the DB Manager offers three tabs. The Info tab provides informa-
tion about the table and its geometry, as well as about existing fields, constraints and indexes. It also allows you
to run Vacuum Analyze and to create a spatial index on a selected table, if not already done. The Table tab shows
all attributes, and the Preview tab renders the geometries as preview.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.5 Complemento dxf2shp

The dxf2shape converter plugin can be used to convert vector data from DXF to shapefile format. It requires the
following parameters to be specified before running:

• Input DXF file: Enter the path to the DXF file to be converted.

• Output Shp file: Enter desired name of the shapefile to be created.

• Output file type: Specify the geometry type of the output shapefile. Currently supported types are polyline,
polygon, and point.

• Export text labels: When this checkbox is enabled, an additional shapefile point layer will be created, and
the associated DBF table will contain information about the “TEXT” fields found in the DXF file, and the
text strings themselves.
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Figura 19.8: Complemento Conversor Dxf2Shape

19.5.1 Usando o Plugin

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see O menu de complementos) and click

on the Dxf2Shape Converter icon, which appears in the QGIS toolbar menu. The Dxf2Shape plugin dialog
appears, as shown in Figure_dxf2shape_1.

2. Enter the input DXF file, a name for the output shapefile and the shapefile type.

3. Marque a caixa Export text labels se você deseja criar uma camada extra do tipo pontos com os rótulos.

4. Clique [OK].

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.6 Complemento eVis

(This section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide.
American Museum of Natural History, Center for Biodiversity and Conservation. Available from
http://biodiversityinformatics.amnh.org/, and released under the GNU FDL.)

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (see O menu de complementos).

The eVis plugin is made up of three modules: the ‘Database Connection tool’, ‘Event ID tool’, and the ‘Event
Browser’. These work together to allow viewing of geocoded photographs and other documents that are linked to
features stored in vector files, databases, or spreadsheets.

19.6.1 Navegador de Evento

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.
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Iniciando o módulo Navegador de Evento

To launch the Event Browser module, click on Database → eVis → eVis Event Browser. This will open the
Generic Event Browser window.

The Event Browser window has three tabs displayed at the top of the window. The Display tab is used to view the
photograph and its associated attribute data. The Options tab provides a number of settings that can be adjusted to
control the behavior of the eVis plugin. Lastly, the Configure External Applications tab is used to maintain a table
of file extensions and their associated application to allow eVis to display documents other than images.

Entendendo a Janela de Exibição

To see the Display window, click on the Display tab in the Event Browser window. The Display window is used
to view geocoded photographs and their associated attribute data.

Figura 19.9: The eVis display window

1. Display window: A window where the photograph will appear.

2. Zoom in button: Zoom in to see more detail. If the entire image cannot be displayed in the display window,
scroll bars will appear on the left and bottom sides of the window to allow you to pan around the image.

3. Zoom out button: Zoom out to see more area.

4. Zoom to full extent button: Displays the full extent of the photograph.

5. Attribute information window: All of the attribute information for the point associated with the photo-
graph being viewed is displayed here. If the file type being referenced in the displayed record is not an
image but is of a file type defined in the Configure External Applications tab, then when you double-click
on the value of the field containing the path to the file, the application to open the file will be launched to
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view or hear the contents of the file. If the file extension is recognized, the attribute data will be displayed
in green.

6. Navigation buttons: Use the Previous and Next buttons to load the previous or next feature when more
than one feature is selected.

Entendendo a janela Opções

Figura 19.10: The eVis Options window

1. File path: A drop-down list to specify the attribute field that contains the directory path or URL for the
photographs or other documents being displayed. If the location is a relative path, then the checkbox must
be clicked. The base path for a relative path can be entered in the Base Path text box below. Information
about the different options for specifying the file location are noted in the section Especificando o local e o
nome de uma fotografia below.

2. Compass bearing: A drop-down list to specify the attribute field that contains the compass bearing asso-
ciated with the photograph being displayed. If compass bearing information is available, it is necessary to
click the checkbox below the drop-down menu title.

3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected
using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in
the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Caminho Diretório base: O caminho de base para que o caminho relativo definido no Figure_eVis_2 (A)
será anexado.

5. Replace path: If this checkbox is checked, only the file name from A will be appended to the base path.
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6. Apply rule to all documents: If checked, the same path rules that are defined for photographs will be used
for non-image documents such as movies, text documents, and sound files. If not checked, the path rules
will only apply to photographs, and other documents will ignore the base path parameter.

7. Remember settings: If the checkbox is checked, the values for the associated parameters will be saved for
the next session when the window is closed or when the [Save] button below is pressed.

8. Redefinir valores: Redefine os valores nesta linha para a configuração padrão.

9. Restore defaults: This will reset all of the fields to their default settings. It has the same effect as clicking
all of the [Reset] buttons.

10. Save: This will save the settings without closing the Options pane.

Entendendo a janela Configurar Aplicações Externas

Figura 19.11: The eVis External Applications window

1. **Arquivo tabela de referência **: Uma tabela contendo os tipos de arquivos que podem ser abertos usando
eVis. Cada tipo de arquivo tem uma extensão de arquivo e o caminho para um aplicativo poder abrí-lo. Isso
fornece a capacidade de abrir uma ampla gama de arquivos como filmes, gravações sonoras, e documentos
de texto em vez de apenas imagens.

2. Adicionar novo tipo de arquivo: Adicionar um novo tipo de arquivo com uma extensão única e o caminho
para o aplicativo poder abrí-lo.

3. ** Excluir linha atual **: Exclui o tipo de arquivo em destaque na tabela e definido por uma extensão de
arquivo e um caminho para um aplicativo associado.

19.6.2 Especificando o local e o nome de uma fotografia

The location and name of the photograph can be stored using an absolute or relative path, or a URL if the pho-
tograph is available on a web server. Examples of the different approaches are listed in Table evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76
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19.6.3 Especificando o local e o nome de outros documentos suportados

Supporting documents such as text documents, videos, and sound clips can also be displayed or played by eVis. To
do this, it is necessary to add an entry in the file reference table that can be accessed from the Configure External
Applications window in the Generic Event Browser that matches the file extension to an application that can be
used to open the file. It is also necessary to have the path or URL to the file in the attribute table for the vector
layer. One additional rule that can be used for URLs that don’t contain a file extension for the document you want
to open is to specify the file extension before the URL. The format is — file extension:URL. The URL
is preceded by the file extension and a colon; this is particularly useful for accessing documents from wikis and
other web sites that use a database to manage the web pages (see Table evis_examples).

19.6.4 Using the Event Browser

When the Event Browser window opens, a photograph will appear in the display window if the document refer-
enced in the vector file attribute table is an image and if the file location information in the Options window is
properly set. If a photograph is expected and it does not appear, it will be necessary to adjust the parameters in the
Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is referenced in the
attribute table, the field containing the file path will be highlighted in green in the attribute information window if
that file extension is defined in the file reference table located in the Configure External Applications window. To
open the document, double-click on the green-highlighted line in the attribute information window. If a supporting
document is referenced in the attribute information window and the file path is not highlighted in green, then it
will be necessary to add an entry for the file’s filename extension in the Configure External Applications window.
If the file path is highlighted in green but does not open when double-clicked, it will be necessary to adjust the
parameters in the Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window, a red asterisk will be displayed on top of the vector
feature that is associated with the photograph being displayed. If a compass bearing is provided, then an arrow will
appear pointing in the direction indicated by the value in the compass bearing display field in the Event Browser
window. The arrow will be centered over the point that is associated with the photograph or other document.

To close the Event Browser window, click on the [Close] button from the Display window.

19.6.5 Ferramenta ID de Evento

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Iniciando o módulo Identificação de Evento

To launch the ‘Event ID’ module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the ref:evis_browser section of this guide.

19.6.6 Conexão com o Base de Dados

The ‘Database Connection’ module provides tools to connect to and query a database or other ODBC resource,
such as a spreadsheet.
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eVis can directly connect to the following types of databases: PostgreSQL, MySQL, and SQLite; it can also
read from ODBC connections (e.g., MS Access). When reading from an ODBC database (such as an Excel
spreadsheet), it is necessary to configure your ODBC driver for the operating system you are using.

Iniciando o módulo Conexão com a Base de Dados

To launch the ‘Database Connection’ module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Conectar a uma base de dados

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Enter the database host in the Database Host textbox. This option is not available if you selected ‘MS Access’ as
the database type. If the database resides on your desktop, you should enter “localhost”.

Enter the name of the database in the Database Name textbox. If you selected ‘ODBC’ as the database type, you
need to enter the data source name.

When all of the parameters are filled in, click on the [Connect] button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established, you will need to check that the correct parameters were entered above.

Figura 19.12: The eVis Database connection window

1. Database Type: A drop-down list to specify the type of database that will be used.
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2. Base de dados hospedeiro: O nome da base de dados hospedeiro.

3. Port: The port number if a MySQL or PostgreSQL database type is selected.

4. Database Name: The name of the database.

5. Connect: A button to connect to the database using the parameters defined above.

6. Output Console: The console window where messages related to processing are displayed.

7. Nome de Usuário: Nome de usuário para uso quando uma base de dados é protegida por senha.

8. Senha: Senha para uso quando uma base de dados é protegida por senha.

9. Consultas pré-definidas: Guia para abrir a janela “Consultas pré-definidas”.

10. **Conexão com a base de dados **: Guia para abrir a janela “Conexão com a Base de dados”.

11. Consulta SQL: Guia para abrir a janela “Consulta SQL”.

12. Help: Displays the online help.

13. OK: Fecha a janela principal do “Conexão com a Base de Dados”.

Execução de consultas SQL

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Click on the [Run Query] button to execute the command. If the query is successful, a Database File Selection
window will be displayed. If the query is not successful, an error message will appear in the Output Console
window.

In the Database File Selection window, enter the name of the layer that will be created from the results of the
query in the Name of New Layer textbox.

1. Janela de Texto de Consulta SQL: Uma tela para escrever consultas SQL.

2. Run Query: Button to execute the query entered in the SQL Query Window.

3. Janela Console: A janela console onde as mensagens relacionadas ao processamento são exibidas.

4. Help: Displays the online help.

5. OK: Closes the main Database Connection window.

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right-clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Dica: Criando uma camada vetorial a partir de uma planilha do Microsoft Excel
When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.
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Figura 19.13: The eVis SQL query tab

Executando consultas pré-definidas

With predefined queries, you can select previously written queries stored in XML format in a file. This is par-
ticularly helpful if you are not familiar with SQL commands. Click on the Predefined Queries tab to display the
predefined query interface.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.

Select the query you want to run from the drop-down menu and then click on the SQL Query tab to see that the
query has been loaded into the query window. If it is the first time you are running a predefined query or are
switching databases, you need to be sure to connect to the database.

Click on the [Run Query] button in the SQL Query tab to execute the command. If the query is successful, a
Database File Selection window will be displayed. If the query is not successful, an error message will appear in
the Output Console window.

1. Open File: Launches the “Open File” file browser to search for the XML file holding the predefined queries.

2. Predefined Queries: A drop-down list with all of the queries defined by the predefined queries XML file.

3. Consulta descrição: Uma breve descrição da consulta. Esta descrição é do arquivo consultas prédefinida
XML.

4. Janela Console: A janela console onde as mensagens relacionadas ao processamento são exibidas.

5. Help: Displays the online help.

6. OK: Fecha a janela principal do “Conexão com a Base de Dados”.
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Figura 19.14: The eVis Predefined Queries tab

Formato XML para consultas predefinidas eVis

As marcas XML lidas por eVis

Marcas Descrição
Consulta Define o início e o fim de uma instrução de consulta.
Descrição Breve A short description of the query that appears in the eVis drop-down menu.
Descrição Uma descrição mais detalhada da consulta exibida na janela de texto Consulta

Predefinida.
Tipo de Base de
Dados

The database type, defined in the Database Type drop-down menu in the Database
Connection tab.

Porta da Base de
Dados

The port as defined in the Port text box in the Database Connection tab.

Nome da Base de
Dados

The database name as defined in the Database Name text box in the Database
Connection tab.

Nome de Usuário
da Base de Dados

The database username as defined in the Username text box in the Database Connection
tab.

Senha de Base de
Dados

The database password as defined in the Password text box in the Database Connection
tab.

Instrução SQL O comando SQL.
autoconexão A flag (“true”” or “false”) to specify if the above tags should be used to automatically

connect to the database without running the database connection routine in the Database
Connection tab.

Um exemplo de arquivo XML completo com três consultas é exibido abaixo:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
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<description>This command will import all of the data in the SQLite database to QGIS
</description>

<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.7 Complemento fTools

O objetivo do módulo python fTools é fornecer um recurso único para várias tarefas SIG comuns aos dados
vetoriais, sem a necessidade de software adicional, bibliotecas, ou trabalho complexo. Fornece um conjunto em
crescimento de formas de gestão de dados espaciais e funções de análise que são rápidas e funcionais.

O fTools está automaticamente instalado e ativado nas novas versões do QGIS, juntamente com todos os módulos,
e pode ser desativado e ativado através do Gestor de Módulos (Veja Seção O menu de complementos). Quando
ativado, o módulo fTools adiciona o menu Vetor ao QGIS, fornecendo funções, desde Ferramentas de Análise e
Investigação a Ferramentas de Geometria e Geoprocessamento, assim como várias ferramentas úteis de Gestão de
Dados.

19.7. Complemento fTools 263



QGIS User Guide, Versão 2.2

19.7.1 Ferramentas de análise

ÍconeFerramenta Finalidade

Matriz de
Distância

Medir distâncias entre dois pontos de uma camada, os resultados saem como a)
matriz de distâncias quadrada, b) matriz de distância linear, ou c) Síntese de
distâncias. Pode limitar distâncias com as características mais próximas de k.

Soma de
comprimento
de linhas

Calcular a soma total dos comprimentos das linhas para cada polígono de uma
camada vetorial do tipo polígono.

Pontos no
polígono

Conta o número de pontos que existem em cada polígono de uma camada de entrada
do tipo vetorial poligonal.

Lista valores
únicos

Origina uma lista de valores únicos num campo de uma camada vetorial.

Estatísticas
básicas

Calcular estatísticas básicas (média, std dev, N, soma, CV) em um campo de
entrada.

Análise de
Vizinhança

Calcula as estatísticas de vizinho mais próximo avaliando o nível de agrupamento
numa camada de pontos vetorial

Coordenada(s)
média(s)

Calcular o centro médio ponderado normal ou inteiro de uma camada vetorial, ou de
várias feições com base em um campo exclusivo de identificação.

Interseções de
linhas

Localizar cruzamentos entre as linhas, e as feições de uma outra shapefile. Útil para
localizar cruzamentos ou fluxo, ignora cruzamentos de linha com comprimento > 0.

Table Ftools 1: Ferramentas de análise fTools

19.7.2 Ferramentas de pesquisa

Ícone Ferramenta Finalidade

Seleção aleatória Seleciona aleatoriamente n números de elementos, ou n percentagem de
elementos.

Seleção aleatória
dentro de
subconjuntos

Selecionar aleatoriamente feições dentro de subconjuntos com base em um
campo exclusivo de identificação.

Pontos aleatórios Gerar pseudo-pontos aleatórios sobre uma camada de entrada.

Pontos regulares Gerar uma grade regular de pontos ao longo de uma região determinada e
exportá-los como um shapefile de pontos.

Grade vetorial Gera uma grelha de linhas ou polígonos baseada num espaçamento específico
dado pelo utilizador.

Selecionar pela
localização

Selecionar feições com base na sua localização em relação a uma outra
camada, para formar uma nova seleção, adicionar ou subtrair da seleção atual.

Polígono a partir da
extensão da camada

Criar uma camada com um único polígono retangular a partir da extensão de
uma camada de entrada raster ou vetorial.

Tabela fTools 2: Ferramentas de Pesquisa fTools
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19.7.3 Ferramentas de geoprocessamento

Ícone Ferramenta Finalidade

Forma(s)
convexa(s)

Criar o mínimo de forma(s) convexas em uma camada de entrada, ou com base
em um campo de ID.

Buffer(s) Criar buffer(s) em torno de feições com base em distâncias, ou em um campo de
distância.

Interseção Intersectar sobreposição de camadas de forma que a saída contém áreas onde
ambas as camadas se cruzam.

União Sobreposição de camadas de forma que a saída contém a interseção e
não-interseção de áreas.

Diferença
simétrica

Sobreposição de camadas de forma que a saída contém tanto as áreas que não se
intersectam da entrada e das camadas de diferença.

Cortar Sobreposição de camadas de forma que a saída contém áreas que se cruzam a
camada de corte.

Diferença Sobreposição de camadas de forma que a saída contém áreas que não cruzam a
camada de corte.

Dissolver Mesclar feições com base no campo de entrada. Todas as feições com valores
idênticos de entrada são combinadas para formar uma única feição.

|elim-
inar|

Elimine
polígonos
prateados

Mescla feições selecionadas com o polígono vizinho com a maior área ou maior
fronteira comum.

Tabela fTools 3: Ferramentas de Geoprocessamento fTools
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19.7.4 Ferramentas de Geometria

Ícone Ferramenta Finalidade

Verificar validade da
geometria

Verifica os polígonos para interseções, buracos fechados, e corrige ordenação
de nós.

Exportar/Adicionar
geometrias de colunas

Adicionar Informações de geometrias vetoriais em camadas do tipo ponto
(xCoord, yCoord), linha (comprimento), ou polígono (área, perímetro).

Centróides de
polígonos

Calcular os centróides reais para cada polígono em uma camada de entrada
do tipo polígono.

Triangulação de
Delaunay

Calcula e produz uma saída baseada na triangulação de Delaunay (como
polígonos) de uma camada de pontos vetorial.

Polígonos de Voronoi Calcula polígonos de Voronoi de uma camada de pontos vetoriais.

Simplificar
geometrias

Generalizar linhas ou polígonos com o algoritmo de Douglas-Peucker.

Densificação de
geometria

Adensa linhas ou polígonos através de adição de vértices.

Densificar geometrias Converter feições de várias partes para feições de partes individuais . Cria
polígonos e linhas simples.

Multipartes para
partes simples

Mesclar várias feições para uma única feição multipartes baseada em um
campo exclusivo de identificação.

Polígonos para linhas Converte polígonos para linhas, polígonos multipartes para várias linhas de
partes únicas.

Linhas para polígonos Converte linhas para polígonos, linhas multipartes para polígonos de partes
simples.

Extração de nós Extrair nós de camadas do tipo linhas e polígonos, de forma a resultar
camadas de pontos.

Tabela fTools 4: ferramentas de Geometrias fTools

Nota: A ferramenta Simplificar geometrias pode ser usada para remover nós duplicados em geometrias de linhas
e polígonos, faça este truque definindo o parâmetro Tolerância de generalização para 0.

19.7.5 Ferramentas de gerenciamento de dados

ÍconeFerramenta Finalidade

Definir a
projeção atual

Especificar o SRC para o arquivo shape cujo SRC não foi definido.

Unir atributos
por
localização

Unir atributos adicionais a camada vetorial com base na relação espacial. Os
atributos de uma camada vetorial são anexados à tabela de atributos de uma outra
camada e exportados como um shapefile.

Dividir
camada
vetorial

Dividir uma camada de entrada em várias outras camadas distintas com base em um
campo de entrada.

Juntar em um
shapefile

Mesclar várioss shapefiles dentro de uma pasta para um novo shapefile com base no
tipo de camada (ponto, linha, área).

Criar índices
espaciais

Cria um índice espacial para os formatos OGR suportados.

Tabela fTools 5: ferramentas de gerenciamento de dados fTools
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Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.8 Módulo de Ferramentas GDAL

19.8.1 O que são as Ferramentas GDAL?

O módulo Ferramentas GDAL oferece uma colecção GUI de ferramentas da Biblioteca de Abstracção de Dados
Geoespaciais, http://gdal.osgeo.org . Estes são ferramentas de gestão raster para consultar, reprojectar, torcer e
unir um conjunto variado de formatos raster. Inclui também ferramentas para criar camadas de contornos (vector),
ou relevos sombreados a partir de MDT matriciais, e para fazer um vrt (Virtual Raster Tile em formato XML) a
partir de uma colecção de um ou mais ficheiros raster. Estas ferramentas estão disponíveis quando o módulo está
instalado e activado.

Biblioteca GDAL

A biblioteca GDAL consiste num conjunto de programas da linha de comandos, cada um com uma lista cheia
de opções. Os utilizadores que sabem usar a linha de comandos podem preferir a execução dos comandos no
terminal., com acesso a todo o conjunto de opções. O módulo Ferramentas GDAL oferece uma interface fácil para
as ferramentas, expondo apenas as opções mais populares.

19.8.2 Lista das ferramentas GDAL

Figura 19.15: Lista do menu Ferramentas GDAL

Projecções

Torcer
(Reprojectar)

Este utilitário serve para os mosaicos de imagem, reprojecção e torções. O programa pode
reprojectar para qualquer projecção suportada, e pode também ser aplicado a PC
armazenados na imagem se a imagem tiver dados em “bruto” com controlo da informação.
Para mais informação pode ler no sítio na internet do GDAL
http://www.gdal.org/gdalwarp.html.

Atribuir
projecção

Esta ferramenta permite definir uma projecção para os rasters que estão georeferenciados
mas não têm a informação da projecção. Com isto também ajuda na possibilidade de alterar a
definição de uma projecção actual. Tanto o modo ficheiro único como o modo batch são
suportados. Para mais informações, visite a página do utilitário no sítio na internet do
GDAL, http://www.gdal.org/gdalwarp.html.

Extrair
projecção

Este utilitário ajuda-o a extrair a informação da projecção de um ficheiro de entrada. Se
quiser extrair a projecção do directório pode usar o modo Batch. Irá criar os ficheiros .prj e
.wld .
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Conversão

Digitalizar
Este programa torna geometrias vectoriais (pontos, linhas e polígonos) em banda(s) de uma
imagem raster. Os vectores são lidos a partir de formatos OGR suportados. Repare que os
dados do vector devem ser do mesmo sistema de coordenadas que os dados rasters; a projecção
“on-the-fly” não é fornecida. Para mais informação veja
http://www.gdal.org/gdal_rasterize.html.

Vectorizar
Este utilitário cria polígonos vectoriais para todas as regiões de pixeis ligadas num matricial
que partilha um valor comum de pixel. Cada polígono é criado com um atributo que indica o
valor do pixel desse polígono. O utilitário irá criar um vector de saída se não existir, por defeito
em formato ESRI shapefile. Veja também http://www.gdal.org/gdal_polygonize.html.

Tranduzir
Este utilitário pode ser usado para converter matriciais em diferente formatos, potencialmente
executa algumas operações como subconfigurações, amostragem, rescalonamento de pixeis no
processo. Para mais informações pode ler em http://www.gdal.org/gdal_translate.html

RGB
para PCT

Este utilitário irá computar uma tabela pseudo-cor optimizada para uma dada imagem RBG
usando um algoritmo da mediana cortado num histograma RGB de resolução reduzida. De
seguida converte a imagem numa imagem de pseudo-cor usando tabelas de cor. Esta conversão
utiliza o pontilhado de Floyd-Steinberg (erro de difusão) para maximizar a qualidade visual da
imagem de saída. Este utilitário é também descrito em http://www.gdal.org/rgb2pct.html

PCT
para RGB

Este utilitário irá converter uma banda de pseudo-cor num ficheiro de entrada para um ficheiro
RGB de saída do formato desejado. Para mais informação veja
http://www.gdal.org/pct2rgb.html

Extracção

Con-
torno

Este programa gera um ficheiro de contornos vectoriais a partir de um modelo digital do terreno
(MDT) matricial. Pode encontrar mais informação em http://www.gdal.org/gdal_contour.html .

Corta-
dor

Este utilitário permite o corte (extracção de um subconjunto) usando um enquadramento
seleccionado ou baseado no limite de um vector. Mais informação pode ser encontrado em
http://www.gdal.org/gdal_translate.html.
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Análise

Crivo Este utilitário remove polígonos rasters mais pequenos que o tamanho de limiar (em
pixeis) fornecido e substitui-os com o valor do pixel mais alto do vizinho mais próximo.
O resultado pode ser escrito na banda raster existente, ou copiado para um novo ficheiro.
Para mais informação veja see http://www.gdal.org/gdal_sieve.html .

Próximo ao
Preto

Este utilitário irá digitalizar a imagem e tentar definir todos os pixeis que existem perto
do preto (ou perto do branco) à volta do limite para exactamente preto (ou branco). Isto é
usado usualmente para “corrigir” perdas em fotos áreas comprimidas para que esses
pixeis de cor possam ser tratadas como transparentes nas operações de mosaico. Veja
também http://www.gdal.org/nearblack.html.

Preencher
sem dados

Este utilitário preenche as regiões raster seleccionadas (usualmente conhecidas com
áreas sem valor) por interpolação de de pixeis validados à volta das bordas da área. Pode
encontrar mais informação em http://www.gdal.org/gdal_fillnodata.html .

Proximidade Este utilitário gera um mapa de proximidade raster indicando a distância desde o centro
de cada pixel para o centro do pixel mais próximo identificado como pixel alvo. Os
pixeis alvo são os que estão presentes no raster inicial em que cada valor do pixel é
definido como valores pixeis alvo. Para mais informação veja
http://www.gdal.org/gdal_proximity.html .

Grelha
(Interpolação)

Este utilitário cria um grelha regular (raster) a partir da leitura de dados dispersos de um
fonte de dados OGR. Os dados de entrada serão interpolados para preencher os nós da
grelha com valores, pode escolher vários métodos de interpolação. O utilitário também é
descrito no sítio na internet do GDAL http://www.gdal.org/gdal_grid.html .

MDE
(Modelos de
Elevação)

Ferramentas para analisar e visualizar MDT. Podem ser criados, relevos sombreados,
declives, exposições, relevo colorido, indíce de rugosidade do terreno, indice de posição
topográfica e mapas de irregularidades a partir de matricias GDAL suportados. Para mais
informação poderá ler em http://www.gdal.org/gdaldem.html
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Diversos

Construir
Matricial Virtual
(Catálogo)

Este programa constrói um VRT (Conjunto de Dados Virtual) que é um mosaico da
lista dos conjuntos de dados do GDAL. Veja também
http://www.gdal.org/gdalbuildvrt.html .

Juntar Este utilitário irá criar mosaicos de imagem a partir de um conjunto. Todas as
imagens devem ter o mesmo sistema de coordenadas e ter o mesmo número de
bandas correspondentes, mas podem ser sobrepostas, e em diferentes resoluções. Nas
áreas de sobreposição, a última imagem será copiada sobre as mais recentes. O
utilitário é também descrito em http://www.gdal.org/gdal_merge.html .

Informação Este utilitário cria uma lista com várias informações sobre o conjunto de dados raster
GDAL suportado. Pode encontrar mais informação em
http://www.gdal.org/gdalinfo.html .

Construir
Reduções

O utilitário gdaladdo pode ser usado para construir ou reconstruir imagem de
visualização para a maioria dos formatos suportados com um dos algoritmos de
redução de escala. Para mais informação veja http://www.gdal.org/gdaladdo.html .

Índice de
Quadrículas

Este utilitário constroi uma shapefile com o registo de cada ficheiro raster de entrada,
um atributo contendo um nome do ficheiro, e a geometria do polígono do limite do
raster. Veja também http://www.gdal.org/gdaltindex.html .

configurações das Ferramentas GDAL

Use este diálogo para embeber variáveis GDAL.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.9 Complemento Georreferenciador

The Georeferencer Plugin is a tool for generating world files for rasters. It allows you to reference rasters to
geographic or projected coordinate systems by creating a new GeoTiff or by adding a world file to the existing
image. The basic approach to georeferencing a raster is to locate points on the raster for which you can accurately
determine coordinates.

Recursos

270 Capítulo 19. Complementos

http://www.gdal.org/gdalbuildvrt.html
http://www.gdal.org/gdal_merge.html
http://www.gdal.org/gdalinfo.html
http://www.gdal.org/gdaladdo.html
http://www.gdal.org/gdaltindex.html


QGIS User Guide, Versão 2.2

Ícone Propósito Ícone Propósito

Abrir Raster Iniciar georreferenciamento

Gerar scrip GDAL Carregar pontos GCP

Salvar pontos GCP como Configurações de transformação

Adicionar ponto Excluir ponto

Mover ponto GCP Movimentar

Aproximar Afastar

Ver a camada Última visualização

Próxima visualização Ligar Georeferenciador ao QGIS

Link QGIS ao Georeferenciador Full histogram stretch

Local histogram stretch

Tabela Georreferenciador 1: Ferramentas do georreferenciador.

19.9.1 Procedimento comum

As X and Y coordinates (DMS (dd mm ss.ss), DD (dd.dd) or projected coordinates (mmmm.mm)), which corre-
spond with the selected point on the image, two alternative procedures can be used:

• The raster itself sometimes provides crosses with coordinates “written” on the image. In this case, you can
enter the coordinates manually.

• Using already georeferenced layers. This can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and with the projection that you
want for your image. In this case, you can enter the coordinates by clicking on the reference dataset loaded
in the QGIS map canvas.

O procedimento habitual para o georreferenciamento de uma imagem consiste em selecionar múltiplos pontos no
raster, especificar suas coordenadas e escolher o tipo de transformação mais apropriado para o arquivo. Baseado
nos dados e parâmetros de entrada, o complemento irá computar os parâmetros do arquivo world ou então criar
um novo GeoTIFF. Quanto mais pontos de controle (coordenadas) forem informados, melhor será o resultado do
processo.

The first step is to start QGIS, load the Georeferencer Plugin (see O menu de complementos) and click on Raster
→ Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as shown in
figure_georeferencer_1.

Para este exemplo, estamos a usar uma carta militar do Sul de Dakota do SDGS. Pode ser visualizada mais tarde
juntamente com a informação proveniente da localização do GRASS spearfish60 . Você pode baixaarr a carta
militar aqui: http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Entrando com pontos de controle GCPs (Ground Control Points)

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.

2. O botão Adicionar Ponto é usado para adicionar pontos na área de trabalho principal e introduzir as suas
coordenadas (veja Figura figura_do_georeferenciador_2). Para este procedimento tem três opções:

• Clique em determinado ponto da imagem raster e entre com suas coordenadas X e Y manualmente.

• Click on a point in the raster image and choose the From map canvas button to add the X and Y
coordinates with the help of a georeferenced map already loaded in the QGIS map canvas.
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Figura 19.16: Janela do Módulo Georeferenciador

• Com o botão , pode mover os GCP em ambas as janelas, se estiverem no lugar errado.

3. Continue entering points. You should have at least four points, and the more coordinates you can provide,
the better the result will be. There are additional tools on the plugin dialog to zoom and pan the working
area in order to locate a relevant set of GCP points.

Figura 19.17: Adicionar pontos à imagem raster

Os pontos que adicionar ao mapa serão guardados num arquivo de texto separado ([filename].points)
normalmente junto com a imagem raster. Isto permite que possamos reabrir o módulo do Georreferenciador mais
tarde e adicionar novos pontos ou apagar existentes para otimizar o resultado. O arquivo de pontos contem valores

na forma de: mapX, mapY, pixelX, pixelY. Pode usar o Carregar pontos GCP e o Guardar pontos GCP como

para gerir os arquivos.

Definindo as configurações de transformação

Depois que os pontos GCP estão devidamente adicionados à imagem raster, é necessário definir as configurações
de transformação para o processo de georreferenciamento.

272 Capítulo 19. Complementos



QGIS User Guide, Versão 2.2

Figura 19.18: Definindo as configurações de transformação do georeferenciador

Algoritmos de transformação disponíveis

Depending on how many ground control points you have captured, you may want to use different transformation
algorithms. Choice of transformation algorithm is also dependent on the type and quality of input data and the
amount of geometric distortion that you are willing to introduce to the final result.

Currently, the following Transformation types are available:

• The Linear algorithm is used to create a world file and is different from the other algorithms, as it does
not actually transform the raster. This algorithm likely won’t be sufficient if you are dealing with scanned
material.

• A transformação de Helmert executa um simples escalonamento e transformações de rotação.

• The Polynomial algorithms 1-3 are among the most widely used algorithms introduced to match source
and destination ground control points. The most widely used polynomial algorithm is the second-order
polynomial transformation, which allows some curvature. First-order polynomial transformation (affine)
preserves colliniarity and allows scaling, translation and rotation only.

• O algoritmo Suavizador em Lâminas Finas (TPS) é o método mais moderno de georreferenciamento, que
permite introduzir deformações locais nos dados. Este algoritmo é útil quando originais de baixa qualidade
estão a ser georreferenciados.

• A transformação Projectiva é uma rotação linear e de translação de coordenadas.

Definindo o método de reamostragem

O tipo de amostragem que escolhe irá depender dos seus dados de entrada e do objetivo do exercício. Se não
quiser mudar as estatísticas da imagem, deverá escolher ‘Vizinho mais próximo´, uma vez que que a ‘Amostragem
cúbica’ irá fornecer um resultado mais suavizado.

It is possible to choose between five different resampling methods:

1. Vizinho mais próximo

2. Linear
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3. Cúbico

4. Cúbico suavizado

5. Lanczos

Definindo as configurações de transformação

Existem várias opções que devem ser definidas para o arquivo raster (georreferenciado) de saída.

• The Create world file checkbox is only available if you decide to use the linear transformation type,
because this means that the raster image actually won’t be transformed. In this case, the Output raster field
is not activated, because only a new world file will be created.

• For all other transformation types, you have to define an Output raster. As default, a new file ([file-
name]_modified) will be created in the same folder together with the original raster image.

• As a next step, you have to define the Target SRS (Spatial Reference System) for the georeferenced raster
(see Trabalhando com Projeções).

• If you like, you can generate a pdf map and also a pdf report. The report includes information about the
used transformation parameters, an image of the residuals and a list with all GCPs and their RMS errors.

• Furthermore, you can activate the Set Target Resolution checkbox and define the pixel resolution of the
output raster. Default horizontal and vertical resolution is 1.

• The Use 0 for transparency when needed can be activated, if pixels with the value 0 shall be visualized
transparent. In our example toposheet, all white areas would be transparent.

• Finally, Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Mostrando e adaptando as propriedades do raster

Clicando no menu Propriedades do raster dialog in the Settings abrirá a caixa de diálogo com as propriedades do
raster que será georreferenciado.

Configurando o georreferenciador

• You can define whether you want to show GCP coordiniates and/or IDs.

• As residual units, pixels and map units can be chosen.

• For the PDF report, a left and right margin can be defined and you can also set the paper size for the PDF
map.

• Finally, you can activate to Show Georeferencer window docked.

Iniciando a transformação

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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19.10 Complemento de Interpolação

The Interplation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (see
Figure_interpolation_1). The plugin requires the following parameters to be specified before running:

• Input Vector layers: Specify the input point vector layer(s) from a list of loaded point layers. If several
layers are specified, then data from all layers is used for interpolation. Note: It is possible to insert lines or
polygons as constraints for the triangulation, by specifying either “points”, “structure lines” or “break lines”

in the Type combo box.

• Interpolation attribute: Select the attribute column to be used for interpolation or enable the Use
Z-Coordinate checkbox to use the layer’s stored Z values.

• Interpolation Method: Select the interpolation method. This can be either ‘Triangulated Irregular Network
(TIN)’ or ‘Inverse Distance Weighted (IDW)’.

• Number of columns/rows: Specify the number of rows and columns for the output raster file.

• Arquivo de Saída: Define o nome do arquivo raster de saída.

• Adicionar resultado para projetar para carregar o resultado na tela do mapa.

Figura 19.19: Complemento Interpolation

19.10.1 Usando o complemento

1. Inicie QGIS e coloque uma camada de ponto vetor (por exemplo, elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see O menu de complementos) and click on the Raster

→ Interpolation → Interpolation , which appears in the QGIS menu bar. The Interpolation plugin
dialog appears as shown in Figure_interpolation_1.

3. Selecione uma camada de entrada (p. ex., elevp’ |selectstring|) e a coluna (p. ex., ‘‘ELEV‘) para interpo-
lação.

4. Select an interpolation method (e.g., ‘Triangulated Irregular Network (TIN)’), and specify a cell size of
5000 as well as the raster output filename (e.g., elevation_tin).

5. Clique [OK].

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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19.11 Módulo Edição Offiline

For data collection, it is a common situation to work with a laptop or a cell phone offline in the field. Upon return-
ing to the network, the changes need to be synchronized with the master datasource (e.g., a PostGIS database). If
several persons are working simultaneously on the same datasets, it is difficult to merge the edits by hand, even if
people don’t change the same features.

O módulo Edição Offline automatiza a sincronização pela cópia do conteúdo da fonte de dados (usualmente Post-
GIS ou WFS-T) para uma base de dados SpatiaLite e armazena as edições the offline em tabelas dedicadas. Depois
de estarem ligadas outra vez à rede, é possível aplicar edições offline no conjunto de dados prinicipal.

19.11.1 Usando o módulo

• Open some vector layers (e.g., from a PostGIS or WFS-T datasource).

• Save it as a project.

• Go to Database → Offline Editing → Convert to offline project and select the layers to save. The content
of the layers is saved to SpatiaLite tables.

• Edite as camadas offline.

• After being connected again, upload the changes using Database → Offline Editing → Synchronize.

Figura 19.20: Criação de um projecto offline de camadas PostGIS ou WFS

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

276 Capítulo 19. Complementos



QGIS User Guide, Versão 2.2

19.12 Oracle Spatial GeoRaster Plugin

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Isto irá carregar o raster para a tabela padrão GDAL_IMPORT table, como coluna designada de RASTER.

19.12.1 Gerindo ligações

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see O menu de complementos).
The first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database that contains

the data. To do this, begin by clicking on the Add Oracle GeoRaster Layer toolbar button – this will open the Select
Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_1):

• Name: Enter a name for the database connection.

• Database instance: Enter the name of the database that you will connect to.

• Username: Specify your own username that you will use to access the database.

• Password: Provide the password associated with your username that is required to access the database.

Figura 19.21: Janela de Criação de Ligação Oracle

Agora, volte à janela principal Oracle Spatial GeoRaster (veja Figure_oracle_raster_2), use a lista drop-down para
escolher uma ligação, e use o botão [Ligar] para estabelecer a ligação. Pode também [Editar] a ligação, abrindo
a janela anterior e efectuar alterações na informação da ligação, ou usar o botão [Apagar] para remover a ligação
da lista drop-down.

19.12.2 Seleccionando um GeoRaster

Once a connection has been established, the subdatasets window will show the names of all the tables that contain
GeoRaster columns in that database in the format of a GDAL subdataset name.

Clique num dos subconjuntos de dados listados e de seguida clique em [Seleccionar] para escolher o nome da
tabela. Agora, outra lista de subconjunto de dados irá mostrar os nomes das colunas GeoRaster nessa tabela.
Geralmente costuma ser uma lista pequena, uma vez que a maioria dos utilizadores não irá ter mais de um ou duas
colunas GeoRaster na mesma tabela.
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Click on one of the listed subdatasets and then click on [Select] to choose one of the table/column combinations.
The dialog will now show all the rows that contain GeoRaster objects. Note that the subdataset list will now show
the Raster Data Table and Raster Id pairs.

At any time, the selection entry can be edited in order to go directly to a known GeoRaster or to go back to the
beginning and select another table name.

Figura 19.22: Janela de Selecção Oracle GeoRaster

The selection data entry can also be used to enter a WHERE clause at the end of the iden-
tification string (e.g., geor:scott/tiger@orcl,gdal_import,raster,geoid=). See
http://www.gdal.org/frmt_georaster.html for more information.

19.12.3 Exibindo o GeoRaster

Finally, by selecting a GeoRaster from the list of Raster Data Tables and Raster Ids, the raster image will be loaded
into QGIS.

The Select Oracle Spatial GeoRaster dialog can be closed now and the next time it opens, it will keep the same
connection and will show the same previous list of subdatasets, making it very easy to open up another image
from the same context.

Nota: GeoRasters that contain pyramids will display much faster, but the pyramids need to be generated outside
of QGIS using Oracle PL/SQL or gdaladdo.

The following is an example using gdaladdo:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Este é um exemplo usando PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
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sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.13 Módulo de Análise do Terreno Matricial

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (see Figure_raster_terrain_1).

Descrição das análises:

• Slope: Calculates the slope angle for each cell in degrees (based on first- order derivative estimation).

• Exposições: Exposição (começando com o 0 para direcção norte, em graus contra-relógio).

• Hillshade: Creates a shaded map using light and shadow to provide a more three-dimensional appearance
for a shaded relief map.

• Ruggedness Index: A quantitative measurement of terrain heterogeneity as described by Riley et al. (1999).
It is calculated for every location by summarizing the change in elevation within the 3x3 pixel grid.

• Relief: Creates a shaded relief map from digital elevation data. Implemented is a method to choose the
elevation colors by analysing the frequency distribution.

Figura 19.23: Módulo Modelação Matricial do Terreno (cálculo do declive)

19.13.1 Usando o módulo

1. Inicie o QGIS e carregue a camada matricial gtopo30 da localização amostra do GRASS.

2. Load the Raster Terrain Analysis plugin in the Plugin Manager (see O menu de complementos).

3. Select an analysis method from the menu (e.g., Raster → Terrain Analysis → Slope). The Slope dialog
appears as shown in Figure_raster_terrain_1.

4. Especifique um caminho de saída do ficheiro, e o tipo de ficheiro.

5. Clique [OK].

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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19.14 Módulo de Mapa de Densidade

O módulo Mapa de Densidade usa a Estimativa de Densidade Kernel para criar um matricial de densidade (mapa
de temperatura) a partir de uma camada de pontos vectorial. A densidade calculada é baseada no número de
pontos numa localização, com um conjunto largo de pontos agrupados resultando em valores altos. Os mapas de
temperatura permitem facilmente identificar “pontos quentes” e agrupar pontos.

19.14.1 Activar o módulo de Mapa de Densidade

Primeiramente, este módulo base necessita de ser activado usando o Gestor de Módulos (veja load_core_plugin).

Depois da activação do Mapa de Densidade o ícone pode ser encontrado na barra de ferramentas do Raster, e
no menu Raster → Mapas de Densidade.

Seleccione o menu Ver → Barra de Ferramentas → Matricial para exibir a Barra de Ferramentas Matricial se não
estiver vísivel.

19.14.2 Usando o módulo de Mapa de Densidade

Ao clicar no botão da ferramenta |hetmap| Mapas de Densidade abre a janela do módulo Mapas de Densidade
(veja figure_heatmap_2).

A janela tem as seguintes opções:

• Camada de entrada de pontos: Apresenta todas as camadas de pontos vectoriais no projecto actual e é
usado para seleccionar a camada que vai ser analisada.

• Ficheiro raster de saída: Usa o botão para seleccionar a pasta e o nome do ficheiro para o raster de
saída que o módulo de mapas de densidade vai gerar. A extensão do ficheiro não é requerida.

• Formato de Saída: selecciona o formato de saída. Embora todos os formatos suportados pelo o GDAL
poderem ser escolhidos, na maioria dos casos o GeoTIFF é o melhor formato de escolha.

• Raio: usado para especificar o raio de pesquisa (ou largura do kernel) do mapa de densidade em metros ou
em unidades de mapa. O raio especifica a distância em torno de um ponto no qual se fará sentir a influência
do ponto. Os valores altos resultam em maior suavização, mas valores pequenos podem mostrar detalhes
finos e a variação da densidade de pontos.

Quando a caixa de verificação Advançada é activada, opções adicionais serão disponibilizadas:

• Linhas e Colunas: usada para mudar as dimensões do raster de saída. Esses valores estão também ligados
aos valores Tamanho de célula X e Tamanho de célula Y. Aumentando o número de linhas ou colunas irá
diminuir o tamanho de célula e aumenta o tamanho do ficheiro de saída. Os valores nas Linhas e Colunas
também estão ligados, portanto duplicando o número de linhas irá automaticamente duplicar o número de
colunas e o tamanho da célula irá passar para metade. A área geográfica do raster de saída irá ser o mesmo!

• Tamanho da célula X e Tamanho da célula Y: controle o tamanho geográfico de cada pixel para o raster
de saída. Alterando estes valores irá também mudar o número de Linhas e Colunas do raster de saída.

• Forma do kernel: A forma do kernel controla o rácio que influencia o ponto decrescente como a distância
proveniente do ponto de crescente. Diferentes kerneis enfraquecem em diferentes rácios, portanto um kernel
triweight dá elementos de maior peso para distâncias perto do ponto que o kernel de Epanechnikov dá.
Consequentemente, o resultado triweight resulta em pontos quentes “nítidos”, e Epanechnikov resulta em
pontos quentes “suavizados”.Um número de funções kernel padrão estão disponíveis no QGIS, que são
descritos e ilustrados no Wikipedia.

• Rácio de declínio: pode ser usado com kerneis triangulares para maior controlo de como a densidade a
partir dos elementos decrescem com a distância a partir do elemento.

– O valor de 0 (=mínimo) indica que a densidade irá ser concentrada no centro do raio dado e será extinto
no borda.
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– O valor de 0.5 inca que esses pixeis da borda do raio serão atribuídos metade da densidade dos pixeis
que estão no raio do centro de pesquisa.

– O valor de 1 refere que a densidade espalha-se por todo o raio do circulo de pesquisa. (Isto é equiva-
lente ao kernel ‘Uniforme’).

– Um valor maior que 1 indica que a densidade é mais alta para a borda do raio de pesquisa, e em
seguida, no centro.

A camada de pontos de entrada pode ter também campos de atributos que podem afectar como influencia o mapa
de densidade:

• Usar o raio a partir do campo: define o raio de pesquisa para cada elemento da camada de entrada.

• Usar o peso a partir do campo: permite a introdução de elementos para ser pesado por um campo de
atributo. Isto pode ser usado para aumentar a influência de certos elementos existente no resultado de mapa
de densidade.

Quando o nome do ficheiro matricial de saída é especificado, o botão [OK] pode ser usado para criar o mapa de
densidade.

19.14.3 Tutorial: Criando um Mapa de Densidade

Para o seguinte exemplo nós iremos usar a camada de pontos vectorial airports do conjunto de dados amostra
do QGIS (veja Amostra de Dados). Outro excelente tutorial QGIS de produzir mapas de densidade podem ser
encontrados em http://qgis.spatialthoughts.com.

Na Figure_Heatmap_1 estão demonstrados os aeroportos do Alaska.

Figura 19.24: Aeroportos do Alaska

1. Seleccione o botão da ferramenta |hetmap| Mapa de Densidade para abrir a janela do módulo Mapas de
Densidades (veja Figure_heatmap_2).

2. No campo Introduzir camada de pontos seleccione aeroportos da lista de camadas de pontos
carregadas no projecto actual.
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3. Especifique um ficheiro de saída clicando o botão perto do campo Raster de saída . Introduza o nome
do ficheiro heatmap_airports (não é necessário extensão).

4. Deixe o Formato de Saída o formato GeoTIFF como padrão.

5. Altere o Raio para 1000000 metros.

6. Clique em [OK] e carregue o mapa de temperatura dos aeroportos (veja Figure_Heatmap_3).

Figura 19.25: Janela do Mapa de Densidade

O QGIS irá gerar o mapa de densidade e adicionar os resultados à sua janela do mapa. Por defeito, o mapa
de densidade é sombreado a cinzento, com as áreas mais brilhantes concentradas nos aeroportos. O mapa de
densidade pode ser personalizado no QGIS para melhorar a aparência.

1. Abra a janela de propriedades da camada do heatmap_airports (seleccione a camada
heatmap_airports, abre o menu de contexto com o botão direito do rato e seleccione Propriedades).

2. Seleccione o separador Estilo.

3. Alterar o Tipo de Renderização para ‘Banda única pseudocor’.

4. Seleccione um suitable mapa de cor adequado , por exemplo YlOrRed.

5. Clique no botão [Carregar] para recolher os valores mínimos e máximos para cada matricial, de depois
clique no botão [Classificar].

6. Pressione [OK] para actualizar a camada.

O resultado final é demonstrado na Figure_Heatmap_4.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.15 Módulo de Cálculo de Rotas

The Road Graph Plugin is a C++ plugin for QGIS that calculates the shortest path between two points on any
polyline layer and plots this path over the road network.

Características principais:

• Calculates path, as well as length and travel time.
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Figura 19.26: O mapa de densidade após ser carregado fica com uma surperfície cinzenta

Figura 19.27: Mapa de Densidade decorado dos aeroportos do Alaska
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Figura 19.28: Módulo de Cálculo de Rotas|nix|

• Optimizes by length or by travel time.

• Exports path to a vector layer.

• Highlights roads directions (this is slow and used mainly for debug purposes and for the settings testing).

As a roads layer, you can use any polyline vector layer in any QGIS-supported format. Two lines with a common
point are considered connected. Please note, it is required to use layer CRS as project CRS while editing a roads
layer. This is due to the fact that recalculation of the coordinates between different CRSs introduces some errors
that can result in discontinuities, even when ‘snapping’ is used.

In the layer attribute table, the following fields can be used:

• Speed on road section (numeric field).

• Direction (any type that can be cast to string). Forward and reverse directions correspond to a one-way road,
both directions indicate a two-way road.

If some fields don’t have any value or do not exist, default values are used. You can change defaults and some
plugin settings in the plugin settings dialog.

19.15.1 Usando o módulo

After plugin activation, you will see an additional panel on the left side of the main QGIS window. Now, en-
ter some parameters into the Road graph plugin settings dialog in the Vector → Road Graph menu (see fig-
ure_road_graph_2).

After setting the Time unit, Distance unit and Topology tolerance, you can choose the vector layer in the Trans-
portation layer tab. Here you can also choose the Direction field and Speed field. In the Default settings tab, you
can set the Direction for the calculation.

Finally, in the Shortest Path panel, select a Start and a Stop point in the road network layer and click on [Calcu-
late].
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Figura 19.29: Configurações do módulo de Cálculo de Rotas

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.16 Complemento de Consulta Espacial

O complemento Complemento de Consulta Espacial permite que faça consultas espaciais (ex.: selecionar elementos)
numa camada alvo com referência a outra camada. A funcionalidade é baseada na biblioteca GEOS e depende de
uma camada fonte de elementos selecionada.

Operações possíveis:

• Contém

• Igual

• Sobrepõe

• Cruza

• Intersecta

• Disjunto

• Toca

• Dentro

19.16.1 Usando complemento

Como exemplo, nós queremos encontrar as regiões no conjunto de dados do Alaska que contém os aeroportos. Os
seguintes passos são necessários:

1. Iniciar QGIS e carregar as camadas de vetoriais :file: regions.shp e :file: airports.shp.

2. Carregue o complemento Consulta Espacial no Gerenciador de Complementos (ver O menu de comple-

mentos) e clique no ícone Consulta Espacial que aparece no menu de ferramentas do QGIS. A janela do
complemento aparecerá.
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3. Selecione a camada regions como camada fonte e airports como camada de elementos referência.

4. Selecione ‘Contém’ como operador e clique [Aplicar].

Agora obtém uma lista de elementos ID da consulta e tem várias opções como é mostrado na fig-
ure_spatial_query_1.

• Clique em Criar camada com a lista de itens

• Selecione um ID da lista e clique em Criar uma camada com os selecionados.

• Selecione ‘Remover da seleção atual’ no campo E uso resultado para .

• Adicionalmente pode Ampliar ao item ou exibir Registo de mensagens.

Figura 19.30: Análise de consulta espacial - regiões contêm aeroportos

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.17 Complemento SPIT

O QGIS vem com um complemento chamado SPIT (Ferramenta de Importação de Shapefile para PostGIS). O
SPIT pode ser usado para carregar múltiplas shapefiles de uma só vez e inclui o suporte para esquemas. Para usar

o SPIT, abre o Gerenciador de Complementis do menu Complementos , no menu Instalado e marque a caixa

perto do :guilabel:‘SPIT‘e clique [OK] .

Para importar uma shapefile, use Base de dados → Spit → Importar Shape para PostgreSQL da barra de menu
para abrir a janela SPIT - Ferramenta de Importação de Shape para PostGIS . Selecione a base de dados PostGIS
que quer conectar e clique em [Conectar]. Se quiser, pode definir ou alterar opções de importação. Agora pode
adicionar um ou mais arquivos para a fila clicando no botão [Adicionar] . Para processar os arquivos, clique no
botão [OK] . O progresso de importação assim como algum tipo de erros/avisos serão exibidos em cada shapefile
processado. Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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Figura 19.31: Usando Complemento SPIT para importar arquivos shapefile do PostGIS

19.18 Complemento SQL Anywhere

O SQL Anywhere é um sistema de gerenciamento de bancos de dados com propriedade relacional (RDBMS) do
Sybase. O SQL Anywhere possui suporte espacial, incluindo OGC, shapefiles e funções internas para exportar
para os formatos KML, GML e SVG.

SQL Anywhere permite que você se conecte a bancos de dados do SQL Anywhere espacialmente habilitado. A
janela Add SQL Anywhere layer é similar em funcionalidade com a janela do PostGIS e SpatiaLite.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.19 Módulo Verificador de Topologia

Topology describes the relationships between points, lines and polygons that represent the features of a geographic
region. With the Topology Checker plugin, you can look over your vector files and check the topology with several
topology rules. These rules check with spatial relations whether your features ‘Equal’, ‘Contain’, ‘Cover’, are
‘CoveredBy’, ‘Cross’, are ‘Disjoint’, ‘Intersect’, ‘Overlap’, ‘Touch’ or are ‘Within’ each other. It depends on
your individual questions which topology rules you apply to your vector data (e.g., normally you won’t accept
overshoots in line layers, but if they depict dead-end streets you won’t remove them from your vector layer).

QGIS has a built-in topological editing feature, which is great for creating new features without errors. But existing
data errors and user-induced errors are hard to find. This plugin helps you find such errors through a list of rules.

É muito simples para criar regras topológicas com o módulo Verificador de Topologia

Nas camadas do tipo vector as seguintes regras estão disponíveis:

• Must be covered by: Here you can choose a vector layer from your project. Points that aren’t covered by
the given vector layer occur in the ‘Error’ field.

• Must be covered by endpoints of: Here you can choose a line layer from your project.
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Figura 19.32: Janela SQL Anywhere (KDE)

Figura 19.33: O Módulo Verificador de Topologia

288 Capítulo 19. Complementos



QGIS User Guide, Versão 2.2

• Must be inside: Here you can choose a polygon layer from your project. The points must be inside a
polygon. Otherwise, QGIS writes an ‘Error’ for the point.

• Must not have duplicates: Whenever a point is represented twice or more, it will occur in the ‘Error’ field.

• Must not have invalid geometries: Checks whether the geometries are valid.

• Must not have multi-part-geometries: All multi-part points are written into the ‘Error’ field.

On line layers, the following rules are available:

• End points must be covered by: Here you can select a point layer from your project.

• Must not have dangles: This will show the overshoots in the line layer.

• Must not have duplicates: Whenever a line feature is represented twice or more, it will occur in the ‘Error’
field.

• Must not have invalid geometries: Checks whether the geometries are valid.

• Must not have multi-part geometries: Sometimes, a geometry is actually a collection of simple (single-
part) geometries. Such a geometry is called multi-part geometry. If it contains just one type of simple
geometry, we call it multi-point, multi-linestring or multi-polygon. All multi-part lines are written into the
‘Error’ field.

• Must not have pseudos: A line geometry’s endpoint should be connected to the endpoints of two other
geometries. If the endpoint is connected to only one other geometry’s endpoint, the endpoint is called a
psuedo node.

On polygon layers, the following rules are available:

• Must contain: Polygon layer must contain at least one point geometry from the second layer.

• Must not have duplicates: Polygons from the same layer must not have identical geometries. Whenever a
polygon feature is represented twice or more it will occur in the ‘Error’ field.

• Must not have gaps: Adjacent polygons should not form gaps between them. Administrative boundaries
could be mentioned as an example (US state polygons do not have any gaps between them...).

• Must not have invalid geometries: Checks whether the geometries are valid. Some of the rules that define
a valid geometry are:

– Os anéis do polígono devem estar fechados.

– Anéis que definem buracos devem estar dentro de anéis que definem os limites exteriores.

– Os anéis não se podem intersectar a si mesmo (nem mesmo tocar ou cruzar um no outro).

– Os anéis não podem tocar outros anéis, à excepção de um ponto.

• Must not have multi-part geometries: Sometimes, a geometry is actually a collection of simple (single-
part) geometries. Such a geometry is called multi-part geometry. If it contains just one type of simple
geometry, we call it multi-point, multi-linestring or multi-polygon. For example, a country consisting of
multiple islands can be represented as a multi-polygon.

• Must not overlap: Adjacent polygons should not share common area.

• Must not overlap with: Adjacent polygons from one layer should not share common area with polygons
from another layer.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.

19.20 Complemento Estatística Zonal

Com o Complemento Estatística Zonal pode-se analisar os resultados de uma classificação temática. Permite calcular
vários valores de pixeis de um raster com ajuda de uma camada poligonal (veja figure_zonal_statistics). Pode
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calcular a soma, valor médio e contagem total dos pixeis que estão dentro do polígono. Este complemento gera
uma coluna de saída na camada vetorial com um prefixo definido pelo usuário.

Figura 19.34: Janela Estatística Zonal (KDE)

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 20

Ajuda e Suporte

20.1 Listas de Discurssão

O QGIS está ativo no seu desenvolvimento e como tal poderá não apresentar alguns erros. A melhor forma para
obter ajuda será juntar-se na lista de discussão qgis-users. As suas questões irão chegar a uma audiência mais
ampla e as respostas irão beneficiar outros.

20.1.1 Usuários QGIS

Esta lista de discussão é usada para uma discussão geral do QGIS, assim como as questões específicas rela-
cionadas com a instalação e o uso. Pode assinar a lista de discussão do qgis-users visitando o seguinte URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

20.1.2 Lista fossgis-talk

For the German-speaking audience, the German FOSSGIS e.V. provides the fossgis-talk-liste mailing list. This
mailing list is used for discussion of open-source GIS in general, including QGIS. You can subscribe to the fossgis-
talk-liste mailing list by visiting the following URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

20.1.3 Desenvolvedor QGIS

Se você é um desenvolvedor enfrentando problemas de natureza mais técnica, você pode querer se juntar a lista
de discussão qgis-desenvolvedor aqui: http://lists.osgeo.org/mailman/listinfo/qgis-developer

20.1.4 Atualizações QGIS

Each time a commit is made to the QGIS code repository, an email is posted to this list. If you
want to be up-to-date with every change to the current code base, you can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-commit

20.1.5 QGIS-trac

Esta lista fornece uma notificação de email relacionado a gerenciamento de projetos, incluindo re-
latórios de bugs, tarefas e solicitações de recursos. Você pode se inscrever para esta lista em:
http://lists.osgeo.org/mailman/listinfo/qgis-trac
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20.1.6 Equipe da Comunidade QGIS

This list deals with topics like documentation, context help, user guide, web sites, blog, mailing lists, forums, and
translation efforts. If you would like to work on the user guide as well, this list is a good starting point to ask your
questions. You can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-community-team

20.1.7 Equipe de lançamento QGIS

This list deals with topics like the release process, packaging binaries for various OSs and announcing new releases
to the world at large. You can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-release-team

20.1.8 Tradução do QGIS

Esta lista trata dos esforços de tradução. Se você gosta de trabalhar na tradução dos manuais ou na interface gráfica
do usuário (GUI), esta lista é um bom ponto de partida para fazer suas perguntas. Você pode se inscrever nesta
lista em: http://lists.osgeo.org/mailman/listinfo/qgis-tr

20.1.9 Aprendizado QGIS

This list deals with QGIS education efforts. If you would like to work on QGIS education ma-
terials, this list is a good starting point to ask your questions. You can subscribe to this list at:
http://lists.osgeo.org/mailman/listinfo/qgis-edu

20.1.10 Comitê Diretor QGIS

Esta lista é usada para discutirmos assuntos do Comité de Direção relacionados com a boa gestão e direção do
GIS. Podem assinar esta lista em: http://lists.osgeo.org/mailman/listinfo/qgis-psc

You are welcome to subscribe to any of the lists. Please remember to contribute to the list by answering questions
and sharing your experiences. Note that the qgis-commit and qgis-trac lists are designed for notification only and
are not meant for user postings.

20.2 IRC

We also maintain a presence on IRC - visit us by joining the #qgis channel on irc.freenode.net. Please wait for a
response to your question, as many folks on the channel are doing other things and it may take a while for them to
notice your question. If you missed a discussion on IRC, not a problem! We log all discussion, so you can easily
catch up. Just go to http://qgis.org/irclogs and read the IRC-logs.

Commercial support for QGIS is also available. Check the website http://qgis.org/en/commercial-support.html for
more information.

20.3 Rastreador de Erros

While the qgis-users mailing list is useful for general ‘How do I do XYZ in QGIS?’-type questions, you
may wish to notify us about bugs in QGIS. You can submit bug reports using the QGIS bug tracker at
http://hub.qgis.org/projects/quantum-gis/issues. When creating a new ticket for a bug, please provide an email
address where we can contact you for additional information.

Please bear in mind that your bug may not always enjoy the priority you might hope for (depending on its severity).
Some bugs may require significant developer effort to remedy, and the manpower is not always available for this.
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Solicitações de recursos também podem ser enviadas usando o mesmo sistema de mensagem de erros. Por favor,
certifique-se de ter selecionado o tipo de recurso.

If you have found a bug and fixed it yourself, you can submit this patch also. Again, the lovely redmine ticketsys-
tem at http://hub.qgis.org/wiki/quantum-gis/issues has this type as well. Check the Patch supplied checkbox
and attach your patch before submitting your bug. One of the developers will review it and apply it to QGIS. Please
don’t be alarmed if your patch is not applied straight away – developers may be tied up with other commitments.

20.4 Blog

The QGIS community also runs a weblog at http://planet.qgis.org/planet/, which has some interesting articles for
users and developers as well provided by other blogs in the community. You are invited to contribute your own
QGIS blog!

20.5 Plugins

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here, you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.

20.6 Wiki

Lastly, we maintain a WIKI web site at http://hub.qgis.org/projects/quantum-gis/wiki where you can find a variety
of useful information relating to QGIS development, release plans, links to download sites, message-translation
hints and more. Check it out, there are some goodies inside!

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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CAPÍTULO 21

Apêndice

21.1 Licença Pública Geral GNU

Versão 2, Junho 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

É permitido a todos copiar e distribuir uma cópia desta documento da licença, porém não é permitido alterar esta.

Preâmbulo

As licenças de muitos software são desenvolvidas para restringir sua liberdade de compartilhá-lo e mudá-lo. Con-
trária a isso, a Licença Pública Geral GNU pretende garantir sua liberdade de compartilhar e alterar software
livres – garantindo que o software será livre e gratuito para os seus usuários. Esta Licença Pública Geral aplica-se
à maioria dos software da Free Software Foundation e a qualquer outro programa cujo autor decida aplicá-la.
(Alguns outros software da FSF são cobertos pela Licença Pública Geral de Bibliotecas, no entanto.) Você pode
aplicá-la também aos seus programas.

Quando falamos em softwares livres, nos referimos a liberdade, não preço. Nossa Licença Publica Geral é proje-
tada para garantir: que você tenha liberdade de compartilhar cópias do software livre (e cobrar por este serviço, se
desejar) que você recebeu o código fonte ou pode adquirir se quiser; que você possa modificar o software ou usar
partes dele em novos softwares livres; que você saiba que pode fazer tais coisas.

Para proteger os seus direitos nós precisamos fazer restrições que proibem qualquer pessoa a negar a você tais
direitos ou a pedir que se renda a eles.Estas restriçoes se traduzem em certas responsabilidades para você, se você
distribuir ou modificar cópias do software.

Por exemplo, se você distribuir cópias de determinado programa, seja ele gratis ou por uma taxa, você deve dar
aos beneficiários todos os direitos que você tem. Você deve garantir que eles também recebam ou possam acessar
o codigo fonte.E você deve mostrar a eles estes termos para que eles saibam seus direitos.

Nós protegemos seus direitos com dois passos: (1) direitos autorais do software, e (2) oferecemos a você esta
licença que lhe dá a permissão legal para copiar, distruibuir e/ou modificar o software.

Também, para a proteção nossa e de cada autor, nós queremos garantir que todos compreendam que não há garantia
para este software livre. Se o software for modificado por outra pessoa e passado adiante, os beneficiários devem
saber que oque eles tem não é o software original, para que, qualquer problema introduzido por outros não reflita
na reputaçao do autor original.

Por fim, qualquer programa livre é constantemente ameaçado por patentes de softwares. Nós queremos evitar o
risco de que redistribuidores de um programa livre obtenham licenças individuais, fazendo assim do programa
proprietário. Para prevenir isso, nós deixamos claro que qualquer patente deve ser licenciada para o uso livre de
todas as pessoas.

Seguem os precisos termos e condições para cópia, ditribuiçao e modificaçao. TERMOS E CONDIÇÕES PARA
CÓPIA, DISTRIBUIÇAO E MODIFICAÇÃO

0. Esta licença se aplica a qualquer programa ou outro trabalho que contenha um aviso inserido pelo detentor
dos direitos autorais informando que o mesmo pode ser distribuído sob as condições desta Licença Pública
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Geral.O “Programa” abaixo refere-se a qualquer programa ou trabalho, e “trabalho baseado no Programa”
significa tanto o Programa em si como quaisquer trabalhos derivados, de acordo com a lei de direitos au-
torais: isto quer dizer um trabalho que contenha o Programa ou parte dele, tanto originalmente ou com
modificações, e/ou tradução para outros idiomas. (Doravante o processo de tradução está incluído sem
limites no termo “modificação”.) Cada licenciado é mencionado como “você”.

Atividades outras que a cópia, a distribuição e modificação não estão cobertas por esta Licença; elas estão
fora de seu escopo. O ato de executar o Programa não é restringido e o resultado do Programa é coberto ape-
nas se seu conteúdo contenha trabalhos baseados no Programa (independentemente de terem sido gerados
pela execução do Programa). Se isso é verdadeiro depende do que o programa faz.

1. Você pode copiar e distribuir cópias fiéis do código-fonte do Programa da mesma forma que você o recebeu,
usando qualquer meio, deste que você conspícua e apropriadamente publique em cada cópia um aviso de
direitos autorais e uma declaração de inexistência de garantias; mantenha intactas todos os avisos que se
referem a esta Licença e à ausência total de garantias; e forneça a outros recebedores do Programa uma
cópia desta Licença, junto com o Programa.

Você pode cobrar uma taxa pelo ato físico de transferir uma cópia e pode, opcionalmente, oferecer garantia
em troca de pagamento.

2. Você pode modificar sua cópia ou cópias do Programa, ou qualquer parte dele, assim gerando um trabalho
baseado no Programa, e copiar e distribuir essas modificações ou trabalhos sob os termos da seção 1 acima,
desde que você também se enquadre em todas estas condições:

(a) Você tem que fazer com que os arquivos modificados levem avisos proeminentes afirmando que você
alterou os arquivos, incluindo a data de qualquer alteração.

(b) Você tem que fazer com que quaisquer trabalhos que você distribua ou publique, e que integralmente
ou em partes contenham ou sejam derivados do Programa ou de suas partes, sejam licenciados, inte-
gralmente e sem custo algum para quaisquer terceirose, sob os termos desta Licnça.

(c) Se qualquer programa modificado normalmente lê comandos interativamente quando executados, você
tem que fazer com que, quando iniciado tal uso interativo da forma mais simples, seja impresso ou
mostrado um anúncio de que não há qualquer garantia (ou então que você fornece a garantia) e que
os usuários podem redistribuir o programa sob estas condições, ainda informando os usuários como
consultar uma cópia desta Licença. (Exceção: se o Programa em si é interativo mas normalmente não
imprime estes tipos de anúncios, seu trabalho baseado no Programa não precisa imprimir um anúncio.)

Estas exigências aplicam-se ao trabalho modificado como um todo. Se seções identificáveis de tal trabalho
não são derivadas do Programa, e podem ser razoavelmente consideradas trabalhos independentes e sepa-
rados por si só, então esta Licença, e seus termos, não se aplicam a estas seções quando você distribui-las
como trabalhos em separado. Mas quando você distribuir as mesmas seções como parte de um todo que
é trabalho baseado no Programa, a distribuição como um todo tem que se enquadrar nos termos desta Li-
cença, cujas permissões para outros licenciados se estendem ao todo, portanto também para cada e toda
parte independente de quem a escreveu.

Desta forma, esta seção não tem a intenção de reclamar direitos os contestar seus direitos sobre o trabalho es-
crito completamente por você; ao invés disso, a intenção é a de exercitar o direito de controlar a distribuição
de trabalhos, derivados ou coletivos, baseados no Programa.

Adicionalmente, a mera adição ao Programa de outro trabalho não baseado no Programa (ou de trabalho
baseado no Programa) em um volume de armazenamento ou meio de distribuição não faz o outro trabalho
parte do escopo desta Licença.

3. Você pode copiar e distribuir o Programa (ou trabalho baseado nele, conforme descrito na Seção 2) em
código-objeto ou em forma executável sob os termos das Seções 1 e 2 acima, desde que você faça um dos
seguintes:

(a) O acompanhe com o código-fonte completo e em forma acessível por máquinas, que tem que ser
distribuído sob os termos das Seções 1 e 2 acima e em meio normalmente utilizado para o intercâmbio
de software; ou,

(b) O acompanhe com uma oferta escrita, válida por pelo menos três anos, de fornecer a qualquer um, com
um custo não superior ao custo de distribuição física do material, uma cópia do código-fonte completo
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e em forma acessível por máquinas, que tem que ser distribuído sob os termos das Seções 1 e 2 acima
e em meio normalmente utilizado para o intercâmbio de software; ou,

(c) O acompanhe com a informação que você recebeu em relação à oferta de distribuição do código-
fonte correspondente. (Esta alternativa é permitida somente em distribuição não comerciais, e apenas
se você recebeu o programa em forma de código-objeto ou executável, com oferta de acordo com a
Subseção b acima.)

O código-fonte de um trabalho corresponde à forma de trabalho preferida para se fazer modificações. Para
um trabalho em forma executável, o código-fonte completo significa todo o código-fonte de todos os módu-
los que ele contém, mais quaisquer arquivos de definição de “interface”, mais os “scripts” utilizados para se
controlar a compilação e a instalação do executável. Contudo, como exceção especial, o código-fonte dis-
tribuído não precisa incluir qualquer componente normalmente distribuído (tanto em forma original quanto
binária) com os maiores componentes (o compilador, o “kernel” etc.) do sistema operacional sob o qual o
executável funciona, a menos que o componente em si acompanhe o executável.

Se a distribuição do executável ou código-objeto é feita através da oferta de acesso a cópias de algum lugar,
então ofertar o acesso equivalente a cópia, do mesmo lugar, do código-fonte equivale à distribuição do
código-fonte, mesmo que terceiros não sejam compelidos a copiar o código-fonte com o código-objeto.

4. Você não pode copiar, modificar, sub-licenciar ou distribuir o Programa, exceto de acordo com as condições
expressas nesta Licença. Qualquer outra tentativa de cópia, modificação, sub-licenciamento ou distribuição
do Programa não é valida, e cancelará automaticamente os direitos que lhe foram fornecidos por esta Li-
cença. No entanto, terceiros que de você receberam cópias ou direitos, fornecidos sob os termos desta
Licença, não terão suas licenças terminadas, desde que permaneçam em total concordância com ela.

5. Você não é obrigado a aceitar esta Licença já que não a assinou. No entanto, nada mais o dará permissão
para modificar ou distribuir o Programa ou trabalhos derivados deste. Estas ações são proibidas por lei, caso
você não aceite esta Licença. Desta forma, ao modificar ou distribuir o Programa (ou qualquer trabalho
derivado do Programa), você estará indicando sua total aceitação desta Licença para fazê-los, e todos os
seus termos e condições para copiar, distribuir ou modificar o Programa, ou trabalhos baseados nele.

6. Cada vez que você redistribuir o Programa (ou qualquer trabalho baseado nele), os recebedores adquirirão
automaticamente do licenciador original uma licença para copiar, distribuir ou modificar o Programa, su-
jeitos a estes termos e condições. Você não poderá impor aos recebedores qualquer outra restrição ao
exercício dos direitos então adquiridos. Você não é responsável em garantir a concordância de terceiros a
esta Licença.

7. Se, em conseqüência de decisões judiciais ou alegações de infringimento de patentes ou quaisquer outras
razões (não limitadas a assuntos relacionados a patentes), condições forem impostas a você (por ordem
judicial, acordos ou outras formas) e que contradigam as condições desta Licença, elas não o livram das
condições desta Licença. Se você não puder distribuir de forma a satisfazer simultaneamente suas obri-
gações para com esta Licença e para com as outras obrigações pertinentes, então como conseqüência você
não poderá distribuir o Programa. Por exemplo, se uma licença de patente não permitirá a redistribuição,
livre de “royalties”, do Programa, por todos aqueles que receberem cópias direta ou indiretamente de você,
então a única forma de você satisfazer a ela e a esta Licença seria a de desistir completamente de distribuir
o Programa.

Se qualquer parte desta seção for considerada inválida ou não aplicável em qualquer circunstância particular,
o restante da seção se aplica, e a seção como um todo se aplica em outras circunstâncias.

O propósito desta seção não é o de induzi-lo a infringir quaisquer patentes ou reivindicação de direitos de
propriedade outros, ou a contestar a validade de quaisquer dessas reivindicações; esta seção tem como único
propósito proteger a integridade dos sistemas de distribuição de software livres, o que é implementado pela
prática de licenças públicas. Várias pessoas têm contribuído generosamente e em grande escala para os
software distribuídos usando este sistema, na certeza de que sua aplicação é feita de forma consistente; fica
a critério do autor/doador decidir se ele ou ela está disposto a distribuir software utilizando outro sistema, e
um licenciado não pode impor esta escolha.

Esta seção destina-se a tornar bastante claro o que se acredita ser conseqüência do restante desta Licença.

8. Se a distribuição e/ou uso do Programa são restringidos em certos países por patentes ou direitos autorais,
o detentor dos direitos autorais original, e que colocou o Programa sob esta Licença, pode incluir uma limi-
tação geográfica de distribuição, excluindo aqueles países de forma a tornar a distribuição permitida apenas
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naqueles ou entre aqueles países então não excluídos. Nestes casos, esta Licença incorpora a limitação
como se a mesma constasse escrita nesta Licença.

9. A Free Software Foundation (Fundação do Software Livre) pode publicar versões revisadas e/ou novas da
Licença Pública Geral de tempos em tempos. Estas novas versões serão similares em espírito à versão atual,
mas podem diferir em detalhes que resolvem novos problemas ou situações.

A cada versão é dada um número distinto. Se o Programa especifica um número de versão específico desta
Licença que se aplica a ele e a “qualquer nova versão”, você tem a opção de aceitar os termos e condições
daquela versão ou de qualquer outra versão publicada pela Free Software Foundation. Se o programa não
especifica um número de versão desta Licença, você pode escolher qualquer versão já publicada pela Free
Software Foundation.

10. Se você pretende incorporar partes do Programa em outros programas livres cujas condições de distribuição
são diferentes, escreva ao autor e solicite permissão. Para o software que a Free Software Foundation detém
direitos autorais, escreva à Free Software Foundation; às vezes nós permitimos exceções a este caso. Nossa
decisão será guiada pelos dois objetivos de preservar a condição de liberdade de todas as derivações do
nosso software livre, e de promover o compartilhamento e reutilização de software em aspectos gerais.

AUSÊNCIA DE GARANTIA

11. PELO PROGRAMA SER LICENCIADO SEM ÔNUS, NÃO HÁ QUALQUER GARANTIA PARA O
PROGRAMA, NA EXTENSÃO PERMITIDA PELAS LEIS APLICÁVEIS. EXCETO QUANDO EX-
PRESSADO DE FORMA ESCRITA, OS DETENTORES DOS DIREITOS AUTORAIS E/OU TER-
CEIROS DISPONIBILIZAM O PROGRAMA “NO ESTADO”, SEM QUALQUER TIPO DE GARAN-
TIAS, EXPRESSAS OU IMPLÍCITAS, INCLUINDO, MAS NÃO LIMITADO A, AS GARANTIAS
IMPLÍCITAS DE COMERCIALIZAÇÃO E AS DE ADEQUAÇÃO A QUALQUER PROPÓSITO. O
RISCO TOTAL COM A QUALIDADE E DESEMPENHO DO PROGRAMA É SEU. SE O PROGRAMA
SE MOSTRAR DEFEITUOSO, VOCÊ ASSUME OS CUSTOS DE TODAS AS MANUTENÇÕES,
REPAROS E CORREÇÕES.

12. EM NENHUMA OCASIÃO, A MENOS QUE EXIGIDO PELAS LEIS APLICÁVEIS OU ACORDO
ESCRITO, OS DETENTORES DOS DIREITOS AUTORAIS, OU QUALQUER OUTRA PARTE QUE
POSSA MODIFICAR E/OU REDISTRIBUIR O PROGRAMA CONFORME PERMITIDO ACIMA,
SERÃO RESPONSABILIZADOS POR VOCÊ POR DANOS, INCLUINDO QUALQUER DANO EM
GERAL, ESPECIAL, ACIDENTAL OU CONSEQÜENTE, RESULTANTES DO USO OU INCAPACI-
DADE DE USO DO PROGRAMA (INCLUINDO, MAS NÃO LIMITADO A, A PERDA DE DADOS
OU DADOS TORNADOS INCORRETOS, OU PERDAS SOFRIDAS POR VOCÊ OU POR OUTRAS
PARTES, OU FALHAS DO PROGRAMA AO OPERAR COM QUALQUER OUTRO PROGRAMA),
MESMO QUE TAL DETENTOR OU PARTE TENHAM SIDO AVISADOS DA POSSIBILIDADE DE
TAIS DANOS.

QGIS Qt exceções a GPL

Em adição, excepcionalmente, a Equipe de Desenvolvimento QGIS dá a permissão de linkar o código
deste programa com a biblioteca QT, inclusa, mas não limitada as seguintes versões (ambas gratuitas
e comerciais):Qt / Não-Comercial do Windows, Qt / Windows, Qt/X11, Qt / Mac, e Qt / Embedded
(ou com versões modificadas do Qt que usam a mesma licença do Qt) e distribuir combinações rela-
cionadas, incluindo os dois. Você deve obedecer a GNU General Public License em todos os aspectos
para todo o código usado em outra Qt. Se você modificar este arquivo, você pode estender essa ex-
ceção para a sua versão do arquivo, mas você não é obrigado a fazê-lo. Se você não quiser fazer isso,
exclua essa declaração exceção de sua versão.

21.2 GNU Licença de Documentação Gratuíta

Versão 1.3, 3 de Novembro de 2008

Direitos Autorais 2000, 2001, 2002, 2007, 2008 Free Software Foundation (Fundação do Software
Livre)

<http://fsf.org/>
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Qualquer pessoa tem permissão para copiar e distribuir cópias fiéis deste documento de licença, mas modifica-lo
não é permitido.

Preâmbulo

O objetivo desta licença é produzir um manual, compêndio, ou outro documento funcional e útil. “Grátis” no
sentido de liberdade: para garantir a todos a efetiva liberdade de copiar e distribui-la com ou sem modificações,
comercialmente ou não.Secundariamente esta licença preserva ao autor e editor uma maneira de ter crédito pelo
seu trabalho, embora não sejam considerados responsaveis por modificações feitas por outros.

Esta licença é uma espécie de “copyleft”, oque significa que trabalhos derivativos do documento devem ser livres
no mesmo sentido. Ela complementa a GNU (Licença Publica Geral), que é uma licença copyleft projetada para
softwares livres.

Criamos esta Licença para que seja usada em manuais para programas livres, porque programas livres precisam
de documentação livre: um programa livre deveria vir com manuais que ofereçam as mesmas liberdades que o
programa oferece. Mas esta Licença não está limitada a manuais de programas de computador; ela pode ser usada
para qualquer trabalho de texto, independentemente do assunto ou se é publicado como um livro impresso. Nós
recomendamos esta Licença principalmente para trabalhos cujo propósito é instrução ou referência.

1. APPLICABILITY AND DEFINITIONS

Esta licença se aplica a qualquer manual ou outro trabalho, em qualquer meio, que contenha uma nota introduzida
pelo detentor dos direitos autorais dizendo que o documento pode ser distribuído sob os termos desta. Tal nota
garante uma licença mundial, livre de royalties, de duração ilimitada, para usar este trabalho sob as condições aqui
colocadas. O “Documento”, abaixo, se refere a qualquer tal manual ou trabalho. Qualquer membro do público é
um licenciado, e será tratado por “você”. Você aceita a licença se copiar, modificar ou distribuir o trabalho de um
modo que necessite de permissão de acordo com a lei de direitos autorais.

Uma “Versão Modificada” do Documento se refere a qualquer trabalho contendo o Documento ou uma parte deste,
quer seja copiado sem modificações, quer com modificações e/ou traduzido para outra língua.

Uma “Seção Secundária” é um apêndice com nome ou uma seção inicial do Documento que trata exclusivamente
da relação dos editores ou autores do Documento com seu assunto geral (ou temas relacionados) e não contém
nada que possa estar diretamente dentro do assunto geral. Assim, se o Documento é em parte um livro- texto de
matemática, uma Seção Secundária não pode explicar nada de matemática. Tal relação pode ser uma conexão
histórica com o assunto ou com temas relacionados, ou tratar de questões legais, comerciais, filosóficas, éticas ou
políticas com relação a eles.

“Seções Invariantes” são certas Seções Secundárias cujos títulos são designados como sendo de Seções invariantes
na nota que afirma que o Documento é publicado sob esta Licença. Se uma seção não se encaixa na definição acima
de Secundária, então não se permite que seja designada como Invariante. O Documento pode não conter nenhuma
Seção Invariante. Se o documento não identificar quaisquer Seções Invariantes, então não há nenhuma.

“Textos de Capa” são certas passagens de texto que são listada como Textos de Capa Frontal ou Texto de Quarta
Capa, na nota que afirma que o Documento é publicado sob esta Licença. Um Texto de Capa Frontal pode ter no
máximo 5 palavras, e um Texto de Quarta Capa pode ter no máximo 25 palavras.

Uma cópia “Transparente” do Documento significa uma cópia que pode ser lida pelo computador, representada
em um formato cuja especificação esteja disponível ao público geral, que seja apropriada para a imediata revisão
do documento usando-se editores de texto genéricos ou (para imagens compostas de pixeis) programas gráficos
genéricos ou (para desenhos) algum editor de desenhos amplamente disponível, e que seja apropriado para in-
clusão em formatadores de texto ou para tradução automática para uma variedade de formatos apropriados para
inclusão em formatadores de texto. Uma cópia feita em outro formato de arquivo Transparente cuja marcação, ou
ausência desta, foi manipulada para impedir ou desencorajar modificação subseqüente pelos leitores não é Trans-
parente. Um formato de imagem não é Transparente se usado em lugar de qualquer quantidade substancial de
texto. Uma cópia que não é “Transparente” é chamada “Opaca”.

Exemplos de formatos apropriados para cópias Transparentes incluem ASCII puro sem marcação, formato de
entrada Texinfo, LaTex, SGML ou XML usando um DTD publicamente disponível, e HTML padrão simples,
PostScript ou PDF projetados para modificação por humanos. Exemplos de formatos de imagem transparentes
incluem PNG, XCF e JPG. Formatos Opacos incluem formatos proprietários que podem ser lidos e editados
somente por processadores de texto proprietários, SGML ou XML para os quais o DTD e/ou ferramentas de
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processamento não são largamente disponibilizadas, e HTML, Postscript ou PDF gerados automaticamente com
propósito apenas de saída por alguns processadores de texto.

“Página de Título” significa, para um livro impresso, a própria página do título, além das páginas subseqüentes
necessárias para conter, de forma legível, o material que esta Licença requer que apareça na página do título. Para
trabalhos em formatos que não têm uma página de título assim, “Página de Título” significa o texto próximo à
ocorrência mais proeminente do título do trabalho, precedendo o início do corpo do texto.

O “publicador” é qualquer pessoa ou entidade que distribua cópias do Documento para o público.

Uma seção “Intitulada XYZ” significa uma sub-unidade com nome do Documento cujo título ou é precisamente
XYZ ou contém XYZ em parênteses seguindo o texto que traduz XYZ em outra língua. (Aqui XYZ representa
o nome de uma seção específica mencionado acima, tal como “Agradecimentos”, “Dedicatória”, “Apoio”, ou
“Histórico”.) “Preservar o Título” de uma seção assim quando você modifica o Documento significa que ela
continua sendo uma seção “Intitulada XYZ” de acordo com esta definição.

O Documento pode incluir Notas de Garantia em seguida à nota que afirma que esta Licença se aplica ao Docu-
mento. Estas Notas de Garantia são tidas como inclusas por referência nesta Licença, mas somente com relação
às notas de garantia: qualquer outra implicação que estas Notas de Garantia possam ter é anulada e não tem efeito
algum no conteúdo desta Licença.

2. VERBATIM COPYING

Você pode copiar e distribuir o Documento em qualquer meio, comercialmente ou não-comercialmente, desde que
esta licença, as notas de direitos autorais (copyright), e a nota de licença afirmando que esta Licença se aplica ao
Documento sejam reproduzidas em todas as cópias, e que você não inclua outras condições, quaisquer que sejam,
às condições desta Licença. Você não pode usar de medidas técnicas para obstruir ou controlar a leitura ou cópia
futura das cópias que você fizer ou distribuir. Contudo, você pode aceitar compensação em troca das cópias. Se
você distribuir um número suficientemente grande de cópias, você deve também respeitar as condições na seção
3.

Você pode também emprestar cópias, sob as mesmas condições acima mencionadas, e você também as pode
mostrar publicamente.

3. COPYING IN QUANTITY

Se você publicar cópias impressas (ou cópias em um meio que normalmente tem capas impressas) do documento,
em número maior que 100, e a nota de licença do Documento requer Textos de Capa, você deve encadernar as
cópias em capas que carreguem, de forma clara e legível, todos estes Textos de Capa: Textos de Capa Frontal na
capa frontal, e Textos de Quarta Capa na quarta capa. Ambas as capas devem também identificar, de forma clara
e legível, você como o editor das cópias. A capa frontal deve apresentar o título completo com todas as palavras
deste igualmente proeminentes e visíveis. Você pode adicionar outro material nas capas. Cópias com mudanças
limitadas às capas, desde que preservando o título do Documento e satisfazendo estas condições, podem ser
tratadas como cópias literais em outros aspectos.

Se os textos necessários a qualquer uma das capas são demasiado volumosos para serem incluídos de forma
legível, você deve colocar os primeiros listados (quantos couberem razoavelmente) na própria capa, e continuar o
resto nas páginas adjacentes.

Se você publicar ou distribuir cópias Opacas do Documento em número maior que 100, você deve ou incluir uma
cópia Transparente legível por computador juntamente com cada cópia Opaca, ou dizer em, ou juntamente com,
cada cópia Opaca um endereço de rede a partir do qual o público geral possa acessar e obter, usando protocolos
de rede públicos padrão, uma cópia Transparente completa do Documento, livre de material adicionado. Se você
decidir pela segunda opção, você deve seguir passos razoavelmente prudentes, quando começar a distribuir as
cópias Opacas em quantidade, para garantir que esta cópia transparente permanecerá acessível no local indicado
por pelo menos um ano após a última vez que você distribuir uma cópia Opaca (diretamente ou através de seus
agentes ou distribuidor) desta edição ao público.

É solicitado, mas não exigido, que você contate os autores do Documento muito antes de redistribuir qualquer
número grande de cópias, para dar a eles uma chance de lhe fornecer uma versão atualizada do Documento.

4. MODIFICATIONS

Você pode copiar e distribuir uma Versão Modificada do Documento sob as condições das seções 2 e 3 acima,
desde que você forneça a Versão Modificada estritamente sob esta Licença, com a Versão Modificada no papel de
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Documento, permitindo assim a distribuição e modificação da Versão Modificada a quem quer que possua uma
cópia desta. Além disso, você deve executar os seguintes procedimentos na Versão Modificada:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. Liste na Página de Título, como autores, uma ou mais pessoas ou entidades responsáveis pela autoria ou
modificações na Versão Modificada, juntamente com pelo menos cinco dos autores principais do Docu-
mento (todos seus autores principais, se houver menos que cinco), a menos que estes lhe desobriguem desta
exigência.

3. Mencione na Página de Título o nome do editor da Versão Modificada, como seu editor.

4. Preserve todas as notas de direitos autorais (copyright) do Documento.

5. Adicione uma nota apropriada de direitos autorais para suas modificações, adjacente às outras notas de
direitos autorais.

6. Inclua, imediatamente após as notas de direitos autorais, uma nota de licença dando ao público permissão
para usar a Versão Modificada sob os termos desta Licença, na forma mostrada no Adendo abaixo.

7. Preserve naquela nota de licença a lista completa de Seções Invariantes e Textos de Capa requeridos dados
na nota de licença do Documento.

8. Inclua uma cópia inalterada desta Licença.

9. Preserve a seção intitulada “Histórico”, preserve seu título, e adicione a esta um item mencionando pelo
menos o título, ano, novos autores, e editor da Versão Modificada conforme incluído na Página de Título.
Se não houver uma seção intitulada “Histórico” no Documento, crie uma mencionando o título, ano, autores
e editor do Documento como mostrado na Página de Título, em seguida adicione um item descrevendo a
Versão Modificada como mencionado na sentença anterior.

10. Preserve o endereço de rede, se algum, dado no Documento para acesso público a uma cópia Transparente
deste e, da mesma maneira, os endereços de rede dados no Documento para versões prévias nas quais este
se baseia. Estes podem ser colocados na seção “Histórico”. Você pode omitir um endereço de rede para um
trabalho que foi publicado pelo menos quatro anos antes do Documento em si, ou se o editor original da
versão à qual o endereço se refere der permissão.

11. Para qualquer seção intitulada “Agradecimentos” ou “Dedicatória”, preserve o título da seção, e preserve
dentro da seção toda a substância e tom de cada um dos agradecimentos e/ou dedicatórias lá mencionados.

12. Preserve todas as Seções Invariantes do Documento, inalteradas no seu texto e títulos. Números de seção
ou o equivalente não são considerados parte dos títulos das seções.

13. Apague qualquer seção intitulada “Apoio”. Tal seção não ser incluída na Versão Modificada.

14. Não modifique o título de qualquer seção a ser intitulada “Apoio” ou que resulte em conflito com título de
qualquer Seção Invariante.

15. Preserve any Warranty Disclaimers.

Se a Versão Modificada incluir novas seções iniciais ou apêndices que sejam qualificados como Seções Se-
cundárias, e não contiver material copiado do Documento, você pode, a seu critério, tornar algumas dessas ou
todas essas seções em invariantes. Para fazer isso, adicione seus títulos à lista de Seções Invariantes na nota de
licença da Versão Modificada. Estes títulos devem ser distintos de quaisquer outros títulos de seções.

Você pode incluir uma seção intitulada “Apoio”, dado que ela contenha nada além de apoio recebido para sua
Versão Modificada por várias fontes – por exemplo, notas do revisor ou de que o texto foi aprovado por uma
organização como a definição autoritativa de um padrão.

Você pode adicionar uma passagem de até cinco palavras como Texto de Capa Frontal, e uma passagem de até
25 palavras como Texto de Quarta Capa, ao fim da lista de Textos de Capa na Versão Modificada. Somente
uma passagem de Texto de Capa Frontal e uma de Texto de Quarta Capa pode ser adicionado por (ou através
de arranjos feitos por) uma entidade qualquer. Se o Documento já incluir um texto de capa para a mesma capa,
previamente incluído por você ou por arranjo feito pela mesma entidade em cujo nome você está agindo, você não
pode adicionar outro; mas você pode substituir o antigo, com permissão explícita do editor anterior, que o incluiu.
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O(s) autor(es) e editor(es) do Documento, por esta Licença, não dão permissão para seus nomes serem usados
para publicidade ou defesa ou apoio implícito para qualquer Versão Modificada.

5. COMBINING DOCUMENTS

Você pode combinar o documento com outros documentos publicados sob esta Licença, sob os termos definidos
na seção 4 acima para versões modificadas, desde que você inclua na combinação todas as Seções Invariantes de
todos os documentos originais, sem modificações, e as liste como Seções Invariantes de seu trabalho combinado,
na sua nota de licença, e que você preserve todas as Notas de Garantia.

O trabalho combinado somente precisa conter uma cópia desta Licença, e múltiplas Seções Invariantes idênticas
podem ser substituídas por uma única cópia. Se houver múltiplas Seções Invariantes com o mesmo nome, porém
com conteúdos diferentes, torne o título de cada uma destas seções único, adicionando ao fim dele, entre parên-
teses, o nome do autor ou editor original desta seção, se conhecido, ou então um número único. Faça o mesmo
ajuste nos títulos de seção na lista de Seções Invariantes na nota de licença do trabalho combinado.

Na combinação, você deve combinar quaisquer seções intituladas “Histórico” nos vários documentos originais,
formando uma seção intitulada “Histórico”; do mesmo modo, combine quaisquer seções intituladas “Agradeci-
mentos”, e quaisquer seções intituladas “Dedicatória”. Você deve apagar todas as seções intituladas “Apoio”.

6. COLLECTIONS OF DOCUMENTS

Você pode fazer uma coleção consistindo do Documento e outros documentos publicados sob esta Licença, e
substituir as cópias individuais desta Licença, nos vários documentos, por uma única cópia a ser incluída na
coleção, desde que você siga as regras desta Licença para cópias literais de cada documento em todos os outros
aspectos.

Você pode extrair um único documento desta coleção, e distribuí-lo individualmente sob esta Licença, desde que
você insira uma cópia desta Licença no documento extraído, e siga esta Licença em todos os outros aspectos com
relação à cópia literal do documento.

7. AGGREGATION WITH INDEPENDENT WORKS

Uma compilação do Documento ou seus derivados com outros documentos ou trabalhos separados e indepen-
dentes, dentro de ou junto a um volume de um meio de armazenagem ou distribuição, configura um “agregado” se
os direitos autorais resultantes da compilação não forem usados para limitar os direitos legais dos usuários desta
além do que os trabalhos individuais permitem. Quando o Documento é incluído em um agregado, esta Licença
não se aplica aos outros trabalhos no agregado que não forem, por sua vez, derivados do Documento.

Se o requerimento do Texto de Capa da seção 3 for aplicável a estas cópias do documento, então, se o Documento
for menor que metade do agregado inteiro, os Textos de Capa do Documento podem ser colocados em capas que
encerrem o Documento dentro do agregado, ou o equivalente eletrônico das capas se o Documento estiver em
formato eletrônico. Do contrário, eles devem aparecer como capas impressas que envolvam o agregado inteiro.

8. TRANSLATION

Uma tradução é considerada como sendo um tipo de modificação, então você pode distribuir traduções do Docu-
mento sob os termos da seção 4. A substituição de Seções Invariantes por traduções requer permissão especial dos
detentores dos direitos autorais, embora você possa incluir traduções de algumas ou todas as Seções Invariantes
juntamente às versões originais destas. Você pode incluir uma tradução desta Licença, e todas as notas de licença
no Documento, e qualquer Nota de Garantia, desde que você também inclua a versão original em Inglês desta
Licença e as versões originais das notas de licença e garantia. Em caso de discordância entre a tradução e a versão
original desta Licença ou nota de licença ou garantia, a versão original prevalecerá.

Se uma seção no Documento for intitulada “Agradecimentos”, “Dedicatória”, ou “Histórico”, o requerimento
(seção 4) de Preservar seu Título (seção 1) tipicamente exigirá a mudança do título em si.

9. TERMINATION

Você não pode copiar, modifica, sub-licenciar, ou distribuir o Documento à exceção do modo expressamente
provido por esta Licença. Qualquer outra tentativa de copiar, modificar, sub-licenciar ou distribuir o Documento é
anulada, e implicará em término automático de seus direitos sob esta Licença.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
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permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Além disso, sua licença de um detentor dos direitos autorais é permanentemente reinstalada se o detentor nofiticar
você da violação por motivos razoáveis, esta é a primeira vez que você recebeu noticias da violação desta licença
de qualquer detentor e você remedia a violaçao anteriormente a 30 dias após ter recebido a notícia.

O término dos seus direitos sobre esta seção nao finaliza a licença de partes que receberam cópias de você sobre
esta licença. Se seus direitos terminaram a não foram permanentemente reinstalados, o recebimento de uma cópia
ou parte do mesmo material nao dá a você o direito de usá-lo.

10. FUTURAS REVISÕES DESTA LICENÇA

A Fundação do Software Livre pode publicar novas, revisadas versões do GNU de tempos em tempos. A nova
versão será similar a presente versão, mas pode diferir em detalhes para encaminhar novos problemas ou preocu-
pações. Veja http://www.gnu.org/copyleft/.

Para cada versão da Licença é dado um número de versão distinto. Se o Documento especificar que uma versão
particular desta Licença “ou qualquer versão posterior” se aplica a ele, você tem a opção de seguir os termos e
condições tanto daquela versão específica, ou de qualquer versão posterior que tenha sido publicada (não como um
rascunho) pela Free Software Foundation. Se o Documento não especificar um número de versão desta Licença,
você pode escolher qualquer versão já publicada (não como rascunho) pela Free Software Foundation. Se o
Documento especificar que um procurador pode decidir quais versões futuras desta licença pode ser usada, uma
afirmação pública do procurador de aceitação de uma versão permanentemente autoriza você a escolher essa
versão para o documento.

11. RELICENCIAMENTO

“Massive Multiauthor Collaboration Site” (ou “Site MMC”) significa que qualquer servidor da World Wide Web
que publica trabalhos protegidos por direitos autorais e também oferece facilidades importantes para qualquer
pessoa para editar essas obras. Um wiki público que qualquer um pode editar, está um exemplo de um servidor. A
“Massive Multiauthor Collaboration” (ou “MMC”) contidos no site significa que qualquer conjunto de trabalhos
protegidos por direitos autorais, assim, publicado no site da MMC.

“CC-BY-SA” significa Creative Commons Attribution-Share Alike 3.0 publicado pela Creative Commons Corpo-
ration, uma corporação sem fins lucrativos com sede principal em San Francisco, Califórnia, bem como futuras
versões de copyleft da licença publicada pela mesma organização.

“Incorporar”significa publicar ou republicar um Documento, por inteiro ou em partes, como parte de outro docu-
mento.

O MMC é “elegível para um novo licenciamento” se está licenciado sob esta Licença, e se todas as obras que foram
publicadas pela primeira vez sob esta licença em outro lugar que este MMC e, posteriormente, incorporadas no
todo ou em parte para o MMC, (1) não tinha textos cobertos ou seções invariantes, e (2) foram assim incorporados
antes de 1 de novembro de 2008.

O operador de um site MMC pode republicar uma MMC contido no site sob CC-BY-SA no mesmo local, a
qualquer momento, antes de 1 de agosto de 2009, desde que o MMC é elegível para um novo licenciamento.

ADDENDUM: Como usar esta Licença em seus documentos

Para usar esta Licença num documento que você escreveu, inclua uma cópia da Licença no documento e ponha as
seguintes notas de copyright e licenças logo após a página de título:

Copyright © ANO SEU NOME. É concedida permissão para copiar, distribuir e / ou modificar este
documento sob os termos da GNU Free Documentation License, Versão 1.3 ou qualquer versão poste-
rior publicada pela Free Software Foundation; sem Secções Invariantes, sem Textos de Capa Frontal,
e sem volta Textos de Capa. Uma cópia da licença é incluída na seção intitulada “GNU Free Docu-
mentation License”.

Se você tiver Seções Invariantes, Textos de Capa Frontal e Textos de Capa Traseira, substitua a linha”com ...
Textos” por esta:

com as Seções Invariantes sendo LISTA SEUS TÍTULOS, com os Textos de Capa sendo LISTA, e
com os textos de Contra-Capa sendo LISTA.
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Se você tiver Seções Invariantes, sem Textos de Capa, ou alguma outra combinação dos três, mesclar essas duas
alternativas para se adequar a situação.

Se o documento contiver exemplos não triviais de código de programas, nós recomendamos a publicação desses
exemplos em paralelo sob a sua escolha de licença de software livre, como a GNU General Public License, para
permitir seu uso em software livre.

Docs for ‘QGIS testing’. Visit http://docs.qgis.org for QGIS 2.2 docs and translations.
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